Logic Pro Effects
for Mac
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effects overview</td>
<td>7</td>
</tr>
<tr>
<td>Effects overview</td>
<td>7</td>
</tr>
<tr>
<td>Add, remove, move, and copy plug-ins</td>
<td>8</td>
</tr>
<tr>
<td><strong>Amps and pedals</strong></td>
<td>12</td>
</tr>
<tr>
<td>Amps and pedals overview</td>
<td>12</td>
</tr>
<tr>
<td>Amp Designer</td>
<td>12</td>
</tr>
<tr>
<td>Bass Amp Designer</td>
<td>27</td>
</tr>
<tr>
<td>Pedalboard</td>
<td>38</td>
</tr>
<tr>
<td>Stompboxes</td>
<td>56</td>
</tr>
<tr>
<td><strong>Delay effects</strong></td>
<td>58</td>
</tr>
<tr>
<td>Delay effects overview</td>
<td>58</td>
</tr>
<tr>
<td>Delay Designer</td>
<td>58</td>
</tr>
<tr>
<td>Echo controls</td>
<td>75</td>
</tr>
<tr>
<td>Sample Delay controls</td>
<td>75</td>
</tr>
<tr>
<td>Stereo Delay controls</td>
<td>76</td>
</tr>
<tr>
<td>Tape Delay controls</td>
<td>78</td>
</tr>
<tr>
<td><strong>Distortion effects</strong></td>
<td>80</td>
</tr>
<tr>
<td>Distortion effects overview</td>
<td>80</td>
</tr>
<tr>
<td>Bitcrusher controls</td>
<td>80</td>
</tr>
<tr>
<td>ChromaGlow controls</td>
<td>82</td>
</tr>
<tr>
<td>Clip Distortion controls</td>
<td>84</td>
</tr>
<tr>
<td>Distortion effect controls</td>
<td>85</td>
</tr>
<tr>
<td>Distortion II controls</td>
<td>86</td>
</tr>
<tr>
<td>Overdrive controls</td>
<td>87</td>
</tr>
<tr>
<td>Phase Distortion controls</td>
<td>87</td>
</tr>
<tr>
<td><strong>Dynamics processors</strong></td>
<td>89</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----</td>
</tr>
<tr>
<td>Dynamics processors overview</td>
<td>89</td>
</tr>
<tr>
<td>Adaptive Limiter controls</td>
<td>90</td>
</tr>
<tr>
<td>Compressor</td>
<td>91</td>
</tr>
<tr>
<td>DeEsser 2 controls</td>
<td>98</td>
</tr>
<tr>
<td>Enveloper controls</td>
<td>100</td>
</tr>
<tr>
<td>Expander controls</td>
<td>101</td>
</tr>
<tr>
<td>Limiter controls</td>
<td>102</td>
</tr>
<tr>
<td>Multipressor</td>
<td>104</td>
</tr>
<tr>
<td>Noise Gate</td>
<td>108</td>
</tr>
<tr>
<td>Surround Compressor</td>
<td>111</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Equalizers</strong></th>
<th>115</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equalizers overview</td>
<td>115</td>
</tr>
<tr>
<td>Channel EQ</td>
<td>116</td>
</tr>
<tr>
<td>Linear Phase EQ</td>
<td>123</td>
</tr>
<tr>
<td>Match EQ</td>
<td>130</td>
</tr>
<tr>
<td>Single Band EQ controls</td>
<td>135</td>
</tr>
<tr>
<td>Vintage EQ Collection</td>
<td>136</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Filter effects</strong></th>
<th>142</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter effects overview</td>
<td>142</td>
</tr>
<tr>
<td>AutoFilter</td>
<td>142</td>
</tr>
<tr>
<td>EVOC 20 Filterbank</td>
<td>147</td>
</tr>
<tr>
<td>EVOC 20 TrackOscillator</td>
<td>152</td>
</tr>
<tr>
<td>Fuzz-Wah</td>
<td>163</td>
</tr>
<tr>
<td>Spectral Gate</td>
<td>167</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Imaging processors</strong></th>
<th>169</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imaging processors overview</td>
<td>169</td>
</tr>
<tr>
<td>Binaural Post-Processing controls</td>
<td>169</td>
</tr>
<tr>
<td>Spatial Audio Monitoring</td>
<td>170</td>
</tr>
<tr>
<td>Direction Mixer</td>
<td>172</td>
</tr>
<tr>
<td>Stereo Spread controls</td>
<td>175</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Mastering Assistant</strong></th>
<th>176</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mastering Assistant overview</td>
<td>176</td>
</tr>
<tr>
<td>Add Mastering Assistant to a project</td>
<td>177</td>
</tr>
<tr>
<td>Mastering Assistant parameters</td>
<td>177</td>
</tr>
<tr>
<td>Metering tools</td>
<td>181</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----</td>
</tr>
<tr>
<td>Metering tools overview</td>
<td>181</td>
</tr>
<tr>
<td>BPM Counter</td>
<td>181</td>
</tr>
<tr>
<td>Correlation Meter</td>
<td>182</td>
</tr>
<tr>
<td>Level Meter</td>
<td>182</td>
</tr>
<tr>
<td>Loudness Meter</td>
<td>184</td>
</tr>
<tr>
<td>MultiMeter</td>
<td>185</td>
</tr>
<tr>
<td>Surround MultiMeter</td>
<td>190</td>
</tr>
<tr>
<td>Use Tuner utility and plug-in</td>
<td>196</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MIDI plug-ins</th>
<th>198</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use MIDI plug-ins</td>
<td>198</td>
</tr>
<tr>
<td>Arpeggiator MIDI plug-in</td>
<td>199</td>
</tr>
<tr>
<td>Chord Trigger</td>
<td>214</td>
</tr>
<tr>
<td>Modifier controls</td>
<td>217</td>
</tr>
<tr>
<td>Modulator</td>
<td>218</td>
</tr>
<tr>
<td>Note Repeater controls</td>
<td>223</td>
</tr>
<tr>
<td>Randomizer controls</td>
<td>224</td>
</tr>
<tr>
<td>Scripter</td>
<td>225</td>
</tr>
<tr>
<td>Transposer controls</td>
<td>241</td>
</tr>
<tr>
<td>Velocity Processor</td>
<td>241</td>
</tr>
<tr>
<td>Record MIDI to Track</td>
<td>244</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Modulation effects</th>
<th>246</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modulation effects overview</td>
<td>246</td>
</tr>
<tr>
<td>Chorus controls</td>
<td>246</td>
</tr>
<tr>
<td>Ensemble controls</td>
<td>247</td>
</tr>
<tr>
<td>Flanger controls</td>
<td>248</td>
</tr>
<tr>
<td>Microphaser controls</td>
<td>249</td>
</tr>
<tr>
<td>Modulation Delay controls</td>
<td>250</td>
</tr>
<tr>
<td>Phaser controls</td>
<td>252</td>
</tr>
<tr>
<td>Ringshifter</td>
<td>253</td>
</tr>
<tr>
<td>Rotor Cabinet effect</td>
<td>258</td>
</tr>
<tr>
<td>Scanner Vibrato controls</td>
<td>262</td>
</tr>
<tr>
<td>Spreader controls</td>
<td>263</td>
</tr>
<tr>
<td>Tremolo controls</td>
<td>264</td>
</tr>
<tr>
<td>Multi effects</td>
<td>266</td>
</tr>
<tr>
<td>--------------</td>
<td>-----</td>
</tr>
<tr>
<td>Multi-effects overview</td>
<td>266</td>
</tr>
<tr>
<td>Beat Breaker</td>
<td>267</td>
</tr>
<tr>
<td>Phat FX</td>
<td>275</td>
</tr>
<tr>
<td>Remix FX</td>
<td>283</td>
</tr>
<tr>
<td>Step FX</td>
<td>286</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pitch effects</th>
<th>297</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch effects overview</td>
<td>297</td>
</tr>
<tr>
<td>Pitch Correction effect</td>
<td>297</td>
</tr>
<tr>
<td>Pitch Shifter</td>
<td>301</td>
</tr>
<tr>
<td>Vocal Transformer</td>
<td>303</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reverb effects</th>
<th>307</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverb effects overview</td>
<td>307</td>
</tr>
<tr>
<td>ChromaVerb</td>
<td>308</td>
</tr>
<tr>
<td>EnVerb controls</td>
<td>315</td>
</tr>
<tr>
<td>SilverVerb controls</td>
<td>316</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Space Designer convolution reverb</th>
<th>318</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space Designer overview</td>
<td>318</td>
</tr>
<tr>
<td>Space Designer interface</td>
<td>319</td>
</tr>
<tr>
<td>Use impulse responses</td>
<td>320</td>
</tr>
<tr>
<td>Space Designer envelopes and EQ</td>
<td>324</td>
</tr>
<tr>
<td>Space Designer global parameters</td>
<td>332</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Specialized effects</th>
<th>339</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specialized effects overview</td>
<td>339</td>
</tr>
<tr>
<td>Exciter controls</td>
<td>339</td>
</tr>
<tr>
<td>SubBass</td>
<td>340</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Utilities and tools</th>
<th>343</th>
</tr>
</thead>
<tbody>
<tr>
<td>Utilities and tools overview</td>
<td>343</td>
</tr>
<tr>
<td>Auto Sampler</td>
<td>343</td>
</tr>
<tr>
<td>Down Mixer controls</td>
<td>348</td>
</tr>
<tr>
<td>Gain controls</td>
<td>349</td>
</tr>
<tr>
<td>Use I/O utility</td>
<td>350</td>
</tr>
<tr>
<td>Multichannel Gain controls</td>
<td>351</td>
</tr>
<tr>
<td>Test Oscillator</td>
<td>352</td>
</tr>
</tbody>
</table>
Legacy effects

Legacy effects overview 354
AVerb controls 354
Bass Amp controls 355
DeEsser controls 356
Denoiser 358
Ducker controls 359
EQ 361
GoldVerb 364
Grooveshifter controls 367
Guitar Amp Pro 368
PlatinumVerb 373
Silver Compressor controls 376
Silver Gate controls 377
Speech Enhancer controls 378

Copyright 379
Effects overview

Effects overview in Logic Pro for Mac

Logic Pro provides an extensive suite of software effect plug-ins that can be used in your productions.

Effects categories include both insert effects and processors that are principally designed for mastering use. Because you’re free to use almost all plug-ins as you see fit, there are few restrictions on the use of effects anywhere in the signal path.

Most effects can be used in mono, stereo, dual mono, or surround channels. Logic Pro also provides a number of dedicated surround plug-ins.

Effects categories cover essential studio processors, such as compression, gating, limiting, equalization, and metering utilities. Both vintage and modern style compressors are emulated, making it easy to attain the sonic characteristics you need. See Dynamics processors and Metering tools.

EQ options are extensive. The Linear Phase EQ is perfect for sculpting your primary vocal and instrument parts. Match EQ analyzes existing audio and allows you to impose an analyzed sonic “fingerprint” on other audio parts. The vintage EQ collection delivers emulations of three classic analog EQ units known for their distinctive sonic coloration. See Equalizers.

A comprehensive collection of reverb, delay, and modulation effects is available to enhance your productions. Among these are the unique ChromaVerb, and the sophisticated and highly configurable Delay Designer and Space Designer plug-ins. Delay Designer lets you create precise, complex, rhythmic delays. Space Designer is a convolution reverb that uses recordings of real-world spaces, such as concert halls and canyons that you can impose on your audio, effectively placing your instrument or vocal in the space. See Reverb effects and Delay effects. Modulation processors include phasing, flanging, ring modulation, vintage rotary speaker emulation, and rich chorus effects. See Modulation effects.

If you’re a guitarist or are using the classic B3 organ, Rhodes, Clavinet, or Mellotron emulations provided by the included vintage instruments, you can choose from a vast collection of retro and modern effect pedals and amplifier simulations. See Amps and pedals.

A number of powerful Distortion and Filter effects further expand your options. The filters include vocoder-like utilities and the Spectral Gate plug-in that offer control over the formant and spectral characteristics of your sounds.
Adding a further string to your bow are the flexible, powerful, and fun multi effects units that combine a collection of processors and modulators in one place. See Multi effects. These are ideal for use with urban and dance floor-oriented tracks, but can truly transform any sound you want to run through them.

You can manipulate pitch with the Pitch Correction, Pitch Shifter and Vocal Transformer effects. These can be used for subtle corrections or for heavy Cher-like processing of vocals and instruments. See Pitch effects.

A selection of MIDI plug-ins includes a flexible arpeggiator, chord memorizer, transposer, and more. These can be inserted in instrument channels and process MIDI data in real time. If you have an interest in creating your own MIDI processing (or generation) utilities, the Scripter plug-in enables you to build custom JavaScript plug-ins. See MIDI plug-ins.

Rounding out the collection are spatial and frequency enhancement plug-ins, and useful studio utilities such as a test oscillator. See Imaging processors, Specialized effects, and Utilities and tools.

**Add, remove, move, and copy plug-ins in Logic Pro for Mac**

You can add plug-ins, replace a plug-in with a different one, and remove plug-ins from a channel strip. You can also move, copy, and bypass plug-ins. If you’re unhappy with any of your plug-in adjustments, you can undo them.

**Add an audio effect plug-in**

In a Logic Pro channel strip, do one of the following:

- Click an Audio Effect slot, then choose a plug-in from the pop-up menu.

The last visible empty Audio Effect slot in a channel strip is shown at half its height; use it in the same way.
• Option-click an Audio Effect slot.
   You can now choose legacy plug-ins from the pop-up menu.

**Add a MIDI effect plug-in**

In a Logic Pro instrument channel strip, do one of the following:

• Click the MIDI Effect slot, then choose a plug-in from the pop-up menu.

• Place the pointer above or below an occupied MIDI Effect slot, click the green line that appears, then choose a plug-in from the pop-up menu.

**Replace a plug-in**

• In a Logic Pro channel strip, place the pointer over the plug-in slot, click the arrows that appear to the right, then choose a plug-in to replace the existing one.
Remove a plug-in

• In a Logic Pro channel strip, place the pointer over the plug-in slot, click the arrows that appear to the right, then choose No Plug-in from the pop-up menu.

Move an effect or MIDI plug-in

• In a Logic Pro channel strip, drag the plug-in up or down in the channel strip, or to another channel strip.

For guidance, use the line that appears when moving the plug-in.

Copy an effect or MIDI plug-in

• In a Logic Pro channel strip, press and hold Option and drag the plug-in to an unused slot.
Bypass a plug-in

If you want to deactivate a plug-in, but don’t want to remove it from the channel strip, you can bypass it. Bypassed plug-ins don’t drain system resources.

• In Logic Pro, to bypass a single plug-in, do one of the following:
  • Place the pointer over the plug-in slot, then click the Bypass button that appears to the left.
  • Option-click the plug-in slot.
  • Click the center area of the plug-in slot to open the plug-in window, then click the Bypass button at the left side of the plug-in window header.

• To bypass multiple plug-ins, click a plug-in slot, then drag the pointer up or down. All swiped plug-in slots switch to the same state.
Amps and pedals

Amps and pedals in Logic Pro for Mac

Logic Pro features an extensive collection of guitar and bass amplifiers and classic pedal effects. You can play live—or process recorded audio and software instrument parts—through these amps and effects.

The amplifier models recreate vintage and modern tube and solid-state amps. Built-in effect units, such as reverb, tremolo, or vibrato, are also reproduced. The modeled amplifiers can be paired with a number of emulated speaker cabinets. These amplifiers and speaker cabinets can be used as a matching set or combined in other ways to create interesting hybrids.

Also emulated are a number of “classic” foot pedal effects—or stompboxes—that were, and remain, popular with guitarists and keyboardists. As with their real-world counterparts, you can chain pedals in any order to create your sound.

Stompbox effects can be used in the Pedalboard plug-in, or you can use them individually in channel strip effect slots. See Stompboxes.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Amp Designer

Amp Designer overview in Logic Pro for Mac

Amp Designer emulates the sound of more than 20 famous guitar amplifiers and the speaker cabinets used with them. Each preconfigured model combines an amp, a cabinet, and EQ that recreates a well-known guitar amplifier sound. You can process guitar signals directly, reproducing the sound of your guitar played through these amplification systems. You can also use Amp Designer for experimental sound design and processing. You can use it with other instruments as well, applying the sonic character of a guitar amp to a trumpet or vocal part, for example.

The amplifiers, cabinets, and EQs emulated by Amp Designer can be combined in numerous ways to alter the tone. Virtual microphones are used to pick up the signal of the emulated amplifier and cabinet. You can choose from, and position, seven different microphone types. Amp Designer also emulates classic guitar amplifier effects, including spring reverb, vibrato, and tremolo.
To add Amp Designer to your project, choose Amps and Pedals > Amp Designer in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

The Amp Designer interface is divided into four main parameter sections.

- **Model parameters**: The Model pop-up menu at the bottom of the window is used to choose a preconfigured model, consisting of an amplifier, a cabinet, an EQ type, and a microphone type. The other pop-up menus enable you to independently choose the type of amplifier, cabinet, and microphone. See Build a custom Amp Designer combo.

- **Amp parameters**: Located at each end of the knobs section, these parameters are used to set the input gain, presence, and output level of an amp. See Amp Designer amplifier controls.

- **Effects parameters**: Located in the center of the knobs section, these parameters control the integrated effects. See Amp Designer effects overview.

- **Microphone parameters**: Located at the right of the interface, these parameters set the type and position of the microphone that captures the amplifier and cabinet sound. See Amp Designer microphone parameters.

- **Output slider**: The Output slider (or the Output field, in the small interface) is found at the lower-right corner of the interface. It serves as the final level control for Amp Designer output that is fed to ensuing effect slots in the channel strip or directly to the channel strip output.

  *Note*: This parameter is different from the Master control, which serves the dual purpose of sound design as well as controlling the level of the Amp section.
Switch between the full and small versions of the interface

• Window size: In Logic Pro, click the disclosure arrow to switch between the full and small versions of the interface.

In the small interface, you can access all parameters except microphone selection and positioning.

Choose an Amp Designer model

You can use the Model pop-up menu to choose a preconfigured model, or you can build a customized model using the Amp, Cabinet, and Mic pop-up menus. See Build a custom Amp Designer combo. Your choices remain visible in the pop-up menus and they are also illustrated in the visual display above them. For example, if you choose Tweed 4X10 from the Cabinet pop-up menu, you see the Tweed cabinet with four 10" speakers on the right side of the display.

• Model pop-up menu: In Logic Pro, choose a preconfigured model, consisting of an amplifier, a cabinet, an EQ type, and a microphone type.

Amp Designer models in Logic Pro for Mac

You can learn about different Amp Designer models, their tone and sonic character, and the musical styles they have traditionally been associated with.
Tweed Combos

The Tweed models are based on American combos from the 1950s and early 1960s that helped define the sounds of blues, rock, and country music. They have warm, complex, clean sounds that progress smoothly through gentle distortion to raucous overdrive as you increase the gain. Even after half a century, Tweeds can still sound contemporary. Many modern boutique amplifiers are based on Tweed-style circuitry.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Tweed Combo</td>
<td>A 1 x 12&quot; combo that transitions smoothly from clean to crunchy, making it a great choice for blues and rock. For extra definition, set the Treble and Presence controls to a value around 7.</td>
</tr>
<tr>
<td>Large Tweed Combo</td>
<td>This 4 x 10&quot; combo was originally intended for bassists, but it was also used by blues and rock guitarists. It is more open and transparent-sounding than the Small Tweed Combo, but it can deliver crunchy sounds.</td>
</tr>
<tr>
<td>Mini Tweed Combo</td>
<td>A small amp with a single 10&quot; speaker, used by countless blues and rock artists. It is quite punchy-sounding and can deliver the clean and crunch tones that Tweed combos are known for.</td>
</tr>
</tbody>
</table>

⚠️ Tip: Tweed combos are responsive to playing dynamics. Adjust the knobs to create a distorted sound, then reduce the level of your guitar volume knob to create a cleaner tone. Turn up your guitar volume knob when soloing.

Classic American Combos

The Black Panel, Brown Panel, and Silver Panel models are inspired by American combos of the mid 1960s. These tend to be loud and clean with a tight low-end and restrained distortion. They are useful for clean-toned rock, vintage R & B, surf music, twangy country, jazz, or any other style where strong note definition is essential.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large Black Panel Combo</td>
<td>A 4 x 10&quot; combo with a sweet, well-balanced tone favored by rock, surf, and R &amp; B players. Great for lush, reverb-saturated chords or strident solos.</td>
</tr>
<tr>
<td>Silver Panel Combo</td>
<td>A 2 x 12&quot; combo with a loud, clean tone. It has a percussive, articulate attack that is suitable for funk, R &amp; B, and intricate chord work. It can be crunchy when overdriven, but most players favor it for clean tones.</td>
</tr>
<tr>
<td>Mini Black Panel Combo</td>
<td>A 1 x 10&quot; combo that is bright and open-sounding, with reasonable low end impact. It excels at clean tones with a minimal overdrive.</td>
</tr>
<tr>
<td>Small Brown Panel Combo</td>
<td>A 1 x 12&quot; combo that is smooth and rich-sounding, but retains a level of detail.</td>
</tr>
<tr>
<td>Blues Blaster Combo</td>
<td>A 1 x 15&quot; combo that has a clear top end with a tight, defined low end. This model is favored by blues and rock players.</td>
</tr>
</tbody>
</table>

⚠️ Tip: Although these amps tend toward a clean and tight sound, you can use a Pedalboard distortion stompbox to attain hard-edged crunch sounds with sharp treble and extended low-end definition. See Pedalboard distortion pedals.
British Stacks

The British Stack models are based on the 50- and 100-watt amplifier heads that have largely defined the sound of heavy rock, especially when paired with 4 x 12" cabinets. At medium gain settings, these amps are suitable for thick chords and riffs. Raising the gain yields lyrical solo tones and powerful rhythm guitar parts. Complex peaks and dips across the tonal spectrum keep the tones clear and appealing, even when heavy distortion is used.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vintage British Stack</td>
<td>Captures the sound of a late 1960s 50-watt amp famed for its powerful, smooth distortion. Notes retain clarity, even at maximum gain. After four decades this remains a definitive rock tone.</td>
</tr>
<tr>
<td>Modern British Stack</td>
<td>1980s and 1990s descendants of the Vintage British amplifier head, which were optimized for hard rock and metal styles of the time. Tonaly, it has a deeper and brighter sound at the low and high end, with a more &quot;scooped&quot; midrange than the Vintage British amp.</td>
</tr>
<tr>
<td>Brown Stack</td>
<td>Unique tones can be coaxed from a British head by running it at lower voltages than its designers intended. The resulting &quot;brown&quot; sound—often more distorted and loose than the standard tone—can add interesting thickness to a guitar sound.</td>
</tr>
</tbody>
</table>

⚠️ Tip: The classic British head and 4 x 12" cabinet combo is ideal for riffs at high gain levels. These heads can also sound good through small cabinets, or at clean, low-gain settings.

British Combos

The British Combos capture the brash, treble-rich sound associated with 1960s British rock and pop. The sonic signature of these amps is characterized by their high-end response, yet they are rarely harsh-sounding due to a mellow distortion and smooth compression.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>British Blues Combo</td>
<td>This 2 x 12&quot; combo has a loud, aggressive tone that is cleaner than the British heads, yet delivers rich distorted tones at high gain settings.</td>
</tr>
<tr>
<td>British Combo</td>
<td>A 2 x 12&quot; combo based on early 1960s amps. Perfect for chiming chords and crisp solos.</td>
</tr>
<tr>
<td>Small British Combo</td>
<td>A 1 x 12&quot; combo with half the power of the British Combo, this amp offers a darker, less open tone.</td>
</tr>
<tr>
<td>Boutique British Combo</td>
<td>A 2 x 12&quot; combo that is a modern take on the original 1960s sound. The tone is thicker, with stronger lows and milder highs than the other British Combos.</td>
</tr>
</tbody>
</table>

⚠️ Tip: You can often use higher Treble and Presence knob settings with the British Combos than with other amp types. If the British Blues Combo is too clean for your needs, combine it with the Pedalboard Hi Drive stompbox for an aggressive blues tone, or the Candy Fuzz stompbox for a heavy rock tone. See Pedalboard distortion pedals.
British Alternatives
The late 1960s amplifier heads and combos that inspired the Sunshine models are loud and aggressive, with full mid frequencies. These amps are useful for single note solos, power chords, and big, open chords—making them popular with the “Brit-pop” bands of the 1990s. The Stadium amps are famed for their ability to play at extremely high levels without dissolving into an indistinct distortion. They retain crisp treble and superb note definition, even at maximum gain settings.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sunshine Stack</td>
<td>A robust-sounding head paired with a 4 x 12&quot; cabinet. It is a good choice for powerful pop-rock chords. If the tone is too dark, use a high Treble knob setting to open up the sound.</td>
</tr>
<tr>
<td>Small Sunshine Combo</td>
<td>A 1 x 12&quot; combo based on a modern amp known for a “big amp” sound. It is brighter than the Sunshine Stack head and has tonal qualities similar to the 1960s British Combo. This amp also sounds good with a 4 x 12&quot; cabinet.</td>
</tr>
<tr>
<td>Stadium Stack</td>
<td>A classic head and 4 x 12&quot; cabinet configuration popular with 1970s arena rock bands. Its tones are cleaner than other Amp Designer 4 x 12&quot; stacks, but it retains body and impact. A good choice if you need power and clarity.</td>
</tr>
<tr>
<td>Stadium Combo</td>
<td>A 2 x 12&quot; combo based on a modern amp. The tone is smoother than the Stadium Stack.</td>
</tr>
</tbody>
</table>

Tip: The Stadium amps can be slow to distort, so most famous users have paired them with aggressive fuzz pedals. Try combining them with the Pedalboard Candy Fuzz or Fuzz Machine stompboxes. See Pedalboard distortion pedals.

Metal Stacks
The Metal Stack models are inspired by the powerful, high gain amplifier heads favored by modern hard rock and metal musicians. All are paired with 4 x 12" cabinets. Their signature tones range from heavy distortion to extremely heavy distortion. These models are ideal if you want powerful lows, harsh highs, and long sustain in your guitar tones.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modern American Stack</td>
<td>A powerful high-gain amp that is ideal for heavy rock and metal. Use the Mids knob to set the right amount of scoop or boost.</td>
</tr>
<tr>
<td>High Octane Stack</td>
<td>Although a powerful, high-gain amp, this model offers a smooth transition between gain settings and natural compression. It is a good choice for fast soloing and for two- or three-note chords.</td>
</tr>
<tr>
<td>Turbo Stack</td>
<td>An aggressive-sounding amp with spiky highs and noisy harmonics, especially at high gain settings. Use the Turbo Stack when you need a guitar tone that cuts through a mix.</td>
</tr>
</tbody>
</table>

Tip: Combining the Turbo Stack with distortion and fuzz pedals can diminish the edgy tone. A dry sound is often the best choice for high-impact riffs.
Additional Combos

The combos and utility models in this category are versatile amps that you can use for a wide variety of musical styles.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Studio Combo</td>
<td>A 1 x 12&quot; combo based on boutique combos of the 1980s and 1990s. These models use multiple gain stages to generate smooth, sustain-heavy distortion and bold, bright, clean sounds. Can deliver a heavier sound when paired with a 4 x 12&quot; cabinet.</td>
</tr>
<tr>
<td>Boutique Retro Combo</td>
<td>A 2 x 12&quot; combo inspired by expensive modern amps that combine the sounds of several 1960s combos. It excels at clean and crunch tones, making it a good choice when you want an old-fashioned flavor but with the crisp highs and defined lows of a modern amplifier. This model has very sensitive tone controls that can deliver countless guitar tones.</td>
</tr>
<tr>
<td>Pawnshop Combo</td>
<td>A 1 x 8&quot; combo based on the inexpensive amps sold in American department stores in the 1960s. Despite their limited features and budget workmanship, these amps are the secret behind the sound of many rock, blues, and punk players. The clean sounds are warm, and distorted sounds are thick, despite the small speaker.</td>
</tr>
<tr>
<td>Transparent Preamp</td>
<td>A preamp stage with no coloration. Note that Transparent Preamp is activated in the Amp pop-up menu, not in the Model pop-up menu.</td>
</tr>
</tbody>
</table>

**Tip:** Combine the Pawnshop Combo amp with the Pedalboard Hi Drive or Candy Fuzz stompboxes to emulate hard rock tones of the late 1960s. See Pedalboard distortion pedals.

Amp Designer cabinets in Logic Pro for Mac

Learn about the properties and tone of each cabinet model available in Amp Designer.

<table>
<thead>
<tr>
<th>Cabinet</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tweed 1 x 12</td>
<td>A 12&quot; open-back cabinet from the 1950s with a warm and smooth tone.</td>
</tr>
<tr>
<td>Tweed 4 x 10</td>
<td>A 4 x 10&quot; open-back cabinet from the late 1950s that was originally conceived for bassists but that guitarists use for its sparkling presence.</td>
</tr>
<tr>
<td>Tweed 1 x 10</td>
<td>A single 10&quot; open-back combo amp cabinet from the 1950s with a smooth sound.</td>
</tr>
<tr>
<td>Black Panel 4 x 10</td>
<td>Classic open-back cabinet with four 10&quot; speakers. Its tone is deeper and darker than the Tweed 4 x 10.</td>
</tr>
<tr>
<td>Silver Panel 2 x 12</td>
<td>An open-back model from the 1960s that provides low-end punch.</td>
</tr>
<tr>
<td>Black Panel 1 x 10</td>
<td>An open-back 1960s cabinet with glassy highs and low/mid body.</td>
</tr>
<tr>
<td>Brown Panel 1 x 12</td>
<td>A balanced 1960s open-back cabinet that is smooth, transparent, and rich-sounding.</td>
</tr>
<tr>
<td>Brown Panel 1 x 15</td>
<td>This early 1960s open-back cabinet houses the largest speaker emulated by Amp Designer. Its highs are clear and glassy, and its lows are tight and focused.</td>
</tr>
<tr>
<td>Cabinet</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vintage British 4 x 12</td>
<td>This late 1960s closed-back cabinet is synonymous with classic rock. The tone is big and thick yet also bright and lively, due to the complex phase cancelations between the four 30-watt speakers.</td>
</tr>
<tr>
<td>Modern British 4 x 12</td>
<td>A closed-back 4 x 12&quot; cabinet that is brighter and has a better low end than the Vintage British 4 x 12, with less midrange emphasis.</td>
</tr>
<tr>
<td>Brown 4 x 12</td>
<td>A closed-back 4 x 12&quot; cabinet with a good low end and complex midrange.</td>
</tr>
<tr>
<td>British Blues 2 x 12</td>
<td>A bright-sounding open-back cabinet with solid lows and crisp highs, even at high gain settings.</td>
</tr>
<tr>
<td>Modern American 4 x 12</td>
<td>A closed-back 4 x 12&quot; cabinet with a full sound. The lows and mids are denser than the British 4 x 12&quot; cabinets.</td>
</tr>
<tr>
<td>Studio 1 x 12</td>
<td>A compact-sounding open-back cabinet with full mids and glassy highs.</td>
</tr>
<tr>
<td>British 2 x 12</td>
<td>A mid 1960s open-back cabinet with an open, smooth tone.</td>
</tr>
<tr>
<td>British 1 x 12</td>
<td>A small open-back cabinet with crisp highs and low/mid transparency.</td>
</tr>
<tr>
<td>Boutique British 2 x 12</td>
<td>A 2 x 12&quot; cabinet based on the British 2 x 12. It has a richer midrange and is more powerful in the treble range.</td>
</tr>
<tr>
<td>Sunshine 4 x 12</td>
<td>A 4 x 12&quot; closed-back cabinet with a thick, rich midrange.</td>
</tr>
<tr>
<td>Sunshine 1 x 12</td>
<td>A single 12&quot; open-back combo amp cabinet with a lively sound that has bright, sweet highs, and transparent mids.</td>
</tr>
<tr>
<td>Stadium 4 x 12</td>
<td>A tight, bright, closed-back British cabinet with bold upper/mid peaks.</td>
</tr>
<tr>
<td>Stadium 2 x 12</td>
<td>A nicely balanced modern British open-back cabinet. Tonally, it is a compromise between the warmth of the Black Panel 4 x 10 and the brilliance of the British 2 x 12.</td>
</tr>
<tr>
<td>Boutique Retro 2 x 12</td>
<td>A 2 x 12&quot; cabinet based on the British 2 x 12. It has a rich, open midrange and is more powerful in the treble range.</td>
</tr>
<tr>
<td>High Octane 4 x 12</td>
<td>A modern, closed-back European cabinet with strong lows and highs and scooped mids appropriate for metal and heavy rock.</td>
</tr>
<tr>
<td>Turbo 4 x 12</td>
<td>A modern, closed-back European cabinet with strong lows, very strong highs, and deeply scooped mids appropriate for metal and heavy rock.</td>
</tr>
<tr>
<td>Pawnshop 1 x 8</td>
<td>A single 8&quot; speaker cabinet that has a strong low-end punch.</td>
</tr>
<tr>
<td>Direct</td>
<td>This option bypasses the speaker emulation section.</td>
</tr>
</tbody>
</table>

⚠️ Tip: A creative sound design option is to choose Direct from the Cabinet pop-up menu, insert Space Designer in the next free effect slot, then load one of the “warped” speaker impulse responses.
Build a custom Amp Designer combo in Logic Pro for Mac

You can use one of the default models or you can create your own hybrid of different amplifiers, cabinets, and so on. You create your own by using the Amp, Cabinet, and Mic pop-up menus, located at the bottom of the window, as well as the EQ pop-up menu.

Note: If you create your own hybrid amp combo, you can use the Settings pop-up menu to save it as a setting file, which also includes any parameter changes you have made.

Choose an Amp Designer amplifier
- In Logic Pro, choose an amplifier from the Amp pop-up menu. See Amp Designer models for details on the characteristics of each amplifier type.

Choose an Amp Designer cabinet
Cabinets have a huge impact on the character of a guitar sound (see Amp Designer cabinets).

Whereas certain amplifier and cabinet pairings have been popular for decades, departing from them can be an effective way to create fresh-sounding tones. For example, most players automatically associate British heads with 4 x 12" cabinets. Amp Designer lets you drive a small speaker with a powerful head, or pair a tiny amp with a 4 x 12" cabinet. You can experiment with random amplifier and cabinet combinations, but you can also make an educated guess about nontraditional combinations by considering the variables that determine the “sound” of the cabinet.

- In Logic Pro, choose a cabinet from the Cabinet pop-up menu. Use the following considerations to guide your decision:
  - Combos or Stacks: Combo amps include both an amplifier and speakers in a single enclosure. These usually have an open back, so the sound resonates in multiple directions. The resulting sound is open—with bright, airy highs and a spacious sound. Amplifier stacks consist of an amplifier head, with the speakers in a separate cabinet. These cabinets generally have a closed back and project the sound forward in a tight, focused beam. They tend to sound more powerful than open-back cabinets, and typically have a tighter low-end response at the expense of some high-end transparency.
• **Old or New Speakers:** Amp Designer models based on vintage cabinets capture the character of aged speakers. These may be a bit looser and duller sounding than new speakers, but many players prefer them for their smoothness and musicality. Sounds based on new cabinets tend to have more snap and bite.

• **Large Speakers or Small Speakers:** A larger speaker doesn't guarantee a larger sound. In fact, the most popular bass guitar cabinet in history uses 8" speakers. You can often get a deeper, richer tone from a 10" speaker than from a large 4 x 12" cabinet. Try several sizes and choose the one that works best for your music.

• **Single Speakers or Multiple Speakers:** Guitarists typically choose cabinets with multiple speakers for their big sound. The number of speakers is less important than it may appear. Phase cancelations occur between the speakers, adding texture and interest to the tone. Much of the “classic rock” sound, for example, is due to tonal peaks and dips caused by interactions between the speakers in a 4 x 12" cabinet.

**Choose a microphone type and placement**

1. In Logic Pro, choose a microphone model from the Mic pop-up menu.

   - **Condenser models:** Emulate the sound of high-end studio condenser microphones. The sound of condenser microphones is fine, transparent, and well-balanced. Choose Condenser 87 or Condenser 414.

   - **Dynamic models:** Emulate the sound of popular dynamic cardioid microphones. Dynamic microphones sound brighter and more cutting than Condenser models. The mid-range is boosted, with softer lower-mid frequencies, making dynamic microphones a good choice for rock guitar tones, especially if you want guitars to cut through other tracks in a mix. Choose Dynamic 20, Dynamic 57, Dynamic 421, or Dynamic 609.

   - **Ribbon 121:** Emulates the sound of a ribbon microphone. A ribbon microphone is a type of dynamic microphone that captures a sound often described as bright or brittle, yet still warm. It is useful for rock, crunch, and clean tones.

2. Drag the white dot in the graphic above the Mic pop-up menu to set the microphone position and distance relative to the cabinet.

**Choose and adjust an EQ type**

1. In Logic Pro, click the word EQ or CUSTOM EQ above the Bass, Mids, and Treble knobs to open the pop-up menu, then choose an EQ model. See [Amp Designer EQ overview](#).

2. Rotate the Bass, Mids, and Treble knobs to adjust the EQ model you choose.
Amp Designer amplifier controls in Logic Pro for Mac

The amp parameters include controls for the input gain, presence, and master output. The Gain knob is located to the left in the knobs section, the Presence and Master knobs are to the right, and the Output parameter is at the lower-right edge of the interface.

**Amplifier parameters**

- **Gain knob**: Set the amount of preamplification applied to the input signal. This control affects specific amp models in different ways. For example, when you use the British Amp, the maximum gain setting produces a powerful crunch sound. When you use the Vintage British Head or Modern British Head, the same gain setting produces heavy distortion, suitable for lead solos.

- **Presence knob**: Adjust the ultra-high frequency range—above the range of the Treble control. The Presence parameter affects only the output (Master) stage.

- **Master knob**: Set the output volume of the amplifier signal sent to the cabinet. For tube amplifiers, increasing the Master level typically produces a compressed and saturated sound, resulting in a more distorted and louder signal.

  **WARNING**: Because high Master knob settings can produce an extremely loud output that can damage your speakers or hearing, start with a low Master knob setting and then slowly increase it.

- **Output slider or field**: Set the final output level of Amp Designer.

  **Note**: The slider is replaced with a field in the small interface.

Amp Designer EQ in Logic Pro for Mac

Hardware amplifier tone controls vary among models and manufacturers. For example, the treble knobs on two different models may target different frequencies or provide different levels of cut or boost. Some equalizer (EQ) sections amplify the guitar signal more than others, thus affecting the way the amp distorts.

Amp Designer provides multiple EQ types to mirror these variations in hardware amplifiers. All EQ types have identical controls—Bass, Mids, and Treble—but these controls can behave very differently depending on which EQ type you choose.

Selecting an EQ type other than the one traditionally associated with an amplifier usually results in significant tonal changes. As with hardware amplifiers, Amp Designer EQs are calibrated to perform well with particular amplifier models. Choosing other EQ types can sometimes produce a thin or unpleasantly distorted tone.
Despite these less pleasant-sounding possibilities, it is worth experimenting with various amplifier and EQ combinations, because many can sound good together.

**EQ parameters**

- **EQ pop-up menu**: Click the word EQ or CUSTOM EQ to choose an EQ type. Each EQ model has unique tonal qualities.
- **Bass, Mids, and Treble knobs**: Adjust the EQ frequency ranges as you would with tone knobs on a hardware guitar amplifier. The behavior and response of these knobs changes when different EQ models are chosen.

**Equalizer types**

Learn about the properties and tonal qualities of each Amp Designer EQ type.

<table>
<thead>
<tr>
<th>EQ type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>British Bright</td>
<td>Inspired by the EQ of British combo amps of the 1960s, it is loud and aggressive, with stronger highs than the Vintage EQ. This EQ is useful if you want more treble definition without an overly clean sound.</td>
</tr>
<tr>
<td>Vintage</td>
<td>Emulates the EQ response of American Tweed-style amps and the vintage British stack amps that used a similar circuit. It is loud and subject to distortion. This EQ is useful if you want a rougher sound.</td>
</tr>
<tr>
<td>U.S. Classic</td>
<td>Derived from the EQ circuit of the American Black Panel amps, it has a tone of higher fidelity than the Vintage EQ, with tighter lows and crisper highs. This EQ is useful if you want to brighten your tone and reduce distortion.</td>
</tr>
<tr>
<td>Modern</td>
<td>Based on a digital EQ unit popular in the 1980s and 1990s, this EQ is useful for sculpting the aggressive highs, deep lows, and scooped mids associated with rock and metal music styles of the era.</td>
</tr>
<tr>
<td>Boutique</td>
<td>Replicating the tone section of a “retro modern” boutique amp, it excels at precise EQ adjustments, though its tone may be too clean when used with vintage amplifiers. This EQ is a good choice if you want a cleaner, brighter sound.</td>
</tr>
</tbody>
</table>
Amp Designer effects overview in Logic Pro for Mac

The effects parameters include reverb, tremolo, and vibrato, which emulate the processors found on many amplifiers. These controls are found in the center of the knobs section.

Reverb, which is controlled by an On/Off switch in the middle, can be added to either tremolo or vibrato, or it can be used independently. See Amp Designer reverb effect.

You can select either Trem(olo), which modulates the amplitude or volume of the sound, or Vib(rato), which modulates the pitch. See Amp Designer tremolo and vibrato.

Note: The Effects section is placed before the Presence and Master controls in the signal flow, and receives the pre-amplified, pre-Master signal.

Amp Designer reverb effect in Logic Pro for Mac

Reverb is always available in Amp Designer, even when you are using a model that is based on an amplifier that provides no reverb function. Reverb is controlled by an On/Off switch and a Level knob in the middle. The Reverb pop-up menu is located above these controls. You can add Reverb to either the tremolo or vibrato effect, or you can use it independently.

Reverb parameters

- **On/Off switch**: Turn the reverb effect on or off.
- **Reverb pop-up menu**: Click the word REVERB to open the pop-up menu, then choose a reverb type. Options include Vintage Spring, Simple Spring, Mellow Spring, Bright Spring, Dark Spring, Resonant Spring, Boutique Spring, Sweet Reverb, Rich Reverb, and Warm Reverb.
- **Level knob**: Set the amount of reverb applied to the preamplified signal.
Reverb types
Learn about the properties and sonic character of each Amp Designer reverb type.

<table>
<thead>
<tr>
<th>Reverb type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vintage Spring</td>
<td>This bright, splashy sound has largely defined combo amp reverb since the early 1960s.</td>
</tr>
<tr>
<td>Simple Spring</td>
<td>A darker, subtler spring sound.</td>
</tr>
<tr>
<td>Mellow Spring</td>
<td>An even darker, low-fidelity spring sound.</td>
</tr>
<tr>
<td>Bright Spring</td>
<td>Has some of the brilliance of Vintage Spring, but with less surf-style splash.</td>
</tr>
<tr>
<td>Dark Spring</td>
<td>A moody-sounding spring. More restrained than Mellow Spring.</td>
</tr>
<tr>
<td>Resonant Spring</td>
<td>Another 1960s-style spring with a strong, slightly distorted midrange emphasis.</td>
</tr>
<tr>
<td>Boutique Spring</td>
<td>A modernized version of the classic Vintage Spring with a richer tone in the bass and mids.</td>
</tr>
<tr>
<td>Sweet Reverb</td>
<td>A smooth modern reverb with rich lows and restrained highs.</td>
</tr>
<tr>
<td>Rich Reverb</td>
<td>A rich and balanced modern reverb.</td>
</tr>
<tr>
<td>Warm Reverb</td>
<td>A lush modern reverb with rich lows/mids and understated highs.</td>
</tr>
</tbody>
</table>

Amp Designer tremolo and vibrato in Logic Pro for Mac
Tremolo and vibrato are controlled by several switches and two knobs in the effects section. Tremolo modulates the amplitude or volume of the sound, and Vibrato modulates the pitch of the sound.

Tremolo and vibrato parameters
- **On/Off switch**: Turn the tremolo or vibrato effect on or off.
- **Trem/Vib switch**: Choose either tremolo or vibrato.
- **Depth knob**: Set the intensity of the modulation for either tremolo or vibrato.
- **Speed knob**: Set the speed of the modulation in hertz. Lower settings produce a smooth, floating sound. Higher settings produce a rotor-like effect.
- **Sync/Free switch**: Choose Sync to synchronize the modulation speed with the host tempo. Choose free to set values with the Speed knob. In Free mode, you can use the Speed knob to set the modulation speed to different bar, beat, and musical note values (1/8, 1/16, and so on, including triplet and dotted-note values).
Amp Designer microphone controls in Logic Pro for Mac

Amp Designer provides seven virtual microphone types. As with other components in the tone chain, different selections can yield very different results. After choosing a cabinet, you can set the type of microphone to emulate and can place the microphone, relative to the cabinet.

The Mic pop-up menu is near the lower right. The speaker-adjustment graphic appears when you move your pointer in the area above the Mic pop-up menu.

*Note:* The parameters described in this section are accessible only in the full Amp Designer interface. If you are in the small interface, click the disclosure arrow to the right of the Output field to switch to the full interface.

### Microphone parameters

- **Microphone XY pad:** Microphone position is indicated by the white dot in the XY pad. Drag the dot to change microphone position and distance. Placement is relative to the cabinet and is limited to near-field positioning.

  By default, the microphone is placed in the center of the speaker cone (on-axis). This placement produces a fuller, more powerful sound, suitable for blues or jazz guitar tones. If you place the microphone on the rim of the speaker (off-axis), you obtain a brighter, thinner tone, making it suitable for cutting rock or R & B guitar parts. Moving the microphone closer to the speaker emphasizes bass response.

- **Mic pop-up menu:** Choose a microphone model.

  - **Condenser models:** Emulates the sound of high-end studio condenser microphones. The sound of condenser microphones is fine, transparent, and well-balanced. Choose from: Condenser 87 and Condenser 414.

  - **Dynamic models:** Emulates the sound of popular dynamic cardioid microphones. Dynamic microphones sound brighter and more cutting than Condenser models. The mid-range is boosted, with softer lower-mid frequencies, making dynamic microphones a good choice for rock guitar tones; useful if you want guitars to cut through other tracks in a mix. Choose from: Dynamic 20, Dynamic 57, Dynamic 421, and Dynamic 609.
• *Ribbon 121*: Emulates the sound of a ribbon microphone. A ribbon microphone is a type of dynamic microphone that captures a sound often described as bright or brittle, yet still warm. It is useful for rock, crunch, and clean tones.

⚠️ Tip: Combining multiple microphone types can produce an interesting sound. Duplicate the guitar track, and insert Amp Designer on both tracks. Select different microphones in each Amp Designer instance while retaining identical settings for all other parameters, then set track signal levels.

### Bass Amp Designer

#### Bass Amp Designer in Logic Pro for Mac

Bass Amp Designer emulates the sound of three famous bass guitar amplifiers and the speaker cabinets used with them. Each preconfigured model combines an amp and cabinet that recreates a well-known bass guitar amplifier sound. The amp and cabinet can be combined with integrated compression and EQ units to alter the tone. You can process signals directly, reproducing the sound of your bass played through these amplification systems. Virtual microphones are used to pick up the signal of the emulated amplifier and cabinet. You can choose from, and position, three different microphone types.

When recording, many bass players use a direct connection to a mixing board or other recording equipment, often using a passive (non powered) or active (powered) D.I. box (Direct Injection box). The use of a pre-amp with passive or active EQ and a hardware compressor instead of, or in addition to, a D.I. box is extremely popular too. Bass Amp Designer emulates a professional-level American D.I. box.

Bass Amp Designer has a two channel design—one for the pre-amp and one for the D.I. box. This lets you flexibly change the signal flow for the following playing and recording configurations: pre-amp with passive or active EQ, compressor, a straight power amp, just the sound of the cabinets and microphones, D.I. box alone, bass amp alone, or both in parallel. See [Bass Amp Designer signal flow](#) and [Bass Amp Designer Pre-amp signal flow](#).

To add Bass Amp Designer to your project, choose Amps and Pedals > Bass Amp Designer in a channel strip Audio Effect plug-in menu. See [Add, remove, move, and copy plug-ins](#).
The Bass Amp Designer interface is divided into four main parameter sections.

- **Model parameters**: The Model pop-up menu at the lower left of the window is used to choose a preconfigured model, consisting of an amplifier, a cabinet, and a microphone type. The other pop-up menus enable you to independently choose the type of amplifier, cabinet, and microphone. See [Build a custom Bass Amp Designer combo](#).

- **Amp parameters**: Located at each end of the knobs section, these parameters are used to set the input gain, presence, and output level of the amp. See [Bass Amp Designer amplifier controls](#).

- **Effects parameters**: Located in the center of the knobs section, these parameters control the integrated EQ and compressor effects. A further graphic or parametric EQ is shown above the compressor controls when the EQ button is turned on. See [Bass Amp Designer effects overview](#).

- **Microphone parameters**: Located at the right of the interface, these parameters set the type and position of the microphone that captures the amplifier and cabinet sound. See [Bass Amp Designer microphone parameters](#).

- **Output slider**: The Output slider is found at the lower-right corner of the interface. It serves as the final level control for Bass Amp Designer output that is fed to ensuing effect slots in the channel strip, or directly to the channel strip output.

  *Note*: This parameter is different from the Master control, which serves the dual purpose of sound design as well as controlling the level of the Amp section.

### Choose a Bass Amp Designer model

- In Logic Pro, choose a preconfigured model, consisting of an amplifier, a cabinet, and a microphone type.

  You can use the Model pop-up menu to choose a preconfigured model, or you can build a customized model using the Amp, Cabinet, and Mic pop-up menus. See [Build a custom Bass Amp Designer combo](#). Your choices remain visible in the pop-up menus, and they are also illustrated in the visual display above them.

### Bass Amp Designer amp models in Logic Pro for Mac

Bass Amp Designer emulates the three most iconic tube bass amps and cabinets from the 1960s, 1970s, and 1980s. The table includes the cabinets that each amplifier is normally matched with.

<table>
<thead>
<tr>
<th>Amp model</th>
<th>Cabinet</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classic Amp</td>
<td>8 x 10 inch speakers</td>
<td>Emulates a 300-watt tube head introduced in 1969. It is ideal for full, fundamental tones.</td>
</tr>
<tr>
<td>Flip Top Amp</td>
<td>1 x 15 inch speaker</td>
<td>Emulates a classic six-tube bass amp with a tuned, closed-back cabinet introduced in 1960. This model is good for a range of musical styles.</td>
</tr>
<tr>
<td>Modern Amp</td>
<td>3-way speaker array</td>
<td>Emulates a 12-tube 360-watt head introduced in 1989. It is suitable for many musical styles and is the ideal choice for highly articulated performances.</td>
</tr>
</tbody>
</table>
Bass Amp Designer cabinet models in Logic Pro for Mac

The table outlines the properties of each cabinet model available in Bass Amp Designer.

<table>
<thead>
<tr>
<th>Cabinet</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modern Cabinet 15&quot;</td>
<td>1 x 15 inch speaker, closed-back design. Very deep and full tone.</td>
</tr>
<tr>
<td>Modern Cabinet 10&quot;</td>
<td>1 x 10 inch speaker, closed-back design. A punchy tone.</td>
</tr>
<tr>
<td>Modern Cabinet 6&quot;</td>
<td>1 x 6 inch speaker, closed-back design.</td>
</tr>
<tr>
<td>Classic Cabinet 8 X 10&quot;</td>
<td>8 x 10 inch speakers, closed-back design.</td>
</tr>
<tr>
<td>Flip Top Cabinet 1 X 15&quot;</td>
<td>1 x 15 inch speaker, closed-back design.</td>
</tr>
<tr>
<td>Modern 3 Way</td>
<td>1 x 15 inch speaker, 1 x 10 inch speaker, and 1 x 6 inch speaker. You can move the microphone vertically and can position it 20, 30, or 40 cm away from the cabinet.</td>
</tr>
<tr>
<td>Direct (PowerAmp Out)</td>
<td>A direct signal from the power stage of the emulated amplifier. The cabinet and microphone are removed from the signal path.</td>
</tr>
<tr>
<td>Direct (PreAmp Out)</td>
<td>A direct signal from the pre-amplifier stage of the emulated amplifier. The cabinet, microphone, and power amp are removed from the signal path.</td>
</tr>
</tbody>
</table>

Build a custom Bass Amp Designer combo in Logic Pro for Mac

You can use one of the default models or you can create your own hybrid of different amplifiers, cabinets, and so on, using the Amp, Cabinet, and Mic pop-up menus.

Note: If you create your own hybrid amp combo, you can use the Settings pop-up menu to save it as a setting file, which also includes any parameter changes you have made.

Choose a Bass Amp Designer amplifier

- In Logic Pro, choose an amplifier from the Amp pop-up menu. See Bass Amp Designer amplifier models in Logic Pro for details on the characteristics of each amplifier.

Choose a Bass Amp Designer cabinet

Cabinets have a huge impact on the character of a bass guitar sound (see Bass Amp Designer cabinet models).
Whereas certain amplifier and cabinet pairings have been popular for decades, departing from them is an effective way to create fresh-sounding tones. You can try random combinations, but if you consider the variables that determine the “sound” of a cabinet, you can make educated guesses about non-traditional amplifier and cabinet combinations.

- In Logic Pro, choose a cabinet from the Cabinet pop-up menu.
  - *Old or new speakers:* Some Bass Amp Designer models capture the character of aged speakers. These may be a bit looser and duller sounding than new speakers, but many players prefer them for their smoothness and musicality. Sounds based on new cabinets tend to have more snap and bite.
  - *Large speakers or small speakers:* Try several sizes and choose the one that works best for your music.
  - *Single speakers or multiple speakers:* The number of speakers is less important than it may appear. Phase cancelations occur between the speakers, adding texture and interest to the tone.

**Choose a microphone type and placement**

1. In Logic Pro, choose a microphone model from the Mic pop-up menu.
   - *Condenser 87:* Emulates the sound of a high-end German studio condenser microphone. The sound of condenser microphones is fine, transparent, and well-balanced.
   - *Dynamic 20:* Emulates the sound of popular American dynamic cardioid microphones. This microphone type sounds brighter and more cutting than the Condenser 87 model. The lower-mid frequencies are rolled off, making it a good choice for miking rock tones. It is especially useful if you want your bass guitar part to cut through other tracks in a mix.
   - *Dynamic 421:* Emulates the sound of a German dynamic cardioid microphone. It can capture a wide frequency range and has a slight emphasis of the treble range. It is useful for clean tones.

2. Drag the white dot in the graphic above the Mic pop-up menu to set the microphone position and distance relative to the cabinet.

**Bass Amp Designer signal flow in Logic Pro for Mac**

Bass Amp Designer has a two-channel design—one for the pre-amp and one for the D.I. box. You can use these independently or can blend them by using the controls at the bottom of the window.

![Bass Amp Designer signal flow](image)

**Important:** The two channels are always used in parallel if the Blend slider is not set to the far right or to the far left position.
The channel signal flow changes when you choose different models from the Cabinet pop-up menu.

<table>
<thead>
<tr>
<th>Cabinet</th>
<th>Blend slider position</th>
<th>Channel 1 routing</th>
<th>Channel 2 routing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any speaker cabinet model</td>
<td>Middle</td>
<td>Pre-amp, power amp, cabinet, mic</td>
<td>D.I. box</td>
</tr>
<tr>
<td>Direct (PowerAmp Out)</td>
<td>Middle</td>
<td>Pre-amp, power amp</td>
<td>D.I. box</td>
</tr>
<tr>
<td>Direct (PreAmp Out)</td>
<td>Middle</td>
<td>Pre-amp</td>
<td>D.I. box</td>
</tr>
<tr>
<td>Any speaker cabinet model</td>
<td>Far left</td>
<td>Pre-amp, power amp, cabinet, mic</td>
<td></td>
</tr>
<tr>
<td>Direct (PowerAmp Out)</td>
<td>Far left</td>
<td>Pre-amp, power amp</td>
<td></td>
</tr>
<tr>
<td>Direct (PreAmp Out)</td>
<td>Far left</td>
<td>Pre-amp</td>
<td></td>
</tr>
<tr>
<td>Direct (PreAmp Out)</td>
<td>Far right</td>
<td></td>
<td>D.I. box</td>
</tr>
</tbody>
</table>

**Bass Amp Designer Pre-amp signal flow in Logic Pro for Mac**

The pre-amp section is very flexible, and can be used in several ways when you use different combinations of On/Off and Pre/Post switches. The signal flow indicated in the Mode column is in series when multiple processors are used—that is, the output of one processor signal is fed into the next processor.

<table>
<thead>
<tr>
<th>Mode</th>
<th>EQ On/Off</th>
<th>Compressor On/Off</th>
<th>Additional EQ On/Off</th>
<th>Pre/Post switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>All off</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>EQ only</td>
<td>On</td>
<td>Off</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Compressor only</td>
<td>Off</td>
<td>On</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Additional EQ only</td>
<td>Off</td>
<td>Off</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>EQ into Compressor only</td>
<td>On</td>
<td>On</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>EQ into Additional EQ only</td>
<td>On</td>
<td>Off</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Additional EQ into Compressor only</td>
<td>Off</td>
<td>On</td>
<td>On</td>
<td>Pre</td>
</tr>
<tr>
<td>Compressor into Additional EQ only</td>
<td>Off</td>
<td>On</td>
<td>On</td>
<td>Post</td>
</tr>
<tr>
<td>All on (EQ into Additional EQ into Compressor)</td>
<td>On</td>
<td>On</td>
<td>On</td>
<td>Pre</td>
</tr>
<tr>
<td>All on (EQ into Compressor into Additional EQ)</td>
<td>On</td>
<td>On</td>
<td>On</td>
<td>Post</td>
</tr>
</tbody>
</table>
Use the Bass Amp Designer D.I. box in Logic Pro for Mac

The D.I. box is modeled on a highly regarded American D.I. unit.

D.I. box parameters

- **Boost knob**: Set the input gain of the D.I. box.
- **HF Cut button**: Turn on a highpass filter. This is used to reduce noise.
- **Tone knob**: Set the tonal color of the D.I. box. Each number represents a preset EQ curve.
  - 1: An EQ curve with a -6 dB scoop from 100 Hz to 10 kHz, most pronounced around 800 Hz. Suitable for acoustic and string instruments, electric bass, and keyboards.
  - 2: An EQ curve with a very pronounced -24 dB v-shaped notch from 100 Hz to 10 kHz, centered around 800 Hz. Suitable for electric bass guitar.
  - 3: An EQ curve with a -3 dB scoop from 100 Hz to 10 kHz, most pronounced around 800 to 1200 Hz. Suitable for acoustics, strings, electric and bass guitar, and keyboards.
  - 4: An EQ curve with a -3 dB scoop from 1 kHz to 10 kHz, most pronounced around 8 kHz. Frequencies between 60 Hz and 1 kHz have a slight boost of 1 or 2 dB above unity. Frequencies above 10 kHz have a +3 dB boost. Suitable for acoustics, strings, electric and bass guitars, and keyboards.
  - 5: A sloped EQ curve that ramps up from -24 dB at 10 Hz to +3 dB at around 900 Hz. Suitable for acoustic and electric guitar.
  - 6: A sloped EQ curve that ramps up from -24 dB at 10 Hz to +3 dB at around 900 Hz. The signal rolls off by approximately 6 dB between 10 and 20 kHz. Suitable for electric and bass guitar.
- **Tone on/off button**: Turn on the tone control.
- **Amp button**: View the Amp interface and parameters.
- **Blend slider**: Drag to hear the D.I. box alone or in parallel with the amplifier.
- **Direct Box button**: View the Direct Box interface and parameters.
Use the D.I. box only
• In Logic Pro, drag the Blend slider to the far right.

Use the D.I. box and the amplifier in parallel
• In Logic Pro, drag the Blend slider to any central position—not to the far right or the far left.

Bass Amp Designer amp controls in Logic Pro for Mac
The amp parameters include controls for channel selection, input filter and gain, and master output. The Gain knob is located to the left in the knobs section and the Master knob and Output slider are located at the far right.

Amplifier parameters
• Channel I/II switch: Switch between channel I and channel II.
  • Channel I is active, with a gain of 0 dB.
  • Channel II is passive, with a gain of -15 dB.
• Bright switch: Switch between normal and bright modes. In the bright position, highs and upper mids are added to the tone.
  Note: The increased mid and high range may lead to a perceived low end roll-off. Use the Bass EQ knob if you feel the bottom end needs a boost.
• Gain knob: Set the amount of preamplification applied to the input signal. The Gain knob affects amp models differently.
• Master knob: Set the output volume of the amplifier signal sent to the cabinet. Increasing the Master level typically produces a compressed and saturated sound, resulting in a more distorted and louder signal.
  Note: If you choose Direct PowerAmp from the Cabinet pop-up menu, the output signal is routed directly to the Amp/Direct Box Blend fader. However, if you choose Direct PreAmp from the Cabinet pop-up menu, the Master knob acts as a pre-amp master gain control before the output signal is routed to the Amp/Direct Box Blend fader.
• Output slider: Set the final output level of Bass Amp Designer.
Bass Amp Designer effects in Logic Pro for Mac

Bass Amp Designer provides multiple EQ types to sculpt your instrument tones.

It provides a basic EQ that mirrors the tonal qualities of the integrated EQ of the amplifier model you choose, if applicable. All amplifier model EQs have identical controls: Bass, Mids, and Treble. See Bass Amp Designer EQ.

Bass Amp Designer also offers an additional Graphic or Parametric EQ that you turn on with the EQ switch above the Master knob at the far right. See Bass Amp Designer Graphic EQ and Bass Amp Designer Parametric EQ.

Bass Amp Designer also integrates a dedicated, custom-built compression circuit that is optimized for electric bass. See Bass Amp Designer compressor.

Bass Amp Designer EQ in Logic Pro for Mac

The EQ section contains a larger and more inclusive set of the EQ units found in the three original bass amps emulated by Bass Amp Designer.

EQ parameters

- **EQ on/off switch**: Turn the EQ (tone controls) on or off.
- **Bass, Mids, and Treble knobs**: Adjust the frequency ranges of the EQ, similar to the tone knobs on a hardware amplifier.
- **Low switch**: Switch between two positions that affect the tone and behavior of the Bass EQ knob.
- **1-2-3 switch**: Switch between three positions that affect the tone and behavior of the Mids EQ knob.
- **High switch**: Switch between two positions that affect the tone and behavior of the Treble EQ knob.
Bass Amp Designer compressor in Logic Pro for Mac

The internal compression circuit is custom-built for use with Bass Amp Designer. It features an AutoGain function that compensates for volume reductions caused by compression.

![Compressor](image)

**Compressor parameters**

- **Compressor on/off switch**: Turn the Compressor on or off.
- **Hard/Soft switch**: Switch between two compression algorithms.
  - **Hard**: Stronger compression, with good control over levels, which makes it easier to fit the bass into an arrangement.
  - **Soft**: Compression with a slow attack and longer sustain phase.
- **Comp(ression) knob**: Set the amount of compression intensity applied to the input signal.
- **Gain knob**: Add gain to, or subtract gain from, the gain staging of the internal AutoGain feature.

  *Note: AutoGain is always active.*

Bass Amp Designer Graphic EQ in Logic Pro for Mac

Bass Amp Designer offers an additional Graphic or Parametric EQ that you turn on with the EQ switch above the Master knob at the far right.

*Note: The Graphic EQ in a pre-compressor signal flow is enabled by default.*

![Graphic EQ](image)

**Graphic EQ parameters**

- **Graphic EQ on/off switch**: Turn the graphic EQ on or off.
- **Type switch**: Click the up position to choose the Graphic EQ. Click the down position to choose the Parametric EQ.

  Graphic and Parametric EQ parameter settings are retained when switching between EQ types and when the additional EQ is turned off. This allows quick AB comparisons.
• **Pre/Post switch:** Choose whether the additional EQ is inserted before or after—pre or post—the compressor module in the signal path.
  
  *Note:* This parameter is relevant only if the Compressor is turned on.

• **Frequency sliders:** Set the amount of boost or cut for each frequency band.

### Bass Amp Designer Parametric EQ in Logic Pro for Mac

Bass Amp Designer offers an additional Graphic or Parametric EQ that you turn on with the EQ switch above the Master knob at the far right. The Parametric EQ provides two EQ bands:

• **HiMid:** Controls frequencies in the high and high-mid range.

• **LoMid:** Controls frequencies in the low and low-mid range.

### Parametric EQ parameters

• **Type switch:** Click the up position to choose the Graphic EQ. Click the down position to choose the Parametric EQ.

  Graphic and Parametric EQ parameter settings are retained when switching between EQ types and when the additional EQ is turned off. This allows quick AB comparisons.

• **Pre/Post switch:** Click to determine if the additional EQ is inserted before or after—pre or post—the compressor section within the signal flow.

  *Note:* This parameter is relevant only if the Compressor is turned on.

• **Gain knobs:** Adjust the amount of cut or boost applied to the frequency range set with the kHz knob.

• **kHz knobs:** Set the frequency range you want to cut or boost with the Gain knob.

• **Q knobs:** Set the width of the band surrounding the frequency set with the kHz knobs.

  The lower the Q knob value, the wider the band, which means that more frequencies are affected. The higher the Q knob value, the narrower the band, which means that only the frequencies nearest to the frequency set with the kHz knob are affected.

### Bass Amp Designer microphone controls in Logic Pro for Mac

Bass Amp Designer offers three virtual microphone types. As with other components in the tone chain, different selections can yield different results. After choosing a cabinet, you can choose the type of microphone to emulate and you can adjust the position of the microphone, relative to the cabinet.
The Mic pop-up menu is near the lower right. The speaker-adjustment graphic appears when you move your pointer in the area above the Mic pop-up menu.

Microphone parameters

- *Microphone XY pad:* Microphone position is indicated by the white dot in the XY pad. Drag the dot to change microphone position and distance. Placement is relative to the cabinet and is limited to near-field positioning.

  By default, the microphone is placed in the center of the speaker cone (on-axis). This placement produces a fuller, more powerful sound. If you place the microphone on the rim of the speaker (off-axis), you obtain a brighter, thinner tone. Moving the microphone closer to the speaker emphasizes bass response.

- *Mic pop-up menu:* Choose a microphone model.
  
  - *Condenser 87:* Emulates the sound of a high-end German studio condenser microphone. The sound of condenser microphones is fine, transparent, and well-balanced.
  
  - *Dynamic 20:* Emulates the sound of popular American dynamic cardioid microphones. This microphone type sounds brighter and more cutting than the Condenser 87 model. The lower-mid frequencies are rolled off, making it a good choice for miking rock tones. It is especially useful if you want your bass guitar part to cut through other tracks in a mix.
  
  - *Dynamic 421:* Emulates the sound of a German dynamic cardioid microphone. It can capture a wide frequency range and has a slight emphasis of the treble range. It is useful for clean tones.

⚠️ **Tip:** Combining multiple microphone types can produce an interesting sound. Duplicate the bass guitar track, and insert Bass Amp Designer on both tracks. Select different microphones in each Bass Amp Designer instance while retaining identical settings for all other parameters, then set track signal levels.
Pedalboard

Pedalboard overview in Logic Pro for Mac

Pedalboard simulates the sound of a number of famous “stompbox” pedal effects. You can process any audio signal with a combination of stompboxes.

You can add, remove, and reorder pedals. The signal flow runs from left to right in the Pedal area. The addition of two discrete busses, coupled with splitter and mixer units, lets you experiment with sound design and precisely control the signal at any point in the signal chain.

All stompbox knobs, switches, and sliders can be automated. Eight Macro controls enable real-time changes to any pedal parameter with a MIDI controller.

Stompbox effects can be used in the Pedalboard plug-in, or you can use them individually in channel strip effect slots. See Stompboxes.

To add Pedalboard to your project, choose Amps and Pedals > Pedalboard in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

- **Pedal Browser**: Shows all pedal effects and utilities. These can be dragged into the Pedal area as part of the signal chain. See Use the Pedalboard Browser. This interface area is also used for the alternative import mode.
- **Pedal area**: This is where you determine the order of effects and set effect parameters. You can add, replace, position, and remove stompboxes here. See Use the Pedalboard Pedal area.
- **Router**: Used to control signal flow in the two effects busses (Bus A and Bus B) available in Pedalboard. See Use the Pedalboard Router.
- **Macro Controls**: Used to assign eight MIDI controllers, which can control any stompbox parameter in real time. See Use Pedalboard Macro Controls.
Use the Pedalboard Browser in Logic Pro for Mac

Pedalboard offers dozens of pedal effects and utilities in the Pedal Browser on the right side of the interface. Each effect or utility stompbox is grouped into a category, such as distortion. Parameters of individual pedals are described in these sections:

• Pedalboard delay pedals
• Pedalboard distortion pedals
• Pedalboard dynamics pedals
• Pedalboard filter pedals
• Pedalboard modulation pedals
• Pedalboard pitch pedals
• Pedalboard utility pedals

View pop-up menu

• View pop-up menu: Choose a pedal category.
• Pedal Browser: Shows only the stompboxes within the category you choose in the View pop-up menu.
• Disclosure arrow: Hide or show the Pedal Browser.

Add a stompbox to the Pedal area

In Logic Pro, do one of the following:

• Drag the effect that you want to insert from the Pedal Browser to the appropriate Pedal area position. This can be to the left, to the right, or in between existing pedals.
• Double-click an effect in the Pedal Browser to add it to the right of all existing stompboxes in the Pedal area.

Note: Double-clicking a stompbox in the Pedal Browser when a stompbox is selected in the Pedal area replaces the selected pedal.
Use Pedalboard import mode in Logic Pro for Mac

Pedalboard has a feature you can use to import parameter settings for each type of pedal. In contrast to the plug-in window Settings pop-up menu, which you use to load a setting for the entire Pedalboard plug-in, this feature can be used to load a setting for a specific stompbox type.

Turn import mode on or off

- **Import Mode button**: Show all pedals used in the most recent Pedalboard setting. When the Import Mode button is active, the Pedal Browser switches to an alternate view mode that displays imported settings. When import mode is inactive, the normal Pedal Browser view is shown.

Import pedal settings into the Pedal Browser

1. In Logic Pro, click the Import Mode button to activate import mode.
   - Note that the View menu changes to the Select Setting button.
   - **Note**: If this is your first attempt to import settings, a dialog opens where you can select a setting to import.

2. **Select Setting button**: Select a setting, then click Open. One or more stompboxes appear in the Pedal Browser.
   - The name of the imported setting is shown at the bottom of the Pedal Browser.

Add an imported pedal to the Pedal area

In Logic Pro, do one of the following:

- **Pedal area**: Drag the stompbox that you want to add from the Pedal Browser to the appropriate Pedal area position. This can be to the left, to the right, or in between existing pedals.

- Make sure that no pedal is selected in the Pedal area, then double-click a stompbox in the Pedal Browser to add it to the right of all existing effects in the Pedal area.

  - **Note**: The parameter settings of pedals added in import mode are also imported.
Replace a pedal setting in the Pedal area with an imported pedal setting

1. In Logic Pro, click the pedal you want to replace in the Pedal area. It is highlighted with a blue outline.

2. Click the stompbox in the Pedal Browser to replace the selected pedal (or pedal setting) in the Pedal area.
   
   The blue outlines of the selected pedal in the Pedal area and Pedal Browser blink on and off to indicate an imported setting. The setting name area at the bottom of the Pedal Browser displays “Click selected item again to revert.”
   
   Note: If you want to make your replacement permanent, click the background in the Pedal Browser, or click the Import Mode button.

3. To restore the previous setting, click the highlighted stompbox in the Pedal Browser. The Import Mode button and the outline of the selected pedal (in the Pedal area) become solidly highlighted, indicating that the original setting has been restored.

Use the Pedalboard Pedal area in Logic Pro for Mac

Pedalboard stompbox effect pedals not only resemble their physical counterparts; they are also used in much the same way, albeit without patch cords, power supplies, and screws or locking mechanisms. The Pedal area layout mirrors a traditional pedalboard, with signals running from left to right.

Add a pedal to the Pedal area

In Logic Pro, do one of the following:

- Drag the stompbox that you want to insert from the Pedal Browser to the appropriate Pedal area position. This can be to the left, to the right, or in between existing pedals.

- Make sure that no pedal is selected in the Pedal area, then double-click a stompbox in the Pedal Browser to add it to the right of all existing effects in the Pedal area.
   
   Note: You insert Mixer and Splitter utility pedals in a different way. See Use the Pedalboard Router.

Change an effect pedal position in the Pedal area

- In Logic Pro, drag the stompbox to a new position, either to the right or the left.
   
   Automation and bus routings, if active, are moved with the effect pedal. For information about automation and bus routings, see Use the Pedalboard Router.
Replace a pedal in the Pedal area

In Logic Pro, do one of the following:

- Drag the stompbox from the Pedal Browser directly over the pedal you want to replace in the Pedal area.
- Click to select the stompbox you want to replace in the Pedal area, then double-click the appropriate pedal in the Pedal Browser.

Note: You can replace “effect” pedals, but not the Mixer or Splitter utilities. Bus routings, if active, are not changed when an effect pedal is replaced. See Use the Pedalboard Router.

Remove a pedal from the Pedal area

In Logic Pro, do one of the following:

- Drag the pedal downward, out of the Pedal area.
- Click the pedal to select it, and press the Delete key.

Use the Pedalboard Router in Logic Pro for Mac

Two discrete signal busses—Bus A and Bus B—provide flexibility when you’re setting up signal processing chains. Bus A (lower) and Bus B (upper) appear as horizontal gray lines in the Router. Stompboxes that you drag into the Pedal area are inserted into Bus A by default. Click the stompbox label to create Bus B if not shown, or to move the pedal between Bus A and Bus B.

Pedalboard can be inserted as a mono, mono-to-stereo, or stereo instance. This affects the appearance of the Router busses, and also available options.

- In mono instances: A single gray line appears between elements on each active Bus.
- In mono-to-stereo instances: One or two parallel gray lines appear between elements on each active Bus, depending on whether switchable mono or stereo stompboxes are inserted. See the task in this section.
- In stereo instances: Two parallel gray lines appear between elements on each active Bus.

The Router is shown only when a stompbox is added to the Pedal area. Once a stompbox has been added, the Router appears when you move your pointer to a position immediately above the Pedal area, and it disappears when you move the pointer away. When you create a second bus routing, the Router remains open even when your pointer is not over it.

Notes on Splitter utility and Mixer utility use

Dragging a Splitter utility into the Pedal area automatically inserts a Mixer utility to the far right of all inserted pedals.

You cannot drag a Splitter utility to the far right of all inserted pedals, to directly after an inserted Splitter utility, to directly in front of an inserted Mixer utility, or to an empty space in the Pedal area.
Dragging a Mixer utility into the Pedal area automatically creates a split point at the earliest possible point—the leftmost point—within the signal chain.

You cannot drag a Mixer utility to the first slot in the Pedal area, to between an inserted Splitter and Mixer utility combination, or directly to the right of an inserted Mixer utility.

**Create a second bus routing**

In Logic Pro, do one of the following:

- Move your pointer immediately above the Pedal area to open the Router, and click the name of a stompbox in the Router.

  Two gray lines (or two sets of parallel gray lines in a stereo instance) appear in the Router. The lower line represents the Bus A routing and the upper line, the Bus B routing. The pedal name moves to the upper line. The chosen stompbox is now routed to Bus B, and a Mixer utility pedal is automatically added to the end of the signal chain.

- Drag a Splitter utility pedal into the Pedal area when more than one pedal is inserted.

  This also inserts a Mixer at the end of the signal chain if one doesn’t already exist.

**Remove the second bus routing**

In Logic Pro, do one of the following:

- Delete the Mixer and Splitter utility pedals from the Pedal area.
- Remove all stompboxes from the Pedal area. This automatically removes any Mixer utility.

**Remove an effect from the second bus**

- In Logic Pro, click the name of the pedal in the Router. (You can also click the lower gray line immediately above the pedal to remove the pedal from the second bus.)

  *Note:* The removal of all effects from Bus B does not remove the second bus. The Mixer utility pedal remains in the Pedal area, even when a single stompbox (effect) is in the Pedal area. This enables parallel routing of wet and dry signals. Only when all pedal effects are removed from the Pedal area are the Mixer utility and second bus removed.

**Determine the split point between busses**

When more than one bus is active, a number of dots appear along the “cables”—the gray lines—in the Router. These represent the output of the pedal to the lower left of the dot.

- In Logic Pro, click the appropriate dot to determine the split point where the signal is routed between busses.

  A cable appears between the busses when you click a dot.

  *Note:* You cannot create a split point directly before or after the Mixer utility.

**Switch between a Splitter utility and a bus split point**

- *Split marker:* Click to move an existing Splitter utility. Double-click to replace a bus split point with a Splitter utility.

  The Splitter utility appears in the Pedal area.

- *Bus split point marker:* Indicates a routing between buses. Double-click a Splitter label to remove the utility from the Pedal area and replace it with a bus split point marker.
Change a Mixer utility position in the Pedal area

• In Logic Pro, drag the Mixer utility to a new position, either to the left or to the right.

If you move the Mixer utility to the left, the “downmix” of Bus A and Bus B occurs at the earlier insertion point. Relevant effect pedals are moved to the right and are inserted into Bus A.

If you move the Mixer utility to the right, the “downmix” of Bus A and Bus B occurs at the later insertion point. Relevant effect pedals are moved to the left and are inserted into Bus A.

Note: A Mixer pedal cannot be moved to a position directly following or preceding a corresponding split point or Splitter utility.

Change a Splitter utility position in the Pedal area

• In Logic Pro, drag the Splitter utility to a new position, either to the left or to the right.

If you move the Splitter utility to the left, the split between Bus A and Bus B occurs at the earlier insertion point. Relevant effect pedals are moved to the right and are inserted into Bus A.

If you move the Splitter utility to the right, the split between Bus A and Bus B occurs at the later insertion point. Relevant effect pedals are moved to the left and are inserted into Bus A.

Note: A Splitter pedal cannot be moved to a position directly preceding (or to the right of) a corresponding Mixer utility.

Change the mono or stereo status of a pedal in the Router

When Pedalboard is inserted as a mono-to-stereo plug-in, modulation effects and the Mixer utility can be used to switch between stereo or mono routings.

• In Logic Pro, click the icon at the right of the element name on Bus A or Bus B to switch between mono or stereo mode.

  • Single circle: Indicates a mono stompbox or Mixer utility. Signals beyond this point on the respective bus are mono, shown as a single gray line.

  The mono signal path on Bus A or Bus B is maintained until a modulation or Mixer stompbox is inserted, and is switched to stereo mode. Signals beyond this point on the respective bus will be stereo. This is indicated by a double gray line.

  • Linked circles: Indicates a stereo stompbox or Mixer utility. Signals beyond this point on the respective bus are stereo, shown as a double gray line.

  The stereo signal path on Bus A or Bus B is maintained until a modulation or Mixer stompbox is inserted, and is switched to mono mode. Signals beyond this point on the respective bus will be mono. This is indicated by a single gray line.

Use Pedalboard Macro Controls in Logic Pro for Mac

Pedalboard provides eight Macro Targets—A through H—that enable you to map any parameter of an inserted stompbox. You can save different mappings with each Pedalboard setting.
Use a controller assignment for Macro A–H Value. MIDI hardware switches, sliders, or knobs can then be used to control the mapped Pedalboard Macro A–H target parameters in real time.

- **Macro A–H Target pop-up menus**: Choose the parameter that you want to control with a MIDI controller.
- **Macro A–H Value sliders and fields**: Set and display the current value for the parameter chosen from the corresponding Macro Target pop-up menu.

**Assign a Macro A–H Target**

1. In Logic Pro, click the disclosure arrow at the bottom left to hide or show the Macro Controls area.
2. Do one of the following:
   - Choose the parameter that you want to control from any of the Macro A–H Target pop-up menus.
     Each stompbox parameter is shown in the following way: *Slot number—Pedal Name—Parameter.*
     For example, *Slot 1—Blue Echo—Time*, or *Slot 2—Roswell Ringer—Feedback.*
     The Slot number refers to the position among the pedals, as they appear from left to right in the Pedal area.
   - Choose *Auto assign* from any Macro A–H Target pop-up menu, then click the appropriate parameter in any inserted pedal.
     *Note*: The chosen parameter is displayed in the Macro A–H Target pop-up menu.

**Pedalboard delay pedals in Logic Pro for Mac**

This table describes the Delay effects pedals.

<table>
<thead>
<tr>
<th>Stompbox</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue Echo</td>
<td>Blue Echo is a simple delay effect.</td>
</tr>
<tr>
<td></td>
<td>- <em>On/Off switch</em>: Turn on or turn off the pedal.</td>
</tr>
<tr>
<td></td>
<td>- <em>Time knob</em>: Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.</td>
</tr>
<tr>
<td></td>
<td>- <em>Repeats knob</em>: Determine the number of delay repeats.</td>
</tr>
<tr>
<td></td>
<td>- <em>Mix knob</em>: Set the level balance between source and effect signals.</td>
</tr>
<tr>
<td></td>
<td>- <em>Tone Cut switch</em>: Choose a fixed frequency internal filter circuit that allows more low (Lo) or high (Hi) frequency content to be heard. Choose Off to turn off the filter.</td>
</tr>
<tr>
<td></td>
<td>- <em>Mute button</em>: Passes the source signal through to the next pedal, while delay repeats continue.</td>
</tr>
<tr>
<td></td>
<td>- <em>Sync button</em>: Turn on to synchronize the Time value with the host tempo.</td>
</tr>
</tbody>
</table>
Stompbox | Description
--- | ---
Spring Box | emulates a spring reverb effect.
• **On/Off switch:** Turn on or turn off the pedal.
• **Time knob:** Set the length of the reverberation to short, medium, or long values.
• **Tone knob:** Set the cutoff frequency, making the effect brighter or darker.
• **Style knob:** Switches between algorithms, each with different characteristics. You can choose Boutique, Simple, Vintage, Bright, or Resonant.
• **Mix knob:** Set the level balance between source and effect signals.

Tie Dye Delay | is a warm-sounding reverse delay effect that's perfect for fans of 1960s and 1970s psychedelic rock.
• **On/Off switch:** Turn on or turn off the pedal.
• **Time knob:** Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.
• **Feedback knob:** Set the amount of effect output sent to the effect input, changing the tonal color, making the effect more pronounced, or both.
• **Tone knob:** Set the cutoff frequency, making the effect brighter or darker.
• **Bright/Dark switch:** Both positions apply a fixed frequency internal EQ.
• **Mix knob:** Set the level balance between source and effect signals.
• **Listen button:** Passes the source signal through to the next pedal while delay repeats continue.
• **Sync button:** Turn on to synchronize the Time value with the host tempo.

Tru-Tape Delay | emulates a vintage tape delay effect.
• **On/Off switch:** Turn on or turn off the pedal.
• **Norm/Reverse switch:** Change the delay playback direction.
• **Lo/Hi Cut knobs:** Adjust the range of the fixed frequency internal EQ.
• **Dirt knob:** Set the amount of input signal gain, which can introduce an overdriven, saturated quality.
• **Flutter knob:** Emulate speed fluctuations in the tape transport mechanism.
• **Sync button:** Turn on to synchronize the Time value with the host tempo.
• **Time knob:** Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.
• **Feedback knob:** Set the amount of effect output sent to the effect input. The buildup of repeating signals can be used creatively for dub-delay and other effects by adjusting Feedback in real time.
• **Mix knob:** Set the level balance between source and effect signals.
Pedalboard distortion pedals in Logic Pro for Mac

This table describes the distortion effects pedals.

<table>
<thead>
<tr>
<th>Stompbox</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Candy Fuzz</td>
<td>Candy Fuzz is a bright, &quot;nasty&quot; distortion effect.</td>
</tr>
<tr>
<td>• On/Off switch: Turn on or turn off the pedal.</td>
<td></td>
</tr>
<tr>
<td>• Drive knob: Set the input gain.</td>
<td></td>
</tr>
<tr>
<td>• Level knob: Set the output level.</td>
<td></td>
</tr>
<tr>
<td>Double Dragon</td>
<td>Double Dragon is a deluxe distortion effect.</td>
</tr>
<tr>
<td>• On/Off switch: Turn on or turn off the pedal.</td>
<td></td>
</tr>
<tr>
<td>• Drive knob: Set the amount of saturation applied to the input signal.</td>
<td></td>
</tr>
<tr>
<td>• Tone knob: Set the cutoff frequency.</td>
<td></td>
</tr>
<tr>
<td>• Level knob: Set the output level.</td>
<td></td>
</tr>
<tr>
<td>• Input knob: Set the input level.</td>
<td></td>
</tr>
<tr>
<td>• Squash knob: Set the threshold for the internal compression circuit.</td>
<td></td>
</tr>
<tr>
<td>• Contour knob: Set the amount of nonlinear distortion applied to the signal.</td>
<td></td>
</tr>
<tr>
<td>• Mix knob: Set the ratio between the source and distorted signals.</td>
<td></td>
</tr>
<tr>
<td>• Bright/Fat switch: Choose between two fixed high shelving filter frequencies.</td>
<td></td>
</tr>
<tr>
<td>Fuzz Machine</td>
<td>Fuzz Machine is an American “fuzz” distortion effect.</td>
</tr>
<tr>
<td>• On/Off switch: Turn on or turn off the pedal.</td>
<td></td>
</tr>
<tr>
<td>• Fuzz knob: Set the input gain.</td>
<td></td>
</tr>
<tr>
<td>• Level knob: Set the output level.</td>
<td></td>
</tr>
<tr>
<td>• Tone knob: Increase treble, while simultaneously reducing low frequencies, as you move it to higher values.</td>
<td></td>
</tr>
<tr>
<td>Grinder</td>
<td>Grinder is a lo-fi dirty &quot;metal&quot; distortion.</td>
</tr>
<tr>
<td>• On/Off switch: Turn on or turn off the pedal.</td>
<td></td>
</tr>
<tr>
<td>• Grind knob: Set the amount of drive applied to the input signal.</td>
<td></td>
</tr>
<tr>
<td>• Filter knob: Make the sound harsher and more crunchy at higher values.</td>
<td></td>
</tr>
<tr>
<td>• Level knob: Set the output level.</td>
<td></td>
</tr>
<tr>
<td>• Full/Scoop switch: Choose between two fixed Gain/Q filter settings. At the Full position, filtering is less pronounced than at the Scoop position.</td>
<td></td>
</tr>
<tr>
<td>Stompbox</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Grit**      | A hard and nasty filtered distortion effect that sounds great on keyboards and guitars.  
• **On/Off switch**: Turn on or turn off the pedal.  
• **Volume knob**: Set the amount of drive applied to the input signal.  
• **Filter knob**: Make the sound harsher and more crunchy at higher values.  
• **Distortion knob**: Set the amount of drive applied to the output signal. |
| **Happy Face Fuzz** | A softer, full-sounding distortion effect.  
• **On/Off switch**: Turn on or turn off the pedal.  
• **Fuzz knob**: Set the amount of saturation applied to the input signal.  
• **Volume knob**: Set the output level. |
| **Hi-Drive** | An overdrive effect that can emphasize high frequency content in the signal.  
• **On/Off switch**: Turn on or turn off the pedal.  
• **Level knob**: Set the output level.  
• **Treble/Full switch**: Set a fixed shelving frequency, allowing either the treble portion or the full range input signal to be processed. |
| **Monster Fuzz** | A saturated, slightly harsh distortion.  
• **On/Off switch**: Turn on or turn off the pedal.  
• **Roar knob**: Set the amount of gain applied to the input signal.  
• **Growl knob**: Set the amount of saturation.  
• **Tone knob**: Set the overall color of the distortion. Higher values increase treble with a corresponding decrease in overall volume.  
• **Texture knob**: Smooth or roughen the distortion.  
• **Grain knob**: Set the amount of nonlinear distortion applied to the signal.  
• **Level knob**: Set the output level. |
| **Octafuzz** | A fat fuzz effect that can deliver a soft, saturated distortion.  
• **On/Off switch**: Turn on or turn off the pedal.  
• **Fuzz knob**: Set the amount of gain applied to the input signal.  
• **Level knob**: Set the output level.  
• **Tone knob**: Set the cutoff frequency of the integrated highpass filter. |
<table>
<thead>
<tr>
<th>Stompbox</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Rawk! Distortion** | A metal/hard rock distortion effect.  
- **On/Off switch**: Turn on or turn off the pedal.  
- **Crunch knob**: Set the amount of saturation applied to the input signal.  
- **Level knob**: Set the output level.  
- **Tone knob**: Set the tonal color. High values are brighter. |
| **Tube Burner** | Emulates a vacuum tube-based distortion that provides a wide palette of sounds, ranging from warm grain to crispy overdrive.  
- **On/Off switch**: Turn on or turn off the pedal.  
- **Fat switch**: Set at the top position to enhance low frequency content in the signal.  
- **Low knob**: Set the low frequency gain.  
- **Mid Freq knob**: Set the center frequency.  
- **Mid Gain knob**: Set the level of the range between the Low and High knob values.  
- **High knob**: Set the high frequency gain.  
- **Tone knob**: Set the tonal color. High values are harsher.  
- **Bias knob**: Adjust to add or avoid crossover distortion.  
- **Squash knob**: Set the threshold for the internal compression circuit.  
- **Drive knob**: Set the amount of saturation applied to the signal pre-output.  
- **Output knob**: Set the output level. |
| **Vintage Drive** | An overdrive effect that emulates the distortion produced by a field-effect transistor (FET), commonly used in solid-state amplifiers. When saturated, FETs generate a warmer-sounding distortion than bipolar transistors, such as those emulated by Grinder.  
- **On/Off switch**: Turn on or turn off the pedal.  
- **Tone knob**: Set the tonal color. High values are harsher.  
- **Drive knob**: Set the amount of saturation applied to the input signal.  
- **Level knob**: Set the output level.  
- **Fat switch**: Set at the top position to enhance low frequency content in the signal. |
Pedalboard dynamics pedals in Logic Pro for Mac

This table describes the dynamics pedals.

<table>
<thead>
<tr>
<th>Stompbox</th>
<th>Description</th>
</tr>
</thead>
</table>
| Squash Compressor | Squash Compressor is a simple compressor effect.  
• On/Off switch: Turn on or turn off the pedal.  
• Sustain knob: Set the threshold level. Signals above this value are reduced in level.  
• Level knob: Set the overall output gain.  
• Attack switch: Set to Fast for signals with fast attack transients, such as drums. Set to Slow for signals with slow attack phases, such as strings. |

Pedalboard filter pedals in Logic Pro for Mac

This table describes the filter effects pedals.

<table>
<thead>
<tr>
<th>Stompbox</th>
<th>Description</th>
</tr>
</thead>
</table>
| Auto-Funk | Auto-Funk is an auto-wah (filter) effect.  
• On/Off switch: Turn on or turn off the pedal.  
• Sensitivity knob: Set a threshold that determines how the filter responds to incoming signal levels.  
• Cutoff knob: Set the center frequency for the filter.  
• BP/LP switch: BP (Bandpass): Signal frequencies just above and below the cutoff are filtered. LP (Lowpass): Only signals below the cutoff are allowed through the filter.  
• Hi/Lo switch: Choose a preset filter resonance setting.  
• Up/Down switch: Set a positive or negative modulation direction—the “wah” filtering occurs above or below the source signal frequency. |
| Classic Wah | Classic Wah is a funky wah effect, straight from 1970s TV police show soundtracks. Drag the pedal vertically to control it.  
• On/Off switch: Turn on or turn off the pedal. |
### Stompbox Description

**Graphic EQ** is a classic 7-band EQ pedal.
- **On/Off switch:** Turn on or turn off the pedal.
- **Frequency sliders:** Drag vertically to boost or cut the corresponding frequency band.
- **Level slider:** Set the overall output gain.

**Modern Wah** is a more aggressive wah effect. Drag the pedal vertically to control it.
- **On/Off switch:** Turn on or turn off the pedal.
- **Q knob:** Low Q values affect a wider frequency range, resulting in softer resonances. High Q values affect a narrower frequency range, resulting in more pronounced emphasis.
- **Mode knob:** Choose a Wah type or control Volume. Each Wah type has a different tonal quality.

---

### Pedalboard modulation pedals in Logic Pro for Mac

This table describes the modulation effects pedals.

<table>
<thead>
<tr>
<th>Stompbox</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Flange Factory</strong> is a deluxe flanging effect with precise sound control. Can be used to switch the stereo or mono mode in the Router in mono-to-stereo instances. See <a href="#">Use the Pedalboard Router</a>.</td>
<td></td>
</tr>
<tr>
<td>- <strong>On/Off switch:</strong> Turn on or turn off the pedal.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Rate knob:</strong> Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Depth knob:</strong> Set the strength of the effect.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Reso knob:</strong> Determine the amount of cutoff frequency resonance.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Mix knob:</strong> Set the level balance between the flanging and source signals.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Wave knob:</strong> Switch between modulation waveforms.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Symmetry knob:</strong> Alter the shape of the modulation waveform.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Curve knob:</strong> Smooth the waveform shape.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Manual knob:</strong> Set a delay time between the source and effect signals. This can result in flanger-chorus effects, or in edgier-sounding modulations.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Low knob:</strong> Set the low frequency cutoff.</td>
<td></td>
</tr>
<tr>
<td>- <strong>High knob:</strong> Set the high frequency cutoff.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Sync button:</strong> Turn on to synchronize the Rate value with the host tempo.</td>
<td></td>
</tr>
<tr>
<td>Stompbox</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Heavenly Chorus</td>
<td><strong>Description:</strong> Heavenly Chorus is a rich, sweet-sounding chorus effect that thickens the sound. Can be used to switch the stereo or mono mode in the Router in mono-to-stereo instances. See Use the Pedalboard Router.  &lt;br&gt;  • <strong>On/Off switch:</strong> Turn on or turn off the pedal.  &lt;br&gt;  • <strong>Rate knob:</strong> Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.  &lt;br&gt;  • <strong>Depth knob:</strong> Set the strength of the effect.  &lt;br&gt;  • <strong>Bright switch:</strong> Set at the top position to apply a fixed frequency internal EQ. Bottom position bypasses the EQ.  &lt;br&gt;  • <strong>Feedback knob:</strong> Set the amount of effect output sent to the effect input, thickening the sound or leading to intermodulations.  &lt;br&gt;  • <strong>Density knob:</strong> Set the ratio between the original and effect signals.  &lt;br&gt;  • <strong>Sync button:</strong> Turn on to synchronize the Rate value with the host tempo.</td>
</tr>
<tr>
<td>Phase Tripper</td>
<td><strong>Description:</strong> Phase Tripper is a simple phasing effect. Can be used to switch the stereo or mono mode in the Router in mono-to-stereo instances. See Use the Pedalboard Router.  &lt;br&gt;  • <strong>On/Off switch:</strong> Turn on or turn off the pedal.  &lt;br&gt;  • <strong>Rate knob:</strong> Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.  &lt;br&gt;  • <strong>Depth knob:</strong> Set the strength of the effect.  &lt;br&gt;  • <strong>Feedback knob:</strong> Set the amount of effect output sent to the effect input, changing the tonal color, making the sweeping effect more pronounced, or both.  &lt;br&gt;  • <strong>Sync button:</strong> Turn on to synchronize the Rate value with the host tempo.</td>
</tr>
<tr>
<td>Phaze 2</td>
<td><strong>Description:</strong> Phaze 2 is a flexible dual-phaser effect. Can be used to switch the stereo or mono mode in the Router in mono-to-stereo instances. See Use the Pedalboard Router.  &lt;br&gt;  • <strong>On/Off switch:</strong> Turn on or turn off the pedal.  &lt;br&gt;  • <strong>LFO 1/2 Rate knobs:</strong> Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.  &lt;br&gt;  • <strong>LFO 1/2 Floor/Ceiling knobs:</strong> Set the lower and upper limits of the frequency range that is swept.  &lt;br&gt;  • <strong>LFO 1/2 Order knobs:</strong> Switch between algorithms, with higher (even) numbers resulting in a heavier phasing effect. Odd order numbers result in more subtle comb-filtering effects.  &lt;br&gt;  • <strong>LFO 1/2 Feedback knobs:</strong> Set the amount of effect output sent to the effect input, changing the tonal color, making the phasing effect more pronounced, or both.  &lt;br&gt;  • <strong>LFO 1/2 Tone knobs:</strong> Rotate left to increase the amount of lowpass filtering. Rotate right to increase the amount of highpass filtering.  &lt;br&gt;  • <strong>LFO 1/2 Mix knob:</strong> Set the level balance between each phaser.  &lt;br&gt;  • <strong>Sync button:</strong> Turn on to synchronize the Rate values of both LFOs with the host tempo.</td>
</tr>
</tbody>
</table>
### Stompbox Description

#### Retro Chorus

- **Description:** A subtle vintage chorus effect. Can be used to switch the stereo or mono mode in the Router in mono-to-stereo instances. See [Use the Pedalboard Router](#).
- **On/Off switch:** Turn on or turn off the pedal.
- **Rate knob:** Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.
- **Depth knob:** Set the strength of the effect.
- **Sync button:** Turn on to synchronize the Rate value with the host tempo.

#### Robo Flanger

- **Description:** A flexible flanging effect. Can be used to switch the stereo or mono mode in the Router in mono-to-stereo instances. See [Use the Pedalboard Router](#).
- **On/Off switch:** Turn on or turn off the pedal.
- **Rate knob:** Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.
- **Depth knob:** Set the strength of the effect.
- **Feedback knob:** Set the amount of effect output sent to the effect input, changing the tonal color, making the flanging effect more pronounced, or both.
- **Manual knob:** Set a delay time between the source and effect signals. This can result in flanger-chorus effects, or in metallic-sounding modulations, particularly when used with high Feedback values.
- **Sync button:** Turn on to synchronize the Rate value with the host tempo.

#### Roswell Ringer

- **Description:** A ring modulation effect that can make incoming audio sound metallic or unrecognizable, and can deliver tremolos, brighten up signals, and more. See [Ringshifter overview](#) for information on ring modulation.

#### Roto Phase

- **Description:** A phaser effect that adds movement to, and alters the phase of, the signal. Can be used to switch the stereo or mono mode in the Router in mono-to-stereo instances. See [Use the Pedalboard Router](#).
- **On/Off switch:** Turn on or turn off the pedal.
- **Rate knob:** Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.
- **Sync button:** Turn on to synchronize the Rate value with the host tempo.
- **Intensity knob:** Set the strength of the effect.
- **Vintage/Modern switch:** Vintage enables a fixed-frequency internal EQ. Modern disables the EQ.
<table>
<thead>
<tr>
<th>Stompbox</th>
<th>Description</th>
</tr>
</thead>
</table>
| Spin Box | Emulates a Leslie rotor speaker cabinet, commonly used with the Hammond B3 organ. Can be used to switch the stereo or mono mode in the Router in mono-to-stereo instances. See Use the Pedalboard Router.  
- **On/Off switch**: Turn on or turn off the pedal.  
- **Cabinet knob**: Switch between speaker box types.  
- **Fast Rate knob**: Set the maximum modulation speed; this applies only when the Fast button is active.  
- **Response knob**: Set the amount of time required for the rotor to reach its maximum and minimum speed.  
- **Drive knob**: Set the amount of input gain, which introduces distortion.  
- **Bright switch**: Turn on to mimic a forward-facing speaker horn in the cabinet, resulting in a brighter tone.  
- **Slow/Brake/Fast buttons**: Determine speaker behavior: Slow rotates the speaker slowly. Fast rotates the speaker quickly, up to the maximum speed set with the Fast Rate knob. Brake stops speaker rotation. |
| The Vibe | Is a vibrato/chorus effect based on the Scanner Vibrato effect unit found in the Hammond B3 organ. Can be used to switch the stereo or mono mode in the Router in mono-to-stereo instances. See Use the Pedalboard Router.  
- **On/Off switch**: Turn on or turn off the pedal.  
- **Rate knob**: Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.  
- **Depth knob**: Set the strength of the effect.  
- **Type knob**: Choose from three vibrato (V1–3) or chorus (C1–3) variations.  
- **Sync button**: Turn on to synchronize the Rate value with the host tempo. |
| Total Tremolo | Is a flexible tremolo effect—modulation of the signal level. Can be used to switch the stereo or mono mode in the Router in mono-to-stereo instances. See Use the Pedalboard Router.  
- **On/Off switch**: Turn on or turn off the pedal.  
- **Sync button**: Turn on to synchronize the Rate value with the host tempo.  
- **Rate knob**: Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.  
- **Depth knob**: Set the strength of the effect.  
- **Wave knob**: Set the (continuously variable) modulation waveform shape.  
- **Smooth knob**: Change the waveform shape.  
- **Volume knob**: Set the post-tremolo gain.  
- **1/2 Speed button**: Halve the current Rate value.  
- **2x Speed button**: Double the current Rate value.  
- **Speed Up button**: Hold down to gradually accelerate the current Rate value to the maximum possible value.  
- **Slow Down button**: Hold down to gradually reduce the current Rate value to the minimum possible value. |
Trem-O-Tone is a simple tremolo effect—modulation of the signal level. Can be used to switch the stereo or mono mode in the Router in mono-to-stereo instances. See Use the Pedalboard Router.

- **On/Off switch:** Turn on or turn off the pedal.
- **Rate knob:** Set the modulation speed in hertz, or synchronized with the host tempo when you turn on the Sync button.
- **Depth knob:** Set the strength of the effect.
- **Level knob:** Set the post-tremolo gain.
- **Sync button:** Turn on to synchronize the Rate value with the host tempo.

---

**Pedalboard pitch pedals in Logic Pro for Mac**

This table describes the pitch effects pedals.

<table>
<thead>
<tr>
<th>Stompbox</th>
<th>Description</th>
</tr>
</thead>
</table>
| Dr. Octave | Dr. Octave is a classic octaver effect with two independent octave controls plus an integrated overdrive.  
- **On/Off switch:** Turn on or turn off the pedal.  
- **Octave 1/2 knobs:** Set the level of each octave-shifted signal.  
- **Direct knob:** Set the balance between the direct and Octave 1 or 2 signals.  
- **Drive knob:** Set the amount of saturation applied to the output signal. |
| Wham | Wham is a pedal-controlled pitch shifter. Drag vertically to control the pitch shift amount.  
- **On/Off switch:** Turn on or turn off the pedal.  
- **Tune knob:** Set the frequency.  
- **Mix knob:** Set the level balance between the source and pitch-shifted signals. |
Pedalboard utility pedals in Logic Pro for Mac

This table describes the parameters of the Mixer and Splitter pedals.

<table>
<thead>
<tr>
<th>Utility</th>
<th>Description</th>
</tr>
</thead>
</table>
| Mixer        | Controls the level relationship between Bus A and Bus B signals. It can be inserted anywhere in the signal chain but is typically used at the end of the chain, shown at the extreme right of the Pedal area. See Use the Pedalboard Router for more information. Can be used to switch the stereo or mono mode in the Router in mono-to-stereo instances.  
• **Mix fader**: Set the level or level balance, depending on the A/Mix/B switch position.  
• **A/Mix/B switch**: Solo the “A” signal, mix the “A” and “B” signals, or solo the “B” signal.  
• **Pan A/B knobs**: Set the pan position for each bus. |
| Splitter     | Splits signals between Router buses, which you determine with the Split or Freq mode switch positions. Splitter utility can be inserted anywhere in the Router signal chain. See Use the Pedalboard Router for more information.  
• **Frequency knob**: Set the frequency used to split signals when Freq mode is active. The Frequency knob has no impact when Split mode is active.  
• **Split/Freq mode switch**: Split: The incoming signal is routed equally to both buses. Freq: Signals above the Frequency knob value are sent to Bus B. Signals below this value are sent to Bus A. |

Stompboxes

Stompboxes overview in Logic Pro for Mac

You can process any audio signal with a combination of stompboxes in the Pedalboard plug-in, or you can insert stompboxes individually in channel strip effect slots.

To add a stompbox to your project, choose Amps and Pedals > Stompboxes > Category > Stompbox name in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Each stompbox is grouped into a category, such as distortion. Parameters of individual pedals are described in these sections:

- Pedalboard delay pedals
- Pedalboard distortion pedals
- Pedalboard dynamics pedals
- Pedalboard filter pedals
- Pedalboard modulation pedals
- Pedalboard pitch pedals

**Insert a stompbox effect in an audio or instrument channel strip**

- Click an effect slot and select the stompbox name from the Amps and Pedals > Stompboxes > Category submenu.
Delay effects

Delay effects in Logic Pro for Mac

Delay effects store the input signal—and hold it for a short time—before sending it to the effect input or output.

The delayed signal creates a repeating echo effect after a given time period. Each subsequent repeat is a little quieter than the previous one. Most delays also let you feed a percentage of the delayed signal back to the input. This can result in a subtle, chorus-like effect or cascading, chaotic audio output.

The delay time can often be synchronized to the project tempo by matching the grid resolution of the project, usually in note values or milliseconds.

You can use delays to double individual sounds to resemble a group of instruments playing the same melody, to create echo effects, to place the sound in a large “space,” to generate rhythmic effects, or to enhance the stereo position of tracks in a mix.

Delay effects are generally used as channel insert or bussed effects. They are rarely used on an overall mix (in an output channel), unless you’re trying to achieve an unusual effect.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Delay Designer

Delay Designer overview in Logic Pro for Mac

Delay Designer is a multitap delay. Unlike traditional delay units that offer only one or two delays (or taps) that may or may not be fed back into the circuit, Delay Designer provides up to 26 individual taps. These taps are all fed from the source signal and can be edited to create unique delay effects.

Delay Designer provides control over the level, pan position, and pitch of each tap. Each tap can also be lowpass or highpass filtered.

Further effect-wide parameters include synchronization, quantization, and feedback.
As the name implies, Delay Designer offers significant sound design potential. You can use it for everything from a basic echo effect to an audio pattern sequencer. You can create complex, evolving, moving rhythms by synchronizing the placement of taps. This leads to further musical possibilities when coupled with judicious use of transposition and filtering. Alternatively, you can set up numerous taps as repeats of other taps, much as you would use the feedback control of a simple delay effect, but with individual control over each repeat.

To add Delay Designer to your project, choose Delay > Delay Designer in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

The Delay Designer interface consists of five main sections:

- **Main display**: Provides a visual representation of all taps. You can see and edit the parameters of each tap in this area. See Use the Delay Designer main display.

- **Tap parameter bar**: Offers a numeric overview of the current parameter settings for the selected tap. You can view and edit the parameters of each tap in this area. See Delay Designer Tap parameter bar.

- **Tap pads**: You can use these two pads to create taps in Delay Designer. See Create Delay Designer taps.

- **Sync section**: You can set all Delay Designer synchronization and quantization parameters in this area. See Use Delay Designer sync mode.

- **Master section**: This area contains the global Mix and Feedback parameters. See Delay Designer master parameters.
Delay Designer main display in Logic Pro for Mac

The main display is used to view and edit tap parameters. You can choose the parameter to show and can quickly zoom or navigate through all taps.

Main display parameters

- **View buttons**: Click to choose the parameter or parameters shown in the Tap display. See Use the Delay Designer Tap display.

- **Autozoom button**: Zoom the Tap display out to make all taps visible. Turn Autozoom off if you want to zoom the display in (by dragging vertically in the Overview display) to view specific taps.

- **Overview display**: Shows all taps in the time range.

- **Toggle buttons**: Click to turn the parameters of a particular tap on or off. The parameter being toggled is selected with the view buttons. The label at the left of the Toggle bar indicates the parameter.

- **Tap display**: Represents each tap as a shaded line. Each tap contains a bright bar (or dot for stereo panning) that indicates the value of the parameter. You can directly edit tap parameters in the Tap display area. See Edit in the Delay Designer Tap display.

- **Identification bar**: Shows an identification letter for each tap. This also serves as a time position indicator for each tap. You can move taps backward or forward in time along this bar/timeline.
Use the Delay Designer Tap display in Logic Pro for Mac

The view buttons determine the parameter shown in the Tap display.

The Toggle bar is shown below the view buttons. You can use it to turn parameters on or off for each tap.

You can use the Overview display to zoom and to navigate the Tap display area.

Tip: If the Overview display is hidden behind a tap, you can move it to the foreground by holding down Shift.

Select the parameter shown in the Tap display

- In Logic Pro, click one of the following buttons to select the parameter or parameters shown in the Tap display.

  - Cutoff button: Show the highpass and lowpass filter cutoff frequencies of taps.
  - Reso(nance) button: Show the filter resonance value of each tap.
  - Transp(ose) button: Show the pitch transposition of each tap.
  - Pan button: Show the pan parameter of each tap.
    - For mono to stereo channels, each tap contains a line showing its pan position.
    - For stereo to stereo channels, each tap contains a dot showing its stereo balance. A line extending outward from the dot indicates stereo spread.
    - For surround channels, each tap contains a line representing its surround angle. See Use Delay Designer in surround.
  - Level button: Show the relative volume level of each tap.

Tip: Press Option-Command to temporarily switch the Tap display to Level view from another view.
**Use Delay Designer tap toggle buttons**

Each tap has its own toggle button in the Toggle bar. These buttons provide a quick way to graphically turn parameters on and off. The parameter being toggled is determined by the current view button selection.

1. In Logic Pro, click the view button for the parameter you want to toggle.
2. Click the toggle button of each tap that you want to change:
   - *Cutoff view:* Turn the filter on or off.
   - *Reso view:* Switch the filter slope between 6 dB and 12 dB.
   - *Pitch view:* Switch pitch transposition on or off.
   - *Pan view:* Switch between the Flip modes.
   - *Level view:* Mute or unmute the tap.

*Note:* The first time you edit a filter or pitch transpose parameter, the filter or pitch transposition module automatically turns on. After you manually turn off either of these modules, however, you need to manually switch it back on.

**Temporarily switch the mute state of taps**

- In any view in Logic Pro, Option-Command-click a toggle button.
  
  When you release the Option and Command keys, the toggle buttons return to their standard functionality in the active view.

**Zoom the Tap display**

In Logic Pro, do one of the following:

- Vertically drag the highlighted section (the bright rectangle) in the Overview display.

- Horizontally drag the highlighted bars—to the left or right of the bright rectangle—in the Overview display.
Note: The Autozoom button needs to be turned off when you manually zoom in the Overview display. When you zoom in on a small group of taps, the Overview display continues to show all taps. The area shown in the Tap display is indicated by the bright rectangle in the Overview display.

Move to different sections of the Tap display

- In Logic Pro, horizontally drag the middle of the bright rectangle in the Overview display.

  The zoomed view in the Tap display updates as you drag.

Create Delay Designer taps in Logic Pro for Mac

You can create new delay taps in three different ways: by using the Tap pads, by creating them in the Identification bar, or by copying existing taps.

The fastest way to create multiple taps is to use the Tap pads. If you have a specific rhythm in mind, you might find it easier to tap out your rhythm on dedicated hardware controller buttons, instead of using mouse or trackpad clicks. If you have a MIDI controller, you can assign the Tap pads to buttons on your device. For information about assigning controllers, see the Control Surfaces Support Help.

After a tap has been created, you can adjust its position, or you can remove it. See Edit Delay Designer taps.

Taps are assigned letters, based on their order of creation. The first tap to be created is assigned as Tap A, the second tap is assigned as Tap B, and so on. Once assigned, each tap is always identified by the same letter, even when moved in time, and therefore reordered. For example, if you initially create three taps, they are named Tap A, Tap B, and Tap C. If you then change the delay time of Tap B so that it precedes Tap A, it is still called Tap B.

The Identification bar shows the letter of each visible tap. The Tap Delay field of the Tap parameter bar displays the letter of the currently selected tap or the letter of the tap being edited when multiple taps are selected (for details, see Edit Delay Designer taps).

Create taps with the Tap pad

1. In Logic Pro, click the upper pad (Start).

   Note: Whenever you click the Start pad, it automatically erases all existing taps. Because of this behavior, after you create your initial taps, you will want to create subsequent taps by clicking in the Identification bar.

   The upper pad label changes to Tap, and a red tap recording bar appears in the strip below the view buttons.

2. To begin recording new taps, click the Tap button.
3. To create new taps, click the Tap button.
   These are created at the exact moments in time of each click, adopting the rhythm of your click pattern.

4. To finish creating taps, click the Last Tap button.
   The final tap is added, ending tap recording, and assigning the last tap as the feedback tap (for more information about the feedback tap, see Delay Designer master parameters).

   Note: If you do not click the Last Tap button, tap recording automatically stops after 10 seconds or when the 26th tap is created, whichever comes first.

**Create a tap in the Identification bar**
- In Logic Pro, click the position where you want to add a tap.

![Identification Bar with Tap A and Delay Time Display](image)

**Copy taps in the Identification bar**
- In Logic Pro, Option-drag a selection of one or more taps to the position where you want to add the tap or taps.

   The delay time of copied taps is set to the drag position.
Edit Delay Designer taps in Logic Pro for Mac

There is always at least one selected tap. You can easily distinguish selected taps by color—the Toggle bar icons and the Identification bar letters of selected taps are white.

You can move a tap backward or forward in time or completely remove it.

Note: When you move a tap, you are actually editing its delay time.

Select a tap
In Logic Pro, do one of the following:

- Click a tap in the Tap display.
- Click the tap letter in the Identification bar.
- Click one of the arrows to the left of the Tap name to select the next or previous tap.
- Choose the tap letter from the pop-up menu to the right of the Tap name.

Select multiple taps
In Logic Pro, do one of the following:

- To select multiple taps: Drag across the background of the Tap display.
- To select multiple nonadjacent taps: Shift-click specific taps in the Tap display.
Move a selected tap in time

• In Logic Pro, in the Identification bar, drag a tap to the left to go forward in time, or to the right to go backward in time.

This method also works when more than one tap is selected.

Note: Editing the Delay Time parameter in the Tap Delay field of the Tap parameter bar also moves a tap in time. For more details about the Tap Delay field and editing taps, see Delay Designer Tap parameter bar.

Delete a tap

In Logic Pro, do one of the following:

• Select a tap, then press the Delete key.
• In the Identification bar, drag a tap letter downward, out of the Tap display.

This method also works when more than one tap is selected.

Delete all selected taps

• In Logic Pro, Control-click (or right-click) a tap, then choose “Delete tap(s)” from the shortcut menu.

Edit in the Logic Pro for Mac Delay Designer Tap display

You can graphically edit any tap parameter that is represented as a vertical line in the Tap display. The Tap display is ideal if you want to edit the parameters of one tap relative to other taps or when you need to edit or align multiple taps simultaneously.

Edit a tap parameter in the Tap display

1. In Logic Pro, click the view button of the parameter you want to edit.
2. Vertically drag the bright line of the tap you want to edit (or one of the selected taps, if multiple taps are selected).

If you selected multiple taps, the values of all selected taps are changed relative to each other.

*Note:* The method outlined above is slightly different for the Filter Cutoff and Pan parameters. See the tasks below.

### Set the values of multiple taps

- In Logic Pro, Command-drag over multiple taps to change their value.

  Parameter values change to match the pointer position as you drag across the taps. Command-dragging across several taps lets you draw value curves, much like using a pencil to create a curved line on a piece of paper.

### Align the values of several taps

1. In Logic Pro, Command-click in the Tap display, and drag while holding down the Command key.

   A line trails behind the pointer as you drag.
2. Click the appropriate position to mark the end point of the line.

The values of taps that fall between the start and end points are aligned along the line.

Reset the value of a tap

In Logic Pro, you can use the Tap display or Tap parameter bar to reset tap parameters to their default values.

- To reset a parameter to its default setting in the Tap display: Option-click a tap to reset the selected parameter to its default setting.
  
  If multiple taps are selected, Option-clicking any tap resets the chosen parameter to its default value for all selected taps.

- To reset a parameter to its default setting in the Tap parameter bar: Option-click a parameter value to reset it to the default setting.

  If multiple taps are selected, Option-clicking a parameter of any tap resets all selected taps to the default value for that parameter.

Edit filter cutoff in the Tap display

In Cutoff view, each tap actually shows two parameters: highpass and lowpass filter cutoff frequency.

- In Logic Pro, drag the cutoff frequency line—the upper line is lowpass and the lower line is highpass—to independently adjust filter cutoff values. Both cutoff frequencies can be adjusted simultaneously by dragging in the area between them.

  When the highpass filter cutoff frequency value is lower than that of the lowpass cutoff frequency, only one line is shown. This line represents the frequency band that passes through the filters—in other words, the filters act as a bandpass filter. In this configuration, the two filters operate in series which means the tap passes through one filter first, then the other.
If the highpass filter cutoff frequency value is above that of the lowpass filter cutoff frequency, the filter switches from serial operation to parallel operation, which means the tap passes through both filters simultaneously. In this case, the space between the two cutoff frequencies represents the frequency band being rejected—in other words, the filters act as a band-rejection filter.

**Edit pan in the Tap display**

In Logic Pro, the way the Pan parameter is represented in the Pan view is entirely dependent on the input channel configuration—mono to stereo, stereo to stereo, or surround.

- In mono input/stereo output configurations, all taps are initially panned to the center.
- In stereo input/stereo output configurations, the Pan parameter adjusts the stereo balance, not the position of the tap in the stereo field.

*Note: Pan is not available in mono configurations.*

*To edit the pan position in mono input/stereo output configurations:* Drag vertically from the center of the tap in the direction you want to pan the tap or taps.

A white line extends outward from the center in the direction you have dragged, reflecting the pan position of the tap or taps.

Lines above the center position indicate pans to the left, and lines below the center position denote pans to the right. Left (blue) and right (green) channels are easily identified.
• To adjust the stereo balance in stereo input/stereo output configurations: Drag the Pan parameter—which appears as a dot on the tap—up or down the tap to adjust the stereo balance.

By default, stereo spread is set to 100%. To adjust the spread width, drag either side of the dot. As you do so, the width of the line extending outward from the dot changes. Keep an eye on the Spread parameter in the Tap parameter bar while you are adjusting.

![Image showing Pan parameter](image)

*Note:* In Surround configurations, the bright line represents the surround angle. See Use Delay Designer in surround.

**Edit taps with shortcut menu commands**

• In Logic Pro, Control-click (or right-click) a tap in the Tap display, then choose one of the following commands from the shortcut menu:
  
  • *Copy sound parameters:* Copies all parameters (except the delay time) of the selected tap or taps to the Clipboard.
  
  • *Paste sound parameters:* Pastes the tap parameters from the Clipboard into the selected tap or taps. If there are more taps in the Clipboard than are selected in the Tap display, the extra taps in the Clipboard are ignored.
  
  • *Reset sound parameters to default values:* Resets all parameters of all selected taps (except the delay time) to the default values.
  
  • *2 x delay time:* Doubles the delay time of all selected taps. For example, the delay times of three taps are set as follows: Tap A = 250 ms, Tap B = 500 ms, and Tap C = 750 ms. If you select these three taps and choose “2 x delay time,” the taps are changed as follows: Tap A = 500 ms, Tap B = 1000 ms, and Tap C = 1500 ms. In other words, a rhythmic delay pattern unfolds half as fast. (In musical terms, it is played in half time.)
  
  • *1/2 x delay time:* Halves the delay time of all selected taps. Using the example above, choosing ”1/2 x delay time” changes the taps as follows: Tap A = 125 ms, Tap B = 250 ms, and Tap C = 375 ms. In other words, a rhythmic delay pattern unfolds twice as fast. (In musical terms, it is played in double time.)
  
  • *Delete tap(s):* Deletes all selected taps.
Delay Designer Tap parameter bar in Logic Pro for Mac

The Tap parameter bar provides access to all parameters of the selected tap. It also shows several parameters that are not available in the Tap display, such as Transpose and Flip.

Editing the parameters of a single, selected tap is fast and precise because all parameters are visible, with no need to switch display views or estimate values with vertical lines. If you choose multiple taps in the Tap display, the values of all selected taps are changed relative to each other.

Option-click a parameter value to reset it to the default setting. If multiple taps are selected, Option-clicking a parameter of any tap resets all selected taps to the default value for that parameter.

Tap parameter bar controls

- *Filter On/Off button:* Turn the highpass and lowpass filters on or off (for the selected tap).
- *Cutoff HP/LP fields:* Set the cutoff frequencies (in Hz) for the highpass and lowpass filters.
- *Slope buttons:* Determine the steepness of the highpass and lowpass filter slope. Click the 6 dB button for a gentler filter slope, or click the 12 dB button for a steeper, more pronounced filtering effect.
  
  *Note:* You cannot set the slope of the highpass and lowpass filters independently.
- *Reso(nance) field:* Set the amount of filter resonance for both filters.
- *Tap Delay fields:* Show the number and name of the selected tap in the upper section and the delay time in the lower section.
- *Pitch On/Off button:* Turn pitch transposition on or off (for the selected tap).
- *Transp(ose) fields:* Drag in the left field to transpose pitch by semitones. The right field fine-tunes each semitone step in cents (1/100 of a semitone).
- *Flip buttons:* Swap the left and right side of the stereo or surround image. Clicking these buttons reverses the tap position from left to right, or vice versa. For example, if a tap is set to 55% left, clicking the flip button swaps it to 55% right.
- *Pan field:* Set pan position for mono signals, stereo balance for stereo signals, or surround angle when used in surround configurations.
  
  - Pan displays a percentage between 100% (full left) and −100% (full right), which represents the pan position or balance of the tap. A value of 0% represents the center panorama position.
  - When used in surround, a surround panner replaces the percentage representation. See Use Delay Designer in surround.
• **Spread field**: Set the width of the stereo spread for the selected tap (in stereo-to-stereo or stereo-to-surround instances).

• **Mute button**: Mute (silence) or unmute the selected tap.

• **Level field**: Set the output level for the selected tap.

### Use Delay Designer sync mode in Logic Pro for Mac

Delay Designer can either synchronize to the project or concert tempo or can run independently. When you are in synchronized mode (sync mode), taps snap to a grid of musically relevant positions, based on note durations. You can also set a Swing value in sync mode, which varies the precise timing of the grid, resulting in a laid-back, less robotic feel for each tap. When you are not in sync mode, taps don’t snap to a grid, nor can you apply the Swing value.

When sync mode is on, a grid that matches the chosen Grid parameter value is shown in the Identification bar. All taps are moved toward the closest delay time value on the grid. Subsequently created or moved taps are snapped to positions on the grid.

When you save a Delay Designer setting, the sync mode status, Grid, grid position of each tap, and Swing values are all saved. This ensures that a setting loaded into a project with a different tempo retains the relative positions, and rhythm, of all taps—at the new tempo.

**Note**: Delay Designer has a maximum delay time of 10 seconds. This means that if you load a setting into a project with a slower tempo (than the tempo saved with the setting), some taps may fall outside the 10 second limit. In such cases, these taps do not play but are retained as part of the setting.
Sync parameters

- **Sync button**: Turn synchronized mode on or off.
- **Grid pop-up menu**: Choose a grid resolution from several musical note durations. The grid resolution (and project tempo) sets the length of each grid increment. As you change grid resolutions, the increments shown in the Identification bar change accordingly. This also determines a step limitation for all taps.

For example, imagine a project with a tempo of 120 bpm. The Grid pop-up menu value is set to 1/16 notes. At this tempo and grid resolution, each grid increment is 125 milliseconds (ms) apart. If Tap A is currently set to 380 ms, turning on sync mode shifts Tap A to 375 ms. If you try to move Tap A forward in time, it snaps to 500 ms, 625 ms, 750 ms, and so on. At a resolution of 1/8 notes, the steps are 250 milliseconds apart, so Tap A automatically snaps to the nearest division (500 ms) and could be moved to 750 ms, 1000 ms, 1250 ms, and so on.

- **Swing field**: Determine how close to the absolute grid position every second grid increment will be.
  - A setting of 50% means that every grid increment has the same value.
  - Settings below 50% result in every second increment being shorter in time.
  - Settings above 50% result in every second grid increment being longer in time.

⚠️ **Tip**: Use subtle grid position variations of every second increment (values between 45% and 55%) to create a less rigid rhythmic feel. High Swing values are unsubtle because they place every second increment directly beside the subsequent increment. Make use of higher values to create interesting and intricate double rhythms with some taps, while retaining the grid to lock other taps into more rigid synchronization with the project tempo.

Delay Designer master parameters in Logic Pro for Mac

The Master section incorporates two global functions: delay feedback and dry/wet mix.

In simple delays, the only way for the delay to repeat is to use feedback. Because Delay Designer offers 26 taps, you can use these taps to create repeats, rather than requiring discrete feedback controls for each tap.

The global Feedback parameter does, however, enable you to send the output of one user-defined tap back through the effect input, to create a self-sustaining rhythm or pattern. This tap is known as the feedback tap.
Master parameters

• **Feedback button:** Turn the feedback tap on or off.
• **Feedback Tap pop-up menu:** Choose a tap as the feedback tap.
• **Feedback Level knob and field:** Set the feedback tap output level before it is routed back into the input.
  - A value of 0% equals no feedback.
  - A value of 100% sends the feedback tap back into the input at full volume.

  *Note:* If Feedback is enabled and you begin creating taps with the Tap pads, Feedback is automatically turned off. When you stop creating taps with the Tap pads, Feedback is automatically re-enabled.

• **Mix sliders:** Independently set the levels of the dry input signal and the post-processing wet signal.

Use Delay Designer in surround in Logic Pro for Mac

Delay Designer is optimized for use in surround configurations. With 26 taps that can be positioned in the surround field, you can create interesting rhythmic and spatial effects.

*Note:* Delay Designer generates separate automation data for stereo pan and surround pan operations. This means that when you use it in surround channels, it does not react to existing stereo pan automation data, and vice versa.

Delay Designer always processes each input channel independently.

• In a mono/stereo input and surround output configuration, Delay Designer processes the two stereo channels independently, and the surround panner lets you place each delay around the surround field.

• In a surround input and surround output configuration, Delay Designer processes each surround channel independently and the surround panner lets you adjust the surround balance of each tap in the surround field.

When you use Delay Designer in any surround configuration, the Pan parameter on the Tap parameter bar is replaced with a surround panner, which lets you determine the surround position of each tap.

![Image](image.png)

*Note:* In the Tap display Pan view, you can adjust only the angle of taps. You must use the surround panner on the Tap Parameter bar to adjust diversity.

Adjust surround parameters

In Logic Pro:

• *To adjust diversity:* Command-drag.
• *To adjust the angle:* Option-Command-drag.
• *To reset the angle and diversity:* Option-click the blue dot.
Echo in Logic Pro for Mac

This simple echo effect always synchronizes the delay time to the project tempo, enabling you to quickly create echo effects that run in time with your composition.

To add the Echo effect to your project, choose Delay > Echo in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Echo parameters

- **Note pop-up menu and knob**: Choose the grid resolution of the delay time in musical note durations, based on the project tempo. Notes (and dots) are displayed around the Note knob when synchronized with the project tempo. Click these buttons or dots (or rotate the knob) to choose an exact synchronization value.
- **: 2 and x 2 buttons**: Halve or double the current delay time.
- **Feedback knob and field**: Determine how often the delay effect is repeated.
- **Color slider and field**: Set the harmonic content (color) of the delay signal.
- **Dry and Wet sliders and fields**: Set the amount of original and effect signal.

Sample Delay in Logic Pro for Mac

Sample Delay is more a utility than an effect—you can use it to delay a channel by single sample values.

When used in conjunction with the phase inversion capabilities of the Gain effect, Sample Delay is useful for correcting timing problems that may occur with multichannel microphones. It can also be used creatively to emulate stereo microphone channel separation.

Every sample at a frequency of 44.1 kHz is equivalent to the time taken for a sound wave to travel 7.76 millimeters. If you delay one channel of a stereo microphone by 13 samples, this emulates an acoustic (microphone) separation of 10 centimeters.
To add Sample Delay to your project, choose Delay > Sample Delay in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Sample Delay parameters

- **Delay knob (L/R) and field:** Set the number of samples or milliseconds the incoming signal is delayed by.
- **Link L & R button:** Turn on to make sure the number of samples is identical for both channels. Adjusting one channel value adjusts the other.
- **Unit buttons:** Choose Samples or ms to change the appearance and behavior of Delay knob and field values.

Stereo Delay in Logic Pro for Mac

Stereo Delay lets you set the Delay, Feedback, and Mix parameters separately for the left and right channels. The Crossfeed knob (for each stereo side) sets the feedback intensity level of each signal being routed to the opposite stereo side. You can use Stereo Delay on mono tracks or busses when you want to create independent delays for the two stereo sides.

*Note:* If you use Stereo Delay on mono channel strips, the track or bus switches to two channel operation from the point of insertion—all effect slots after the chosen slot are stereo.

To add Stereo Delay to your project, choose Delay > Stereo Delay in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
The parameters for the left and right delays are identical. The following descriptions apply to both channels. Global and Output Mix parameters are described after the channel parameters.

Channel parameters

- **Input pop-up menu**: Choose the input signal for the two stereo sides. Options include Off, Left, Right, L + R, and L – R.

- **Delay Time knob and field**: Set the delay time in milliseconds or in note values when synchronized with the project tempo. Notes (and dots) are displayed around the Delay Time knob when synchronized with the project tempo. Click these buttons or dots (or rotate the knob) to choose an exact synchronization value.

  *Note*: Clicking note or dot values resets the Deviation parameter value. Choose a value from the Note pop-up menu to retain the current Deviation value.

- **Note pop-up menu**: Set the grid resolution for the delay time when the Tempo Sync button is active.

- **Deviation field**: Set the amount of deviation from the grid.

- **: 2 and x 2 buttons**: Halve or double the current delay time.

- **Low/High Cut slider and field**: Cut frequencies below the Low Cut value and above the High Cut value from the effect signal.

- **Feedback knob and field**: Set the amount of feedback for the left and right delay signals.

- **Feedback Phase button**: Invert the phase of the corresponding channel feedback signal.

- **Crossfeed Left to Right (Right to Left) knob and field**: Transfer the feedback signal of the left channel to the right channel, and vice versa.

- **Crossfeed Phase button**: Invert the phase of the crossfed feedback signals.

Global and Output Mix parameters

- **Routing pop-up menu**: Choose the internal signal routing. Options include Customized, Straight, Crossfeed, 90/10, 10/90, Ping Pong L/R, Pan L/R, and Rotate L/R.

- **Tempo Sync button**: Synchronize delay repeats with the project tempo. Set note values with the Note pop-up menu or Delay Time knob.

- **Stereo Link button**: Turn on to make corresponding parameter adjustments for both channels. Adjusting one channel value adjusts the other. Relative values are maintained.
  
  *Press Command to temporarily flip stereo linking, allowing you to adjust a control in a linked fashion even when Stereo Link mode is not active.*

  *Command-drag a slider to adjust a single channel when in Stereo Link mode.*

  *Note*: Stereo Link mode can be automatically disabled when you choose a new routing or setting. Reenable, if required.

- **Output Mix sliders and fields**: Independently control the level of the left and right channel signals.
Tape Delay in Logic Pro for Mac

Tape Delay simulates the sound of vintage tape echo machines. It can run at a free rate or can be synchronized with the project tempo. The effect is equipped with a highpass and lowpass filter in the feedback loop, making it easy to create authentic dub echo effects. Tape Delay also includes an LFO for delay time modulation. This can be used to produce chorus effects, even on long delays.

To add Tape Delay to your project, choose Delay > Tape Delay in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Tape Delay parameters

- **Tempo Sync button:** Synchronize delay repeats with the project tempo (including tempo changes). The current tempo is shown in the field below the button. Set note values with the Note pop-up menu or Delay Time knob.

- **Delay Time knob and field:** Set the delay time in milliseconds. Notes (and dots) are displayed around the Delay Time knob when synchronized with the project tempo. Click these buttons or dots (or rotate the knob) to choose an exact synchronization value.

  Note: Clicking note or dot values resets the Deviation parameter value. Choose a value from the Note pop-up menu to retain the current Deviation value.

- **2 and x 2 buttons:** Halve or double the current delay time.

- **Note pop-up menu:** Set the grid resolution for the delay time.

- **Deviation field:** Set the amount of deviation from the grid.

- **Smoothing slider and field:** Even out the LFO and flutter effect. See LFO and Flutter parameters.

- **Clip Threshold knob:** Set the level of the distorted tape saturation signal. Higher values produce no additional audible distortion. Lower values result in an aggressive distortion. This behavior is influenced by high Feedback values which result in eventual distortion, irrespective of the Clip Threshold value. That said, aggressive distortion and signal breakup are achieved far more rapidly when a low Clip Threshold level is used.

- **Spread knob and field:** Set the width of the effect signal in stereo instances. This parameter is not available in mono instances.
• **Tape Head Mode buttons**: Choose Clean or Diffuse mode to emulate a different tape head position. This affects the behavior of other parameters, such as Flutter and Feedback.

• **Low/High Cut sliders and fields**: Cut frequencies below the Low Cut value and above the High Cut value to shape the sound of taps (delay repeats) with the highpass and lowpass filters. The filters are located in the feedback circuit, which means that the filtering effect increases in intensity with each delay repeat. If you want an increasingly muddy and confused tone, move the High Cut slider toward the left. For ever thinner echoes, move the Low Cut slider toward the right. If you can’t hear the effect, check the Dry and Wet controls and the filter settings.

• **LFO Rate knob and field**: Set the speed of the LFO.

• **LFO Intensity knob and field**: Set the amount of LFO modulation. A value of 0 turns off delay modulation.

• **Flutter Rate/Intensity knobs and fields**: Simulate the speed irregularities of tape transports used in analog tape delay units.
  
  • **Flutter Rate**: Set the speed variation.
  
  • **Flutter Intensity**: Set the intensity of the “flutter” effect.

• **Feedback knob**: Set the amount of delayed and filtered signal that is routed back to the input. Set to the lowest possible value to generate a single echo. Set to 100% to endlessly repeat the signal. The levels of the original signal and taps (echo repeats) tend to accumulate and may cause distortion. Use the Character parameters to change the color of these overdriven signals.

• **Freeze button**: Capture current delay repeats and sustain them until turned off.

• **Dry/Wet sliders and fields**: Independently control the amount of original and effect signal.
Distortion effects

Distortion effects overview in Logic Pro for Mac

Distortion effects simulate the distortion created by vacuum tubes, transistors, or digital circuits.

Vacuum tubes were used in audio amplifiers before the development of digital audio technology. They are still used in musical instrument amplifiers today. When overdriven, tubes produce a musically pleasing distortion that has become a familiar part of the sound of rock and pop music. Analog tube distortion adds a distinctive warmth and bite to the signal.

There are also distortion effects that intentionally cause clipping and digital distortion of the signal. These can be used to modify vocal, music, and other tracks to produce an intense, unnatural tone, or to create sound effects.

Distortion effects include parameters for tone, which let you shape the way the distortion alters the signal (often as a frequency-based filter), and for gain, which let you control how much the distortion alters the output level of the signal.

**WARNING:** When set to high output levels, distortion effects can damage your hearing—and your speakers. When you adjust effect settings, it is recommended that you lower the output level of the track, and raise the level gradually when you are finished.

Included are Bitcrusher, ChromaGlow, Clip Distortion, Distortion, Distortion II, Overdrive, and Phase Distortion. You’ll also find some great guitar pedal distortion effects in Pedalboard.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Bitcrusher in Logic Pro for Mac

Bitcrusher is a low-resolution digital distortion effect. You can use it to emulate the sound of early digital audio devices, to create artificial aliasing by dividing the sample rate, or to distort signals until they are unrecognizable.
To add Bitcrusher to your project, choose Distortion > Bitcrusher in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Bitcrusher parameters

- **Mode buttons**: Set the distortion mode to Fold, Clip, or Wrap. Signal peaks that exceed the clip level are processed.
  
  **Note**: The Clip Level parameter has a significant impact on the behavior of all three modes. This is reflected in the waveform display, so try each mode button and adjust the Clip Level slider to get a feel for how this works.
  
  - **Fold button**: Set a softer distortion by halving the level of the center portion of the signal above the threshold. The start and end levels of the clipped signal are unchanged.
  
  - **Clip button**: Enable to cause an abrupt distortion when the clipping threshold is exceeded. Clipping that occurs in most digital systems is closest to Cut mode.
  
  - **Wrap button**: Set a less severe distortion by offsetting the start, mid, and end levels of the signal above the threshold. This parameter smooths signal levels when they cross the threshold. The center portion of the clipped signal is also softer than in Cut mode.
  
- **Drive knob and field**: Set the amount of gain applied to the input signal.
  
  **Note**: Raising the Drive level also tends to increase the amount of clipping at the effect output.
  
- **Resolution knob and field**: Set the bit rate (between 1 and 24 bits) to alter the calculation precision of the process. Lower values increase the number of sampling errors, generating more distortion. At extremely low bit rates, the amount of distortion can be greater than the level of the usable signal.
  
- **Downsampling knob and field**: Reduce the sample rate. A value of 1x has no effect on the signal, a value of 2x halves the sample rate, and a value of 10x reduces the sample rate to one-tenth of the original. (For example, if you set Downsampling to 10x, a 44.1 kHz signal is sampled at just 4.41 kHz.)
  
  **Note**: Downsampling has no impact on the playback speed or pitch of the signal.
  
- **Mix knob and field**: Set the balance between the dry and crushed signal.
  
- **Waveform display**: Shows the impact of parameters on the distortion process.
  
- **Clip Level handle and field**: Set the point (below the clipping threshold of the channel) at which the signal starts clipping. Drag the green dot at the top left, or the field, to set the clip level.
ChromaGlow in Logic Pro for Mac

ChromaGlow is a saturation plug-in designed to replicate the warmth and coloration of analog audio equipment. By introducing harmonic distortion to incoming audio signals, it emulates the nonlinear response and subtle compression found in analog gear. This process enriches the harmonic content of the audio, resulting in a more nuanced and textured sound with enhanced character and depth. Additionally, the subtle compression effect helps to smooth out dynamics and tame transients, contributing to a polished and professional-sounding end result.

ChromaGlow is available on Macs with Apple silicon.

To add ChromaGlow to your project, choose Distortion > ChromaGlow in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

ChromaGlow parameters

- **Model pop-up menu**: Choose from a range of saturation models that emulate vintage audio equipment.
  - **Retro Tube**: Replicates the warmth and even-order harmonics characteristic of vacuum tube equipment, offering a smooth and pleasant distortion that infuses audio with warmth and a vintage ambiance.
  - **Modern Tube**: Imparts the harmonic richness, gentle compression, and pleasing distortion that is typical of tube-based gear. This type of saturation can add warmth, character, and a vintage vibe to audio signals, making it a popular choice for enhancing the sound of individual tracks or entire mixes.
  - **Magnetic**: Mimics the saturation and compression qualities of analog tape machines. It introduces a warm, organic, and slightly compressed sound, with added harmonics. It’s great for achieving a vintage, analog feel.
  - **Squeeze**: Replicates the saturation achieved through intentional pushing of a compressor, which introduces harmonic distortion and modifies the tonal characteristics of an audio signal. This imparts warmth, character, and color to the sound.
  - **Analog Preamp**: Provides an assertive, vibrant, and punchy sound characterized by a distinctively sharp and edgy quality, in contrast to the smoother distortion of tubes or the gentle saturation of tape.
• **Style pop-up menu:** Choose an alternative style for the selected model to impart a different colourization on the sound.

  • **Retro Tube:** When selected, the following styles are available:
    
    • **Clean:** Subtly and smoothly adds a touch of warmth to the sound along with a slight muddiness.
    
    • **Colorful:** Introduces a significant amount of character to the sound while also imparting a noticeable sense of muddiness.

  • **Modern Tube:** When selected, the following styles are available:
    
    • **Clean:** Delivers a pristine and transparent sound with a touch of warmth. It preserves the clarity of the audio while subtly enhancing it with the characteristics typically associated with tube amplification.
    
    • **Colorful:** Blends classic warmth with modern clarity, offering rich, harmonically nuanced audio reminiscent of vintage amps, but with improved fidelity.

  • **Magnetic:** When selected, the following styles are available:
    
    • **Colorful:** Turns on the transformer component to deliver a saturated, warm, and character-rich sound.
    
    • **Clean:** Turns off the transformer component for a cleaner signal with less harmonic content.

  • **Squeeze:** When selected, the following styles are available:
    
    • **Soft Press:** Delivers smooth, natural compression with gentle characteristics, enhancing warmth and richness. This option is ideal for achieving subtle, musical compression.
    
    • **Hard Press:** Generates assertive, punchy compression with evident distortion. Use this style for a more dramatic impact, particularly on percussive sounds, or to attain a pronounced and bold vocal presence.

  • **Analog Preamp:** When selected, the following styles are available:
    
    • **Clean:** Turns on a transistor-based saturation circuit, resulting in a cleaner signal with reduced distortion.
    
    • **Colorful:** Provides a vintage, woolly sound with soft clipping, offering a subtly compressed and warm tone.

• **Drive knob and field:** Set the amount of saturation applied to the signal.

• **Bypass Below button:** Turn the Bypass Below control on or off.

• **Bypass Below field:** Set the highpass filter frequency, preserving high frequencies while distorting mid and low frequencies.

• **Level In field:** Set the amount of gain applied to the plug-in input signal.

• **Level Out field:** Set the amount of gain applied to the plug-in output signal.

• **Mix field:** Set the percentage of the effect signal mixed with the original signal.

• **Display:** Shows the intensity of the saturation settings on the signal.
Low Cut parameters

- *Low Cut button:* Turn the low cut filter on or off.
- *Slope pop-up menu:* Choose a slope to determine the extent of frequency reduction. Increasing the slope to a higher number results in more extreme filtering.
- *Frequency field:* Set the cutoff frequency of the lowpass filter.
- *Resonance field:* Set to emphasize frequencies surrounding the cutoff frequency.
- *Pre/Post buttons:* Apply low cut equalization adjustments to the audio signal before or after the saturation effect is applied.

High Cut parameters

- *High Cut button:* Turn the high cut filter on or off.
- *Slope pop-up menu:* Choose a slope to determine the extent of frequency reduction. Increasing the slope to a higher number results in more extreme filtering.
- *Frequency field:* Set the cutoff frequency of the highpass filter.
- *Resonance field:* Set to emphasize frequencies surrounding the cutoff frequency.
- *Pre/Post buttons:* Apply high cut equalization adjustments to the audio signal before or after the saturation effect is applied.

Clip Distortion in Logic Pro for Mac

Clip Distortion is a nonlinear distortion effect that produces unpredictable harmonic spectra. It can simulate warm, overdriven tube sounds and can also generate heavy distortions.

Clip Distortion has an unusual combination of serially connected filters. The incoming signal is amplified by the Drive value, passes through a highpass filter, then is subjected to nonlinear distortion. Following the distortion, the signal passes through a lowpass filter. The effect signal is then recombined with the original signal, and this mixed signal is sent through a further lowpass filter. All three filters have a slope of 6 dB/octave.

This unique combination of filters allows for gaps in the frequency spectra that can sound good with this sort of nonlinear distortion.

To add Clip Distortion to your project, choose Distortion > Clip Distortion in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Clip Distortion parameters

- **Input Gain knob and field:** Set the amount of gain applied to the plug-in input signal. This behaves like a preamplifier for the Drive parameter.

- **Drive knob and field:** Set the amount of additional gain (distortion) applied to the input signal. After being amplified by Drive, the signal passes through a highpass filter.

- **Clip circuit display:** Shows the impact of all parameters.
  - **Tone handle and field:** Set the cutoff frequency (in hertz) of the highpass filter.
  - **Symmetry handle and field:** Set the amount of nonlinear (asymmetrical) distortion applied to the signal.
  - **Clip Filter handle and field:** Set the cutoff frequency (in hertz) of the first lowpass filter.

- **Mix knob and field:** Set the ratio between the effect (wet) signal and original (dry) signals, following the clip filter.

- **High Shelving knob and field:** Set the frequency (in hertz) of the high shelving filter. If you set the High Shelving Frequency to around 12 kHz, you can use it like the treble control on a mixer channel strip or a stereo hi-fi amplifier. Unlike these types of treble controls, however, you can boost or cut the signal by up to ±30 dB with the Gain parameter.

- **LP Filter knob and field:** Set the cutoff frequency (in hertz) of the lowpass filter. This processes the mixed signal.

- **Gain knob and field:** Set the amount of gain applied to the output of signals above the high shelving filter frequency.

- **Output Gain knob and field:** Set the amount of gain applied to the plug-in output signal.

Distortion effect in Logic Pro for Mac

The Distortion effect simulates the low fidelity distortion generated by a bipolar transistor. You can use it to simulate playing a musical instrument through a highly overdriven amplifier or to create unique distorted sounds.

To add the Distortion effect to your project, choose Distortion > Distortion in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Distortion parameters

- *Drive knob and field*: Set the amount of saturation applied to the signal.
- *Tone knob and field*: Set the frequency for the high cut filter. Filtering the harmonically rich distorted signal produces a softer tone.
- *Output knob and field*: Set the output level.
- *Level Compensation button*: Turn on to reference the overall processing of the signal to 0 dB. This compensates for increases in loudness caused by adding distortion.
- *Display*: Shows the impact of parameters on the signal.

Distortion II in Logic Pro for Mac

Distortion II emulates the distortion circuit of a Hammond B3 organ. You can use it on musical instruments to recreate this classic effect or can use it creatively when designing new sounds.

To add the Distortion II effect to your project, choose Distortion > Distortion II in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Distortion II parameters

- *PreGain knob and field*: Set the amount of gain applied to the input signal.
- *Drive knob and field*: Set the amount of saturation applied to the signal.
- *Tone knob and field*: Boosts the integrated high shelf filter gain both pre- and post-distortion, which results in a different tone.
- *Type pop-up menu*: Choose the type of distortion.
  - *Growl*: Emulates a two-stage tube amplifier similar to the type found in a Leslie 122 speaker cabinet, which is often used with the Hammond B3 organ.
  - *Bity*: Emulates the sound of a bluesy (overdriven) guitar amp.
  - *Nasty*: Produces hard distortion, suitable for creating very aggressive sounds.
  - *Class AB soft*: Emulates a softer crossover distortion encountered in transistorized amplifiers when driving a higher load.
  - *Class AB hard*: Emulates a harder crossover distortion encountered in transistorized amplifiers when driving a higher load.

  Crossover, in this case, refers to a switching between two matched transistors. In Class AB designs, both transistors remain on at all times, reducing the effect of hard switching between them.
Overdrive in Logic Pro for Mac

Overdrive emulates the distortion produced by a field effect transistor (FET), commonly used in solid-state musical instrument amplifiers and hardware effects devices. When saturated, FETs generate a warmer-sounding distortion than bipolar transistors, such as those emulated by the Distortion effect.

To add the Overdrive effect to your project, choose Distortion > Overdrive n in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Overdrive parameters

- **Drive knob and field:** Set the saturation amount for the simulated FET transistor.
- **Tone knob and field:** Set the frequency of the high cut filter. Filtering the harmonically rich distorted signal produces a softer tone.
- **Output knob and field:** Set the output level.
- **Level Compensation button:** Turn on to reference the overall processing of the signal to 0 dB. This compensates for increases in loudness caused by using overdrive.
- **Display:** Shows the impact of parameters on the signal.

Phase Distortion in Logic Pro for Mac

The Phase Distortion effect is based on a modulated delay line, similar to a chorus or flanger effect (see Modulation effects overview). Unlike these effects, however, the delay time is not modulated by a low frequency oscillator (LFO) but rather by a lowpass-filtered version of the input signal itself, using an internal side chain. This means that the incoming signal modulates its own phase position.

The input signal only passes the delay line and is not affected by any other process. The Mix parameter blends the effect signal with the original signal.
To add Phase Distortion to your project, choose Distortion > Phase Distortion in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Phase Distortion parameters

- **Monitor button**: Turn on to hear the input signal in isolation. Turn off to hear the mixed signal.
- **Cutoff knob and field**: Set the (center) cutoff frequency of the lowpass filter.
- **Resonance knob and field**: Emphasize frequencies surrounding the cutoff frequency.
- **Display**: Shows the impact of parameters on the signal.
- **Intensity knob and field**: Set the amount of modulation applied to the signal.
- **Phase Reverse button**: Turn on to reduce the delay time on the right channel when input signals that exceed the cutoff frequency are received. Available only for stereo instances of the Phase Distortion effect.
- **Delay slider and field**: Set the maximum delay time.
- **Mix slider and field**: Set the percentage of the effect signal mixed with the original signal.
Dynamics processors in Logic Pro for Mac

Dynamics processors control the perceived loudness of your audio, add focus and punch to tracks and projects, and optimize the sound for playback in different situations.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

The dynamic range of an audio signal is the range between the softest and loudest parts of the signal—technically, between the lowest and highest amplitudes. Dynamics processors enable you to adjust the dynamic range of individual audio files, tracks, or an overall project. This can be to increase the perceived loudness or to highlight the most important sounds, while ensuring that softer sounds are not lost in the mix. Several dynamics processors provide a Side Chain input.

There are four types of dynamics processors. These are each used for different audio processing tasks. Logic Pro also includes the unique Enveloper, which doesn’t fit any single category.

- Compressors: Downward compressors behave like an automatic volume control, lowering the volume whenever it rises above a certain level, called the *threshold*. By reducing the highest parts of the signal, called *peaks*, a compressor raises the overall level of the signal, increasing the perceived volume. This gives the signal more focus by making the louder (foreground) parts stand out, while keeping the softer background parts from becoming inaudible. Compression also tends to make sounds tighter or punchier because transients are emphasized, depending on attack and release settings, and because the maximum volume is reached more swiftly.

In addition, compression can make a project sound better when played back in different audio environments. For example, the speakers of a television or in a car typically have a narrower dynamic range than the sound system in a cinema. Compressing the overall mix can help make the sound fuller and clearer in lower-fidelity playback situations.

Compressors are typically used on vocal tracks to make the singing prominent in an overall mix. They are also commonly used on music and sound effect tracks, but they are rarely used on ambience tracks. See Compressor overview, DeEsser 2, and Surround Compressor overview.

Some compressors—multiband compressors—can divide the incoming signal into different frequency bands and apply different compression settings to each band. This helps to achieve the maximum level without introducing compression artifacts. Multiband compression is typically used on an overall mix. See Multipressor overview.
• *Expanders:* Expanders are similar to compressors, except that they raise, rather than lower, the signal when it exceeds the threshold. Expanders are used to add life to audio signals. See [Expander](#).

• *Limiters:* Limiters (also called *peak limiters*) work in a similar way to compressors in that they reduce the audio signal when it exceeds a set threshold. The difference is that whereas a compressor gradually lowers signal levels that exceed the threshold, a limiter quickly reduces any signal that is louder than the threshold to the threshold level. The main use of a limiter is to prevent clipping while preserving the maximum overall signal level. See [Adaptive Limiter](#) and [Limiter](#).

• *Noise gates:* Noise gates alter the signal in a way that is opposite to that used by compressors or limiters. Whereas a compressor lowers the level when the signal is louder than the threshold, a noise gate lowers the signal level whenever it falls below the threshold. Louder sounds pass through unchanged, but softer sounds, such as ambient noise or the decay of a sustained instrument, are cut off. Noise gates are often used to eliminate low-level noise or hum from an audio signal. See [Noise Gate](#).

---

**Adaptive Limiter in Logic Pro for Mac**

Adaptive Limiter is a versatile tool for controlling the perceived loudness of sounds. It works by rounding and smoothing peaks in the signal, producing an effect similar to an analog amplifier being driven hard. Like an amplifier, it can slightly color the sound of the signal. You can use Adaptive Limiter to achieve maximum gain, without introducing unwanted distortion and clipping, which can occur when the signal exceeds 0 dBFS.

Adaptive Limiter is typically used on the final mix, where it can be placed after a compressor, such as Multipressor, and before a final gain control, resulting in a mix of maximum loudness. Adaptive Limiter can produce a louder-sounding mix than can be achieved by normalizing the signal.

To add Adaptive Limiter to your project, choose Dynamics > Adaptive Limiter in a channel strip Audio Effect plug-in menu. See [Add, remove, move, and copy plug-ins](#).

*Note:* Using Adaptive Limiter adds latency when the Lookahead parameter is active. The effect is typically used for mixing and mastering previously recorded tracks, not while recording. Bypass Adaptive Limiter while recording.
Adaptive Limiter parameters

- **Input meters**: Show input levels in real time. The Margin field shows the peak input level. You can reset the Margin field by clicking it.

- **Reduction meter**: Show the amount of gain reduction. The Margin field shows the peak reduction level. You can reset the Margin field by clicking it.

- **Output meters**: Show output levels of the limited signal. The Margin field shows the peak output level. You can reset the Margin field by clicking it.

- **Gain knob and field**: Set the amount of gain after input scaling.

- **Out Ceiling knob and field**: Set the maximum output level, or ceiling. The signal does not rise above this.

- **Lookahead knob and field**: Set the playback buffer size (how far in the future the file is analyzed for peaks). Also see the Optimal Lookahead parameter. Values lower than the optimal buffer size are indicated in red.

- **Remove DC Offset button**: Turn on to activate a highpass filter that removes direct current (DC) from the signal. DC can be introduced by lower-quality audio hardware.

- **True Peak Detection button**: Turn on to detect inter-sample peaks in the signal.

- **Optimal Lookahead field and button**: Use the Apply button to set the optimal playback buffer size. This changes the value shown for the Lookahead parameter.

  *Note*: The Optimal Lookahead value is automatically determined and cannot be changed directly.

Compressor

Compressor in Logic Pro for Mac

Compressor emulates the sound and response of several professional-level compressors. It tightens up your audio by reducing sounds that exceed a certain threshold level, smoothing out the dynamics and increasing the overall volume—the perceived loudness. Compression helps bring the key parts of a track or mix into focus, while preventing softer parts from becoming inaudible. It is probably the most versatile and widely used sound-shaping tool in mixing, next to EQ.

You can use Compressor with individual tracks, including vocal, instrumental, and effects tracks, as well as on the overall mix. Usually you insert Compressor directly into a channel strip, but it can be used on aux channels or elsewhere in the signal path.
To add Compressor to your project, choose Dynamics > Compressor in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

The interface is divided into two main areas:

- **Main parameters**: The bulk of the interface contains the meters and Threshold, Ratio, Knee, Attack, and other controls. See Compressor main parameters.
- **Output or Side Chain parameters**: The right side of the interface is shared by two discrete groups of parameters. Click the Side Chain or Output button to view and use the parameters in each group. See Compressor output parameters and Compressor side chain parameters.

**Compressor main parameters in Logic Pro for Mac**

The main part of the interface contains the core compression parameters. You can choose the type of compressor circuit and can adjust the settings.

*Note: Not all parameters listed are available in each Compressor model.*
Compressor parameters

- **Circuit Type buttons**: Choose the type of circuit emulated by Compressor. The interface updates when you choose a model. The choices are Platinum Digital, Studio VCA and FET, Classic VCA, or Vintage VCA, FET, and Opto.

  - **Platinum Digital**: A clean-sounding compression type with a fast transient response. It can be used on a variety of sources.

  - **FET**: Field Effect Transistor compressors are known for fast transient responses. They can deliver a clean or warmer tone (notably midrange), and can be pushed toward a “crunchy” tone on transients. Ideal for drums, vocals, guitars, and other signals with a fast attack phase. FET compressors can only attenuate the signal.

  - **VCA**: Voltage Controlled Amplifier compressors can respond slowly or quickly to incoming transients. They tend towards a clean tone and are well-suited for bass guitars and low-frequency signals. VCA compressors can attenuate or amplify the signal.

  - **Opto**: Optical compressors are known for their fast transient response and non-linear release handling. They are very clean and are ideal for vocals and guitars. They are also often used as limiting amplifiers across buses or outputs.

- **Side Chain and Output buttons**: View Side Chain or Output parameters.

- **Gain Reduction meter/graph**: Click either the Meter or Graph button to change the real-time compression amount display.

- **Input Peak indicator**: Displays the peak level at the compressor input.

- **Input Gain meter**: Displays the real-time level at the compressor input.

- **Input Gain knob and field**: Set the level at the compressor input.

- **Threshold knob and field**: Set the threshold level—signals above this threshold value are reduced in level.

- **Ratio knob and field**: Set the compression ratio—the ratio of signal reduction when the threshold is exceeded.

- **Make Up knob and field**: Set the amount of gain applied to the compressed signal.

- **Auto Gain buttons**: The Off button disables autogain. The 0 dB and -12 dB buttons compensate for volume reductions caused by compression.

- **Knee knob and field**: Set the strength of compression at levels close to the threshold. Lower values result in more severe or immediate compression (hard knee). Higher values result in gentler compression (soft knee).

- **Attack knob and field**: Set the time it takes for Compressor to react when the signal exceeds the threshold.

- **Release knob and field**: Set the time it takes for Compressor to stop reducing the signal after the signal level falls below the threshold. This parameter works in conjunction with the Auto Release function when active.

- **Auto Release button**: Make the release time dynamically adjust to the audio material. The behavior of the auto release function (and compression results) change when different Release knob values are used.

- **Output Peak indicator**: Displays the peak level of the compressor output.

- **Output Gain meter**: Displays the overall level of the compressor output in real time.

- **Output Gain knob and field**: Set the overall level of the compressor output.
Compressor output parameters in Logic Pro for Mac

Compressor output parameters are shown to the right when the Output button is active.

![Compressor output parameters](image)

Compressor output parameters

- **Limiter button**: Turn the integrated limiter on or off. Limiting prevents the output of Compressor from exceeding the threshold value.
- **Limiter Threshold knob and field**: Set the threshold level for the limiter.
- **Distortion knob**: Choose whether to apply clipping above 0 dB, and the type of clipping. Soft, Hard, and Clip reduce the signal around the 0 dB line in different ways, resulting in a smoothed or squared off distortion of the signal peaks.
  - **Soft**: Rounds off the signal as it approaches the 0 dB level, reducing the overall signal, rather than abruptly limiting amplitude.
  - **Hard**: Emulates a transistor effect that abruptly limits amplitude above 0 dB.
  - **Clip**: Limits amplitude at the 0 dB mark, but can be more punchy than the Hard setting, depending on the input material.
- **Mix knob and field**: Set the balance between dry (source) and wet (effect) signals. This enables you to either reduce signal peaks (dry), or to increase the level of softer signals (wet).

Compressor side chain parameters in Logic Pro for Mac

Compressor side chain parameters are shown to the right when the Side Chain button is active.
You should note that side chain parameters are active even if no external side chain source is selected. As with hardware VCA compressors, the (compressor) audio input is “normalized” as a side chain source when no external side chain signal is patched.

Note: Not all parameters listed are available in each Compressor model.

**Compressor side chain parameters**

- **Detection buttons**: Choose the way stereo side chain signals are handled at the side chain input.
  - *Max button*: Turn on to compress both channels if either stereo channel exceeds or falls below the threshold.
  - *Sum button*: When enabled, the combined level of both channels must exceed the threshold before compression occurs.
  - **Peak/RMS buttons**: Use in conjunction with the Max and Sum buttons. Choose Peak or RMS to determine whether signal peaks or a signal average is used for detection. These can help with avoiding artifacts such as clicks in the processed signal, depending on the type of audio material and parameter settings (notably Attack).
- **Filter buttons**: Turn the filter on or off. Turn on Listen to monitor the side chain signal.
- **Filter mode knob**: Choose the type of filter used to process the incoming side chain signal. Filtering the side chain input signal can enhance the precision of trigger signals, resulting in more surgical compression. The choices are LP (lowpass), BP (bandpass), HP (highpass), ParEQ (parametric), and HS (high shelving).
- **Frequency knob and field**: Set the center frequency for the side chain filter.
- **Q knob and field**: Set the width of the frequency band affected by the side chain filter.
- **Gain knob and field**: Set the amount of gain applied to the side chain signal.
Use Compressor in Logic Pro for Mac

This section explains how to effectively use the main Compressor parameters.

Tip: Click the Meter or Graph button to change the meter. This visual aid can help you to achieve more precise compression.

Compressor Threshold and Ratio

The most important Compressor parameters are Threshold and Ratio. The Threshold parameter sets the floor level in decibels. Signals that exceed this level are reduced by the amount set as the Ratio.

The Ratio parameter is a percentage of the overall level; the more the signal exceeds the threshold, the more it is reduced. A ratio of 4:1 means that increasing the input by 4 dB results in an increase of the output by 1 dB, if above the threshold.

For example, with the Threshold set at −20 dB and the Ratio set to 4:1, a −16 dB peak in the signal (4 dB louder than the threshold) is reduced by 3 dB, resulting in an output level of −19 dB.

Compressor envelope times

The Attack and Release parameters shape the dynamic response of Compressor. The Attack parameter determines the time it takes after the signal exceeds the threshold level before Compressor starts reducing the signal.

Many sounds, including voices and musical instruments, rely on the initial attack phase to define the core timbre and characteristic of the sound. When compressing these types of sounds, set higher Attack values to make sure that the attack transients of the source signal aren’t lost or altered.

When attempting to maximize the level of an overall mix, it is best to set the Attack parameter to a lower value, because higher values often result in no, or minimal, compression.

The Release parameter determines how quickly the signal is restored to its original level after it falls below the threshold level. Set a higher Release value to smooth out dynamic differences in the signal. Set lower Release values if you want to emphasize dynamic differences.

Important: The results of your settings for the Attack and Release parameters depend not only on the type of source material but on the compression ratio and threshold settings.
Compressor Knee

The Knee parameter determines whether the signal is slightly, or severely, compressed as it approaches the threshold level.

Setting a Knee value close to 0 (zero) results in no compression of signal levels that fall just below the threshold, while levels at the threshold are compressed by the full Ratio amount. This is known as *hard knee compression*, which can cause abrupt and often unwanted transitions as the signal reaches the threshold.

Increasing the Knee parameter value increases the amount of compression as the signal approaches the threshold, creating a smoother transition. This is called *soft knee compression*.

Other Compressor parameters

As Compressor reduces levels, the overall volume at its output is typically lower than the input signal. You can adjust the output level with the Make Up knob.

You can also use the Auto Gain parameter to compensate for the level reduction caused by compression (choose either 0 dB or −12 dB).

When the Platinum Digital type is chosen, Compressor can analyze the signal using one of two methods Peak or root mean square (RMS). While Peak is technically more accurate, RMS provides a better indication of how people perceive the signal loudness.

*Note:* If you turn on Auto Gain and RMS simultaneously, the signal may become oversaturated. If you hear any distortion, turn off Auto Gain and adjust the Make Up knob until the distortion is inaudible.

Use a side chain with Compressor

Use of a side chain with a compressor is common. The dynamics (level changes) of another channel strip is used as a control source for compression. For example, the dynamics of a drum groove can be used to rhythmically change the compression, and therefore dynamics, of a guitar, synthesizer, or bass part.

The side chain signal is used only as a detector or trigger in this situation. The side chain source is used to control the compressor, but the audio of the side chain signal is not actually routed through the compressor.

1. In Logic Pro, insert Compressor into a channel strip.
2. Click the Side Chain button in the Compressor window.
3. In the plug-in window header, choose the channel strip that carries the signal you want to use as the side chain source from the Side Chain pop-up menu.
4. Choose the Max or Sum analysis method with the Detection buttons.
5. Adjust Compressor parameters.
DeEsser 2 in Logic Pro for Mac

DeEsser 2 is a fast-acting dynamics compressor designed to isolate and attenuate a particular band of high frequencies in a complex audio signal. It is commonly used on vocal recordings to reduce unwanted sibilance (harsh s and t sounds) caused by the microphone positioning, the vocalist’s delivery of the performance, or compression and saturation effects.

You can use DeEsser 2 on a vocal track to reduce sibilance without affecting other frequencies on the track. DeEsser 2 attenuates the selected frequency only if it exceeds a set threshold level, preventing the sound from becoming darker when no sibilance is present. It has extremely fast attack and release response times for the shortest of transients, helping the recording retain a natural sound.

To add DeEsser 2 to your project, choose Dynamics > DeEsser 2 in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

DeEsser 2 provides two operating modes—Relative and Absolute—for working with high- or low-level audio signals. Also included are two filter shapes and range parameters that you can use to define and control the affected frequency range.

DeEsser 2 parameters

- **Detection meter**: Shows the input signal level of the selected frequency. Behavior of the meter changes in Absolute or Relative mode. See Mode pop-up menu description.
- **Detection max field**: The maximum level of the selected frequency is shown. Click to reset.
- **Detection meter slider**: Drag to set the Threshold, or amplification level, above which gain reduction of the selected frequency is applied.
- **Reduction meter**: Shows the amount of gain reduction applied.
- **Reduction max field**: The maximum level is shown (peak hold). Click to reset.
- **Reduction meter slider**: Drag to set the maximum amount of dynamic gain reduction applied to the selected frequency.
- **Threshold knob and field**: Set the Threshold, or amplification level, above which gain reduction of the selected frequency is applied.
- **Max Reduction knob and field**: Set the maximum amount of dynamic gain reduction applied to the selected frequency.
• **Frequency knob and field:** Set the center or maximum frequency of the detection filter, depending on the chosen filter.

• **Mode pop-up menu:** Choose Relative or Absolute mode. Relative is highly responsive and works with both high- and low-level level signals. Absolute works with high level signals, fulfilling the role of a classic de-esser.

• **Relative:** In this mode the level of the filtered signal (determined by the Range, Frequency and Filter settings) is compared with the full bandwidth level of the incoming signal. The Threshold parameter value determines the amplification level of the filtered signal (because the level of the filtered signal will always be lower than the full bandwidth signal). When the amplified, filtered signal level is lower than the full bandwidth signal, the Detection meter shows a blue meter below the Threshold value and no processing occurs. When the amplified, filtered signal level is higher than the full bandwidth level, the Detection meter shows a yellow meter above the Threshold value and processing takes place.

• **Absolute:** The Detection level meter shows the level of the incoming filtered signal (determined by the Range, Frequency and Filter settings). When the level surpasses the Threshold parameter value the meter display switches from blue (not processed) to yellow (processed). Low level signals can only be processed in Absolute mode if the Threshold parameter is set to a very low value.

• **Range buttons:** Set the filter frequency range. Split affects only signals within the set frequency band. Wide affects the entire frequency range.

• **Filter buttons:** Choose a lowpass shelving or peak filter shape. To reduce a broad range of frequencies, click the Lowpass Filter button. To reduce specific frequencies in a narrow range, click the Peak Filter button. The filter is applied before detection.

• **Filter Solo button:** Turn on to hear the filtered signal—the split frequency band—in isolation, when Split is turned on.

**Use DeEsser 2**

Imagine that you need to reduce unwanted sibilance on a vocal track. The following steps outline how you might do this.

1. In Logic Pro, start playback of the incoming signal. Ideally, this should be soloed (and cycled, if a shorter phrase).

2. In DeEsser 2, use the Mode pop-up menu to choose a mode. The default Relative mode works for most signals.

3. Identify the frequency you want to attenuate. Sibilance in human voices typically occurs between 5 and 10 kHZ.

   Tip: To help identify the frequency you want to attenuate, insert Channel EQ in an Audio Effect slot before the DeEsser 2 and watch the EQ Channel analyzer as the project plays.

4. Set the frequency you want to reduce using the Frequency knob. You can click the Filter Solo button to make the frequency easier to hear and identify.
5. Drag the Threshold knob to the level at which DeEsser 2 should start to apply reduction. To set a narrow frequency range, click the Split Range button. To set a broader range, click the Wide Range button.

6. Drag the Max Reduction knob to set how much sibilance to reduce. The Reduction meter shows how much sibilance DeEsser 2 is attenuating.

*Note:* Be prudent with how much reduction you apply. Sibilance is a natural part of speech and removing too much may make your vocals sound strange.

**Enveloper in Logic Pro for Mac**

Enveloper is an unusual processor that lets you shape the attack and release phases of a signal—the signal *transients*, in other words. This makes it a unique tool that can be used to achieve results that differ from other dynamics processors. In contrast to a compressor or expander, Enveloper operates independently of the absolute level of the input signal, but this works only if the Threshold slider is set to the lowest possible value.

To add Enveloper to your project, choose Dynamics > Enveloper in a channel strip Audio Effect plug-in menu. See *Add, remove, move, and copy plug-ins*.

The most important Enveloper parameters are the two Gain sliders, one on each side of the central display. These govern the Attack and Release levels of each respective phase.

Boosting the attack phase can add snap to a drum sound, or it can amplify the initial pluck or pick sound of a stringed instrument. Attenuating the attack causes percussive signals to fade in more softly. You can also mute the attack, making it virtually inaudible. A creative use for this effect is alteration of the attack transients to mask poor timing of recorded instrument parts.

Boosting the release phase also accentuates any reverb applied to the affected channel strip. Conversely, attenuating the release phase makes reverb-drenched tracks sound drier. This is particularly useful when you are working with drum loops, but it has many other applications as well.
Enveloper parameters

- **Threshold slider and field:** Set the threshold level. Signals that exceed the threshold have their attack and release phase levels altered. In general, set the Threshold to the minimum value and leave it there. Only when you significantly raise the release phase level, which also boosts any noise in the original recording, should you raise the Threshold slider slightly. This limits Enveloper to affecting only the useful part of the signal.

- **(Attack) Gain slider and field:** Boost or attenuate the attack phase of the signal. When the Gain slider is set to the center position—0%—the signal is unaffected.

- **Lookahead slider and field:** Set the pre-read analysis time for the incoming signal. The Lookahead slider defines how far into the future of the incoming signal Enveloper looks, to anticipate upcoming events. You generally do not need to use this feature, except when processing signals with extremely sensitive transients. If you do raise the Lookahead value, you may need to adjust the attack time to compensate.

- **Display:** Shows the attack and release curves applied to the signal.

- **(Attack) Time knob and field:** Set the time it takes for the signal to increase from the threshold level to the maximum Gain level. Attack Time values of around 20 ms and Release Time values of 1500 ms are a good starting point.

- **(Release) Time knob and field:** Set the time it takes for the signal to fall from the maximum gain level to the threshold level.

- **(Release) Gain slider and field:** Boost or attenuate the release phase of the signal. When the Gain slider is set to the center position—0%—the signal is unaffected.

- **Out Level slider and field:** Set the level of the output signal. Drastic boosting or cutting of either the release or attack phase may change the overall level of the signal. You can compensate for this by adjusting the Out Level slider.

Expander in Logic Pro for Mac

Expander is similar in concept to a compressor, but increases, rather than reduces, the dynamic range above the threshold level. You can use Expander to add liveliness and freshness to your audio signals.

To add Expander to your project, choose Dynamics > Expander in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Expander parameters

- **Input meter**: Shows the input signal level.
- **Expansion meter**: Shows the amount of gain (expansion) applied to the signal.
- **Output meter**: Shows the overall output signal level.
- **Threshold knob and field**: Set the threshold level. Signals above this level are expanded.
- **Ratio knob and field**: Set the expansion ratio—the ratio of signal expansion when the threshold is exceeded.
  
  *Note*: Because Expander is a genuine upward expander—in contrast to a downward expander, which increases the dynamic range below the Threshold—the Ratio knob features a value range of 1:1 to 0.5:1.

- **Gain knob and field**: Set the amount of gain.

- **Auto Gain button**: Turn on to compensate for the level increase caused by expansion. When Auto Gain is active, the signal sounds softer, even when the peak level remains the same.
  
  *Note*: If you dramatically change the dynamics of a signal (with extreme Threshold and Ratio values), you may need to reduce the Gain knob level to avoid distortion. In most cases, turning on Auto Gain adjusts the signal appropriately.

- **Knee knob and field**: Determine the strength of expansion at levels close to the threshold. Lower values result in more severe or immediate expansion—hard knee. Higher values result in a gentler expansion—soft knee.

- **Attack knob and field**: Set the time it takes for Expander to respond to signals that exceed the threshold level.

- **Release knob and field**: Set the time it takes for Expander to stop processing the signal after it falls below the threshold level.

- **Output Clip pop-up menu**: Choose whether to apply clipping above 0 dB, and the type of clipping. Soft and Hard change the signal around 0 dB in different ways, resulting in a smoothed or squared off distortion of signal peaks.

- **Peak/RMS buttons**: Determine whether the Peak or RMS method is used to analyze the signal.

Limiter in Logic Pro for Mac

Limiter works much like a compressor but with one important difference: where a compressor proportionally reduces the signal when it exceeds the threshold, a limiter reduces any peak above the threshold to the threshold level, effectively limiting the signal to this level.

Limiter is used primarily when mastering. Typically, you apply Limiter as the very last process in the mastering signal chain, where it raises the overall volume of the signal so that it reaches, but does not exceed, 0 dB.

To add Limiter to your project, choose Dynamics > Limiter in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Limiter is designed in such a way that if set to 0 dB Gain and 0 dB Output Level, it has no effect on a normalized signal. If the signal clips, Limiter reduces the level before clipping can occur. Limiter cannot, however, fix audio that is clipped during recording.

Limiter parameters

- **Input meters**: Show input levels in real time. The Margin field shows the highest input level. Click the Margin field to reset it.
- **Reduction meter**: Shows the amount of limiting in real time.
- **Output meters**: Show output levels of the limited signal. The Margin field shows the highest output level. Click the Margin field to reset it.

  
  *Note:* The Surround Limiter doesn’t show the Input and Output level meters of mono and stereo variants.

- **Gain knob and field**: Set the amount of gain applied to the input signal.
- **Release knob and field**: Set the time it takes for Limiter to stop processing, after the signal falls below the threshold level.
- **Output Level knob and field**: Set the output level of the signal.
- **Lookahead knob and field**: Adjust how far ahead (in milliseconds) Limiter analyzes the audio signal. This enables it to react earlier to peak volumes by adjusting the amount of reduction.

  
  *Note:* Lookahead causes latency, but this has no perceptible effect when you use Limiter as a mastering effect on prerecorded material. Set it to higher values if you want the limiting effect to occur before the maximum level is reached, thus creating a smoother transition.

- **Mode pop-up menu**: Choose between Legacy and Precision algorithms. Use Precision for hard limiting, but be aware that this can introduce distortion artifacts.
- **Soft Knee button (Legacy mode)**: Turn on to limit the signal only when it reaches the threshold. The transition to full limiting is nonlinear, producing a softer, less abrupt effect, and reducing distortion artifacts that can be produced by hard limiting (in Precision mode).
- **True Peak Detection button (Precision mode)**: Turn on to detect inter-sample peaks in the signal.
Multipressor

Multipressor in Logic Pro for Mac

Multipressor (an abbreviation for multiband compressor) is a versatile audio mastering tool. It splits the incoming signal into different frequency bands—up to four—and enables independent compression of each band. After compression is applied, the bands are combined into a single output signal.

The advantage of compressing different frequency bands separately is that it allows more compression to be applied to bands that need it, without affecting other bands. This avoids the "pumping" effect often associated with high amounts of compression.

Because the use of higher compression ratios on specific frequency bands is possible, Multipressor can achieve a higher average volume without causing audible artifacts.

Raising the overall volume level can result in a corresponding increase in the existing noise floor. Each frequency band features downward expansion, which lets you reduce or suppress this noise.

Downward expansion works as a counterpart to compression. Whereas a compressor compresses the dynamic range of higher volume levels, the downward expander expands the dynamic range of the lower volume levels. With downward expansion, the signal is reduced in level when it falls below the threshold level. This works in a similar way to a noise gate, but rather than abruptly cutting off the sound, it smoothly fades the volume with an adjustable ratio.

See the Multipressor Display, Frequency Band, and Output parameter sections, and use tips.

To add Multipressor to your project, choose Dynamics > Multipressor in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Multipressor display parameters in Logic Pro for Mac

Multipressor parameters are grouped into three main areas: the graphic display in the upper section, the set of controls for each frequency band in the lower section, and the output parameters at the right.

**Display parameters**

- **Graphic display**: View and adjust the frequency and gain for each frequency band. The amount of gain change from 0 dB is indicated by blue bars. The band number appears in the center of active bands. You can adjust each frequency band in the following ways:
  - Drag the horizontal bar up or down to adjust the gain makeup for that band.
  - Drag the vertical edges of a band to the left or right to set the crossover frequencies, which adjusts the overall band frequency range.
- **Crossover fields**: Drag to set the crossover frequency between adjacent bands.
- **Gain Make-up fields**: Drag to set the amount of the gain make-up for each band.
Multipressor frequency band controls in Logic Pro for Mac

Multipressor parameters are grouped into three main areas: the graphic display in the upper section, the set of controls for each frequency band in the lower section, and the output parameters on the right.

Frequency band parameters

• *Compression Threshold fields*: Set the compression threshold for the selected band. Setting the parameter to 0 dB results in no compression of the band. This parameter can also be set with the upper arrow to the left of each level meter.

• *Compression Ratio fields*: Set the compression ratio for the selected band. Setting the parameter to 1:1 results in no compression of the band.

• *Expansion Threshold fields*: Set the expansion threshold for the selected band. Setting the parameter to its minimum value (−60 dB) means that only signals that fall below this level are expanded. This parameter can also be set with the lower arrow to the left of each level meter.

• *Expansion Ratio fields*: Set the expansion ratio for the selected band.

• *Expansion Reduction fields*: Set the amount of downward expansion for the selected band.

• *Peak/RMS fields*: Set a smaller value for shorter peak detection, or a larger value for RMS detection, in milliseconds.

• *Attack fields*: Set the time before compression starts for the selected band, after the signal exceeds the threshold.

• *Release fields*: Set the time before compression stops on the selected band, after the signal falls below the threshold.

• *Band on/off buttons*: Turn each band on or off. When enabled, the button is highlighted, and the corresponding band appears in the graphic display area above.
• **Bypass buttons:** Bypass the selected frequency band.
• **Solo buttons:** Turn on to hear compression on only the selected frequency band.
• **Level meters:** The bar on the left shows the input level, and the bar on the right shows the output level.

**Multipressor output parameters in Logic Pro for Mac**

Multipressor parameters are grouped into three main areas: the graphic display in the upper section, the set of controls for each frequency band in the lower section, and the output parameters on the right.

**Output parameters**

• **Auto Gain pop-up menu:** Turn on to reference the overall processing of the signal to 0 dB, making the output louder.
• **Lookahead value field:** Set how far ahead the effect analyzes the incoming signal, allowing faster reactions to peak volumes.
• **Out slider and field:** Set the overall gain at the Multipressor output.
• **Level meter:** Shows the overall output level.
Use Multipressor in Logic Pro for Mac

In the graphic display, the blue bars show the gain change—not merely the gain reduction—as with a standard compressor. The gain change display is a composite value consisting of the compression reduction, plus the expander reduction, plus the auto gain compensation, plus the gain make-up.

Compression parameters
The Compression Threshold and Compression Ratio parameters are the key parameters for controlling compression. Usually the most useful combinations of these two settings are a low Compression Threshold with a low Compression Ratio, or a high Compression Threshold with a high Compression Ratio.

Downward Expansion parameters
The Expansion Threshold, Expansion Ratio, and Expansion Reduction parameters are the key parameters for controlling downward expansion. They determine the strength of the expansion applied to the chosen range.

Peak/RMS and Envelope parameters
Adjusting the parameter between Peak (0 ms, minimum value) and RMS (root mean square −200 ms, maximum value) is dependent on the type of signal you want to compress. An extremely short Peak detection setting is suitable for compression of short and high peaks of low power, which do not typically occur in music. The RMS detection method measures the power of the audio material over time and thus works much more musically. This is because human hearing is more responsive to the overall power of the signal than to single peaks. As a basic setting for most applications, the centered position is recommended.

Output parameters
The Out slider sets the overall output level. Set Lookahead to higher values when the Peak/RMS fields are set to higher values (farther towards RMS). Set Auto Gain to On to reference the overall processing to 0 dB, making the output louder.

Noise Gate

Noise Gate in Logic Pro for Mac
Noise Gate is commonly used to suppress unwanted noise that is audible when the audio signal is at a low level. You can use it to remove background noise, crosstalk from other signal sources, and low-level hum.

Noise Gate works by allowing signals above the threshold level to pass unimpeded, while reducing signals below the threshold level. This effectively removes lower-level parts of the signal, while allowing the desired parts of the audio to pass.

In Ducker mode, the source signal is reduced in level. Ducking is a common technique used in radio and television broadcasting. When the DJ or announcer speaks while music is playing, the music level is automatically reduced. When the announcement has finished, the music is automatically raised to its original volume level.
To add Noise Gate to your project, choose Dynamics > Noise Gate in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Noise Gate parameters

- **Gate/Ducker buttons:** Set the operating mode. See Use Noise Gate.
- **Threshold knob and field:** Set the threshold level. Signals that fall below the threshold are reduced in level.
- **Reduction/Ducking knob and field:** Set the amount of signal reduction.
- **Hysteresis slider and field:** Set the difference (in decibels) between the threshold values that open and close the gate. This prevents the gate from rapidly opening and closing when the input signal level is close to the threshold level.
- **Open/Close indicators:** Show current gate state.
- **Attack knob and field:** Set the time it takes to fully open the gate after the signal exceeds the threshold.
- **Hold knob and field:** Set the time the gate remains open after the signal falls below the threshold.
- **Release knob and field:** Set the time it takes to reach maximum attenuation after the signal falls below the threshold.
- **Lookahead slider and field:** Control how far ahead Noise Gate analyzes the incoming signal, allowing the effect to respond more quickly to peak levels.
- **Characteristics pop-up menu:** Choose a Bandpass or Band Reject filter type.
- **Monitor button:** Turn on to hear the side chain signal, including the effect of the High Cut and Low Cut filters (if enabled).
- **Filter button:** Turn on to adjust the High Cutoff and Low Cutoff parameters.
- **High Cutoff slider and field:** Set the upper cutoff frequency for the side chain signal.
- **Low Cutoff slider and field:** Set the lower cutoff frequency for the side chain signal.

Note: When no external side chain is selected, the input signal is used as the side chain control signal.
Use Noise Gate in Logic Pro for Mac

Set the Reduction knob to the lowest possible value to make sure that sounds below the Threshold value are completely suppressed. Set Reduction to a higher value to reduce low-level sounds but still allow them to pass. You can also use Reduction/Ducking to boost the signal by up to 20 dB, which is useful for ducking effects.

The Attack, Hold, and Release knobs modify the dynamic response of Noise Gate. If you want the gate to open extremely quickly for percussive signals such as drums, set the Attack knob to a lower value. For sounds with a slow attack phase, such as string pads, set Attack to a higher value. Similarly, when working with signals that fade out gradually or that have longer reverb tails, set a higher Release knob value that allows the signal to fade out naturally.

The Hold knob determines the minimum amount of time that the gate stays open. You can use the Hold knob to prevent abrupt level changes—known as chattering—caused by rapid opening or closing of the gate.

The Hysteresis slider provides another option for preventing chattering, without needing to define a minimum Hold time. Use it to set the range between the threshold values that open and close the gate. This is useful when the signal level hovers around the Threshold level, causing Noise Gate to switch on and off repeatedly, thus producing the undesirable chattering effect. The Hysteresis slider essentially sets the gate to open at the Threshold level and remain open until the level drops below another, lower, level. As long as the difference between these two values is large enough to accommodate the fluctuating level of the incoming signal, Noise Gate can function without creating chatter. This value is always negative. Generally, −6 dB is a good place to start.

In some situations, the level of the signal you want to keep and the level of the noise signal may be close, making it difficult to separate them. For example, when you are recording a drum kit and using Noise Gate to isolate the sound of the snare drum, the hi-hat may also open the gate in many cases. To remedy this, use the side chain controls to isolate the desired trigger signal with the High Cut and Low Cut filters.

Important: The side chain signal is used only as a detector/trigger in this situation. The filters are used to isolate particular trigger signals in the side chain source, but they have no influence on the actual gated signal—the audio being routed through Noise Gate.

Use the side chain filters
1. In Logic Pro, click the Monitor button to hear how the High Cut and Low Cut filters affect the incoming trigger signal.
2. Drag the High Cutoff slider to set the upper frequency. Trigger signals above this are filtered.
3. Drag the Low Cutoff slider to set the lower frequency. Trigger signals below this are filtered.

The filters allow only very high (loud) signal peaks to pass. In the drum kit example above, you could remove the hi-hat signal, which is higher in frequency, with the High Cut filter and allow the snare signal to pass. Turn off monitoring to set a suitable Threshold level more easily.
Use Noise Gate in Ducking mode

1. In Logic Pro, insert Noise Gate into an aux channel strip and click the Ducker button.
2. Assign all channel strip outputs that you want to “duck” (dynamically lower the volume of the mix) to a bus—the aux channel strip chosen in step 1.
3. In the Noise Gate plug-in window header, choose the bus that carries the ducking (vocal) signal from the Side Chain pop-up menu.
   *Note:* The ducked side chain is mixed with the output signal after passing through the plug-in. This ensures that the ducking side chain signal—the voiceover—is heard at the output.
4. Adjust Noise Gate parameters as required.

Surround Compressor

Surround Compressor in Logic Pro for Mac

Surround Compressor, based on the Compressor plug-in, is specifically designed for compression of complete surround mixes. It is commonly inserted in a surround output channel strip or in audio or aux channel strips—busses—that carry multichannel audio.

To add Surround Compressor to your project, choose Dynamics > Surround Compressor in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

You can adjust the compression ratio, knee, attack, and release for the main, side, surround, and LFE channels, depending on the chosen surround format. All channels include an integrated limiter and provide independent threshold and output level controls.
You can link channels by assigning them to one of three groups. When you adjust the threshold or output parameter of any grouped channel, the parameter adjustment is mirrored by all channels assigned to the group.

The interface is divided into three sections:

- The Link section at the top contains menus used to assign each channel to a group. See Surround Compressor Link parameters.
- The Main section includes controls common to all the main channels and the threshold and output controls for each channel. See Surround Compressor Main parameters.
- The LFE section on the lower right includes separate controls for the LFE channel. See Surround Compressor LFE parameters.

**Surround Compressor Link parameters in Logic Pro for Mac**

Surround Compressor Link parameters provide grouped channel control.
Link parameters

- **Circuit Type pop-up menu**: Choose the type of circuit emulated by Surround Compressor. The choices are Platinum, Classic A_R, Classic A_U, VCA, FET, and Opto (optical).

- **Group pop-up menus**: Set group membership for each channel—A, B, C, or no group (indicated by -). Moving the Threshold or Output Level slider for any grouped channel moves the sliders for all channels assigned to that group.

  **Tip**: Press Command and Option while moving the Threshold or Output Level slider of a grouped channel to temporarily unlink the channel from the group. This lets you set independent threshold settings while maintaining the side-chain detection link necessary for a stable surround image.

- **Bypass buttons**: Bypass the channel. If the channel belongs to a group, all grouped channels are bypassed.

- **Detection pop-up menu**: Choose the signal type to exceed or fall below the threshold. Max uses the maximum level of each signal. Sum uses the summed level of all signals.
  - If Max is chosen and any of the surround channels exceeds or falls below the threshold, that channel (or group of channels) is compressed.
  - If Sum is chosen, the combined level of all channels must exceed the threshold before compression occurs.

**Surround Compressor Main parameters in Logic Pro for Mac**

The Surround Compressor Main parameters set compression and output values.

![Surround Compressor Main parameters in Logic Pro for Mac](image)

**Main parameters**

- **Ratio knob and field**: Set the ratio of signal reduction when the threshold is exceeded.
- **Knee knob and field**: Set the ratio of compression at levels close to the threshold.
- **Attack knob and field**: Set the time it takes to reach full compression, after the signal exceeds the threshold.
- **Release knob and field**: Set the time it takes to return to zero compression, after the signal falls below the threshold.
- **Auto button**: Turn on to dynamically adjust the release time to the audio material.
- **Limiter button**: Turn limiting for the main channels on or off.
- **Threshold knob and field**: Set the threshold for the limiter on the main channels.
- **Main Compressor Threshold sliders and fields**: Set the threshold level for each channel, including LFE, which also has independent controls.
- **Main Output Levels sliders and fields**: Set the output level for each channel, including LFE, which also has independent controls.

**Surround Compressor LFE parameters in Logic Pro for Mac**

Surround Compressor LFE parameters control the low frequency effects (LFE) channel settings.

![LFE parameters](image)

**LFE parameters**

- **Ratio knob and field**: Set the compression ratio for the LFE channel.
- **Knee knob and field**: Set the knee for the LFE channel.
- **Attack knob and field**: Set the attack time for the LFE channel.
- **Release knob and field**: Set the release time for the LFE channel.
- **Auto button**: Turn on to automatically adjust the release time to the audio signal.
- **Threshold knob and field**: Set the threshold for the limiter on the LFE channel.
- **Limiter button**: Turn limiting on or off for the LFE channel.
Equalizers overview in Logic Pro for Mac

An equalizer (commonly abbreviated as EQ) shapes the sound of incoming audio by changing the level of specific frequency bands.

Equalization is one of the most-used audio processes, both for music projects and in post-production work for video. You can use EQ to subtly or significantly shape the sound of an audio file, an instrument, a vocal performance, or a project by adjusting specific frequencies or frequency ranges.

All EQs are specialized filters that allow certain frequencies to pass through unchanged while raising (boosting) or lowering (cutting) the level of other frequencies. Some EQs can be used in a “broad-brush” fashion, to boost or cut a large range of frequencies. Other EQs, particularly parametric and multiband EQs, can be used for more precise control.

The simplest types of EQs are single-band EQs, which include low cut and high cut, lowpass and highpass, shelving, and parametric EQs. See Single-Band EQ.

Multiband EQs such as Channel EQ or Linear Phase EQ combine several filters in one unit, enabling you to control a large part of the frequency spectrum. Multiband EQs let you independently set the frequency, bandwidth, and Q factor of each frequency spectrum band. This provides extensive and precise tone-shaping of any audio source, be it an individual audio signal or an entire mix.

Some EQs, particularly vintage units, are known for the distinctive sonic coloration they impart on the sound. See Vintage EQ collection overview.

Other EQs allow you to analyze incoming audio to capture a sonic “fingerprint” which you can then apply to other audio material. See Match EQ overview.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.
Channel EQ

Channel EQ overview in Logic Pro for Mac

Channel EQ is a versatile multiband EQ. It provides eight color-coded frequency bands, including lowpass and highpass filters, low and high shelving filters, and four flexible parametric bands. It also features a Fast Fourier Transform (FFT) Analyzer that shows real-time changes to the frequency curve, allowing you to see which parts of the frequency spectrum may need adjustment. See Channel EQ parameters.

You can use Channel EQ to shape the sound of individual tracks or audio files or for tone-shaping on an overall project mix. The Analyzer and graphic controls make it easy to view and change the audio signal in real time.

Tip: The parameters of Channel EQ and Linear Phase EQ are identical, enabling you to freely copy settings between them. If you replace a Channel EQ with a Linear Phase EQ (or vice versa) in the same effect slot, the current settings are automatically transferred to the new EQ.

To add Channel EQ to your project, do one of the following:

- Click the EQ overview on a channel strip.
- Choose Equalizers > Channel EQ in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Use the Channel EQ graphic display

The graphic display shows the current curve of each EQ band. The scale is shown in decibels. The color of each band matches the corresponding button above the display. Each band (and corresponding Frequency, Gain, and Q field) is highlighted as you move the pointer across it.

Click a curve line segment, the (center frequency) control point, or anywhere in the space between the zero line and EQ curve to adjust the band.

Click the control point to select a band for editing. Once a band is selected, no other band control point that falls within the active area of the selected band can be selected.

Click the graphic display background (outside a band) to deselect the selected band.

Hold down Command while performing any of the following operations to limit dragging to vertical or horizontal movement.

- Drag anywhere in the band to adjust gain and the center frequency.
• Drag the vertical lines that encompass the selected band to adjust the Q (bandwidth) only. Two arrow icons are shown.
• Use a two-finger vertical swipe with the trackpad, or a single-finger vertical swipe with the Magic Mouse, to adjust the Q value of the selected band.
• Drag the horizontal line in the selected band to adjust the gain only. If Q-Coupling is enabled, both the gain and bandwidth are adjusted. Two arrow icons are shown.
• Drag the intersection of vertical and horizontal lines in the selected band to adjust the gain and Q simultaneously. Four arrow icons are shown.
• Drag the control point to adjust the center frequency only.  
  Note: Horizontally dragging the control point in band 1 and band 8 adjusts both the frequency and Q.
• Hold down Option-Command to adjust the Q and center frequency simultaneously. A “Q” icon is shown at the pointer position.

Channel EQ parameters in Logic Pro for Mac

The central area of the Channel EQ window includes the graphic display and parameters for shaping each EQ band. The master Gain slider is shown at the right. The Analyzer and Q-Couple controls are shown at the lower left.

Channel EQ parameters

• Band 1 On/Off button: Switch on a high pass filter. Only frequencies above the set frequency value are allowed to pass.
  • Band 1 background or control point: Drag the red control point to change the frequency and Q values. Drag the red shaded area horizontally to change the frequency value.
  • Band 1 vertical/horizontal line: Drag vertically to change the slope.  
    Note: The Q parameter of band 1 and band 8 has no effect when the slope is set to 6 decibels per octave. When the Q parameter is set to an extremely high value, such as 100, these filters affect only a very narrow frequency band.
• **Band 2 On/Off button**: Switch on a low shelving filter that cuts or boosts frequencies below the set frequency.
  - **Band 2 background or control point**: Drag the orange shaded area, curve, or control point to change the frequency and gain values. Click the control point to select the band.
  - **Band 2 horizontal line**: Drag vertically to change the gain value.
  - **Band 2 vertical line**: Drag horizontally to change the Q value.
  - **Band 2 vertical/horizontal lines**: Drag to change the gain and Q values.

• **Band 3 On/Off button**: Switch on a parametric filter with three controls. Frequency sets a center frequency. Q sets the width of the frequency band around the center frequency. Gain sets the level of the band.
  - **Band 3 background or control point**: Drag the yellow shaded area, curve, or control point to change the frequency and gain values. Click the control point to select the band.
  - **Band 3 horizontal line**: Drag vertically to change the gain value.
  - **Band 3 vertical line**: Drag horizontally to change the Q value.
  - **Band 3 vertical/horizontal lines**: Drag to change the gain and Q values.

• **Band 4 On/Off button**: Switch on a parametric filter with three controls. Frequency sets a center frequency. Q sets the width of the frequency band around the center frequency. Gain sets the level of the band.
  - **Band 4 background or control point**: Drag the green shaded area, curve, or control point to change the frequency and gain values. Click the control point to select the band.
  - **Band 4 horizontal line**: Drag vertically to change the gain value.
  - **Band 4 vertical line**: Drag horizontally to change the Q value.
  - **Band 4 vertical/horizontal lines**: Drag to change the gain and Q values.

• **Band 5 On/Off button**: Switch on a parametric filter with three controls. Frequency sets a center frequency. Q sets the width of the frequency band around the center frequency. Gain sets the level of the band.
  - **Band 5 background or control point**: Drag the aqua shaded area, curve, or control point to change the frequency and gain values. Click the control point to select the band.
  - **Band 5 horizontal line**: Drag vertically to change the gain value.
  - **Band 5 vertical line**: Drag horizontally to change the Q value.
  - **Band 5 vertical/horizontal lines**: Drag to change the gain and Q values.
• **Band 6 On/Off button:** Switch on a parametric filter with three controls. Frequency sets a center frequency. Q sets the width of the frequency band around the center frequency. Gain sets the level of the band.
  - **Band 6 background or control point:** Drag the blue shaded area, curve, or control point to change the frequency and gain values. Click the control point to select the band.
  - **Band 6 horizontal line:** Drag vertically to change the gain value.
  - **Band 6 vertical line:** Drag horizontally to change the Q value.
  - **Band 6 vertical/horizontal lines:** Drag to change the gain and Q values.

• **Band 7 On/Off button:** Switch on a high shelving filter that cuts or boosts frequencies above the set frequency.
  - **Band 7 background or control point:** Drag the purple shaded area, curve, or control point to change the frequency and gain values. Click the control point to select the band.
  - **Band 7 horizontal line:** Drag vertically to change the gain value.
  - **Band 7 vertical line:** Drag horizontally to change the Q value.
  - **Band 7 vertical/horizontal lines:** Drag to change the gain and Q values.

• **Band 8 On/Off button:** Switch on a low pass filter. Only frequencies below the set frequency value are allowed to pass.
  - **Band 8 background or control point:** Drag the pink control point to change the frequency and Q value. Drag the pink shaded area horizontally to change the frequency value.
  - **Band 8 vertical/horizontal lines:** Drag vertically to change the slope.
  - **Frequency control:** Drag to set the frequency of the selected band.
  - **Gain/Slope control:** Drag to set the amount of gain for the selected band. For bands 1 and 8, this changes the slope of the filter.
  - **Q control:** Drag to set the Q factor or resonance of the effected range around the center frequency in the selected band.

  *Note:* The Q parameter of band 1 and band 8 has no effect when the slope is set to 6 dB per octave. When the Q parameter is set to an extremely high value, such as 100, these filters affect only a very narrow frequency band.

• **Analyzer Range display:** Drag vertically to offset the scaling of the Analyzer range. Control-click to open a shortcut menu where you can set the Analyzer Range value.
  - **Scale display:** Drag vertically to offset the scaling of the overall EQ curve. Control-click to open a shortcut menu where you can set the EQ dB Scale Mode.
  - **Master Gain slider and field:** Set the overall output level of the signal. Use it after boosting or cutting individual frequency bands. Control-click the graphic display to open a shortcut menu where you can enable an overlay on the Channel EQ graphic display, which shows the overall EQ curve when adjusted by the Master Gain parameter.
  - **Analyzer button:** Turn the Analyzer on or off. Play the audio signal and watch the graphic display to identify peaks and troughs in the frequency spectrum. Control-click to open a shortcut menu where you can set Analyzer Mode and Analyzer Resolution.

See [Channel EQ shortcut menus](#), [Channel EQ Analyzer](#), and extended parameters.
• **Analyzer (Pre/Post) button:** Set to display the frequency curve before or after EQ is applied, when Analyzer mode is active.

• **Q-Couple button:** Turn on Gain-Q coupling to automatically adjust the Q when you change the gain on any EQ band. This preserves the perceived bandwidth of the bell curve. Control-click to open a shortcut menu to set the Gain-Q Couple Strength value. See Channel EQ shortcut menus.

• **HQ button:** Turn on to enable oversampling.
  This setting is useful when you are EQing near the upper end of the spectrum (5kHz and higher) and your project sample rate is below 96kHz. Without oversampling, filters (notably peaking filters) can sound harsh because they become narrower at high frequencies, and have an asymmetric slope.

• **Processing pop-up menu:** Choose to process both sides of a stereo signal, or the Left Only, Right Only, Mid Only, or Side Only signal. See Channel EQ use tips for information on using Channel EQ with Mid-Side recordings.

### Use Logic Pro for Mac Channel EQ shortcut menus

The Channel EQ graphic display and the Analyzer and Q-Couple buttons provide additional parameters that you can use to enhance the behavior of Channel EQ.

Control-click the Channel EQ graphic display, or the Analyzer or Q-Couple button to open a context menu that contains the following parameters.

#### Graphic Display

• **Linear 12 dB, 30 dB, and 60 dB mode:** Set the scale of the Channel EQ graphic display to a linear value.

• **Warped:** Set the Channel EQ graphic display to a logarithmic, non-linear scale.

• **Visualize Master Gain:** Turn on to view an overlay on the Channel EQ graphic display which shows the overall EQ curve when adjusted by the Master Gain parameter.

#### Analyzer

• **Analyzer Mode:** Choose Peak or RMS.

• **Analyzer Resolution:** Choose a sample resolution for the Analyzer: Resolution low (2048 points), Resolution medium (4096 points), or Resolution high (8192 points).

#### Gain-Q Couple Strength

Choose the amount of Gain-Q coupling.

• **Proportional:** Scales the bandwidth proportionally as you change the gain. A proportional Q design widens the filter bandwidth at lower cut/boost levels and narrows it at higher settings.

• **Light or medium:** Allows some change as you raise or lower the gain.
• Strong: Preserves most of the perceived bandwidth.

• Asymmetric: These settings feature a stronger coupling for negative gain values than for positive values, so the perceived bandwidth is more closely preserved when you cut, rather than boost, gain.

Note: If you play back automation of the Q parameter with a different Gain-Q Couple Strength setting, the actual Q values are different than when the automation was recorded.

Channel EQ extended parameters in Logic Pro for Mac

Click the disclosure arrow at the lower left to display the extended parameters.

• Analyzer Decay slider and field: Set the decay rate (in dB per second) of the Analyzer curve. These are shown as a peak decay in Peak mode or an averaged decay in RMS mode.

Channel EQ use tips in Logic Pro for Mac

The way you use Channel EQ depends on the audio material and your intended outcome. A useful workflow for many situations is as follows: Set the Channel EQ to a flat response (no frequencies boosted or cut), turn on the Analyzer, and play the audio signal. Watch the graphic display to see which parts of the frequency spectrum have frequent peaks and which parts of the spectrum stay at a low level. Pay attention to sections where the signal distorts or clips. Use the graphic display or parameter controls to adjust the frequency bands.

You can reduce or eliminate unwanted frequencies, and you can raise quieter frequencies to make them more pronounced. You can adjust the center frequencies of bands 2 through 7 to affect a specific frequency—either one you want to emphasize, such as the root note of the music, or one you want to eliminate, such as hum or other noise. While doing so, change the Q parameter or parameters so that only a narrow range of frequencies is affected, or widen it to alter a broader frequency area.

You can offset the decibel scale of the graphic display by vertically dragging either the left or right edge of the display, where the dB scale is shown, when the Analyzer is not active. When the Analyzer is active, dragging the left edge adjusts the Analyzer dB scale, and dragging the right edge adjusts the linear dB scale.

Process Mid-Side recordings with Channel EQ

Mid-Side routing effectively splits a stereo signal into separate stereo and mono signals. This allows discrete processing of each signal. See Stereo miking techniques for a description of Mid-Side (MS) recordings.

1. In Logic Pro, insert a Channel EQ instance for each mode in the channel strip: one for Mid, one for Side. You can also choose to insert a third instance for a stereo signal, if an overall EQ is useful.

2. Choose a mode from the Processing pop-up menu:
   • Mid Only: You hear only the sound of identical signals in each side, such as lead vocals, and mono signals, such as bass or guitar parts.
   • Side Only: You hear only the sound of the different signals in each side, such as reverb or backing vocals.
3. Turn on the Analyzer if required. See Channel EQ Analyzer.

4. Adjust the frequency parameters of the Channel EQ instance running in Side mode. One typical use would be to reduce the low frequencies and perhaps boost the upper frequencies. This cleans up the bottom end and enhances stereo effects present in the signal.

5. Adjust the frequency parameters of the Channel EQ instance running in Mid mode. Often used to boost or sculpt the low frequencies of signals such as bass.

**Channel EQ Analyzer in Logic Pro for Mac**

The Analyzer uses a mathematical process called a Fast Fourier Transform (FFT) to provide a real-time curve of all frequency components in the incoming signal. This is superimposed over any EQ curves you have set. The Analyzer curve uses the same scale as the EQ curves, making it easy to recognize important frequencies in the incoming audio. This also simplifies the task of setting EQ curves to raise or lower the levels of frequencies and frequency ranges.

The bands derived from FFT analysis are scaled logarithmically—there are more bands in higher octaves than in lower octaves.

As soon as the Analyzer is activated, you can change the scaling display from the default dynamic range of 60 dB. Drag vertically on the scale to the right of the graphic display to set the maximum value to anywhere between +20 dB and −80 dB. The Analyzer display is always dB-linear. There are several additional Analyzer parameters in the Channel EQ shortcut menus and the extended parameters.

Here are the steps:

- Click the Analyzer button, then play the project to view changes to the frequency curve. This can help you to decide which frequencies to boost or cut.

- While the project plays, a real-time frequency curve for the track appears in the EQ display (when the Analyzer is set to Post EQ), showing which frequencies are louder or softer. You can adjust bands in the EQ display while watching changes to the frequency curve.

*Note:* Be sure to turn off the Analyzer when you’re not using it. When the EQ window is visible, the Analyzer uses additional processing power. High Analyzer resolutions also require significantly more processing power. High resolution is necessary when attempting to accurately analyze very low bass frequencies, for example.
Linear Phase EQ

Linear Phase EQ overview in Logic Pro for Mac

The high-quality Linear Phase EQ effect is similar to Channel EQ, sharing the same parameters and eight-band layout. See Channel EQ overview. You can copy settings between them. If you replace Channel EQ with Linear Phase EQ (or vice versa) in the same effect slot, the current settings are automatically transferred to the new EQ.

Linear Phase EQ uses a different underlying technology to Channel EQ that preserves the phase of the audio signal. Phase coherency is always maintained, even when you apply extreme EQ curves to the sharpest signal transients. This differs from Channel EQ, which can introduce phase shifts of the signal that can have an audible (and often desirable) effect on the sound.

A further difference between Channel EQ and Linear Phase EQ is that the latter uses a fixed amount of CPU resources, regardless of the number of active bands. Linear Phase EQ also introduces greater amounts of latency. See the Linear Phase EQ use, parameter, and Analyzer sections.

Note: Use the Linear Phase EQ where phase coherence between tracks is needed, such as multi microphone recordings. The Linear Phase does not introduce any phase shift to the signal which can also be beneficial in mastering, but it does impact on the onset of the transient. This is most evident when using steep cut filters, or high boosts/cuts of narrow filter bands.

To add Linear Phase EQ to your project, choose Equalizers > Linear Phase EQ in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Use the Linear Phase EQ graphic display

The graphic display shows the current curve of each EQ band. The scale is shown in decibels. The color of each band matches the corresponding button above the display. Each band (and corresponding Frequency, Gain, and Q field) is highlighted as you move the pointer across it. Click a curve line segment, the (center frequency) control point, or anywhere in the space between the zero line and EQ curve to adjust the band.

Click the control point to select a band for editing. Once a band is selected, no other band control point that falls within the active area of the selected band can be selected.

Click the graphic display background (outside a band) to deselect the selected band.
Hold down Command while performing any of the following operations to limit dragging to vertical or horizontal movement.

- Drag anywhere in the band to adjust gain and the center frequency.
- Drag the vertical lines that encompass the selected band to adjust the Q (bandwidth) only. Two arrow icons are shown.
- Use a two-finger vertical swipe with the trackpad, or a single-finger vertical swipe with the Magic Mouse, to adjust the Q value of the selected band.
- Drag the horizontal line in the selected band to adjust the gain only. If Q-Coupling is enabled, both the gain and bandwidth are adjusted. Two arrow icons are shown.
- Drag the intersection of vertical and horizontal lines in the selected band to adjust the gain and Q simultaneously. Four arrow icons are shown.
- Drag the control point to adjust the center frequency only.
  
  Note: Horizontally dragging the control point in band 1 and band 8 adjusts both the frequency and Q.
- Hold down Option-Command to adjust the Q and center frequency simultaneously. A “Q” icon is shown at the pointer position.

Linear Phase EQ parameters in Logic Pro for Mac

The central area of the Linear Phase EQ window includes the graphic display and parameters for shaping each EQ band. The master Gain slider is shown at the right. The Analyzer and Q Couple controls are shown at the lower left.

Linear Phase EQ parameters

- **Band 1 On/Off button**: Switch on a high pass filter. Only frequencies above the set frequency value are allowed to pass.

- **Band 1 background or control point**: Drag the red control point to change the frequency and Q values. Drag the red shaded area horizontally to change the frequency value.

- **Band 1 vertical/horizontal line**: Drag vertically to change the slope.
  
  Note: The Q parameter of band 1 and band 8 has no effect when the slope is set to 6 decibels per octave. When the Q parameter is set to an extremely high value, such as 100, these filters affect only a very narrow frequency band.
• **Band 2 On/Off button**: Switch on a low shelving filter that cuts or boosts frequencies below the set frequency.
  • **Band 2 background or control point**: Drag the orange shaded area, curve, or control point to change the frequency and gain values. Click the control point to select the band.
  • **Band 2 horizontal line**: Drag vertically to change the gain value.
  • **Band 2 vertical line**: Drag horizontally to change the Q value.
  • **Band 2 vertical/horizontal lines**: Drag to change the gain and Q values.

• **Band 3 On/Off button**: Switch on a parametric filter with three controls. Frequency sets a center frequency. Q sets the width of the frequency band around the center frequency. Gain sets the level of the band.
  • **Band 3 background or control point**: Drag the yellow shaded area, curve, or control point to change the frequency and gain values. Click the control point to select the band.
  • **Band 3 horizontal line**: Drag vertically to change the gain value.
  • **Band 3 vertical line**: Drag horizontally to change the Q value.
  • **Band 3 vertical/horizontal lines**: Drag to change the gain and Q values.

• **Band 4 On/Off button**: Switch on a parametric filter with three controls. Frequency sets a center frequency. Q sets the width of the frequency band around the center frequency. Gain sets the level of the band.
  • **Band 4 background or control point**: Drag the green shaded area, curve, or control point to change the frequency and gain values. Click the control point to select the band.
  • **Band 4 horizontal line**: Drag vertically to change the gain value.
  • **Band 4 vertical line**: Drag horizontally to change the Q value.
  • **Band 4 vertical/horizontal lines**: Drag to change the gain and Q values.

• **Band 5 On/Off button**: Switch on a parametric filter with three controls. Frequency sets a center frequency. Q sets the width of the frequency band around the center frequency. Gain sets the level of the band.
  • **Band 5 background or control point**: Drag the aqua shaded area, curve, or control point to change the frequency and gain values. Click the control point to select the band.
  • **Band 5 horizontal line**: Drag vertically to change the gain value.
  • **Band 5 vertical line**: Drag horizontally to change the Q value.
  • **Band 5 vertical/horizontal lines**: Drag to change the gain and Q values.
• **Band 6 On/Off button**: Switch on a parametric filter with three controls. Frequency sets a center frequency. Q sets the width of the frequency band around the center frequency. Gain sets the level of the band.
  
  • **Band 6 background or control point**: Drag the blue shaded area, curve, or control point to change the frequency and gain values. Click the control point to select the band.
  
  • **Band 6 horizontal line**: Drag vertically to change the gain value.
  
  • **Band 6 vertical line**: Drag horizontally to change the Q value.
  
  • **Band 6 vertical/horizontal lines**: Drag to change the gain and Q values.

• **Band 7 On/Off button**: Switch on a high shelving filter that cuts or boosts frequencies above the set frequency.

  • **Band 7 background or control point**: Drag the purple shaded area, curve, or control point to change the frequency and gain values. Click the control point to select the band.
  
  • **Band 7 horizontal line**: Drag vertically to change the gain value.
  
  • **Band 7 vertical line**: Drag horizontally to change the Q value.
  
  • **Band 7 vertical/horizontal lines**: Drag to change the gain and Q values.

• **Band 8 On/Off button**: Switch on a low pass filter. Only frequencies below the set frequency value are allowed to pass.

  • **Band 8 background or control point**: Drag the pink control point to change the frequency and Q value. Drag the pink shaded area horizontally to change the frequency value.
  
  • **Band 8 vertical/horizontal lines**: Drag vertically to change the slope.

• **Frequency control**: Drag to set the frequency of the selected band.

• **Gain/Slope control**: Drag to set the amount of gain for the selected band. For bands 1 and 8, this changes the slope of the filter.

• **Q control**: Drag to set the Q factor or resonance of the effected range around the center frequency in the selected band.

  **Note**: The Q parameter of band 1 and band 8 has no effect when the slope is set to 6 decibels per octave. When the Q parameter is set to an extremely high value, such as 100, these filters affect only a very narrow frequency band.

• **Analyzer Range display**: Drag vertically to offset the scaling of the Analyzer range. Control-click to open a shortcut menu where you can set the Analyzer Range value.

• **Scale display**: Drag vertically to offset the scaling of the overall EQ curve. Control-click to open a shortcut menu where you can set the EQ dB Scale Mode.

• **Master Gain slider and field**: Set the overall output level of the signal. Use it after boosting or cutting individual frequency bands. Control-click the graphic display to open a shortcut menu where you can enable an overlay on the Linear Phase EQ graphic display, which shows the overall EQ curve when adjusted by the Master Gain parameter.
• **Analyzer button:** Turn the Analyzer on or off. Play the audio signal and watch the graphic display to identify peaks and troughs in the frequency spectrum. Control-click to open a shortcut menu where you can set Analyzer Mode and Analyzer Resolution. See [Linear Phase EQ shortcut menus](#), [Use the Linear Phase EQ Analyzer](#), and [Linear Phase EQ extended parameters](#).

• **Analyzer (Pre/Post) button:** Set to display the frequency curve before or after EQ is applied, when Analyzer mode is active.

• **Q-Couple button:** Turn on Gain-Q coupling, which automatically adjusts the Q when you raise or lower the gain on any EQ band. This preserves the perceived bandwidth of the bell curve. Control-click to open a shortcut menu to set the Gain-Q Couple Strength value. See [Linear Phase EQ shortcut menus](#).

• **Processing pop-up menu:** Choose to process both sides of a stereo signal, or the Left Only, Right Only, Mid Only, or Side Only signal. See [Linear Phase EQ use tips](#) for information about using Linear Phase EQ with Mid-Side recordings.

### Use Linear Phase EQ shortcut menus in Logic Pro for Mac

The Linear Phase EQ graphic display and the Analyzer and Q-Couple buttons provide additional parameters that you can use to enhance the behavior of Channel EQ. Control-click the Linear Phase EQ graphic display, or the Analyzer or Q-Couple button to open a context menu that contains the following parameters.

#### Graphic Display

Choose the EQ dB Scale Mode

- **Linear 12 dB, 30 dB, and 60 dB mode:** Set the scale of the Channel EQ graphic display to a linear value.
- **Warped:** Set the Linear Phase EQ graphic display to a logarithmic, non-linear scale.
- **Visualize Master Gain:** Turn on to view an overlay on the Linear Phase EQ graphic display which shows the overall EQ curve when adjusted by the Master Gain parameter.

#### Analyzer

- **Analyzer Mode:** Choose Peak or RMS.
- **Analyzer Resolution:** Choose a sample resolution for the Analyzer: Resolution low (2048 points), Resolution medium (4096 points), or Resolution high (8192 points).

#### Gain-Q Couple Strength

Choose the amount of Gain-Q coupling.

- **Proportional:** Scales the bandwidth proportionally as you change the gain. A proportional Q design widens the filter bandwidth at lower cut/boost levels and narrows it at higher settings.
- **Light or medium:** Allows some change as you raise or lower the gain.
• **Strong:** Preserves most of the perceived bandwidth.

• **Asymmetric:** These settings feature a stronger coupling for negative gain values than for positive values, so the perceived bandwidth is more closely preserved when you cut, rather than boost, gain.

  *Note:* If you play back automation of the Q parameter with a different Gain-Q Couple Strength setting, the actual Q values are different than when the automation was recorded.

### Linear Phase EQ extended parameters in Logic Pro for Mac

Click the disclosure arrow at the lower left to display the extended parameters.

• **Analyzer Decay slider and field:** Set the decay rate (in dB per second) of the Analyzer curve. This is shown as a peak decay in Peak mode or an averaged decay in RMS mode.

### Linear Phase EQ use tips in Logic Pro for Mac

Linear Phase EQ is typically used as a mastering tool that is inserted into master or output channel strips. The way you use Linear Phase EQ depends on the audio material and your intended outcome. A useful workflow for many situations is as follows: Set Linear Phase EQ to a flat response (no frequencies boosted or cut), turn on the Analyzer, then play the audio signal. Watch the graphic display to see which parts of the frequency spectrum have frequent peaks and which parts of the spectrum stay at a low level. Pay attention to sections where the signal distorts or clips. Use the graphic display or parameter controls to adjust the frequency bands.

You can reduce or eliminate unwanted frequencies and you can raise quieter frequencies to make them more pronounced. You can adjust the center frequencies of bands 2 through 7 to affect a specific frequency—either one you want to emphasize, such as the root note of the music, or one you want to eliminate, such as hum or other noise. Use the Q parameter or parameters so that only a narrow range of frequencies is affected.

You can offset the decibel scale of the graphic display by vertically dragging either the left or right edge of the dB scale when the Analyzer is not active. When the Analyzer is active, dragging the left edge adjusts the Analyzer dB scale, and dragging the right edge adjusts the linear dB scale.

### Process Mid-Side recordings with Linear Phase EQ

Mid-Side routing effectively splits a stereo signal into separate stereo and mono signals. This allows discrete processing of each signal. See Stereo miking techniques for a description of Mid-Side (MS) recordings.

1. In Logic Pro, insert a Linear Phase EQ instance for each mode in the channel strip: one for Mid, one for Side. You can also choose to insert a third instance for a stereo signal, if an overall EQ is useful.

2. Choose a mode from the Processing pop-up menu:
   - **Mid Only:** You hear only the sound of identical signals in each side, such as lead vocals, and mono signals, such as bass or guitar parts.
   - **Side Only:** You hear only the sound of the different signals in each side, such as reverb or backing vocals.
3. Turn on the Analyzer if required. See Use the Linear Phase EQ Analyzer.

4. Adjust the frequency parameters of the Linear Phase EQ instance running in Side mode. One typical use would be to reduce the low frequencies and perhaps boost the upper frequencies. This cleans up the bottom end and enhances stereo effects present in the signal.

5. Adjust the frequency parameters of the Linear Phase EQ instance running in Mid mode. Often used to boost or sculpt the low frequencies of signals such as bass.

Use the Linear Phase EQ Analyzer in Logic Pro for Mac

The Analyzer uses a mathematical process called a Fast Fourier Transform (FFT) to provide a real-time curve of all frequency components in the incoming signal. This is superimposed over any EQ curves you have set. The Analyzer curve uses the same scale as the EQ curves, making it easy to recognize important frequencies in the incoming audio. This also simplifies the task of setting EQ curves to raise or lower the levels of frequencies or frequency ranges.

The bands derived from FFT analysis are scaled logarithmically—there are more bands in higher octaves than in lower octaves.

As soon as the Analyzer is activated, you can change the display scaling from the default dynamic range of 60 dB. Drag vertically on the scale to the right of the graphic display to set the maximum value to anywhere between +20 dB and −80 dB. The Analyzer display is always dB-linear. There are several additional Analyzer parameters in the Linear Phase EQ shortcut menus and the extended parameters.

Here are the steps:

• Click the Analyzer button, then play the project to view changes to the frequency curve. This can help you to decide which frequencies to boost or cut.

• While the project plays, a real-time frequency curve for the track appears in the EQ display (when the Analyzer is set to Post EQ), showing which frequencies are louder or softer. You can adjust bands in the EQ display while watching changes to the frequency curve.

Note: Be sure to turn off the Analyzer when you’re not using it. When the EQ window is visible, the Analyzer uses additional processing power. High Analyzer resolutions also require significantly more processing power. High resolution is necessary when attempting to accurately analyze very low bass frequencies, for example.
Match EQ overview in Logic Pro for Mac

Match EQ allows you to analyze and store the average frequency spectrum of an audio file as a template. You can apply this template to another audio signal so that it matches the spectrum of the original file. This is also known as a fingerprint EQ, where one sonic fingerprint is applied to another signal.

Match EQ lets you acoustically match the tonal quality or overall sound of different songs you plan to include on a CD, for example, or to impart the color of any source recording to your own projects.

Match EQ is a learning equalizer that analyzes the frequency spectrum of an audio signal such as an audio file, a channel strip input signal, or a template. The average frequency spectrum of the source file (the template) and of the current material (this can be the entire project or individual channel strips within it) is analyzed. These two spectra are then matched, creating a filter curve. This filter curve adapts the frequency response of the current material to match that of the template. Before applying the filter curve, you can modify it by boosting or cutting any number of frequencies or by inverting the curve.

The Analyzer allows you to visually compare the frequency spectrum of the source file and the resulting curve, making it easier to make manual corrections at specific points within the spectrum.

Note: Although Match EQ acoustically matches the frequency curve of two audio signals, it does not match any dynamic differences between the two signals.

See the Use Match EQ, Match EQ parameters, and Edit the Match EQ filter curve sections.

To add Match EQ to your project, choose Equalizers > Match EQ in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Match EQ parameters in Logic Pro for Mac

Match EQ offers the parameters described in this section.
Match EQ parameters

- **Fade Extremes checkbox**: Select to set an automatic high cut and low cut threshold. Matching signals above or below these thresholds are slowly faded to zero.

- **Main display**: Displays the filter curve created by matching the template to the current material. You can also edit the filter curve directly (see Edit the Match EQ filter curve).

- **Scale display**: Drag the scale to set the 0 dB reference line and scaling in the main display.

- **Mode buttons**: Set the information shown in the graphic display. Choices are:
  - **Current**: Displays the frequency curve for the audio learned as current material. This is shown in green.
  - **Reference**: Displays the learned frequency curve template for the source file. This is shown in purple.
  - **EQ Curve**: Displays the filter curve created by matching the template and the current material. This is shown in yellow.

- **Action menu**: Choose and execute commands from the Current or Reference Action menu.
  - **Clear**: Clears the Current Material Spectrum or Reference Spectrum.
  - **Copy**: Copies the Current Material Spectrum or Reference Spectrum to the Clipboard.
  - **Paste**: Pastes the Current Material Spectrum or Reference Spectrum from the Clipboard.
  - **Load**: Loads the Current Material Spectrum or Reference Spectrum from a setting file.
  - **Generate**: Creates a Current Material Spectrum or Reference Spectrum from an audio file.

- **Current Learn button**: Start or stop the process of learning the frequency spectrum of the project you want to match with the source file or input.

- **Reference Learn button**: Start or stop the process of learning the frequency spectrum of the source file or input.

- **EQ Curve Match button**: Match the frequency spectrum of the current material to that of the template (source) file.

- **Analyzer button**: Turn the Analyzer on or off. Play the audio signal and watch the graphic display to identify peaks and low level parts of the frequency spectrum.

- **Pre/Post button**: Choose whether the Analyzer looks at the signal before (Pre) or after (Post) the filter curve is applied.

- **Smoothing slider and field**: Set the amount of smoothing for the filter curve, using a constant bandwidth set in semitone steps. A value of 0.0 has no impact on the filter curve. A value of 1.0 means a smoothing bandwidth of one semitone. A value of 4.0 means a smoothing bandwidth of four semitones (a major third). A value of 12.0 means a smoothing bandwidth of one octave, and so on.

  **Note**: Smoothing has no effect on any manual changes you make to the filter curve.
• **Channel pop-up menu:** Click to determine if separate curves are displayed by the Analyzer. Choose L&R for stereo, or an individual L or R channel. In surround instances, choose All channels or an individual channel. Changes to the filter curve affect the chosen channel if a single channel is selected.

  *Note:* The Hide Others and Channel Link parameters are disabled when you use the effect on a mono channel.

• **Hide Others checkbox:** Hide or show other channels when an individual channel is chosen in the Channel pop-up menu. The visible impact of this parameter is directly tied to the Channel Link slider value.

  *Note:* The Hide Others parameter is disabled when you use the effect on a mono channel.

• **Channel Link slider and field:** Refine settings made with the Channel pop-up menu.
  - When set to 100%, all channels are represented by a common EQ curve.
  - When set to 0%, a separate filter curve is displayed for each channel (chosen with the Channel pop-up menu).
  - Settings between 0 and 100% blend these values with your filter curve changes for each channel. This results in a hybrid curve.

  *Note:* The Channel Link parameter is disabled when you use the effect on a mono channel.

• **Phase pop-up menu:** Choose the operational principle of the filter curve.
  - *Linear:* Prevents processing from altering the signal phase, but latency is higher.
  - *Minimal:* Alters the signal phase (slightly), but latency is reduced.
  - *Minimal, Zero Latency:* Adds no latency, but has a higher CPU overhead than the other options.

• **Apply slider and field:** Determine the impact of the filter curve on the signal.
  - Values above 100% magnify the effect.
  - Values below 100% reduce it.
  - Negative values (~1% to ~100%) invert the peaks and troughs in the filter curve.
  - A value of 100% has no impact on the filter curve.

• **LFE Handling buttons (Extended Parameters area):** In surround instances, click to process or bypass the LFE channel.
Use Match EQ in Logic Pro for Mac

These tasks are those commonly used with Match EQ to match the frequency spectrum of a mix with the spectrum of a source audio file. You can adapt some, or all, to your own workflow.

Learn or create a Match EQ template

You can drag an audio file to the Current or Reference Learn buttons for use as either the current material or template material. A progress bar appears while Match EQ is analyzing the file. You can also load a previously saved plug-in setting, or you can import the settings of another unsaved Match EQ instance by copying and pasting.

In Logic Pro, do one of the following:

- Drag an audio file from the Finder to the Reference Learn button, and select the source channel strip as a side chain.
- Use Match EQ on the source channel strip and save a setting. Import this setting into the target Match EQ instance.

The filter curve is updated automatically each time a new Reference or Current material spectrum is learned or loaded when the EQ Curve Match button is turned on. You can alternate between the matched (and possibly scaled or manually modified) filter curve and a flat response by turning the Match button on or off.

Match the EQ of a project mix to the EQ of a source audio file

1. In Logic Pro, in the project you want to match to the source audio file, insert Match EQ (typically on Output 1-2).
2. Drag the source audio file to the Reference Learn button.
3. Return to the start of your mix, click the Current Learn button, and play your mix (the current material) from start to finish.
4. When you are done, click the EQ Curve Match button.

When you click either of the Learn buttons, the main display shows the frequency curve for the function. You can review any of the frequency curves when no file is being processed by choosing one of the other view options or modes.

Note: Only one of the Learn buttons can be turned on at a time. For example, if the Reference Learn button is on and you click the Current Learn button, analysis of the (Reference) template file stops, the current status is used as the spectral template, and analysis of the incoming audio signal (Current Material) begins.
Edit spectra with the Match EQ Action menu

This menu provides commands that can be applied to the either the Reference or the Current Material spectrum.

- In Logic Pro, choose one of the following from the Action menu:
  - Clear Current Material/Reference Spectrum: Clears the current spectrum.
  - Copy Current/Reference Spectrum: Copies the current spectrum to the Clipboard (this can be used by any Match EQ instance in the current project).
  - Paste Current/Reference Spectrum: Pastes the Clipboard contents to the current Match EQ instance.
  - Load Current Material/Reference Spectrum from setting file: Loads the spectrum from a stored setting file.
  - Generate Current Material/Reference Spectrum from audio file: Generates a frequency spectrum for an audio file you have chosen.

Refine the Match EQ curve

Each time you match two audio signals, either by loading or learning a new spectrum while Match is activated or by turning on Match after a new spectrum has been loaded, any existing changes to the filter curve are discarded and Apply is set to 100%.

In Logic Pro, do either of the following:

- Drag the Apply slider down from the default 100% value to avoid extreme spectral changes to your mix.
- Drag the Smoothing slider to adjust the spectral detail of the generated EQ curve—if required.

Use the matched EQ on a channel strip

Match EQ creates a filter curve based on the differences between the spectrum of the template and the current material. This curve automatically compensates for differences in gain between the template and the current material, with the resulting EQ curve referenced to 0 dB. A yellow filter response curve, showing the average spectrum of your mix, is visible in the main display when the EQ Curve button is active. This curve approximates (mirrors) the average spectrum of your source audio file.

1. In Logic Pro, choose the channel strip that you want to match from the Side Chain pop-up menu of the Match EQ window.
2. Click the Reference Learn button.
3. Play the entire source audio file from start to finish. To stop the learn process, click the Reference Learn button again.
4. Return to the start of your mix, click the Current Learn button, and play your mix (the current material) from start to finish.
5. When you are done, click the EQ Curve Match button.
Edit the Match EQ filter curve in Logic Pro for Mac

You can edit the filter curve in the EQ Curve display by adjusting the various points shown in each band. As you drag a point, the current value is shown, allowing precise changes.

Adjust Match EQ curve values
In Logic Pro, do any of the following:

• Drag horizontally to shift the peak frequency for the band (over the entire spectrum).
• Drag vertically to adjust the gain of the band.
• Hold down Shift, then drag vertically to adjust the Q Factor.
• While clicking, press Option to reset the gain to 0 dB.
• Press Option to reset all changes you have made to the curve.

Change the Match EQ scale range
The colors and modes of the dB scales on the left and right of the display are automatically adapted to the active function. If the Analyzer is active, the left scale displays the average spectrum in the signal, while the right scale serves as a reference for the peak values of the Analyzer. A dynamic range of 60 dB is shown by default. If this is not precise enough for your edits, you can increase the range.

• In Logic Pro, drag either scale to set values of up to +20 dB and −100 dB.

Change Match EQ gain with the scales
• In Logic Pro, drag either scale to adjust the overall gain of the filter curve from −30 to +30 dB.

The left scale—and the right, if the Analyzer is inactive—shows the dB values for the filter curve.

Single Band EQ in Logic Pro for Mac
Single Band EQ can operate in several modes. When you choose an EQ type with the EQ Mode buttons, the controls shown below the buttons update to provide functions appropriate to the EQ type.

To add Single Band EQ to your project, choose Equalizers > Single Band EQ in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Single-Band EQ parameters

- **Mode buttons:** Choose an EQ type.
  - **Low Cut:** Low Cut EQ attenuates the frequency range that falls below the selected frequency.
  - **Low Shelf:** Low Shelving EQ affects only the frequency range that falls below the selected frequency.
  - **Parametric:** Parametric EQ is a simple filter with a variable center frequency. It can be used to boost or cut any frequency band in the audio spectrum, either with a wide frequency range or as a notch filter with a very narrow range. A symmetrical frequency range on either side of the center frequency is boosted or cut.
  - **High Shelf:** High Shelving EQ affects only the frequency range above the selected frequency.
  - **High Cut:** High Cut EQ attenuates the frequency range above the selected frequency.
- **Frequency knob and field:** Set the cutoff frequency.
- **Gain knob and field:** Set the amount of cut or boost. Available only for Shelf and Parametric EQs.
- **Slope knob and field:** Choose the amount of cut, in decibels per octave. The higher the value, the more pronounced the effect. Available only for Low Cut and Hi Cut EQs.
- **Q Factor knob and field:** Set the width of the frequency band around the cutoff frequency.

Vintage EQ Collection

Vintage EQ collection in Logic Pro for Mac

The Vintage Console EQ, Vintage Graphic EQ, and Vintage Tube EQ plug-ins are modeled on the original EQ circuits of three classic units from the 1950s, 1960s, and 1970s.

The unique output stage of each unit is also modeled, allowing you to pair the output stage of any unit with the original or other EQ models.

Further enhancements include fully sweepable frequency controls that allow more detailed signal contouring than the fixed frequency options found on some of the original devices.

Each vintage EQ unit provides a distinct tonal signature that imparts a sonic color on signals, unlike precise, clean modern equalizers such as the other included EQs.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

All vintage EQ models share a set of common Output parameters, along with unique parameters that are discussed in each section.
Output parameters

- **Drive knob**: Set the amount of gain/saturation of the chosen vintage EQ output stage. This imparts the distortion and coloration of the original hardware output stage, even if all EQ bands are in a neutral position.

- **Output Model pop-up menu**: Choose a vintage EQ model output stage. You can use the matching output stage model for the active EQ or can choose the output stage of another unit. The output stage allows you to add harmonic distortion to your signals.
  - **Silky (Tube EQ)**: The output stage of the Vintage Tube EQ.
  - **Punchy (Graphic EQ)**: The output stage of the Vintage Graphic EQ.
  - **Smooth (Console EQ)**: The output stage of the Vintage Console EQ.

- **Phase pop-up menu**: Set the processing mode of the EQ and the chosen output stage. Natural mirrors the cut/boost phase shifts of the original EQ. Linear allows EQ changes without phase shifts of the source signal.
  
  Each analog EQ introduces phase shifts of the signal which can have an audible (and often desirable) effect on the sound. In some situations, however, phase shifts can affect transients. This is especially the case when using steep cut filters, or high boost of narrow filters. Linear phase filters let you change only the gain of a certain frequency area of your material by retaining the phase, with slightly higher latency than in natural mode.

- **Volume field**: Drag vertically to set the overall plug-in output level. Range is ±25 dB.

**Vintage Console EQ in Logic Pro for Mac**

Vintage Console EQ emulates the EQ section of a well-known mixing console channel that is noted for its tonal color, warmth, smooth top end, and mid-forward presence. A three-band design with switchable low and mid range bands and a fixed 12 kHz high frequency band, it also has a passive third-order (18 dB/octave) low cut/highpass filter.

The original console module is regarded as a cult classic by many recording engineers, and has been used on countless hit records over the past 40 to 50 years.
To add Vintage Console EQ to your project, choose Equalizers > Vintage EQ Collection > Vintage Console EQ in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

### Vintage Console EQ parameters

- **In/Out switch**: Turn the EQ circuit on or off.
- **Low Cut button**: Turn the low cut/highpass filter on or off. This is a third-order filter set at 18 dB per octave.
- **Low Cut knob**: Set the low cut/highpass filter frequency at 50, 80, 160, or 300 Hz, or set values between these increments. Frequencies below this are rolled off at a fixed 18 dB per octave.
- **Low button**: Turn the low shelving filter on or off.
- **Low Gain knob**: Set the low shelving filter level. The gain range is ±16 dB.
- **Low knob**: Set the low shelving filter center frequency at 35, 60, 110, or 220 Hz, or set values between these increments.
- **Mid button**: Turn the mid range filter on or off.
- **Mid Gain knob**: Set the mid range filter level. The gain range is ±18 dB.
- **Mid Freq knob**: Set the mid range filter center frequency at 0.36, 0.7, 1.6, 3.2, 4.8, or 7.2 kHz, or set values between these increments.
- **High button**: Turn the high shelving filter on or off. Fixed at 12 kHz.
- **High Gain knob**: Set the high shelving level. The gain range is ±16 dB.

### Vintage Graphic EQ in Logic Pro for Mac

Vintage Graphic EQ is based on a classic mixing console module. The 10 EQ bands provide 12 dB of cut/boost. It emulates the Proportional Q design of the original device, which widens filter bandwidth at lower cut/boost levels and narrows filter bandwidth at higher cut/boost levels.

Frequencies aren't fixed at the default values, and you can proportionally scale all bands to provide more focus on a portion of the overall frequency spectrum. This flexibility makes it great for precise signal shaping and also a useful tool for tasks such as tuning difficult rooms.
To add Vintage Graphic EQ to your project, choose Equalizers > Vintage EQ Collection > Vintage Graphic EQ in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

![Vintage Graphic EQ Parameters](image)

**Vintage Graphic EQ parameters**

You can change the standard frequency by dragging the Tune field.

- **In/Out switch**: Turn the EQ circuit on or off.
- **Tune field**: Drag to set the frequency of all band sliders. Scaling of frequencies is proportional. This can be used to tune the bands to your project key.
  
  **Tip**: When set to +12 you can boost 32 kHz which results in a very smooth high-end boost.

- **EQ band sliders**: Drag to cut or boost the selected frequency of the incoming signal by ±12dB.

**Vintage Tube EQ in Logic Pro for Mac**

Vintage Tube EQ emulates two retro EQ units that were often paired as they complemented each other. These units are still in use today, despite being out of production for decades.

The main original unit (upper) that Vintage Tube EQ is based on is a valve-equipped analog design. It is a lossless passive equalizer. This means that the signal level remains constant even if the EQ is switched out. The original unit is noted for the “musical” quality of its filters, making it a versatile tool for mixing and mastering.

The low-frequency section of Vintage Tube EQ is a shelving EQ with sweepable frequency bands between 20 and 100 Hz. These frequencies can be boosted by 13.5 dB or cut by 17.5 dB. You can create unusual EQ curves by simultaneously boosting and cutting overlapping frequencies.

The Vintage Tube EQ high-frequency section provides up to 18 dB of boost at frequencies sweepable from 3 to 16 kHz. A Bandwidth control changes the Q value. A shelf-cut EQ provides up to 16 dB of attenuation between 5 and 20 kHz.

The second emulated EQ model (lower) is often paired with the original unit. It’s the perfect partner for the upper unit, adding mid-range flexibility that lets you fine-tune signals in this frequency spectrum, with a beautifully matched tonal signature.
To add Vintage Tube EQ to your project, choose Equalizers > Vintage EQ Collection > Vintage Tube EQ in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

**Vintage Tube EQ upper unit parameters**

- *In/Out switch*: Turn the EQ circuit on or off.
- *Low Boost knob*: Set the amount of low frequency boost, up to 13.5 dB.
- *Low Atten knob*: Set the amount of low frequency attenuation (cut), up to 17.5 dB.
- *Low Freq knob*: Set the low range center frequency to 20, 30, 60, or 100 Hz, or values between these increments.
- *High Boost knob*: Set the amount of high frequency boost, up to 18 dB.
- *High Bandwidth knob*: Set the Q, or bandwidth, of the high frequency range from narrow to broad.
- *High Freq knob*: Set the high range center frequency to 1, 2, 3, 4, 5, 6, 8, 10, 12, 14, or 16 kHz, or values between these increments.
- *High Atten knob*: Set the amount of high frequency attenuation (cut), up to 16 dB.
- *High Atten Sel knob*: Set the high range shelving frequency to 5, 10, or 20 kHz, or values between these increments.
**Vintage Tube EQ lower unit parameters**

- **In/Out switch**: Turn the EQ circuit on or off.
- **Low Freq knob**: Set the low range center frequency to 0.2, 0.3, 0.5, 0.7, or 1.0 kHz, or values between these increments.
- **Low Peak knob**: Set the amount of low frequency boost, up to 10 dB.
- **Dip Freq knob**: Set the Dip (attenuation) center frequency to 0.2, 0.3, 0.5, 0.7, or 1.0, 1.5, 2, 3, 4, or 5 kHz, or values between these increments.
- **Dip knob**: Set the amount of attenuation (cut) for the selected Dip frequency, up to 10 dB.
- **High Freq knob**: Set the high range center frequency to 1.5, 2, 3, 4, or 5 kHz, or values between these increments.
- **High Peak knob**: Set the amount of high frequency boost, up to 8 dB.
Filter effects

Filter effects in Logic Pro for Mac

Filters are used to emphasize or suppress frequencies in an audio signal, resulting in a change in the tonal color of the audio.

Logic Pro contains a variety of advanced filter-based effects that you can use to creatively modify your audio. These effects are most often used to radically alter the frequency spectrum of a sound or mix. Several filter effects provide a Side Chain input.

Included are AutoFilter and Spectral Gate, which can be used for interesting sound design manipulations, the vocoder-based EVOC 20 Filterbank and EVOC 20 TrackOscillator plug-ins, and the Fuzz-Wah.

Note: Equalizers (EQs) are special types of filters. They are not usually used as “effects” per se, but as tools to refine the frequency spectrum of a sound or mix. See Equalizers overview.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

AutoFilter

AutoFilter overview in Logic Pro for Mac

AutoFilter is a versatile filter effect with several unique features. You can use it to create classic, analog-style synthesizer effects, or as a tool for creative sound design.

The effect works by analyzing incoming signal levels through use of a threshold parameter. Any signal level that exceeds the threshold is used as a trigger for a synthesizer-style ADSR envelope or an LFO (low frequency oscillator). These control sources are used to dynamically modulate the filter cutoff.

AutoFilter lets you choose between different filter types and slopes, control the amount of resonance, add distortion for more aggressive sounds, and mix the original, dry signal with the processed signal.
To add AutoFilter to your project, choose Filter > AutoFilter in a channel strip Audio Effect plug-in menu. See *Add, remove, move, and copy plug-ins*.

The AutoFilter window is divided into Filter,Envelope, Distortion, LFO, and Output parameter sections.

- **Filter parameters**: Control the tonal color of the filtered sound. See *AutoFilter filter controls*.
- **Envelope parameters**: Define how the filter cutoff frequency is modulated over time. See *AutoFilter envelope controls*.
- **Distortion parameters**: Distort the signal both before and after the filter. See *AutoFilter distortion controls*.
- **LFO parameters**: Define how the filter cutoff frequency is modulated by the LFO. See *AutoFilter LFO controls*.
- **Output parameters**: Set the level of both the dry and effect signal. See *AutoFilter output controls*. 
AutoFilter filter controls in Logic Pro for Mac

The Filter parameters precisely tailor the tonal color.

Filter parameters

- **On/off switch**: Turn the filter section on or off.
- **Cutoff knob and field**: Set the cutoff frequency for the filter. Higher frequencies are attenuated, whereas lower frequencies are allowed to pass through in a lowpass filter. The reverse is true in a highpass filter. When the State Variable Filter is set to bandpass (BP) mode, the filter cutoff determines the center frequency of the frequency band that is allowed to pass.
- **Resonance knob and field**: Boost or cut signals in the frequency band that surrounds the cutoff frequency. Very high Resonance values cause the filter to begin oscillating at the cutoff frequency. This self-oscillation occurs before you reach the maximum Resonance value.
- **State Variable buttons**: Switch the filter between highpass (HP), bandpass (BP), lowpass (LP), or peak (PK) modes.
- **4-Pole Lowpass buttons**: Set the slope of the lowpass filter to 6, 12, 18, or 24 dB per octave.
  
  *Note*: Clicking one of these buttons automatically chooses the lowpass (LP) filter and slope, overriding any active State Variable filter button.
- **Fatness slider and field**: Boost the level of low frequency content. When you set Fatness to its maximum value, adjusting Resonance has no effect on frequencies below the cutoff frequency. This parameter is used to compensate for a weak or “brittle” sound caused by high resonance values, when in the lowpass filter mode.
- **Spread slider and field**: Set the stereo spread width.
- **Envelope slider and field**: Determine the impact of the envelope on cutoff frequency.
- **LFO slider and field**: Determine the impact of the LFO on cutoff frequency.
AutoFilter envelope controls in Logic Pro for Mac

The envelope is used to shape the filter cutoff over time. When the input signal exceeds the set threshold level, the envelope is triggered.

![AutoFilter envelope controls](image)

**Envelope parameters**

- **On/off switch**: Turn the envelope section on or off.
- **Threshold knob and field**: Set an input level that—if exceeded—triggers the envelope or LFO that dynamically modulates filter cutoff frequency. See AutoFilter LFO controls and AutoFilter filter controls.
  
  *Note*: Retriggering of the envelope or LFO occurs only if the Retrigger button is active.
- **Dynamic knob and field**: Determine the input signal modulation amount. You can modulate the peak value of the envelope section by varying this control.
- **Attack handle and field**: Drag the handle horizontally (or field vertically) to set the envelope attack time.
- **Decay handle and field**: Drag the handle horizontally (or field vertically) to set the envelope decay time.
  
  - Drag this handle horizontally to set the decay time and vertically to set the sustain level.
- **Sustain handle and field**: Drag the handle (or field) vertically to set the envelope sustain level. If the input signal falls below the threshold level before the envelope sustain phase, the release phase is triggered.
- **Release handle and field**: Drag the handle horizontally (or field vertically) to set the envelope release time. This is triggered as soon as the input signal falls below the threshold.
AutoFilter distortion controls in Logic Pro for Mac

The distortion parameters can be used to overdrive the filter input or filter output. The distortion input and output modules are identical, but their positions in the signal chain—before and after the filter, respectively—result in remarkably different sounds.

Distortion parameters

- **On/off switch**: Turn the distortion section on or off.
- **Pre Filter knob and field**: Set the amount of distortion applied before the filter section processes the signal.
- **Post Filter knob and field**: Set the amount of distortion applied after the filter section processes the signal.
- **Mode pop-up menus**: Choose the distortion type for either the pre or post filter. Options are: Classic, Tube, and Scream.

AutoFilter LFO controls in Logic Pro for Mac

The LFO is used as a modulation source for filter cutoff.
LFO parameters

- **On/off switch:** Turn the LFO section on or off.
- **Sync button:** Synchronize the LFO with the project tempo. You can set bar values, triplet values, and more with the Rate knob and field.
- **Rate knob and field:** Set the speed of LFO modulation.
- **Sync Phase knob and field:** When Sync is active, rotate to set the phase relationship between the LFO rate and the project tempo. This parameter is dimmed when Beat Sync is disabled.
- **Stereo Phase knob and field:** Set the phase relationship of the LFO modulations between the two channels (stereo only).
- **Retrigger button:** Turn on to retrigger the LFO waveform from the start of the cycle each time.
- **Waveform buttons:** Select the shape of the LFO waveform. Choose from: descending sawtooth, ascending sawtooth, triangle, pulse wave, or random.
- **Pulse Width knob and field:** Alter the curve shape of the selected waveform.

AutoFilter output controls in Logic Pro for Mac

The Output parameters are used to set the wet/dry balance and overall level.

Output parameters

- **Dry Signal slider and field:** Set the amount of original, dry signal added to the filtered signal.
- **Main Out slider and field:** Set the overall output level. This compensates for higher levels caused by the use of distortion or by the filtering process itself.

EVOC 20 Filterbank

EVOC 20 Filterbank overview in Logic Pro for Mac

EVOC 20 Filterbank consists of two formant filter banks. The input signal passes through the two filter banks in parallel. Each bank features level faders for up to 20 frequency bands, allowing independent level control of each band. Setting a level fader to its minimum value completely suppresses the formants in that band. You can control the position of the filter bands with the Formant Shift parameter. You can also crossfade between the two filter banks.

The EVOC 20 Filterbank interface is divided into three main sections: the Formant Filter parameters section in the center of the window, the Modulation parameters section at the bottom, and the Output parameters section along the right side.
To add EVOC 20 Filterbank to your project, choose Filter > EVOC 20 Filterbank in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

- **Formant Filter parameters**: Control the frequency bands in the two filter banks—the upper, blue, filter bank A and the lower, green, filter bank B. See EVOC 20 Filterbank Formant Filter.
- **Modulation parameters**: Control how Formant Filter parameters are modulated. See EVOC 20 Filterbank modulation.
- **Output parameters**: Control the overall output level and panning of the EVOC 20 Filterbank. See EVOC 20 Filterbank output controls.

### About formants

A formant is a peak in the frequency spectrum of a sound. In the context of human voices, formants are the key component that enables humans to distinguish between different vowel sounds, based purely on the frequency of these sounds. Formants in human speech and singing are produced by the vocal tract, with most vowel sounds containing four or more formants.
EVOC 20 Filterbank Formant Filter in Logic Pro for Mac

The parameters in this section provide precise level and frequency control of the filters.

Formant Filter parameters

- **High and Low Frequency parameters**: Determine the lowest and highest frequencies allowed to pass by the filter banks. Frequencies that fall outside these boundaries are cut.
  
  - The length of the horizontal blue bar at the top represents the frequency range. The silver handles on the left and right ends of the blue bar set the Low Frequency and High Frequency values, respectively. You can move the entire frequency range by dragging the blue bar.
  
  - You can also drag in the numeric fields that are below the blue bar to adjust the frequency values separately.

- **Frequency band faders**: Set the level of each frequency band in filter bank A—the blue faders—or filter bank B—the green faders. You can quickly create complex level curves by dragging horizontally, or “drawing,” across either row of faders.

- **Formant Shift knob**: Move all bands in both filter banks up or down the frequency spectrum.

  Note: The use of Formant Shift can result in the generation of unusual resonant frequencies when high Resonance settings are used.

- **Bands value field**: Set the number of frequency bands—up to 20—in each filter bank.

- **Lowest button**: Switch the lowest filter band between bandpass or highpass mode. In bandpass mode, the frequencies above and below the lowest band are ignored. In highpass mode, all frequencies below the lowest band are filtered.

- **Highest button**: Switch the highest filter band between bandpass or lowpass mode. In bandpass mode, the frequencies above and below the highest band are ignored. In lowpass mode, all frequencies above the highest band are filtered.

- **Resonance knob**: Determine the basic sonic character of both filter banks. High Resonance settings emphasize the center frequency of each band and result in a sharper, brighter character. Low settings result in a softer character.
• *Boost A and Boost B knobs:* Set the amount of boost or cut applied to the frequency bands in filter bank A or B. You can use these knobs to compensate for the reduction in volume caused by lowering the level of one or more bands. If you use Boost A and Boost B to set the mix relationship between filter bank levels, you can use Fade AB (see “Fade AB slider” below) to alter the tonal color, but not the levels.

• *Slope pop-up menu:* Choose the amount of filter attenuation applied to all filters in both filter banks. You can choose 1, which sounds softer at 6 dB/octave, or 2, which sounds brighter at 12 dB/octave.

• *Fade AB slider:* Crossfade between filter bank A and filter bank B. At the top position, only bank A is audible, and at the bottom position, only bank B is audible. In the middle position, the signals passing through both banks are evenly mixed.

**EVOC 20 Filterbank modulation in Logic Pro for Mac**

The modulation section contains two LFOs. The Shift LFO parameters on the left side control the Formant Shift parameter, and the Fade LFO parameters on the right side control the Fade AB parameter.

![EVOC 20 Filterbank modulation in Logic Pro for Mac](image)

**Modulation parameters**

• *Shift LFO Intensity slider:* Set the amount of Formant Shift modulation by the Shift LFO.

• *Rate knobs and fields:* Set the speed of modulation. Values to the left are synchronized with the Logic Pro tempo and include bar values, triplet values, and so on. Values to the right are nonsynchronized, or free, and are displayed in hertz—cycles per second.

  Note: The ability to use synchronous bar values could be used to perform a formant shift every four bars on a cycled one-bar percussion part, for example. Alternatively, you could perform the same formant shift on every eighth-note triplet within the same part. Either method can generate interesting results.

• *Waveform buttons:* Set the waveform type used by the Shift LFO (left column) or the Fade LFO (right column). You can choose from the following waveforms for each LFO:
  • Triangle
  • Falling and rising sawtooth
  • Square up and down around zero (bipolar, good for trills)
  • Square up from zero (unipolar, good for changing between two definable pitches)
  • Random stepped waveform (S&H)
  • Smoothed random waveform
• **Fade LFO Intensity slider**: Control the amount of Fade AB modulation by the Fade LFO.

⚠️ **Tip**: LFO modulations are the key to interesting effects. Set up either completely different or complementary filter curves in both filter banks. You can use rhythmic material—such as a drum loop—as an input signal, and set up tempo-synchronized modulations, with different rates for each LFO. Also try inserting a tempo-synchronized delay effect—such as Tape Delay—after the EVOC 20 Filterbank to produce unique polyrhythms.

## EVOC 20 Filterbank output controls in Logic Pro for Mac

The output parameters provide control over the level and stereo width. The output section also incorporates an integrated overdrive (distortion) circuit.

![EVOC 20 Filterbank output controls](image)

### Output parameters

- **Overdrive button**: Turn the overdrive circuit on or off.

  *Note*: To hear the overdrive effect, you might need to boost the level of one or both filter banks.

- **Level slider**: Set the volume of the output signal.

- **Stereo Mode pop-up menu**: Choose the input/output mode.
  - In s/s mode (stereo input/stereo output), the left and right channels are processed by separate filter banks.
  - In m/s mode (mono input/stereo output), a stereo input signal is first summed to mono before being routed to the filter banks.

- **Stereo Width knob**: Distribute the output signals of the filter bands in the stereo field.
  - At the 0 position to the left, the outputs of all bands are centered.
  - At the centered position at the top, the outputs of all bands ascend from left to right.
  - At the full position to the right, the bands are output to the left and right channels alternately.
EVOC 20 TrackOscillator

EVOC 20 TrackOscillator overview in Logic Pro for Mac

EVOC 20 TrackOscillator is a vocoder with a monophonic pitch tracking oscillator. The tracking oscillator tracks, or follows, the pitch of a monophonic input signal. If the input signal is a sung vocal melody, the individual note pitches are tracked and mirrored, or played, by the synthesis engine.

EVOC 20 TrackOscillator features two formant filter banks, an analysis bank, and a synthesis filter bank. Each offers multiple input options.

You can capture an analysis signal source by using the audio arriving at the input of the channel strip that EVOC 20 TrackOscillator is inserted into or by using a side chained signal from another channel strip.

The synthesis source can be derived from the audio input of the channel strip that EVOC 20 TrackOscillator is inserted into, a side chain signal, or the tracking oscillator.

To add EVOC 20 TrackOscillator to your project, choose Filter > EVOC 20 TrackOscillator in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Because you can select both the analysis and synthesis input signals, EVOC 20 TrackOscillator is not limited to pitch tracking effects; you can also use it for unusual filter effects. For example, you could filter an orchestral recording on one channel strip with train noises side chained from another channel strip. Or you could use it to process drum loops with side chained signals, such as other drum loops or rhythmic guitar, clavinet, and piano parts.

Vocoder overview

The word vocoder is an abbreviation for voice encoder. A vocoder analyzes and transfers the sonic character of the audio signal arriving at its analysis input to the synthesizer sound generators. The result of this process is heard at the output of the vocoder.

The classic vocoder sound uses speech as the analysis signal and a synthesizer sound as the synthesis signal. This sound was popularized in the late 1970s and early 1980s. You may be familiar with tracks such as “O Superman” by Laurie Anderson, “Funkytown” by Lipps Inc., and numerous Kraftwerk pieces—such as “Autobahn,” “Europe Endless,” “The Robots,” and “Computer World.”

In addition to these “singing robot” sounds, vocoding has also been used in many films—such as with the Cylons in Battlestar Galactica, and most famously, with the voice of Darth Vader from the Star Wars saga.

Vocoding, as a process, is not strictly limited to vocal performances. You could use a drum loop as the analysis signal to shape a string ensemble sound arriving at the synthesis input.

The speech analyzer and synthesizer features of a vocoder are two bandpass filter banks. Bandpass filters allow a frequency band—a slice in the overall frequency spectrum—to pass through unchanged. Frequencies that fall outside the band are cut.
In the EVOC 20 plug-ins, these filter banks are named the *analysis* and *synthesis* banks. Each filter bank has a matching number of corresponding bands—if the analysis filter bank has five bands (1, 2, 3, 4, and 5), there is a corresponding set of five bands in the synthesis filter bank. Band 1 in the analysis bank is matched to band 1 in the synthesis bank, band 2 to band 2, and so on.

The audio signal arriving at the analysis input passes through the analysis filter bank, where it is divided into bands.

An envelope follower is coupled to each filter band. The envelope follower of each band tracks, or follows, volume changes in the audio source—or, more specifically, the portion of the audio that has been allowed to pass by the associated bandpass filter. In this way, the envelope follower of each band generates dynamic control signals.

These control signals are then sent to the synthesis filter bank—where they control the levels of the corresponding synthesis filter bands. This is done with voltage-controlled amplifiers (VCAs) in analog vocoders. Volume changes to the bands in the analysis filter bank are imposed on the matching bands in the synthesis filter bank. These filter level changes are heard as a synthetic reproduction of the original input signal—or a mix of the two filter bank signals.

**EVOC 20 TrackOscillator interface in Logic Pro for Mac**

EVOC 20 TrackOscillator is divided into a number of parameter sections.

- **Analysis In parameters:** Determine how the input signal is analyzed and used by the analysis filter bank. See *Analysis In controls*.
- **U/V Detection parameters:** Detect the unvoiced portions of the sound in the analysis signal, improving speech intelligibility. See *EVOC 20 TrackOscillator U/V detection controls*.
- **Synthesis In parameters:** Determine how the input signal is used by the synthesis filter bank. See *Synthesis In controls*.
- **Tracking Oscillator parameters:** Determine how the analysis input signal is used by the oscillator. See *EVOC 20 TrackOscillator oscillator controls*.
• **Formant Filter parameters:** Configure the analysis and synthesis filter banks. See [EVOC 20 TrackOscillator formant filter](#).

• **LFO parameters:** Modulate either the oscillator pitch or the Formant Shift parameter. See [EVOC 20 TrackOscillator modulation](#).

• **Output parameters:** Configure the output signal of the EVOC 20 TrackOscillator. See [EVOC 20 TrackOscillator output controls](#).

**EVOC 20 TrackOscillator Analysis In controls in Logic Pro for Mac**

The parameters of the Analysis In section determine how the input signal is analyzed and used by EVOC 20 TrackOscillator.

![EVOC 20 TrackOscillator Analysis In controls](image)

**Analysis In parameters**

- **Attack knob:** Determine how quickly each envelope follower—coupled to each analysis filter band—reacts to rising signals.

- **Release knob:** Determine how quickly each envelope follower—coupled to each analysis filter band—reacts to falling signals.

- **Freeze button:** Hold the current analysis sound spectrum indefinitely. When Freeze is enabled, the analysis filter bank ignores the input source, and the Attack and Release knobs have no effect.

- **Bands field:** Set the number of frequency bands analyzed and then used by the synthesis engine. Up to 20 bands can be used.

- **Analysis In pop-up menu:** Choose the analysis signal source.
  
  - **Track:** Uses the input audio signal of the channel strip the EVOC 20 TrackOscillator is inserted into as the analysis signal.
  
  - **SideCh(ain):** Uses a side chain as the analysis signal. You choose the side chain source channel strip from the Side Chain pop-up menu in the upper-right corner of the plug-in window.

**Note:** If Side Chain is chosen and no Side Chain channel strip is assigned, the EVOC 20 TrackOscillator reverts to Track mode.
Set Attack and Release times in EVOC 20 TrackOscillator

- In Logic Pro, rotate the Attack and Release knobs to set times that provide the most articulated sound.

Longer attack times result in a slower tracking response to transients—level spikes—of the analysis input signal. A long attack time on percussive input signals, such as a spoken word or hi-hat part, translates into a less articulated vocoder effect. Set the Attack parameter to the lowest possible value to enhance articulation.

Longer release times cause the analysis input signal transients to sustain for a longer period at the vocoder output. A long release time on percussive input signals, such as a spoken word or hi-hat part, translates into a less articulated vocoder effect. Use of extremely short release times results in rough, grainy vocoder sounds. Release values of around 8 to 10 ms are useful starting points.

Freeze the input signal in EVOC 20 TrackOscillator

- In Logic Pro, click the Freeze button to hold, or sustain, the sound spectrum of the analysis input signal.

By freezing the input signal you can capture a particular characteristic of the signal, which is then imposed as a complex sustained filter shape on the Synthesis section. Here are some examples of when this could be useful:

- If you are using a spoken word pattern as a source, the Freeze button could capture the attack or tail phase of an individual word within the pattern—the vowel a, for example.

- People cannot sustain sung notes indefinitely. To compensate for this human limitation, use the Freeze button. If the synthesis signal needs to be sustained but the analysis source signal—a vocal part—is not sustained, use the Freeze button to lock the current formant levels of a sung note, even during gaps in the vocal part, between words in a vocal phrase.

Tip: The Freeze parameter can be automated, which may be useful in this situation.

Set the number of filter bank bands in EVOC 20 TrackOscillator

- In Logic Pro, vertically drag the Bands field to set the number of frequency bands the EVOC 20 TrackOscillator filter bank uses.

The greater the number of frequency bands, the more precisely the sound can be reshaped. As the number of bands is reduced, the source signal frequency range is divided up into fewer bands, and the resulting sound is formed with less precision by the synthesis engine. A good compromise between sonic precision—allowing incoming signals such as speech and vocals to remain intelligible—and resource usage is around 10 to 15 bands.

Tip: To attain the best possible pitch tracking, it is essential to use a mono signal with no overlapping pitches. Ideally, the signal should be unprocessed and free of background noises. Using a signal processed with even a slight amount of reverb, for example, can produce unusual results. Processing a signal with no audible pitch, such as drum loop, also delivers unusual results, but the resulting artifacts might be perfect for your project.
EVOC 20 TrackOscillator U/V detection in Logic Pro for Mac

Human speech consists of a series of voiced sounds—tonal sounds or formants—and unvoiced sounds. The main distinction between voiced and unvoiced sounds is that voiced sounds are produced by an oscillation of the vocal cords, whereas unvoiced sounds are produced by blocking and restricting the air flow with lips, tongue, palate, throat, and larynx.

If speech containing voiced and unvoiced sounds is used as a vocoder analysis signal but the synthesis engine doesn’t differentiate between voiced and unvoiced sounds, the result sounds rather weak. To avoid this problem, the synthesis section of the vocoder must produce different sounds for the voiced and unvoiced parts of the signal.

EVOC 20 TrackOscillator includes an Unvoiced/Voiced detector. This unit detects the unvoiced portions of the sound in the analysis signal and then substitutes the corresponding portions in the synthesis signal with noise, with a mixture of noise and synthesizer signal, or with the original signal. If the U/V Detector detects voiced parts, it passes this information to the synthesis section, which uses the normal synthesis signal for these portions.

About formants
A formant is a peak in the frequency spectrum of a sound. In the context of human voices, formants are the key component that enables humans to distinguish between different vowel sounds—based purely on the frequency of the sounds. Formants in human speech and singing are produced by the vocal tract, with most vowel sounds containing four or more formants.
U/V detection parameters

• **Sensitivity knob:** Determine how responsive U/V detection is. Turn to the right for higher settings, where more of the individual unvoiced portions of the input signal are recognized. When high settings are used, the increased sensitivity to unvoiced signals can lead to the U/V sound source being used on the majority of the input signal, including voiced signals. Sonically, this results in a sound that resembles a radio signal that is breaking up and contains a lot of static, or noise. (The U/V sound source is determined by the Mode menu, as described below.)

• **Mode pop-up menu:** Choose the sound sources used to replace the unvoiced content of the input signal.
  - **Noise:** Uses noise alone for the unvoiced portions of the sound.
  - **N + Syn (Noise + Synthesizer):** Uses noise and the synthesizer for the unvoiced portions of the sound.
  - **Blend:** Uses the analysis signal after it has passed through a highpass filter for the unvoiced portions of the sound. The Sensitivity parameter has no effect when this setting is used.
  - **Level knob:** Set the volume of the signal used to replace the unvoiced content of the input signal.

*Important:* Be careful with the Level knob, particularly when using a high Sensitivity value, to avoid internally overloading the EVOC 20 TrackOscillator.

Logic Pro for Mac EVOC 20 TrackOscillator Synthesis In controls

The Synthesis In section controls various aspects of the tracking signal for the synthesizer. The tracking signal is used to trigger the internal synthesizer.

![Synthesis In parameters](image)

**Synthesis In parameters**

• **Synthesis In pop-up menu:** Choose the tracking signal source.
  - **Track:** Use the input audio signal of the channel strip that EVOC 20 TrackOscillator is inserted into as the synthesis signal, which drives the internal synthesizer.
  - **SideCh (SideChain):** Use a side chain as the synthesis control signal. You choose the side chain source channel from the Side Chain pop-up menu in the upper-right corner of the EVOC 20 TrackOscillator window.
  - **Osc. (Oscillator):** Set the tracking oscillator as the synthesis source. The oscillator mirrors, or tracks, the pitch of the analysis input signal. Choosing Osc activates the other parameters in the synthesis section. If Osc is not chosen, the FM Ratio, FM Int, and other parameters in this section have no effect.

*Note:* If you choose Side Chain and no Side Chain channel is assigned, EVOC 20 TrackOscillator reverts to Track mode.

• **Bands field:** Set the number of frequency bands analyzed and then used by the synthesis engine.
EVOC 20 TrackOscillator oscillators in Logic Pro for Mac

The tracking oscillator follows the pitch of incoming monophonic audio signals and mirrors these pitches with a synthesized sound. The FM tone generator for the tracking oscillator consists of two oscillators, each of which generates a sine wave. The frequency of Oscillator 1, the carrier, is modulated by Oscillator 2, the modulator, which deforms the sine wave of Oscillator 1. This results in a waveform with rich harmonic content.

**Important:** The parameters discussed in this section are available only if the Synthesis In menu is set to Osc. See *Synthesis In controls.*

![Image of Tracking Oscillator parameters](image)

**Tracking oscillator parameters**

- **FM Ratio field:** Set the ratio between Oscillators 1 and 2, which defines the basic character of the sound. Even-numbered values or their multiples produce harmonic sounds, whereas odd-numbered values or their multiples produce inharmonic, metallic sounds.
  - An FM Ratio of 1.000 produces results resembling a sawtooth waveform.
  - An FM Ratio of 2.000 produces results resembling a square wave with a pulse width of 50%.
  - An FM Ratio of 3.000 produces results resembling a square wave with a pulse width of 33%.
- **FM Int knob:** Determine the intensity of modulation. Higher values result in a more complex waveform with more overtones.
  - At a value of 0, the FM tone generator is disabled and a sawtooth wave is generated.
  - At values above 0, the FM tone generator is activated. Higher values result in a more complex and brighter sound.
- **Coarse Tune field:** Set the pitch offset of the oscillator in semitones.
- **Fine Tune field:** Adjust the tuning in hertz.

**EVOC 20 TrackOscillator pitch controls in Logic Pro for Mac**

The tracking oscillator pitch parameters control the automatic pitch correction feature of the tracking oscillator. They can be used to constrain the pitch of the tracking oscillator to a scale or chord. This allows subtle or strong pitch corrections and can be used creatively on unpitched material with high harmonic content, such as cymbals and high-hats.

![Image of TrackOscillator pitch controls](image)
Tracking oscillator pitch parameters

- **Pitch Quantize Strength slider:** Determine how pronounced the automatic pitch correction is.
- **Pitch Quantize Glide slider:** Set the amount of time pitch correction takes, allowing sliding transitions to quantized pitches.
- **Root/Scale keyboard:** Click notes to define the pitch or pitches that the tracking oscillator is quantized to.
- **Root/Scale pop-up menu:** Click below Scale to choose the scale that the tracking oscillator is quantized to.

*Note:* There are two discrete fields available for this parameter: Root and Scale. The Root (key) can be changed independently of the scale chosen in the pop-up menu.

- **Max Track field:** Set the highest frequency. All frequencies above this threshold are cut, making pitch detection more robust. If pitch detection produces unstable results, reduce this parameter to the lowest possible setting that allows all appropriate input signals to be heard or processed.

Choose a root or scale in EVOC 20 TrackOscillator

1. In Logic Pro, click the green value field under Scale to open the pop-up menu.
2. Choose the scale or chord you want to use as the basis for pitch correction.

*Note:* You can also set the root key of the chosen scale or chord by vertically dragging the Root (key) field, or by double-clicking the root note and entering a root key between C and B. The Root parameter is not available when the Root/Scale value is set to “chromatic” or “user.”

Add notes to, or remove notes from, the chosen scale or chord in EVOC 20 TrackOscillator

In Logic Pro:

- **To add notes to the scale or chord:** Click unused keys on the small keyboard to highlight them in green.
- **To remove notes from the scale or chord:** Click selected notes, which then are no longer highlighted.

⚠️ Tip: Your last edit is remembered. If you choose a new scale or chord but do not make any changes, you can revert to the previously set scale by choosing “user” from the Root/Scale pop-up menu.

EVOC 20 TrackOscillator formant filter in Logic Pro for Mac

EVOC 20 TrackOscillator features two formant filter banks—one for the Analysis In section and one for the Synthesis In section. The entire frequency spectrum of an incoming signal is analyzed by the Analysis section and is divided equally into a number of frequency bands. Each filter bank can control up to 20 of these frequency bands.
The Formant Filter display is divided in two by a horizontal line. The upper half applies to the analysis section and the lower half to the synthesis section. Parameter changes are reflected in the Formant Filter display, thus providing feedback on what is happening to the signal as it is routed through the two formant filter banks.

Formant filter parameters

- **Low and High Frequency parameters**: Determine the lowest and highest frequencies allowed to pass by the filter section. Frequencies that fall outside these boundaries are cut.
  - The length of the horizontal blue bar at the top represents the frequency range for both analysis and synthesis—unless Formant Stretch or Formant Shift is used. You can move the entire frequency range by dragging the blue bar. The silver handles on either end of the blue bar set the Low Frequency and High Frequency values, respectively.
  - You can also drag in the numeric fields to adjust the frequency values separately.
  - **Lowest button**: Switch the lowest filter band between bandpass or highpass mode. In bandpass mode, the frequencies above and below the lowest band are ignored. In highpass mode, all frequencies below the lowest band are filtered.
  - **Highest button**: Switch the highest filter band between bandpass or lowpass mode. In bandpass mode, the frequencies above and below the highest band are ignored. In lowpass mode, all frequencies above the highest band are filtered.
  - **Formant Stretch knob**: Change the width and distribution of all bands in the synthesis filter bank. This can be a broader or narrower frequency range than that defined by the High and Low Frequency parameters.

When Formant Stretch is set to 0, the width and distribution of the bands in the synthesis filter bank at the bottom match the width of the bands in the analysis filter bank at the top. Low values narrow the width of each band in the synthesis bank, whereas high values widen the bands. The control range is expressed as a ratio of the overall bandwidth.
• **Formant Shift knob**: Move all bands in the synthesis filter bank up or down the frequency spectrum.

When Formant Shift is set to 0, the positions of the bands in the synthesis filter bank match the positions of the bands in the analysis filter bank. Positive values move the synthesis filter bank bands up in frequency, whereas negative values move them down—in relation to the analysis filter bank band positions.

When combined, Formant Stretch and Formant Shift alter the formant structure of the resulting vocoder sound, which can lead to interesting timbre changes. For example, using speech signals and tuning Formant Shift up results in "Mickey Mouse" effects.

Formant Stretch and Formant Shift are also useful if the frequency spectrum of the synthesis signal does not complement the frequency spectrum of the analysis signal. You could create a synthesis signal in the high-frequency range from an analysis signal that mainly modulates the sound in a lower-frequency range, for example.

*Note*: Use of the Formant Stretch and Formant Shift parameters can result in the generation of unusual resonant frequencies when high Resonance settings are used.

• **Resonance knob**: Change the basic sonic character of the vocoder. Low settings result in a soft character, whereas high settings lead to a more snarling, sharp character. Technically, increasing the Resonance value emphasizes the middle frequency of each frequency band.

**EVOC 20 TrackOscillator modulation in Logic Pro for Mac**

The parameters in this section control the LFO, which can be used to modulate either the pitch of the tracking oscillator, thus creating a vibrato, or the Formant Shift parameter of the synthesis filter bank.

![Image of modulation parameters](image)

**Modulation parameters**

• **Shift Intensity slider**: Set the amount of formant shift modulation by the LFO.

• **Pitch Intensity slider**: Set the amount of pitch modulation—vibrato—by the LFO.

• **Waveform buttons**: Set the waveform type used by the LFO. You can choose from the following waveforms:
  • Triangle
  • Falling and rising sawtooth
  • Square up and down around zero (bipolar, good for trills)
  • Square up from zero (unipolar, good for changing between two definable pitches)
  • Random stepped waveform (S&H)
  • Smoothed random waveform
• **LFO Rate knob and field:** Set the speed of modulation. Values to the left are synchronized with the Logic Pro tempo and include bar values, triplet values, and so on. Values to the right are nonsynchronized, or free, and are displayed in hertz—cycles per second.

  Note: The ability to use synchronous bar values could be used to perform a formant shift every four bars on a cycled one-bar percussion part, for example. Alternatively, you could perform the same formant shift on every eighth-note triplet within the same part. Either method can generate interesting results.

### EVOC 20 TrackOscillator output controls in Logic Pro for Mac

The output section provides control over the type, stereo width, and level of signal that is sent from EVOC 20 TrackOscillator.

![](image)

#### Output parameters

- **Signal pop-up menu:** Choose the signal that is sent to the plug-in main outputs.
  - **Voc(oder):** Hear the vocoder effect.
  - **Syn(thesis):** Hear only the synthesizer signal.
  - **Ana(lysis):** Hear only the analysis signal.

  Note: The last two settings are mainly useful for monitoring purposes.

- **Level slider:** Set the overall volume of the output signal.

- **Stereo Mode pop-up menu:** Choose the input/output mode.
  - In s/s mode (stereo input/stereo output), the left and right channels are processed by separate filter banks.
  - In m/s mode (mono input/stereo output), a stereo input signal is first summed to mono before being routed to the filter banks.
• **Stereo Width knob:** Distribute the output signals of the synthesis section filter bands in the stereo field.
  • At the 0 position to the left, the outputs of all bands are centered.
  • At the centered position, the outputs of all bands ascend from left to right.
  • At the Full position to the right, the bands are output—alternately—to the left and right channels.

**EVOC 20 TrackOscillator extended parameters in Logic Pro for Mac**

The extended parameters provide additional advanced options for EVOC 20 TrackOscillator. Click the disclosure arrow at the lower left to view and use these parameters.

**Extended parameters**

• **Track Mode pop-up menu:** Choose the pitch tracking mode.
  • **Old:** Pitch tracking mode based on a Fast Fourier Transform calculation.
  • **Cepstrum:** Pitch tracking mode based on analysis of harmonic spacing, enabling grouped harmonics and/or sidebands to be identified.
  • **AKF:** Pitch tracking mode based on analysis of harmonic content, enabling the fundamental frequency to be identified.

• **Oscillator Wave slider and field:** Choose an oscillator waveform from 100 Digiwaves for oscillator 2, the modulator.
  
  *Digiwaves* are very short samples of the attack transients of various sounds and instruments.

• **Fixed Note slider and field:** Set a fixed note frequency or set to the "track" position to enable tracking mode.

**Fuzz-Wah**

**Fuzz-Wah overview in Logic Pro for Mac**

The Fuzz-Wah plug-in emulates classic wah effects, combined with compression and fuzz distortion effects. The name *wah wah* comes from the sound it produces. It has been a popular effect—usually a pedal effect—with electric guitarists since the days of Jimi Hendrix. The pedal controls the cutoff frequency of a bandpass, a lowpass, or less commonly a highpass filter.
To add Fuzz-Wah to your project, choose Filter > Fuzz-Wah in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Fuzz-Wah effects work in series—where the output of one effect is fed into the next in an effects chain. The routing order lets you choose whether a distorted signal should be wah-filtered (for funkier sounds) or the wah-filtered sound should be distorted (for screaming sounds), for example.

Horizontally drag the name of the effect to determine the order of the effects chain.

**Auto Wah in Logic Pro for Mac Fuzz-Wah effect**

These parameters determine the tone and behavior of the wah effect.

You can control the wah effect with the Auto Wah feature, which continually performs a filter sweep across the entire range. You can also control the wah sweep with MIDI foot pedals or other controllers.
Auto Wah parameters

- **On/off button**: Turn the Auto Wah effect on or off.
- **Wah Type pop-up menu**: Choose a Wah effect type.
  - **Classic Wah**: This setting mimics the sound of a popular wah pedal with a slight peak characteristic.
  - **Retro Wah**: This setting mimics the sound of a popular vintage wah pedal.
  - **Modern Wah**: This setting mimics the sound of a distortion wah pedal with a constant Q(uality) Factor setting. The Q determines the resonant characteristics. Low Q values affect a wider frequency range, resulting in softer resonances. High Q values affect a narrower frequency range, resulting in more pronounced emphasis.
  - **Opto Wah 1**: This setting mimics the sound of a distortion wah pedal with a constant Q(uality) Factor setting.
  - **Opto Wah 2**: This setting mimics the sound of a distortion wah pedal with a constant Q(uality) Factor setting.
  - **Resonant LP**: In this mode, the Wah works as a resonance-capable lowpass filter. At the minimum pedal position, only low frequencies can pass.
  - **Resonant HP**: In this mode, the Wah works as a resonance-capable highpass filter. At the maximum pedal position, only high frequencies can pass.
  - **Peak**: In this mode, the Wah works as a peak (bell) filter. Frequencies close to the cutoff frequency are emphasized.
  - **Auto Gain button**: Limit the output signal dynamic range. The wah effect can cause the output level to vary widely. Auto Gain compensates for this tendency and keeps the output signal within a more stable range.
  - **Relative Q knob and field**: Adjust the main filter peak, resulting in a sharper or softer wah sweep.
  - **Wah Level knob and field**: Set the amount of the wah-filtered signal.
  - **Depth knob and field**: Set the depth of the Auto Wah effect. When set to 0, the automatic wah feature is disabled.
  - **Attack knob and field**: Set the time it takes for the wah filter to fully open.
  - **Release knob and field**: Set the time it takes for the wah filter to close.
  - **Range slider and field**: Sweep the wah filter with a MIDI pedal. The two smaller sliders set the maximum and minimum values of the sweep range.
Fuzz-Wah effect Compressor in Logic Pro for Mac

The Compressor effect is normally used just before the Fuzz (distortion) effect. This allows you to increase or decrease the perceived gain, thus providing a suitable input level to the distortion circuit. You can, however, place the Compressor at any position in the effects chain or can disable it completely.

Compressor effect parameters

• On/off button: Turn the Compressor effect on or off.
• Ratio knob and field: Adjust the compression slope. The additional gain offered by the compression circuit—when directly preceding the Fuzz effect—lets you create crunchy distortions.

Fuzz controls in Logic Pro for Mac Fuzz-Wah effect

These parameters control the integrated distortion circuit.

Fuzz parameters

• On/off button: Turn the Fuzz distortion effect on or off.
• Gain knob and field: Set the level of distortion.
• Tone knob and field: Adjust the tonal color of the distortion. Low settings tend to be warmer, and high settings are brighter and harsher.
Spectral Gate

Spectral Gate overview in Logic Pro for Mac

Spectral Gate is an unusual filter effect that you can use as a tool for creative sound design.

It works by dividing the incoming signal into two frequency ranges—above and below a central frequency band that you specify with the Center Freq and Bandwidth parameters. The signal ranges above and below the defined band can be individually processed with the Low Level and High Level parameters and the Super Energy and Sub Energy parameters.

To add Spectral Gate to your project, choose Filter > Spectral Gate in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Spectral Gate parameters

- **Threshold slider and field**: Set the threshold level that is used to divide frequency ranges. When the threshold is exceeded, the frequency band defined by the Center Freq and Bandwidth parameters is divided into upper and lower frequency ranges.
- **Speed slider and field**: Set the modulation frequency for the defined frequency band.
- **CF Modulation slider and field**: Set the intensity of center frequency modulation.
- **BW Modulation slider and field**: Set the amount of bandwidth modulation.
- **Graphic display**: Shows the frequency band defined by the Center Freq and Bandwidth parameters.
- **Center Frequency knob and field**: Set the center frequency of the band you want to process.
- **Bandwidth knob and field**: Set the width of the frequency band you want to process.
- **Super Energy knob and field**: Set the level of the frequency range above the threshold.
- **High Level slider and field**: Mix the frequencies of the original signal—above the selected frequency band—with the processed signal.
- **Sub Energy knob and field**: Set the level of the frequency range below the threshold.
• **Low Level slider and field:** Mix the frequencies of the original signal—below the selected frequency band—with the processed signal.

• **Gain slider and field:** Set the overall output level.

### Use Spectral Gate in Logic Pro for Mac

One way you can familiarize yourself with the operation of Spectral Gate is to start with a drum loop. Set Center Freq to its minimum value (20 Hz) and Bandwidth to its maximum value (20,000 Hz) to process the entire frequency range. Turn up the Super Energy and Sub Energy knobs, one at a time, and then try different Threshold settings to get a sense of how different Threshold levels affect the sound of Super Energy and Sub Energy. When you have obtained a sound that you like or consider useful, narrow the Bandwidth parameter drastically, gradually increase Center Freq, and then use the Low Level and High Level sliders to mix in some treble and bass from the original signal. At lower Speed settings, turn up the CF Modulation or BW Modulation sliders.

### Get started with Spectral Gate

1. In Logic Pro, rotate the Center Frequency and Bandwidth knobs to set the frequency band you want to process.
   
   The graphic display shows the band that you define with these two parameters.

2. Drag the Threshold slider to set the appropriate level.
   
   All incoming signals above and below the threshold level are divided into upper and lower frequency ranges.

3. Rotate the Super Energy knob to control the level of the frequencies above the threshold, and rotate the Sub Energy knob to control the level of the frequencies below the threshold.

4. Drag the Low Level slider and the High Level slider to mix the frequencies that fall outside the defined frequency band with the processed signal.

   - Use the Low Level slider to blend the frequencies below the defined frequency band with the processed signal.
   
   - Use the High Level slider to blend frequencies above the defined frequency band with the processed signal.

5. Drag the Speed, CF Modulation, and BW Modulation sliders to modulate the defined frequency band.

   - Use the Speed slider to determine the modulation frequency.

   - Use the CF Modulation slider to define the intensity of the center frequency modulation.

   - Use the BW Modulation slider to control the amount of bandwidth modulation.

6. Drag the Gain slider to adjust the final output level of the processed signal.
Imaging processors

Imaging processors in Logic Pro for Mac

The imaging processors are tools for manipulating the stereo image. You can use them to make certain sounds, or the overall mix, seem wider and more spacious. You can also alter the phase of individual sounds within a mix to enhance or suppress particular transients.

See Binaural Post-Processing, Direction Mixer, and Stereo Spread.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Binaural Post-Processing in Logic Pro for Mac

Each channel strip allows you to use a special version of the Pan knob, known as Binaural Panner. This is a psychoacoustic processor that can simulate arbitrary sound source positions—including up and down information—when fed a standard stereo signal.

The output signal that results when you use Binaural Panner is best suited for headphone playback. You can, however, use the integrated conditioning of Binaural Panner to ensure a neutral sound that is suitable for speaker playback as well as headphone playback.
Binaural Post-Processing parameters

- **Compensation Mode pop-up menu**: Choose the type of processing applied for different playback systems.

  - **Headphone FF—optimized for front direction**: For headphone playback, utilizing free-field compensation. In this mode, sound sources placed in front of the listening position have neutral sound characteristics.

  - **Headphone HB—optimized for horizontal directions**: For headphone playback, optimized to deliver the most neutral sound for sources placed on, or close to, the horizontal plane.

  - **Headphone DF—averaged over all directions**: For headphone playback, utilizing diffuse-field compensation. In this mode, the sound, on average, is most neutral for arbitrarily placed, or moved, sources.

  - **Speaker CTC—Cross Talk Cancelation**: For speaker playback, allowing you to play back binaurally panned signals through stereo loudspeakers. Good spatial reproduction is restricted to a limited range of listening positions, on the symmetrical plane, between the speakers.

- **CTC-Speaker Angle slider and field**: Set an angle that matches the physical angle of your stereo speakers, relative to the listening position.

  *Note*: This parameter is available only when the Speaker CTC compensation mode is chosen.

Binaurally pan multiple channels

1. In Logic Pro, turn off the integrated conditioning.
2. Route the output of all binaurally panned signals to an aux channel.
3. Choose Imaging > Binaural Post-Processing to insert a Binaural Post-Processing plug-in in the target aux channel strip.
4. Apply diffuse-field compensation to all Binaural Panner outputs at once.

Binaural panning of several grouped channels is simpler to manage than using a Binaural Panner instance on each channel. It also sounds better and reduces computer processing requirements.

Spatial Audio Monitoring in Logic Pro for Mac

You can use the Spatial Audio Monitoring plug-in to check your surround mix in the Apple Renderer binaural formats or on built-in computer speakers that support spatial audio.

*Note*: To use the Spatial Audio Monitoring plug-in, you must have macOS Monterey 12.3 or later installed. The Apple Renderer (Head Tracking) monitoring format requires a Mac with Apple silicon.
To insert the plug-in, click the Audio Effect slot in the surround master channel strip, then choose Imaging > Spatial Audio Monitoring from the plug-in pop-up menu. If you have other plug-ins on the surround master channel, insert the Spatial Audio Monitoring plug-in in the last empty Audio Effect slot.

Choose one of the following formats from the Monitoring Format pop-up menu:

- **Monitoring Format pop-up menu**: Select an option to monitor your surround mix in a binaural format on headphones or on built-in computer speakers that support spatial audio.
  - **Apple Renderer (Standard Spatial Audio Profile)**: This is the headphone virtualization used by Apple Music to render a binaural spatial audio mix for playback on headphones.
  - **Apple Renderer (Personalized Spatial Audio Profile)**: This headphone virtualization uses Personalized Spatial Audio to optimize the immersive sound experience on headphones.

  To use this option, you must first create a Personalized Spatial Audio profile on your iPhone (iOS 16 or later with a TrueDepth camera). After that, when you sign in with your Apple ID on any Mac (macOS 13 Ventura or later), Personalized Spatial Audio is automatically turned on.

  - **Apple Renderer (Head Tracking, Standard Spatial Audio Profile)**: Used by Apple Music to render a binaural spatial audio mix for playback on Apple headphones that support head tracking. This format is only available when head tracking-capable headphones or earbuds are selected as the output device. Head tracking is turned off when bouncing with this format.

  The Bluetooth enabled headphones or earbuds transmit any movement of your head to the renderer, which updates the three-dimensional sound field in real time, so any signal, regardless of the wearer’s head movement, remains in its virtual location when listened to over headphones.

  - **Apple Renderer (Head Tracking, Personalized Spatial Audio Profile)**: This option uses the Apple Renderer algorithm with head tracking enabled and is optimized with Personalized Spatial Audio.

  - **Renderer for Built-in Speakers**: This format is available only if you use Logic Pro on a computer that supports Spatial Audio playback on internal speakers, and the speakers are selected as the output device in Logic Pro settings.
Direction Mixer

Direction Mixer in Logic Pro for Mac

You can use Direction Mixer to decode middle and side audio recordings or to spread the stereo base of a left/right recording and determine its pan position.

Direction Mixer works with any type of stereo recording, regardless of the miking technique used. For information about the most common stereo miking techniques—AB, XY, and MS—see Stereo miking techniques.

To add Direction Mixer to your project, choose Imaging > Direction Mixer in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Direction Mixer parameters

- **Input buttons**: Set the input signal type. Use LR if the input signal is a standard left/right signal. Use MS if the signal is middle and side encoded.

- **Direction knob and field**: Set the pan position for the middle—the center of the stereo base—of the recorded stereo signal. When Direction is set to a value of 0, the midpoint of the stereo base in a stereo recording is perfectly centered within the mix.

  **When you work with LR signals:**
  
  - At 90°, the center of the stereo base is panned hard left.
  
  - At −90°, the center of the stereo base is panned hard right.
  
  - Higher values move the center of the stereo base back toward the center of the stereo mix, but this also has the effect of swapping the stereo sides of the recording. For example, at a value of either 180° or −180°, the center of the stereo base is dead center in the mix, but the left and right sides of the recording are swapped.

  **When you work with MS signals:**
  
  - At 90°, the middle signal is panned hard left.
  
  - At −90°, the middle signal is panned hard right.
  
  - Higher values move the middle signal back toward the center of the stereo mix, but this also has the effect of swapping the side signals of the recording. For example, at a value of either 180° or −180°, the middle signal is dead center in the mix, but the left and right sides of the side signal are swapped.
• Spread slider and field: Determine the spread of the stereo base in LR input signals or set the side signal level in MS input signals. Spread parameter behavior changes when fed LR or MS signals. These differences are outlined below:

When you are working with LR signals:
• At a neutral value of 1, the left side of the signal is positioned precisely to the left and the right side precisely to the right. As you decrease the Spread value, the two sides move toward the center of the stereo image.
• A value of 0 produces a summed mono signal—both sides of the input signal are routed to the two outputs at the same level. At values greater than 1, the stereo base is extended out to an imaginary point beyond the spatial limits of the speakers.

When you are working with MS signals:
• Values of 1 or higher increase the level of the side signal, making it louder than the middle signal.
• At a value of 2, you hear only the side signal.
• Split button: Split the signal into independently controlled high and low ranges.
• Crossover field: Set the frequency where the signal is split between high and low ranges. Drag vertically, or double-click and type a value.

• Direction High/Low knobs and fields: Independently set the central pan position for the recorded stereo signal in the upper or lower frequency range (set with Crossover).
• Spread High/Low sliders and fields: Independently set the stereo spread in LR signals or set the side signal level in MS signals for the upper/lower frequency range (set with Crossover).

Stereo miking techniques in Logic Pro for Mac
There are three common stereo miking variations used in recording: AB, XY, and MS. A stereo recording contains two channel signals.

AB and XY recordings both record left and right channel signals, but the middle signal is the result of combining both channels.

MS recordings record a middle signal, but the left and right channels are decoded from the side signal, which is the sum of both left and right channel signals.
AB miking

In an AB recording, two microphones—commonly omnidirectional, but any polarity can be used—are equally spaced from the center and pointed directly at the sound source. Spacing between microphones is extremely important for the overall stereo width and perceived positioning of instruments within the stereo field.

The AB technique is commonly used for recording one section of an orchestra, such as the string section, or perhaps a small group of vocalists. It is also useful for recording piano or acoustic guitar.

AB is not well suited to recording a full orchestra or group as it tends to smear the stereo imaging/positioning of off-center instruments. It is also unsuitable for mixing down to mono because phase cancelations can occur between channels.

XY miking

In an XY recording, two directional microphones are symmetrically angled from the center of the stereo field. The right-hand microphone is aimed at a point between the left side and the center of the sound source. The left-hand microphone is aimed at a point between the right side and the center of the sound source. This results in a 45° to 60° off-axis recording on each channel (or 90° to 120° between channels).

XY recordings tend to be balanced in both channels, with good positional information being encoded. XY recording is commonly used for drum recording and is also suitable for larger ensembles and many individual instruments.

Typically, XY recordings have a narrower sound field than AB recordings, so they can lack a sense of perceived width when played back. XY recordings can be mixed down to mono.

MS miking

To make a Middle and Side (MS) recording, two microphones are positioned as closely together as possible—usually placed on a stand or hung from the studio ceiling. One is a cardioid (or omnidirectional) microphone that directly faces the sound source you want to record—in a straight alignment. The other is a bidirectional microphone, with its axes pointing to the left and right of the sound source at 90° angles. The cardioid microphone records the middle signal to one side of a stereo recording. The bidirectional microphone records the side signal to the other side of a stereo recording. MS recordings made in this way can be decoded by the Direction Mixer.

When MS recordings are played back, the side signal is used twice:

- As recorded
- Panned hard left and phase reversed, panned hard right

MS is ideal for all situations where you need to retain absolute mono compatibility. The advantage of MS recordings over XY recordings is that the stereo middle is positioned on the main recording direction (on-axis) of the cardioid microphone. This means that slight fluctuations in frequency response that occur off the on-axis—as is the case with every microphone—are less troublesome, because the recording always retains mono compatibility.
Stereo Spread in Logic Pro for Mac

Stereo Spread is generally used when mastering. There are several ways to extend the stereo base (or the perception of space), including using reverbs or other effects and altering the signal phase. These options can sound good, but they can also weaken the overall sound of your mix by ruining transient responses, for example.

Stereo Spread extends the stereo base by distributing a selectable number of frequency bands from the middle frequency range to the left and right channels. This is done alternately—middle frequencies to the left channel, middle frequencies to the right channel, and so on. This greatly increases the perception of stereo width without making the sound totally unnatural, especially when it is used on mono recordings.

To add Stereo Spread to your project, choose Imaging > Stereo Spread in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Stereo Spread parameters

- **Lower Intensity slider and field:** Set the amount of stereo base extension for the lower frequency bands.
- **Upper Intensity slider and field:** Set the amount of stereo base extension for the upper frequency bands.
  
  *Note:* When setting the Lower Int and Upper Int sliders, be aware that the stereo effect is most apparent in the middle and higher frequencies. Distributing low frequencies between the left and right speakers can significantly alter the energy of the overall mix. Use low values for the Lower Int parameter and avoid setting the Lower Freq parameter below 300 Hz.

- **Graphic display:** Shows the number of bands the signal is divided into and the effect intensity in the upper and lower frequency bands. The upper section represents the left channel. The lower section represents the right channel. The frequency scale displays frequencies in ascending order, from left to right.
- **Upper/Lower Frequency slider and fields:** Determine the highest and lowest frequencies that are redistributed in the stereo image.
- **Order knob and field:** Determine the number of frequency bands that the signal is divided into. A value of 8 is usually sufficient for most tasks, but you can use up to 12 bands.
Mastering Assistant overview in Logic Pro for Mac

Mastering Assistant is a plug-in designed to make your final mix sound great across any playback device. By meticulously analyzing audio, it automatically fine-tunes the sound through dynamic adjustments, precisely balanced frequency corrections, and additional sonic enhancements. Mastering Assistant also provides dynamic processing and spectral shaping inspired by boutique analog hardware devices used by professional mastering engineers. Using Mastering Assistant on your final mix will help to ensure that your project meets industry-specified loudness levels that can prepare it for distribution on streaming services like Apple Music.

Recommended workflow

The following steps map out the typical workflow for mastering a project using Mastering Assistant:

- Finish mixing your project, making sure everything sounds balanced and dynamically consistent and has enough headroom so that your project doesn’t clip.
- Add Mastering Assistant to the stereo output channel strip. See Add Mastering Assistant to a project.
• Let Mastering Assistant analyze your project:
  • When you add Mastering Assistant, an analysis is triggered, and its internal parameters are adjusted to produce the best results.
  • Mastering Assistant analyzes the whole project unless you set a cycle, in which case it will analyze only the part of the project within the cycle area.
  • Listen to your project to hear how Mastering Assistant has improved the sound, while noting any manual changes you’d like to make.
  • Open Mastering Assistant and adjust essential parameters such as loudness, frequency distribution, and stereo width, or change the overall sound by selecting a character preset. See Mastering Assistant parameters.
  • When you’re satisfied with the sound of your project, you can bounce your project from the File menu. See the Bounce a project to an audio file topic in the Logic Pro User Guide.

Add Mastering Assistant to a project in Logic Pro for Mac

Add Mastering Assistant from the Mastering Assistant effect slot
• Click the Mastering Assistant effect slot on the stereo output channel strip.

Add Mastering Assistant from the Mix menu
• Choose Mastering Assistant from the Mix menu.

Mastering Assistant parameters in Logic Pro for Mac

Mastering Assistant provides the following controls:
• **Character menu:** Mastering Assistant allows you to choose the character of the processing applied to your project. The character presets change the sonic qualities of Mastering Assistant, inspired by hardware mastering chains used by professional recording engineer:
  
  - **Clean:** An algorithm that offers a transparent yet punchy result. This style is good for EDM, acoustic music, and anything that needs a clean yet punchy sound.
  
  - **Valve:** An algorithm that simulates a processing chain utilizing tubes to deliver a deep low end and refined high end, making it a great option for both acoustic music and the hip-hop genre.
  
  - **Punch:** An algorithm that embodies an aggressive sound with a subtle emphasis on the mid-range frequencies, ideally suited for rock music.
  
  - **Transparent:** An algorithm inspired by a modern and tight-sounding compressor, suitable for most genres of music.

  *Note:* Character presets Transparent, Punch, and Valve are only available on Mac computers with Apple silicon.

• **Auto EQ slider:** Control the amount of the correction EQ estimated by Mastering Assistant. After analyzing your project, Mastering Assistant shows the frequency curve that it applies to improve the sound of your project, with the Auto EQ slider set at 100%. You can adjust the amount of auto EQ by dragging the slider up or down.

• **Reanalyze button:** Trigger a new analysis of your project if it has undergone changes. The button name changes to Reanalyze Section when a cycle range is set or to Analyze after you add content to an empty project.

• **Bypass button:** Switch to the unprocessed audio. This allows you to directly compare the audio with or without processing, providing a clear evaluation of the effects applied. Use in combination with the Loudness Compensation button to avoid any sudden jumps in loudness. Remember to turn off bypass before bouncing your project.

• **Loudness Compensation button:** Match the volume of the processed audio with that of the original, ensuring a balanced and unbiased basis for comparison. By doing so, you can accurately assess any changes or improvements made during the processing stage without being influenced by differences in loudness. Remember to turn off loudness compensation before bouncing your project.

### Dynamics section

• **Loudness knob:** Change the loudness of the processed audio. When you adjust the loudness knob to its center position, the output typically registers at around –14 LUFS-I. This typically is the target loudness for many streaming platforms. However, in the mastering process, adhering strictly to this value isn’t always the best approach. Instead, mastering engineers aim for a loudness level that best complements the specific mix. The optimal loudness can vary considerably based on the genre and the unique characteristics of the project.

• **Excite button:** Introduce saturation to frequencies within the upper-mid range of the signal. This produces more overtones and adds richness and crispness to your mix. The enriched signal produces results similar to vintage transformer-based console designs of the ‘60s, ‘70s, and ‘80s.
• **True Peak meter:** Displays the signal level on a dBTP (dB measured as true peak) scale, and the dBTP max level. Click to clear the numeric scale and max level.

True Peak represents the absolute highest level a signal is reaching, which is very important for observing where it is in relation to the ceiling, or the highest level a digital audio signal can reach before distorting or clipping. The signal level is represented by a green bar that turns yellow above –3 dB and red when it exceeds 0 dB. The numeric display follows the same color code. When the level exceeds 0 dB, the portion of the bar above the 0 dB point turns red. However, Mastering Assistant limits the processed signal to –1 dBFS True Peak, meeting the requirement for streaming platforms.

• **LUFS meter:** The M, S, and I fields and meters indicate the current momentary, short-term, and integrated loudness measurement of your processed mix. The loudness for each measurement (M, S, I) is represented by a green bar. A meter turns yellow when the measured loudness exceeds the target loudness.

• **LU Range field:** Indicates the loudness range during measurement (using the Start/Pause button).

• **Start/Pause button:** Activate the loudness meter, initiating the measurement of the audio signal's loudness. While the meter is running, it actively monitors and displays the loudness of any incoming audio signal. Pause halts the measurement process. The loudness reading ceases to update and typically holds at the last measured value. This is useful if you want to pause the measurement or if you've finished analyzing a particular section of audio.

• **Reset button:** Clear any current readings or measurements on the loudness meter. Ideal for when you want to start a fresh measurement, perhaps for a new piece of audio or after making adjustments to the audio.

**Spread section**

• **Width knob:** Increase or decrease the width of your mix. This knob will be set to a position other than the center if Mastering Assistant’s analysis finds that the stereo width of your project is too narrow or wide. Turn this knob all the way to the left to create a mono mix that you can use to check mono compatibility.

• **Correlation meter:** Displays the phase relationship of a stereo signal. Your project should be above 0; the further it is, the better the mono compatibility.
  - A correlation of +1 (the far right position) means that the left and right channels correlate 100%—they are completely in phase.
  - A correlation of 0 (the center position) indicates the widest permissible left/right divergence, often audible as an extremely wide stereo effect.
  - Correlation values lower than 0 indicate that out-of-phase material is present, which can lead to phase cancellations if the stereo signal is combined into a monaural signal.
Spectrum analyzer and EQ section

The EQ module includes a spectrum analyzer and a composite EQ curve.

• **Spectrum analyzer:** Displays the real-time magnitude (expressed in decibels) of a signal across the frequency spectrum.

• **Composite curve:** The collective filter response curve of the analyzed signal, depicted as a solid line spanning the spectrum. Each individual band contributes to the overall contour of this curve.

• **Custom EQ button:** Turn the custom EQ on or off. When turned on, a dashed line illustrates the custom EQ curve, accompanied by three control points (blue dots) that you can drag to make very broad-stroke EQ adjustments.

• **Low frequency control point:** Adjust the low frequency by dragging the control point left and right. Adjust the low frequency gain by dragging up and down.
  - **Low Freq field:** Enter a low shelving filter frequency from 20 Hz to 200 Hz.
  - **Low Gain field:** Enter a low shelving filter level. The gain range is ±6 dB.

• **Mid frequency control point:** Adjust the mid frequency by dragging the control point left and right. Adjust the mid frequency gain by dragging up and down.
  - **Mid Freq field:** Enter a mid-range filter frequency from 200 Hz to 8,000 kHz.
  - **Mid Gain field:** Enter a mid-range filter level. The gain range is ±6 dB.

• **High frequency control point:** Adjust the high frequency by dragging the control point left and right. Adjust the high frequency gain by dragging up and down.
  - **High Freq field:** Enter a high-range filter frequency from 8,000 kHz to 20,000 kHz.
  - **High Gain field:** Enter a high shelving filter level. The gain range is ±6 dB.
Metering tools

Metering tools in Logic Pro for Mac

You can use the Metering tools to analyze audio in a variety of ways. These plug-ins provide different views of your audio data that extend the information shown in channel strip meters. The Metering plug-ins have no effect on the audio signal and are intended for use as diagnostic aids.

Each meter is specifically designed to view different characteristics of an audio signal, making each suitable for particular studio situations. For example, BPM Counter displays the tempo, Correlation Meter displays the phase relationship, Loudness Meter shows the momentary, short-term, and integrated loudness levels, and Level Meter displays the level of an incoming audio signal. MultiMeter combines these tools and other analysis features in a single utility.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

BPM Counter in Logic Pro for Mac

BPM Counter analyzes the tempo of incoming audio in beats per minute (bpm). The detection circuit looks for any transients, also known as impulses, in the input signal. Transients are very fast, nonperiodic sound events in the attack portion of the signal. The more obvious this impulse is, the easier it is for BPM Counter to detect the tempo.

Percussive drum and instrumental rhythm parts, such as basslines, are suitable for tempo analysis, whereas pad sounds are unsuitable candidates for tempo analysis.

To add BPM Counter to your project, choose Metering > BPM Counter in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
BPM Counter parameters

- **BPM Counter**: Analyzes the tempo of incoming audio in beats per minute (bpm). Click the numerical display to reset.

  The numerical display the current analysis status. If the LED is flashing, a tempo measurement is taking place. When the LED is continuously lit, analysis is complete, and the tempo is displayed. The measurement ranges from 80 to 160 beats per minute. The measured value is displayed with an accuracy of one decimal place.

  *Note*: BPM Counter also detects tempo variations in the signal and tries to analyze them accurately. If the LED starts flashing during playback, this indicates that BPM Counter has detected a tempo that has deviated from the last received (or set) tempo. As soon as a new, constant tempo is recognized, the LED stops flashing and the new tempo displayed.

- **:2 and x2 buttons**: Set the displayed tempo to half or double the analyzed rate.

Correlation Meter in Logic Pro for Mac

**Correlation Meter**: Displays the phase relationship of a stereo signal.

To add Correlation Meter to your project, choose Metering > Correlation Meter in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

- A correlation of +1 (the far right position) means that the left and right channels correlate 100%—they are completely in phase.
- A correlation of 0 (the center position) indicates the widest permissible left/right divergence, often audible as an extremely wide stereo effect.
- Correlation values lower than 0 indicate that out-of-phase material is present, which can lead to phase cancelations if the stereo signal is combined into a monaural signal.

Correlation Meter parameter

- **View pop-up menu**: Choose a Horizontal or Vertical display and set a size.
  
  *Note*: You can also set a size by dragging the lower corners of the plug-in window.

Level Meter in Logic Pro for Mac

**Level Meter**: Displays the current signal level on a decibel scale. The signal level for each channel is represented by a blue bar. Signals (above the target level) approaching the 0 dB level are represented by a yellow bar. When the level exceeds 0 dB, the portion of the bar above the 0 dB point turns red.
Stereo Level Meter instances show independent left and right bars, whereas mono instances display a single bar.

Surround Level Meter instances display a bar for each channel.

To add Level Meter to your project, choose Metering > Level Meter in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Peak level values are displayed numerically and graphically. You can reset these values by clicking in the display.

**Level Meter parameters**

- **Level pop-up menu**: Choose a display setting using Peak, RMS, Peak & RMS, True Peak, or True Peak & RMS characteristics.
  - The True Peak options display interpolated sample values.
  - RMS levels appear as dark blue bars. Peak levels appear as light blue bars. You can also choose to view both Peak and RMS levels simultaneously.
  - **Target level handle**: Drag to set a target level. Signals above this level and below 0 dB are shown in yellow. Surround instances provide discrete handles for center and LFE, with all other channels controlled by a single handle.
  - **View pop-up menu**: Choose a Horizontal or Vertical display and set a size.

  *Note*: You can also set a size by dragging the lower corners of the plug-in window.

**Peak and RMS levels**

The peak value is the highest level that the signal will reach. The RMS (root mean square) value is the effective value of the total signal. In other words, it is a measurement of the continuous power of the signal.

Human hearing is optimized for capturing continuous signals, making our ears RMS instruments, not peak reading instruments. Therefore, using RMS meters makes sense most of the time. Alternatively, you can use both RMS and Peak meters.
Loudness Meter in Logic Pro for Mac

Loudness Meter shows the momentary, short-term, and integrated loudness levels. Loudness indicates the perceived level of a signal that is indicative of human hearing, making it a useful reference tool when mixing or mastering. Loudness Meter conforms to the EBU R 128 specification.

Loudness is measured in Loudness Units, relative to Full Scale (LUFS). Each LU is equivalent to one decibel (dB).

To add Loudness Meter to your project, choose Metering > Loudness Meter in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Loudness Meter parameters

- **M, S, and I fields and meters**: Indicate the current momentary, short-term, and integrated signal levels of incoming audio material. The loudness for each measurement (M, S, I) is represented by a blue bar. A meter turns yellow when the measured loudness exceeds the target loudness line.

- **Target level line**: Drag to set a target level between -30 LUFS and 0 LUFS.

- **LU Range field**: Indicates the loudness range during measurement (using the Start/Pause button).

- **Integrated field**: Indicates the integrated loudness level during measurement (using the Start/Pause button).

- **Start/Pause button**: Turn on to analyze and show the Integrated Loudness and the LU Range for a portion or the full length of the audio material. Pause retains the current LU Range and Integrated values. Click again to resume real-time display.

- **Reset button**: Clear all values.

- **View pop-up menu**: Choose a Horizontal or Vertical display. You can resize Loudness Meter by choosing a value from the View pop-up menu.

  **Note**: You can also set a size by dragging the lower corners of the plug-in window.
MultiMeter

MultiMeter in Logic Pro for Mac

MultiMeter provides a collection of professional gauge and analysis tools in a single window. It includes:

- An **Analyzer** to view the level of each 1/3-octave or major second frequency band.
- A **Goniometer** for judging phase coherency in a stereo sound field.
- **Level and Loudness Meters** to view the signal level and perceived loudness (conforming to the AES 128 specification) for each channel.
- A **Correlation Meter** to spot mono phase compatibility.
- **Peak parameters**.

You can view either the Analyzer or Goniometer results in the main display area. Use the Analyzer or Goniometer buttons to switch between modes and to set parameters. The Loudness/Level and Correlation meters are always visible in the Full display, as are several common parameters.

You can set a size by dragging the lower corners of the plug-in window. The View pop-up menu provides further Display, Meters, or Full items that show a partial view or the complete plug-in interface. Control-click in the main display when a partial view is enabled to switch between modes.

To add MultiMeter to your project, choose Metering > MultiMeter in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Although you can insert MultiMeter directly into any channel strip, it is more commonly used in the master channel strip of Logic Pro—when you are working on the overall mix.

There is also a surround version of MultiMeter, with parameters for each channel and a slightly different layout. See Surround MultiMeter overview.
MultiMeter Analyzer parameters in Logic Pro for Mac

In Analyzer mode, the main display shows the frequency spectrum of the input signal as 31 or 63 independent frequency bands. Each frequency band represents one-third of an octave or a major second. The Analyzer parameters are used to activate Analyzer mode and to customize the appearance of the incoming signal in the main display.

MultiMeter Analyzer parameters

- **Analyzer button**: Switch the main display to Analyzer mode.
- **Top/Range fields**: Change Analyzer display values by setting the maximum level (Top) and the overall dynamic range (Range).
- **Scale**: Indicates the scale of levels. Drag the scale vertically to adjust the Range value. Changing the scale is useful when analyzing highly compressed material because it makes it easier to identify small level differences.
- **Detection buttons**: Determine the channels shown in the Analyzer results in the main display.
  - **Left or Right**: Displays the left or right channels.
  - **LRmax**: Displays the maximum level of the stereo inputs.
  - **Mono**: Displays the spectrum of the mono sum of both (stereo) inputs.
- **Mode buttons**: Determine how levels are displayed. You can choose Peak, Slow RMS, or Fast RMS characteristics.
  - The two RMS modes show the effective signal average and provide a representative overview of perceived volume levels.
  - The Peak mode shows level peaks accurately.
- **Analyzer Bands pop-up menu**: Choose the number of bands shown in the Analyzer display. Choices are: 31 Bands (Third-Octave) or 63 Bands (Major Second).
MultiMeter Goniometer parameters in Logic Pro for Mac

A goniometer helps you to judge the coherence of the stereo image and determine phase differences between the left and right channels. Phase problems are easily spotted as trace cancelations along the center line (M—mid/mono).

The idea of the goniometer was born with the advent of early two-channel oscilloscopes. To use such devices as goniometers, users would connect the left and the right stereo channels to the X and Y inputs, while rotating the display by 45° to produce a useful visualization of the signal stereo phase.

The signal trace slowly fades to black, imitating the retro glow of the tubes found in older goniometers, while also enhancing the readability of the display.

<table>
<thead>
<tr>
<th>MULTI METER GONIOMETER</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Goniometer button:</strong></td>
<td>Switch the main display to Goniometer mode.</td>
</tr>
<tr>
<td><strong>Auto Gain knob and field:</strong></td>
<td>Set the amount of display compensation for low input levels. You can set Auto Gain levels in 10% increments or set it to off.</td>
</tr>
<tr>
<td><strong>Note:</strong> To avoid confusion with the Auto Gain parameter found in other included effects and processors (such as the compressors), Auto Gain is only used as a display parameter in the meters. It increases display levels to enhance readability. It does not change the actual audio levels.</td>
<td></td>
</tr>
<tr>
<td><strong>Decay knob and field:</strong></td>
<td>Determine the time it takes for the Goniometer trace to fade to black.</td>
</tr>
</tbody>
</table>

MultiMeter Goniometer parameters

- **Goniometer button:** Switch the main display to Goniometer mode.
- **Auto Gain knob and field:** Set the amount of display compensation for low input levels. You can set Auto Gain levels in 10% increments or set it to off.
  - **Note:** To avoid confusion with the Auto Gain parameter found in other included effects and processors (such as the compressors), Auto Gain is only used as a display parameter in the meters. It increases display levels to enhance readability. It does not change the actual audio levels.
- **Decay knob and field:** Determine the time it takes for the Goniometer trace to fade to black.

MultiMeter Level and Loudness in Logic Pro for Mac

Level Meter displays the current signal level on a logarithmic decibel scale. The signal level for each channel is represented by a blue bar. Signals (above the target level) approaching the 0 dB level are represented by a yellow bar. When the level exceeds 0 dB, the portion of the bar above the 0 dB point turns red.
RMS and peak levels are shown simultaneously, with RMS levels appearing as dark blue bars and Peak levels appearing as light blue bars. When the level exceeds 0 dB, the portion of the bar above the 0 dB mark turns red.

- **Peak and RMS fields**: Peak and RMS values are displayed numerically (in dB increments) above the Level Meter. Click the display to reset values.

Loudness Meter shows the momentary loudness level. Loudness indicates the perceived level of a signal that is indicative of human hearing, making it a useful reference tool when mixing or mastering. Loudness Meter conforms to the AES 128 specification.

Loudness is measured in Loudness Units, relative to Full Scale (LUFS). Each LU is equivalent to one decibel. MultiMeter provides two indicators above the Loudness Meter.

- **LU-I field**: Loudness Unit-Integrated, which indicates the perceived level from start to end of the program material.
- **LU-S field**: Loudness Unit-Short term, which indicates the perceived level of the most recent 3 seconds of program material.

- **Level pop-up menu**: Choose how levels are displayed from Peak, RMS, Peak & RMS, True Peak, or True Peak & RMS characteristics.
  - The two RMS modes show the effective signal average and provide a representative overview of perceived volume levels.
  - The True Peak options display interpolated sample values.
  - The Peak mode shows level peaks accurately.
- **Return Rate pop-up menu**: Choose how quickly analyzed signals return from peak/maximum levels to zero or incoming signal levels. This is expressed in dB per second.
- **Peak pop-up menu**: Choose the hold time for the Level Meter. Choose 2, 4, or 6 seconds—or infinite.

  **Note**: The Hold button must be turned on for the selected time value to have an effect.
- **Hold button**: Turn on to show a small indicator for the most recent peak level. This is displayed as follows:
  - **Level Meter**: A small yellow segment above each stereo level bar indicates the most recent peak level.
  - **Correlation Meter**: The horizontal area around the correlation indicator denotes phase correlation deviations in real time, in both directions. A vertical line to the left of the correlation indicator shows the maximum negative phase deviation value. You can reset this line by clicking it during playback.
- **Reset button**: Reset all values in the Level Meter.
MultiMeter Correlation Meter in Logic Pro for Mac

Correlation Meter gauges the phase relationship of a stereo signal.

Correlation Meter scale values indicate the following:

- A +1 correlation value indicates that the left and right channels correlate 100%. In other words, the left and right signals are in phase and are the same shape.
- Correlation values to the right of the center position indicate that the stereo signal is mono compatible.
- The middle position indicates the highest allowable amount of left/right divergence, which is often audible as an extremely wide stereo effect.
- When the Correlation Meter moves to the left of the center position, out-of-phase material is present. This leads to phase cancelations if the stereo signal is combined into a mono signal.

MultiMeter Peak parameters in Logic Pro for Mac

MultiMeter offers common Peak parameters for the Analyzer and Goniometer metering tools. The Level and Correlation meters have discrete Peak parameters. See MultiMeter Level and Loudness.

MultiMeter Peak parameters

- **Peak pop-up menu**: Choose the hold time for all metering tools. Choose 2, 4, or 6 seconds—or infinite.
  
  *Note*: The (Peak) Hold button must be turned on for the selected time value to have an effect.

- **Hold button**: Turn on peak hold for all metering modes in MultiMeter. This is displayed in the following ways:
  
  - **Analyzer**: A small segment above each 1/3-octave level bar indicates the most recent peak level.
  - **Goniometer**: All illuminated pixels are held during a peak hold.
• **Reset button**: Reset the peak hold segments of all metering tools.

• **Return Rate pop-up menu**: Shown only in mono instances. Choose how quickly analyzed signals return from peak/maximum levels to zero or incoming signal levels. This is expressed in dB per second.

  Note: This parameter is shown below the MultiMeter Level and Loudness when a stereo instance is active.

### Surround MultiMeter

### Surround MultiMeter in Logic Pro for Mac

The surround version of MultiMeter is specifically designed for analysis and metering of multichannel surround files. You can view either the Analyzer, Goniometer, or Correlation/Balance Meter results in the main display area. Use the Analyzer, Goniometer, or Balance buttons to switch between modes and to set parameters. The Loudness and Level Meters are always visible in the Full display, as are several common parameters.

Although you can insert Surround MultiMeter directly into any channel strip, it is more commonly used in the master channel strip when you are working on the overall surround mix.

You can set a size by dragging the lower corners of the plug-in window. The View pop-up menu provides further Display, Meters, or Full items that show a partial view or the complete plug-in interface. Control-click in the main display when a partial view is enabled to switch between modes.

To add Surround MultiMeter to your project, choose Metering > Surround MultiMeter in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Surround MultiMeter Analyzer in Logic Pro for Mac

In Analyzer mode, the main display shows the frequency spectrum of the input signal as 31 or 63 independent frequency bands. Each frequency band represents one-third of an octave or a major second. The Analyzer parameters are used to activate Analyzer mode and to customize the appearance of the incoming signal in the main display.

Analyzer parameters

- **Analyzer button**: Switch the main display to Analyzer mode.
- **Top field**: Indicates the maximum level. Drag vertically to adjust.
- **Range field**: Indicates the overall dynamic range. Drag vertically to adjust.
- **Scale**: Indicates the scale of levels. Drag the scale vertically to adjust the Range value. Changing the scale is useful when analyzing highly compressed material because it makes it easier to identify small level differences.
- **Sum and Max buttons**: Show the summed or maximum resulting level in the Analyzer display. Sum and Max are relevant only when multiple Channel buttons are selected.
- **Channel buttons**: Select one or multiple channels for metering. The number and appearance of these buttons vary when different surround output configurations are chosen.
- **Mode buttons**: Determine how levels are displayed. You can choose Peak, Slow RMS, or Fast RMS characteristics.
  - The two RMS modes show the effective signal average and provide a representative overview of perceived volume levels.
  - The Peak mode shows level peaks accurately.
- **Analyzer Bands pop-up menu**: Choose the number of bands shown in the Analyzer display. Choices are: 31 Bands (Third-Octave) or 63 Bands (Major Second).
- **Return Rate pop-up menu**: Choose how quickly analyzed signals return from peak/maximum levels to zero or incoming signal levels. This is expressed in dB per second.
Surround MultiMeter Goniometer in Logic Pro for Mac

A goniometer helps you to judge the coherence of the stereo image and to determine phase differences between the left and right channels. Phase problems are easily spotted as trace cancelations along the center line (M—mid/mono).

The idea of the goniometer was born with the advent of early two-channel oscilloscopes. To use such devices as goniometers, users would connect the left and the right stereo channels to the X and Y inputs, while rotating the display by 45° to produce a useful visualization of the signal stereo phase. The signal trace slowly fades to black, imitating the retro glow of the tubes found in older goniometers, while also enhancing the readability of the display.

Because the Surround MultiMeter Goniometer is dealing with multichannel signals, the display is divided into multiple segments, as shown in the image. Each segment indicates a speaker position. When the surround panner is moved in a channel strip, the indicator changes accordingly. This indicates not only left and right channel coherence, but also the front-to-rear coherence.

Goniometer parameters

- **Goniometer button**: Switch the main display to Goniometer mode.
- **L–R, Ls–Rs buttons**: Determine the channel pairs shown in the main display.
- **Auto Gain knob and field**: Set the amount of display compensation for low input levels. You can set Auto Gain levels in 10% increments, or you can turn it off.
  
  **Note**: To avoid confusion with the Auto Gain parameter found in other included effects and processors (such as the compressors), Auto Gain is only used as a display parameter in the meters. It increases display levels to enhance readability. It does not change audio levels.
- **Decay knob and field**: Set the time it takes for the Goniometer trace to fade to black.
Surround MultiMeter Balance in Logic Pro for Mac

The Balance/Correlation Meter gauges the balance or sound placement between all incoming signals. Strongly correlated signals are shown as sharp markers and less strongly correlated signals are shown as a blurred area.

_Balance button:_ View the Correlation Meter in the main display.

Depending on the chosen surround format, a number of points that indicate speaker positions are shown (L, R, C, Ls, and Rs in a 5.1 configuration are displayed in the figure). Lines connect these points. The center position of each connecting line is indicated by a blue marker.

A gray ball indicates the surround field/sound placement. As you move the surround panner of the channel strip, the ball in the Correlation Meter mirrors your movements. The blue markers also move in real time, with shaded gray lines indicating the divergence from the centered positions on each of the connecting lines.

- **LFE Correlation Meter:** The horizontal area around the white correlation indicator denotes phase correlation deviations in real time. This is shown in both directions. LFE Correlation Meter scale values indicate the following:
  - A +1 correlation value indicates that the signal is balanced.
  - Correlation values in the yellow/green zone (between +1 and the middle position) indicate that the signal is mono compatible.
  - The middle position indicates the highest allowable amount of channel divergence.
  - When the meter moves into the red area to the left of the center position, out-of-balance material is present.

- **LFE Correlation buttons:** Choose the channels shown by the correlation meter.
Surround MultiMeter Peak parameters in Logic Pro for Mac

Surround MultiMeter offers common Peak parameters for the Analyzer, Goniometer, and Correlation/Balance metering tools. The Level Meter has discrete Peak parameters. See Surround MultiMeter Loudness and Level Meters.

Peak parameters

- **Hold Time pop-up menu**: Choose the hold time for all metering tools. Choose 2, 4, or 6 seconds—or infinite.
  
  **Note**: The (peak) Hold button must be turned on for the selected time value to have an effect.

- **Hold button**: Turn on to use for all metering tools in Surround MultiMeter. This is displayed as follows:
  
  - **Analyzer**: A small yellow segment above each level bar indicates the most recent peak level.
  
  - **Goniometer**: All illuminated pixels are held during a peak hold.
  
  - **Balance/Correlation Meter**: The horizontal area around the white correlation indicator denotes phase correlation deviations in real time, in both directions.
  
- **Reset button**: Reset the peak hold segments of all metering tools.

Surround MultiMeter Loudness and Level in Logic Pro for Mac

The Loudness Meter to the left of the Level Meter shows the momentary loudness level. Loudness indicates the perceived level of a signal which is indicative of human hearing, making it a useful reference tool when mixing or mastering. The Loudness Meter conforms to the AES 128 specification.

Loudness is measured in Loudness Units, relative to Full Scale (LUFS). Each LU is equivalent to one decibel. Surround MultiMeter provides two indicators above the Loudness Meter. You can freely drag the target level indicator.

- **LU-I field**: Loudness Unit-Integrated, which indicates the perceived level from start to end of the program material.

- **LU-S field**: Loudness Unit-Short term, which indicates the perceived level of the most recent 3 seconds of program material.

The Level Meter displays the current signal level on a logarithmic decibel scale. The signal level for each channel is represented by a blue bar. Signals (above the draggable target level) approaching the 0 dB level are represented by a yellow bar. When the level exceeds 0 dB, the portion of the bar above the 0 dB point turns red.
Peak values are displayed numerically (in dB increments) above the Level Meter. Click in the display to reset peak values.

**Level Meter parameters**

- *Level pop-up menu*: Choose how levels are displayed from Peak, RMS, Peak & RMS, True Peak, or True Peak & RMS characteristics.
  - The two RMS modes show the effective signal average and provide a representative overview of perceived volume levels.
  - The True Peak options display interpolated sample values.
  - The Peak mode shows level peaks accurately.
- *Return Rate pop-up menu*: Choose how quickly analyzed signals return from peak/maximum levels to zero or incoming signal levels. This is expressed in dB per second.
- *Peak pop-up menu*: Choose the hold time for the Level Meter. Choose 2, 4, or 6 seconds—or infinite.
  
  *Note*: The Hold button must be turned on for the selected time value to have an effect.
- *Hold button*: Turn on to show a small yellow segment above each level bar which indicates the most recent peak level.
- *Reset button*: Reset all values in the Level Meter.
Use Tuner utility and plug-in in Logic Pro for Mac

You can tune instruments connected to your system with the Tuner utility or plug-in. This ensures that external instrument recordings are in tune with any software instruments, samples, or existing recordings in your projects.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

![Tuner graphic](image)

**Tuner parameters**

- *Graphic Tuning display*: Indicates the pitch of the note in cents. At the centered (12 o'clock) position, the note is correctly tuned. If the indicator moves to the left of center, the note is flat. If the indicator moves to the right of center, the note is sharp. Color is also used to indicate tuning accuracy, with green denoting a tuned signal, and orange indicating a detuned signal.

- *Reference Tuning field*: Drag vertically to set the pitch of the note used as the basis for tuning. The default is for note A at 440 Hz and can be set in a range from 410 to 470 in 0.1 Hz steps.

- *Keynote display*: Shows the target pitch of the note being played (the closest tuned pitch).

- *Tune Deviation display*: Shows the tuning deviation in cents.

- *Mute button*: Silence the active channel.

- *View pop-up menu*: Choose a Horizontal or Vertical display and set a size.

  *Note*: You can also set a size by dragging the lower corners of the plug-in window.
Use the Tuner utility
1. In Logic Pro, click the Tuner icon on the control bar.
   The Tuner utility window opens.
2. Play a single note on the instrument and watch the Graphic Tuning and Keynote displays. If the note is flat or sharp of the keynote, orange segments are shown in the Graphic Tuning display, the Keynote is shown in orange, and the Tune Deviation display indicates how far (in cents) the note is off pitch.
3. Adjust the tuning of your instrument until the indicator is centered in the Graphic Tuning display and the Tune Deviation field shows zero (0 cents).
   The Graphic Tuning display and Keynote are shown in green when correctly tuned.

Use the Tuner plug-in
1. In Logic Pro, insert the Tuner plug-in into an audio channel strip.
   The Tuner plug-in window opens.
2. Play a single note on the instrument and watch the Graphic Tuning and Keynote displays. If the note is flat or sharp of the keynote, orange segments are shown in the Graphic Tuning display, the Keynote is shown in orange, and the Tune Deviation display indicates how far (in cents) the note is off pitch.
3. Adjust the tuning of your instrument until the indicator is centered in the Graphic Tuning display and the Tune Deviation field shows zero (0 cents).
   The Graphic Tuning display and Keynote are shown in green when correctly tuned.
MIDI plug-ins

Use MIDI plug-ins in Logic Pro for Mac

MIDI plug-ins are inserted in software instrument channel strips and process or generate MIDI data—played from a MIDI region or a MIDI keyboard—in real time. Included are the Arpeggiator, Chord Trigger, and Modulator, along with plug-ins for transposition, randomization and other processing. Scripter enables you to create your own MIDI processing and generation scripts.

MIDI plug-ins are inserted in software instrument channel strips.

MIDI plug-ins have a MIDI input, the MIDI processor, and a MIDI output. The output signals sent from MIDI plug-ins are standard MIDI events such as MIDI note or controller messages. To learn how to record the output of MIDI plug-ins, see Record MIDI plug-in output

If you're new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Insert one or more MIDI plug-ins

1. In Logic Pro, click the space between the EQ graphic and the Instrument slot of a software instrument channel strip.

2. Choose the name of the MIDI plug-in you want to use from the MIDI plug-ins pop-up menu.

   The selected MIDI plug-in window opens, and a green label with the MIDI plug-in name is shown in the channel strip.

3. To insert additional MIDI plug-ins, move the pointer over the top or bottom edge of the inserted MIDI plug-in label in the channel strip, then click when you see a green line.

   Note: The plug-in window does not open automatically for MIDI plug-ins inserted in this way. Click the label to open the plug-in window.

Change the order of MIDI plug-ins

- In Logic Pro, drag the label of the MIDI plug-in that you want to move over the label of the target MIDI plug-in.
  - If the target MIDI plug-in is in the top slot: It is moved down the list.
  - If the target MIDI plug-in is in the bottom slot: It is moved up the list.
  - If the target MIDI plug-in is in a middle slot: The positions of the two plug-ins are swapped.
Remove a MIDI plug-in

- In Logic Pro, click the arrows near the right edge of the MIDI plug-in label that you want to remove, then choose No Plug-in from the pop-up menu.

Bypass a MIDI plug-in

1. In Logic Pro, click the Bypass button near the left edge of the MIDI plug-in label. The plug-in label is dimmed. All parameter settings of the plug-in are retained when bypassed.

2. Click the Bypass button to restore the MIDI plug-in.

Arpeggiator MIDI plug-in

Arpeggiator MIDI plug-in overview in Logic Pro for Mac

The Arpeggiator MIDI plug-in generates musically interesting arpeggios based on incoming MIDI notes. It provides split and remote features that let you control nearly all Arpeggiator functions without taking your hands off the keyboard, making it a powerful live performance tool.

An arpeggio is a succession of notes in a chord. Rather than all notes being played at one time, they are played one after the other in a pattern: up, down, random, and so on. The Arpeggiator plug-in provides a number of preset patterns, inclusive of switchable variations and inversions. Inversions change the root note of the chord from the lowest note, resulting in a different start note in arpeggiated patterns. These features let you quickly switch between patterns and feels when performing live, or when creating new projects in the studio.
The Arpeggiator MIDI plug-in is divided into three areas.

- **Control parameters**: This area contains the Play and Latch controls. See Arpeggiator MIDI plug-in control parameters.

- **Note order parameters**: The note order parameters determine the arpeggio type and include four variations or inversions, the arpeggio octave range, and the arpeggio speed. See Arpeggiator MIDI plug-in note order parameters.

- **Advanced parameters**: The advanced Arpeggiator controls are divided into four groups. Click the Pattern, Options, Keyboard, or Controller button to open each parameter group. See pattern parameters, options parameters, keyboard parameters, and Assign Arpeggiator controllers.

### Arpeggiator control parameters in Logic Pro for Mac

The control parameters start and stop the Arpeggiator and determine the latching behavior. You can also capture a live arpeggio as a MIDI region.

#### Control parameters

- **Play button**: Start or stop arpeggiated playback of note input from a MIDI keyboard or a MIDI region. The Play button is highlighted when in play mode. When the Arpeggiator plug-in is stopped, incoming MIDI notes are passed through, and the settings of the split and remote keyboard parameters are retained. See Arpeggiator MIDI plug-in keyboard parameters.

  - **When the host application is in play mode**: The arpeggio starts playing whenever the Arpeggiator Play button is on, including when the plug-in is first inserted. Arpeggio playback is linked to the Logic song position.

  - **When the host application is stopped**: Arpeggio playback stops. Incoming MIDI notes are passed through, and keyboard split and remote settings are retained.

*Note*: You can click the Arpeggiator Play button while Logic Pro is stopped to begin arpeggio playback from the first step in the arpeggio.

- **Capture live performance buttons**: Click, then drag the top button to copy source notes to any instrument track. Drag the lower button to copy the playing arpeggio. The played notes or currently playing arpeggio pattern is placed as a MIDI region at the target position.

- **Latch button**: Turn Latch mode on or off. This allows an arpeggio to run without you holding down keys. Latch mode behavior is determined with the Latch mode pop-up menu.
- **Latch mode pop-up menu**: Choose a Latch mode.
  - **Reset**: The first key played clears the currently latched notes.
  - **Transpose**: Play a single key to transpose the arpeggio relative to the note value of the pressed key and the lowest arpeggiated note.
    
    **Note**: Pressing more than one key simultaneously clears currently latched notes and starts a new arpeggio.
  - **Gated Transpose**: This option is the same as Transpose Latch mode with the difference that the arpeggio only plays while a key is pressed. As soon as the key is released, the arpeggio is muted.
  - **Add**: Play keys—one by one, or simultaneously as a chord—to add them to the latched arpeggio. You can play the same key multiple times and the note repeats the number of times it is struck.
  - **Add Temporarily**: This option is the same as Add Latch mode except that played notes are added to the latched arpeggio only while held. When a temporarily added key is released, it is removed from the arpeggio.
  - **Through**: All incoming MIDI notes are passed through the Arpeggiator plug-in, enabling you to play along with a latched arpeggio.
  - **Delete Last button**: Delete the last note, rest, or tie that was added to the arpeggio.
    
    **Note**: Each event is allocated a unique position identification number and the “last” event has the highest position identification number.
  - **Clear button**: Remove all notes from the Arpeggiator plug-in latch memory. The arpeggio stops playing and all position identification numbers are reset to zero, enabling you to create a new arpeggio without turning off Latch mode, which can be useful in a live situation when preparing for a chord change.
  - **Silent Capture checkbox (extended parameter)**: Click the disclosure arrow at the lower left to display the extended parameters. Select to capture an arpeggio step by step without being disturbed by the immediate response of the running arpeggiator.
    - When enabled, the arpeggiator is stopped and Latch/Add mode is engaged.
    - When disabled, Play is re-engaged (if previously active) and Latch mode switches to Transpose.

### Arpeggiator note order parameters in Logic Pro for Mac

The note order parameters provide control of a pre-programmed order of notes that are played at a preset playback rate. Once all notes are played, the arpeggio cycles from the start. When you play a single key, it is repeated. When you play multiple keys, the held notes are played one after the other. As you play additional notes, these are seamlessly added to the arpeggio. When you release notes, they are removed from the arpeggio. The arpeggio stops when you release all played keys (unless Latch mode is turned on in the control parameters).
The Arpeggiator plug-in automatically assigns position identification numbers to each note in the order they are played. These position identification numbers associate an event, such as a note, rest, or a tie, with a particular step. This lets you switch between note order presets while retaining a rest on the third step, for example.

![Arpeggiator Interface](image)

**Note order parameters**

All note order parameters can be changed while an arpeggio is playing. Changes are immediate and are seamlessly applied to the running arpeggio.

- **Rate knob and field:** Set the arpeggiator rate. Choose from: 1/4, 1/8, 1/16 (including triplet and dotted notes), and 1/32. You can also click the field to choose a value from a pop-up menu. The LED indicates the rate and briefly changes color at the start of each new cycle.

- **Direction buttons:** Set the arpeggio direction.
  - **Up:** The arpeggio is played from the lowest note to the highest note.
  - **Down:** The arpeggio is played from the highest note to the lowest note.
  - **Up/Down:** The arpeggio plays up and down, from the lowest note; the highest and lowest notes repeat.
  - **Outside-in:** The arpeggio plays the highest then the lowest notes, then the second highest and second lowest, the third highest and third lowest, and so on.
  - **Random:** Arpeggiated notes play in a random order.
  - **As Played:** All notes play in the order they were triggered.

- **Lock button:** Works in conjunction with the As Played button. When you first click the As Played button, an open lock symbol is shown. Click once you have triggered an arpeggio to lock the current note order. A closed lock symbol is shown. This note order and feel is retained for any newly triggered arpeggios, but with new notes replacing the original notes. Click the lock symbol again to clear the locked note order and to revert to the standard “as played” behavior. The lock state and note order can be saved with a setting.

- **Variation switch:** Determine the type of note order variation. See note order variations for details.

- **Oct Range/Inversions button:** Switch between two modes: Octave Range or Inversions. The four-position Oct Range/Inversion switch below the buttons is used to determine the octave range or the chord inversion pattern.
• **Oct Range/Inversion switch**: Determine the octave range or the chord inversion pattern. See [note order inversions](#) for details on the four switch position behaviors in Inversions mode.

In Octave Range mode:

• **Position 1**: The arpeggio repeats without transposition.

• **Position 2**: The lowest note is transposed by one octave. Once repeated, the arpeggio restarts in the original octave.

• **Position 3**: The first repetition is transposed by one octave, and the second repetition is transposed by two octaves. Once the second repetition is played, the arpeggio restarts in the original octave.

• **Position 4**: The first repetition is transposed by one octave, the second by two octaves, and the third by three octaves. Once the third repetition is played, the arpeggio restarts in the original octave.

In Inversions mode:

• **Position 1**: The arpeggio repeats without inverting the held notes.

• **Position 2**: The arpeggio is inverted once during the first repetition. Once repeated, the arpeggio restarts.

• **Position 3**: The arpeggio is inverted twice, once each during the first and the second repetition. Once the second repetition is played, the arpeggio restarts.

• **Position 4**: The arpeggio is inverted three times, once each during the first, second, and third repetitions. Once the third repetition is played, the arpeggio restarts.

---

**Arpeggiator note order variations in Logic Pro for Mac**

The table outlines the Arpeggiator behavior in each note order preset when the Variation switch is set to the four available positions.

<table>
<thead>
<tr>
<th>Note order</th>
<th>Variation 1</th>
<th>Variation 2</th>
<th>Variation 3</th>
<th>Variation 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td>Plays the second step first. This variation consists of four steps; all pressed keys are divided into groups of four with the note order applied to all groups. If there are fewer than four notes, the steps without an assigned key are skipped. Once all keys are played, the arpeggio restarts with the lowest note.</td>
<td>Plays the second step first. This variation consists of four steps; all pressed keys are divided into groups of four with the note order applied to all groups. If there are fewer than four notes, the steps without an assigned key are skipped. Once all keys are played, the arpeggio restarts with the lowest note.</td>
<td>Plays the third step first. This variation consists of four steps; all pressed keys are divided into groups of four with the note order applied to all groups. If there are fewer than four notes, the steps without an assigned key are skipped. Once all keys are played, the arpeggio restarts with the lowest note.</td>
<td>This variation, which consists of three steps, plays up and overlaps; all pressed keys are divided into groups of three with the note order applied to all groups. If there are fewer than three notes, the steps without an assigned key are skipped. Once all keys are played, the arpeggio restarts with the lowest note.</td>
</tr>
<tr>
<td>Note order</td>
<td>Variation 1</td>
<td>Variation 2</td>
<td>Variation 3</td>
<td>Variation 4</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>-------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Down</td>
<td>Plays the second step first. This variation consists of four steps; all pressed keys are divided into groups of four with the note order applied to all groups. If there are fewer than four notes, the steps without an assigned key are skipped. Once all keys are played, the arpeggio restarts with the highest note.</td>
<td>Plays the second step first. This variation consists of four steps; all pressed keys are divided into groups of four with the note order applied to all groups. If there are fewer than four notes, the steps without an assigned key are skipped. Once all keys are played, the arpeggio restarts with the highest note.</td>
<td>This variation, which consists of three steps, plays down and overlaps; all pressed keys are divided into groups of three with the note order applied to all groups. If there are fewer than three notes, the steps without an assigned key are skipped. Once all keys are played, the arpeggio restarts with the highest note.</td>
<td></td>
</tr>
<tr>
<td>Up and down</td>
<td>Plays from the lowest to highest note in consecutive order, then plays from the highest to the lowest note, and restarts when all keys are played.</td>
<td>Plays from the lowest to highest note in consecutive order, then plays from the second highest to the second lowest note, and restarts when all keys are played.</td>
<td>This two-step variation works with pairs of notes. The second note of the pair plays first. In a four-note chord, the order is 2, 1, 4, 3. Once the pattern is played, the note order is reversed, then the arpeggio restarts.</td>
<td></td>
</tr>
<tr>
<td>Outside-in</td>
<td>Plays the highest note, then the lowest note, then the second highest and the second lowest note, and so on. The arpeggio restarts when all keys are played.</td>
<td>Plays the highest note, then the lowest note, then plays the second lowest and the second highest note, and so on. The arpeggio restarts when all keys are played.</td>
<td>This is an inside-out variation. The number of played keys is divided by two (rounded up to the nearest whole number). The highest center note is played, then the low-center note, and so on. In a six-note chord, the order is 4, 3, 5, 2, 6, 1. The arpeggio restarts when all keys are played.</td>
<td></td>
</tr>
<tr>
<td>Random</td>
<td>Played note order is randomly generated and can include duplicate notes.</td>
<td>Played note order is randomly generated but no note is played twice. The arpeggio restarts when all keys are played.</td>
<td>This variation favors low notes. Played note order is randomly generated and can include duplicate notes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This variation favors high notes. Played note order is randomly generated and can include duplicate notes.</td>
<td>This variation favors low notes. Played note order is randomly generated and can include duplicate notes.</td>
<td>This variation favors high notes. Played note order is randomly generated and can include duplicate notes.</td>
<td></td>
</tr>
<tr>
<td>Note order</td>
<td>Variation 1</td>
<td>Variation 2</td>
<td>Variation 3</td>
<td>Variation 4</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>As Played</td>
<td>Plays all notes in the order they were played, then restarts.</td>
<td>Plays all notes in the reverse order they were played, then restarts.</td>
<td>Plays all notes in the order they were played, then plays notes in reverse order, doubling the first and last played notes. The arpeggio restarts once all notes are played.</td>
<td>Plays all notes in the order they were played, then plays notes in reverse order, but does not repeat the first and last played notes. The arpeggio restarts once all notes are played.</td>
</tr>
<tr>
<td><strong>Arpeggiator note order inversions in Logic Pro for Mac</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The table outlines the Arpeggiator behavior in each note order preset when the Oct Range/ Inversion switch is set to the four positions in Inversions mode (set with the Oct Range/ Inversions button). Inversions change the root note of the chord, resulting in a different start note to arpeggiated patterns.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note order</td>
<td>Inversion 1</td>
<td>Inversion 2</td>
<td>Inversion 3</td>
<td>Inversion 4</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Up</td>
<td>Plays the original chord, then three inversions in consecutive order and restarts. Playback order: original, 1, 2, 3.</td>
<td>Plays the second inversion first. Playback order: 1, original, 2, 3.</td>
<td>Plays the third inversion first. Playback order: 2, original, 1, 3.</td>
<td>This variation, which consists of three steps, plays up and overlaps. Playback order: original, 2, 1, 3.</td>
</tr>
<tr>
<td>Down</td>
<td>Plays the original chord, then three inversions in consecutive order and restarts. Playback order: 3, 2, 1, original.</td>
<td>Plays the second step first. Playback order: 2, 3, 1, original.</td>
<td>Plays the third step first. Playback order: 1, 3, 2, original.</td>
<td>This variation, which consists of three steps, plays down and overlaps. Playback order: 3, 1, 2, original.</td>
</tr>
<tr>
<td>Up and down</td>
<td>Plays the original chord, then three inversions in consecutive order, then reverses the order, repeating the first and last. Playback order: original, 1, 2, 3, 2, 1, original.</td>
<td>Plays the second step first. Playback order: 1, original, 3, 2, 2, 3, original, 1.</td>
<td>Once the pattern is played, the order is reversed, then the arpeggio restarts. Playback order: original, 2, 1, 3, 1, 2, original.</td>
<td>Once the pattern is played, the order is reversed, but the third inversion is not repeated. Playback order: original, 1, 2, 3, 2, 1.</td>
</tr>
<tr>
<td>Outside-in</td>
<td>Plays the highest inversion, then the original, then plays the second highest and the second lowest inversion, and so on. Playback order: 3, original, 2, 1.</td>
<td>Plays the original, then the highest inversion, then plays the second lowest and the second highest inversion, and so on. Playback order: original, 3, 1, 2.</td>
<td>This is an inside-out variation. Playback order: 1, 2, original, 3.</td>
<td>This is an inside-out variation. Playback order: 2, 1, 3, original.</td>
</tr>
<tr>
<td>Note order</td>
<td>Inversion 1</td>
<td>Inversion 2</td>
<td>Inversion 3</td>
<td>Inversion 4</td>
</tr>
<tr>
<td>------------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>Random</td>
<td>Played inversion order is randomly generated and can include duplicate chord inversions.</td>
<td>Played inversion order is randomly generated but no chord inversion is played twice.</td>
<td>This variation favors low chord inversions. Played inversion order is randomly generated and can include duplicate chord inversions.</td>
<td>This variation favors high chord inversions. Played inversion order is randomly generated and can include duplicate chord inversions.</td>
</tr>
</tbody>
</table>

### Arpeggiator pattern parameters in Logic Pro for Mac

Click the Pattern button to open the Arpeggiator pattern parameters.

The Pattern parameters are divided into two distinct functional modes: Live and Grid. The modes are mutually exclusive, so turning on one turns off the other. It also provides a unique Live Capture to Grid facility.

When Grid mode is active, it controls the arpeggio velocity, cycle length, step length, rests, ties, and chords. All live input of available grid parameters, such as velocities, is ignored.

When you switch to Live mode, the arpeggio performance is controlled live by your input. For example, the velocities of arpeggiated notes are determined by the way you played them. Any existing grid values are retained but are disabled until you return to Grid mode.

*Note:* When you capture a live performance, grid values are not retained.

![Pattern parameters in Logic Pro](image)

**Pattern parameters**

- *Pattern button:* Open the Arpeggiator pattern parameters, where you can edit and adjust pattern settings.

- *Live button:* Turn on Live mode, where you can add rests, ties, and chords in real time with onscreen buttons or MIDI keyboard keys. See Use Arpeggiator Live mode.

- *Arrow button (Live mode only):* Capture the currently playing velocities, rests, ties, and chords. Grid mode is automatically turned on and the captured performance can be edited in the grid. See Use Arpeggiator Grid mode.

- *Grid button:* Turn on Grid mode. The grid has 16 steps. Each step controls velocity, length, rest, tie, and chord status.
Use Arpeggiator Live mode in Logic Pro for Mac

In Live mode, you can add rests, ties, and chords in real time by clicking the onscreen buttons or by using equivalent MIDI keyboard remote keys. See keyboard parameters.

The grid acts as a display only. Incoming MIDI velocities, rests, ties, and chords are displayed in real time but cannot be edited in the grid. To edit individual arpeggiator steps, click the Grid button to turn on Use Arpeggiator Grid mode.

Note: Rests, ties, and chords are active only when Latch mode is turned on. See control parameters.

Live mode parameters

- **Rest button**: Insert a rest at the current arpeggiator step position. A position identification number is assigned to the rest, ensuring that its rhythmic position (step number) within the arpeggio is retained, even when different note order presets are chosen.
  
  Note: Rests can only be added while building the arpeggio, which means that at least one key must be held if you want to add a rest. Once all keys are released, the Arpeggiator acts in accordance with the rules of the set Latch mode and expects to receive a MIDI note for transposition and so on. In Latch Add mode, this restriction does not apply because it allows you to add MIDI notes, rests, ties, and chords after all keys are released.

- **Tie button**: Insert a tie at the current arpeggiator step position. A position identification number is assigned to the tie, ensuring that its rhythmic position (step number) within the arpeggio is retained, even when different note order presets are chosen.

- **Chord button**: Insert a chord at the current arpeggiator step position. When the arpeggiator encounters a chord step, it simultaneously plays all notes, including their unique velocities, currently in memory (latched or held). A position identification number is assigned to the chord, ensuring that its rhythmic position (step number) within the arpeggio is retained, even when different note order presets are chosen.
Use Arpeggiator Grid mode in Logic Pro for Mac

The grid consists of 16 steps. Each step controls the step velocity as well as its length, rest, tie, and chord status. In addition, a cycle length can be set. The current grid pattern is automatically saved with the project or concert. You can also save and load your own or supplied grid patterns. The Arpeggiator plug-in assigns incremental position identification numbers to each note in the order they were received, regardless of the initially selected note order preset. These position identification numbers are used to "lock" an event, such as a note, a rest, or a tie to a particular step.

![Arpeggiator Grid mode in Logic Pro](image)

**Grid mode parameters**

- **Step on/off buttons:** Turn each of the 16 available steps on or off.
  - *If a step is turned on:* An arpeggiator note is played at the respective grid position.
  - *If a step is turned off:* The grid position is silent and is perceived as a rest.

  **Note:** To ensure the integrity of the arpeggio, the note that would have been played—if the step had been active—is moved to the next active grid position.

- **Velocity/length bars:** Drag vertically to set the velocity for each active step. Drag left to reduce step length. Drag right to increase step length or to create a tie to the next step.

  - Where multiple velocity/length bars exist, click above them to draw in the velocity of several steps.
  - Drag a velocity/length bar toward the left to reduce the step length. Dragging to the right increases the step length. This enables you to create different arpeggiator grooves. Dragging snaps to fixed positions at 25%, 50%, 75%, or 100% of the step length. Hold down Shift, then drag to set the step length freely. Changes are reflected immediately in the Grid display by a shaded bar that indicates the step length.

  - Drag a velocity/length bar toward the right until it overlaps the next step to create a tie to that step. If the step to the right is a rest (an inactive step), this step is automatically turned on to create the tie. A step can be tied to multiple steps in a row. The original velocity values of tied steps are replaced by the velocity of the first step they are tied to, indicated graphically by the velocity bar extending over all tied steps. Changes are reflected immediately in the Grid display by a shaded bar that indicates the tie length.

  **Note:** Within an arpeggio, ties are perceived as a rhythmic element rather than a melodic variation. As a consequence, the tied note may change if notes are added after the tie has been entered, or if you choose a different note order preset.
• **Chord on/off buttons:** Turn on Chord mode for the respective step. When the Arpeggiator encounters a chord step, it simultaneously plays all notes currently in (latched or held) memory on that step. If a chord step is tied to a non-chord step, Chord mode is automatically activated for that step. If a non-chord step is tied to a chord step, Chord mode is automatically turned off for that step. Moving the velocity bar on a chord step changes the overall level of the chord, while retaining relative velocity differences between notes in the chord.

• **Cycle length bar:** Drag the handle at the end of the bar to change the grid length. The currently playing step is indicated by a light running inside the Cycle length bar. 

  *Note:* The grid length set with the Cycle length bar is independent of the Arpeggio cycle length parameter (which sets the length of the arpeggiated note pattern) described in options parameters. The grid length cycles independently of the effective note pattern. This prevents disruptions to the perceived rhythmic pattern created by the grid that can be caused by a change to the arpeggio length.

• **Scroll bar:** Drag to move to steps that aren't visible in the Grid display.

• **Pattern pop-up menu:** Choose a menu item to save or load user grid patterns or to load a supplied grid pattern.

  • **Save Pattern as:** Opens a name field. Enter a name, then click the Save button to save your pattern. Click Cancel to exit the “Save Pattern as” name field.

    User patterns are shown in the Pattern pop-up menu.

    *Note:* Supplied grid patterns cannot be overwritten. If you attempt to do so, a “Save Pattern as” name field appears.

  • **Recall Default:** Deletes all current data and reverts to a “from scratch” state.

  • **Delete User Pattern:** Deletes the current user pattern.

  • **Custom:** This menu item is shown automatically when any pattern changes have been made. It can be considered the “current state” pattern preset.

• **Previous/Next Pattern button:** Choose the previous or next pattern preset.

### Arpeggiator options parameters in Logic Pro for Mac

Click the Options button to set global Arpeggiator playback parameters, such as note length and velocity.
Options parameters

- **Options button**: Set global Arpeggiator playback parameters, such as note length and velocity.
- **Note Length knob**: Define the length of arpeggiated notes. This ranges from 1 to 150%.
  
  *Note*: This is a global scaling parameter that retains the relative length differences between individual steps that may have been changed in Grid mode.
- **Random knob**: Set the amount of random note length variation.
- **Velocity knob**: Determine the maximum range of possible velocity values for arpeggiated notes. At the far right position (100%), the original velocities of recorded or played notes are retained. At the far left position (0%), the original velocities of recorded or played notes are ignored and all notes are output at a constant velocity.
- **Vel (Velocity Base) field**: Drag vertically to set a minimum velocity value used for random velocity modulations and crescendos.
- **Crescendo/Random button**: Switch between two modes: Random and Crescendo. The amount of variation is controlled with the Crescendo/Random knob. The range of the crescendo or possible random velocities is set with the Velocity parameters.
- **Crescendo/Random knob**: Set the strength of the crescendo or random velocity variation for the chosen Crescendo/Random mode.
  
  - **When set to Crescendo**: The set amount is added to, or subtracted from, the velocity of all notes on each arpeggio repetition, starting with the second cycle.
  
  - **When set to Random**: The velocity values of all notes are randomized symmetrically by the set amount. At a value of 0% there is no randomization applied. At a value of 100% the velocity values are completely randomized.
- **Swing knob and field**: Set the strength of note swing. Swing moves every second note closer to the nearest downbeat. A value of 0% results in no note movement, whereas a value of 100% results in extreme note movement.
- **Cycle Length knob**: Set a length for the arpeggio. You can choose from the following:
  
  - **By Grid**: Matches the arpeggio length to the host application division setting. This is useful for rhythmically synchronizing the arpeggio length with other regions.
  
  - **1 to 32**: Set the arpeggio length to the specified number of notes.
  
  - **As Played**: The arpeggio length is determined by the length of played notes.
Arpeggiator keyboard parameters in Logic Pro for Mac

Click the Keyboard button to open the Arpeggiator keyboard parameters. The dots shown on the keyboard represent the output of currently playing notes, including any key and scale adjustments. You can also open the Remote Key editor window from the Keyboard pane. For further details, see Use Arpeggiator keyboard parameters.

Keyboard parameters

- **Keyboard button**: Set Arpeggiator keyboard parameters, such as scale and splits.
- **Input Snap pop-up menu**: Choose a beat value to snap the first incoming note to a position, thus quantizing the arpeggio start point.
  
  The default Input snap pop-up menu value is “link to rate,” which matches the set Arpeggiator Rate (see note order parameters).
- **Key pop-up menu**: Choose a root key for the chosen scale. C is the default key.
- **Scale pop-up menu**: Choose a scale. Played keys are snapped to the nearest note in the chosen scale. Choose from: Chromatic (default), Major, Major Pentatonic, Major Blues, Lydian, Mixolydian, Klezmer, Minor Pentatonic, Minor Blues, Japanese, Natural Minor, Harmonic Minor, Melodic Minor, Dorian, Phrygian, Locrian, and South-East Asian.
- **Keyboard Split button**: Divide your MIDI keyboard range into three zones.
- **Remote (Key editor) button**: You must first click the Keyboard Split button to make the Remote (Key editor) button visible. Opens the Remote Key editor window, where you can assign a range of MIDI keys to Arpeggiator functions.

Use Arpeggiator keyboard parameters in Logic Pro for Mac

The Arpeggiator keyboard parameters let you split your keyboard into zones that are used for standard note playback, arpeggio note triggering, and remote control of the Arpeggiator plug-in parameters.

Resize the Arpeggiator keyboard display

The default keyboard range spans the 88 notes from C0 to C7.

- In Logic Pro, click the keyboard, then drag left or right to reveal additional octaves, in one octave increments.
Set up a keyboard split in the Arpeggiator

By default, the complete MIDI key range (0–127) is used solely for arpeggiating. You can split your MIDI keyboard into several zones to control Arpeggiator plug-in functions with MIDI keys. The onscreen keyboard reflects the split layout.

- In Logic Pro, click the Keyboard Split button to divide your MIDI keyboard range into three zones.
  - **Remote zone**: Notes played in this zone trigger an Arpeggiator function. Drag handles to resize. Drag name to move.
  - **Arpeggio zone**: Notes played in this keyboard zone are arpeggiated. Drag handles to resize. Drag name to move.
  - **Through zone**: Notes are passed through the Arpeggiator plug-in unprocessed. This zone covers all keys outside the two zones listed above.

Resize the Arpeggio or Remote zone in the Arpeggiator

- In Logic Pro, drag the handles above each end of the Arpeggio or Remote zone to resize it.

Move the Arpeggio or Remote zone in the Arpeggiator

- In Logic Pro, click the name of either the Arpeggio or Remote zone and drag to the left or right. If the zones are adjacent, both zones are moved.

  The Arpeggio and Remote zones can swap places so that the Remote zone sits above the Arpeggio zone or vice versa, but the two zones cannot overlap.
Remote control the Arpeggiator with a MIDI keyboard

Most Arpeggiator parameters can be remote controlled using a MIDI keyboard. By default, only a few Remote commands are available. You can resize the Remote zone to make more commands available.

1. In Logic Pro, you must first click the Keyboard Split button to display the Remote (Key editor) button.

   The type and number of available remote keys is determined by the Remote zone range. Keys outside this range are dimmed and assigned functions cannot be remote controlled with a MIDI keyboard.

2. Click the Remote button to open the Remote Key editor window.

   A zoomed-in keyboard is displayed, with each key labeled according to its assigned function. Click the Remote button a second time to close the Remote Key editor window. You can also click the Keyboard Split button to exit the Remote Key editor window.

3. Drag the left or right border of the range bar above the Remote Key editor keyboard to resize the Remote zone.

Assign Arpeggiator controllers in Logic Pro for Mac

Controller button: Assign up to four MIDI controllers to Arpeggiator plug-in parameters.

Assign a MIDI controller to an Arpeggiator parameter

In Logic Pro, you need to choose:

- **MIDI Controller pop-up menu**: Choose a MIDI controller type.
- **Destination pop-up menu**: Choose a target parameter: Note Length, Note Length Random, Velocity Range, Velocity Base, and (De-)Crescendo.
Learn a MIDI controller in the Arpeggiator
1. In Logic Pro, choose a parameter from any of the Destination pop-up menus.
2. Choose Learn from any of the MIDI Controller pop-up menus.
3. Move a controller on your MIDI keyboard to assign it to the Destination parameter.
   
   The Learn feature has a 20-second timeout facility. If you do not move a controller on your MIDI device within 20 seconds, Learn mode is automatically disabled.

Chord Trigger

Chord Trigger overview in Logic Pro for Mac

The Chord Trigger MIDI plug-in lets you trigger chords by playing a single MIDI key. The onscreen keyboards have two functions: the display of incoming and outgoing MIDI notes and the assignment of chords to keys.

Chord Trigger parameters

- **Single/Multi Chord buttons**: Click Single to assign a single chord to a trigger key. Play up and down the keyboard to transpose the memorized chord in relation to the trigger key. Click Multi to assign a different chord to each key on the keyboard. Single Chord mode mimics the Chord Memo or Note Stack feature found on many classic synthesizers.

- **Upper keyboard**: Shows incoming MIDI notes, which are lit when played. Notes within the blue chord trigger range that have chord assignments are indicated by dots. Drag the handles above the keyboard to set the chord trigger range. Notes that fall within this range are processed. Notes outside the range are not processed. You can also click notes in the chord trigger range to trigger chords.

  **Note**: Notes that fall within the chord trigger range that do not have chord assignments will not be heard, resulting in a dead zone on your MIDI keyboard. You should limit the trigger range to encompass only notes that you want to use for chord assignments.

- **Lower keyboard**: Shows the resulting MIDI output—the chords triggered by incoming MIDI notes. The notes of each chord (in the chord trigger range) are displayed as blue dots when played. Notes outside the chord trigger range are lit when played.
• **Learn button**: Turn Learn mode on or off. Click a trigger key on the upper keyboard. Click the notes you want to assign to the trigger key on the lower keyboard. You can set a MIDI keyboard note to act as a remote control for Learn mode in the Extended parameters. See Use Chord Trigger for details on using Learn mode.

• **Clear button**: Erase a Trigger Key note and the corresponding chord.

• **Chord Transpose field**: Drag vertically, click the up/down arrows, or click and type a transposition value for chord playback.

### Use Chord Trigger in Logic Pro for Mac

Chord Trigger is straightforward to use: choose a mode (single or multi), set a chord trigger range, select a trigger key, then set up a chord. You can also transpose chords and quickly assign multiple chords—onscreen or with your MIDI keyboard.

#### Define the chord trigger range

The shaded chord trigger range is shown on the upper keyboard. Incoming MIDI notes that fall within this range are interpreted as trigger keys that play the chord (Single Chord mode) or the chords (Multi Chord mode) assigned to them. Chords can be assigned to keys within the chord trigger range. Incoming MIDI notes that fall outside the defined chord trigger range are passed through Chord Trigger unaffected. This allows you to play a melody with the right hand while triggering/transposing memorized chords with the left, for example.

- In Logic Pro, drag the handles of the chord trigger range bar above the upper keyboard to define a keyboard range.
  - **In Single Chord mode**: Playing a MIDI note (or clicking the upper keyboard) within the defined chord trigger range plays and transposes a single memorized chord. The transposition is performed in relation to the trigger key the chord is assigned to. For example, if a chord is assigned to C2, playing a D2 transposes the chord upward by two semitones. Playing a B1 transposes the chord down by a semitone.
  - **In Multi Chord mode**: Playing a MIDI note (or clicking the upper keyboard) within the defined chord trigger range triggers the chord that is memorized for the played key. Keys that do not have a chord assigned to them are silent when played.

*Note*: If the chord trigger range is made shorter, memorized chords that fall outside the range become inaccessible but are not deleted. Lengthening the chord trigger range makes assigned chords accessible again.
Transposing Chords in the Chord Trigger Range (Multi Chord Mode Only)

You may want to transpose triggered chords in some circumstances. For example, in Multi Chord mode you can move the entire chord trigger range upward by two semitones to change a chord progression in C-Major (starting with the C trigger key) into a progression that plays in D-Major, starting with the D trigger key.

Drag left or right to transpose.

- In Logic Pro, drag the center of the chord trigger range left or right.
  All memorized chords are moved with the chord trigger range and are automatically transposed.

Transpose Chords by Semitones or Octaves

- In Logic Pro, drag vertically, click the up/down arrows, or click and type a transposition value in the Chord Transpose field.
  All memorized chords can be transposed up or down by up to four octaves.

Assign a Chord to a Key Using the Onscreen Keyboard

1. In Logic Pro, click the Learn button.
   The Learn button label changes to “Trigger Key” and the button begins to blink.
2. Click a trigger key—within the chord trigger range—on the upper keyboard.
   The trigger key is set up for chord assignment. The Learn (Trigger Key) button label changes to “Chord.”
3. Click the note or notes you want to assign to the trigger key on the lower keyboard.
   As you click each note, you hear it and any previously assigned notes in the chord.
   Click assigned notes a second time to unassign or remove them from the chord.
4. To end chord assignment, click the Learn button.

You can repeat these steps to assign a different chord to each key in the chord trigger range when in Multi Chord mode. In Single Chord mode, only one chord can be learned.

Assign a Chord to a Key Using a MIDI Keyboard

It can be faster to use your MIDI keyboard when assigning chords to trigger keys. The Learn process can be started and stopped by playing an assigned note on your MIDI keyboard.

1. In Logic Pro, click the disclosure arrow at the lower left to open the extended parameters.
2. Choose the MIDI note number you want to use as a remote control for the Learn button from the Learn Remote pop-up menu.
   Choose Off if you no longer want to use a MIDI note as the Learn button remote control.
3. Play the note selected as the Learn button remote control on your MIDI keyboard.
The Learn button label changes to “Trigger Key” and the button begins to blink.

4. Play a trigger key—within the chord trigger range—on your MIDI keyboard.
This enables the trigger key for chord assignment. The Learn (Trigger Key) button label changes to “Chord.”

5. Play the note or notes you want to assign to the trigger key on your MIDI keyboard.
As you play each note, you hear it and any previously assigned notes in the chord.
Play assigned notes a second time to unassign or remove them from the chord.

6. Play the note selected as the Learn button remote control on your MIDI keyboard to end chord assignment.
You can repeat steps 3–6 to assign a different chord to each key in the chord trigger range when in Multi Chord mode. In Single Chord mode, only one chord can be learned.

**Clear a chord assignment**
1. In Logic Pro, click the Clear button.
   - *In Single Chord mode:* The assigned chord is erased.
   - *In Multi Chord mode:* The button label changes to “Trigger Key” and begins to blink.

2. Click the trigger key that you want to clear on the upper keyboard.
The chord assigned to the trigger key is erased and the trigger key is dimmed, indicating that no chord is assigned.

**Clear all chord assignments**
The following applies only to Multi Chord mode.

- In Logic Pro, press Option, then click the Clear button.
  All chords on all trigger keys are erased.

**Modifier in Logic Pro for Mac**
The Modifier MIDI plug-in lets you quickly reassign or filter a single continuous controller (CC) or fader event. You can also scale or add to event values.
Modifier parameters

- **Input Thru button**: Define whether or not the input event is sent to the output in addition to the reassignment.

- **Input Event pop-up menu**: Choose or learn the type of MIDI input event that you want to reassign or filter.

- **Re-Assign To pop-up menu**: Choose or learn the type of MIDI output event. You can also learn parameters for plug-ins in the same channel strip. If set to Off, the event type chosen in the Input pop-up menu is filtered.

- **Scale slider**: Set the scaling amount for the output event type chosen in the Re-assign To pop-up menu.

- **Add slider**: Set the offset amount for the output event type chosen in the Re-assign To pop-up menu.

Assign a MIDI event to a plug-in parameter

You can assign and send MIDI events to plug-ins in the same channel strip, allowing you to control parameters without using MIDI CC messages.

1. In Logic Pro, choose Learn Plug-in Parameter from the Re-Assign To pop-up menu.
2. Click the parameter in the target plug-in.
   
   The name of the plug-in and parameter are shown in the Re-Assign To field.

Modulator

Modulator overview in Logic Pro for Mac

The Modulator MIDI plug-in can generate continuous controller, aftertouch, and pitch bend messages. It consists of one syncable LFO and one Delay/Attack/Hold/Release envelope. See Modulator LFO and envelope.
Both the LFO and envelope can be assigned to output any continuous controller, aftertouch, plug-in parameter (in the same channel strip), or pitch bend message. You can also specify a step width for the continuous outputs of the LFO and envelope, resulting in modulations that are reminiscent of classic Sample & Hold circuits.

Modulator LFO in Logic Pro for Mac
Modulator LFO parameters

- **LFO on/off button:** Turn the LFO on or off.
- **Waveform Shape buttons:** Select a waveform shape. Choose from: triangle, sine, square, and random. Each is suited for different types of modulations.
- **Waveform display:** Shows the LFO waveform shape.
- **Symmetry slider:** Adjust the symmetry of the waveform. This deforms the waveform in the following ways:
  - **Triangle:** Shapes the triangle waveform into either an upward-sawtooth or downward-sawtooth waveform. A symmetry value of 0 results in a perfect triangle waveform.
  - **Sine:** Changes the angle of the waveform, resulting in a sawtooth-like waveform with peaks that lean left or right. A symmetry value of 0 results in a perfect sine waveform.
  - **Square:** Symmetry acts as a pulse width control. A symmetry value of 0 results in a perfect square waveform.
- **Similarity slider:** Adjust the amount of deviation when a random waveform is chosen. This alters the waveform in the following way:
  - **Random:** Similarity determines the maximum deviation between two consecutive random values. Low symmetry settings result in random values that are minimally different from one to the next, whereas high symmetry settings result in random values that deviate significantly.
- **Trigger switch:** Determine how the LFO reacts to incoming MIDI note on messages.
  - **Free:** The LFO ignores MIDI note on messages.
  - **Single:** After all notes have been released, the LFO is reset by the first MIDI note on message it receives.
    - **Note:** This means that legato playing does not reset the LFO, so keep this in mind during performances.
  - **Multi:** The LFO is reset by each received MIDI note on message.
- **Steps per LFO Cycle (Smoothing) slider and field:** Determine the number of steps per LFO cycle.
  By default, the LFO produces a smoothed continuous stream of controller events, but you can use this parameter to create a stepped controller signal that is similar to the output of a Sample and Hold circuit. When you set a manual step rate, the LFO rate can be changed without altering the number of steps.
  - **Note:** If the square or random waveform is selected, the Steps per LFO Cycle slider is renamed to Smoothing. The slider smooths the normally steep slopes of the square and random waveforms.
- **Rate knob:** Set the cycle speed of the LFO in hertz or in beat values when the Sync button is on. The LFO rate can be modulated by the envelope. See Modulator envelope.
- **Sync button:** Synchronize the LFO rate to the project tempo.
- **To pop-up menu:** Choose a continuous controller number, aftertouch, or pitch bend as the LFO output target. You can also learn a plug-in parameter.
- **Output Level slider:** Scale the LFO output level.
• **Offset slider:** Set a positive or negative offset in order to tailor the output for the intended target.

• **Oscilloscope:** Displays the shape of the LFO control signal before it is scaled.

• **MIDI Channel pop-up menu (extended parameter):** Click the disclosure arrow at the lower left. Choose a MIDI output channel.

**Assign a MIDI event to a plug-in parameter**

You can assign and send MIDI events to plug-ins in the same channel strip, allowing you to control parameters without using MIDI CC messages.

1. In Logic Pro, choose Learn Plug-in Parameter from the To pop-up menu.
2. Click the parameter in the target plug-in.

   The name of the plug-in and parameter are shown in the To field.

**Modulator envelope in Logic Pro for Mac**

![Modulator envelope in Logic Pro for Mac](image)

**Modulator Envelope parameters**

• **Envelope on/off button:** Turn the envelope on or off.

• **Envelope display:** Shows the current envelope shape. Drag the handles in the display to set the following parameters:
  
  • **Delay:** Delay the onset of the envelope. Ranges from 0 to 10 seconds.
  
  • **Attack:** Set the time required to reach the sustain level. Ranges from 0 to 10 seconds.
  
  • **Hold:** Set the sustain level and duration. Ranges from 0 to 10 seconds.
  
  • **Release:** Set the time required for the envelope to fall to a value of zero after the sustain phase of the envelope has finished. Ranges from 0 to 10 seconds.
• **Trigger switch**: Determine if the envelope is triggered by the LFO or by incoming MIDI note on messages.

• **LFO**: The envelope is re-triggered when the LFO reaches its (positive) peak value. See Modulator LFO.

  *Note*: The envelope ignores incoming LFO triggers if it is currently completing an envelope pass.

• **Single**: After all notes have been released, the envelope is re-triggered by the first MIDI note on message it receives.

  *Note*: This means that legato playing does not reset the envelope, so keep this in mind during performances.

• **Multi**: The envelope is re-triggered by each received MIDI note on message.

• **Steps per Env(e)lope Pass slider and field**: Determine the number of steps per envelope pass. By default, the envelope produces a smoothed continuous stream of controller events, but you can use this parameter to create a stepped controller signal that is similar to the output of a Sample and Hold circuit. When you set a manual step rate, the envelope time can be changed without altering the number of steps.

• **Env to LFO Rate knob**: Set the maximum amount of LFO modulation (LFO depth). The LFO rate can be modulated by the Attack, Hold, and Release parameters (see above).

• **Env to LFO Amp knob**: Set the maximum amount of LFO output modulation. This enables you to fade the LFO in or out with the envelope.

• **To pop-up menu**: Choose a continuous controller number, aftertouch, or pitch bend as the envelope output target. You can also learn a plug-in parameter.

• **Output Level slider**: Scale the envelope output level.

• **Offset slider**: Set a positive or negative offset in order to tailor the output for the intended target.

• **Oscilloscope**: Displays the shape of the envelope control signal before it is scaled.

• **MIDI Channel pop-up menu (extended parameter)**: Click the disclosure arrow at the lower left. Choose a MIDI output channel.

**Assign a MIDI event to a plug-in parameter**

You can assign and send MIDI events to plug-ins in the same channel strip, allowing you to control parameters without using MIDI CC messages.

1. In Logic Pro, choose Learn Plug-in Parameter from the To pop-up menu.
2. Click the parameter in the target plug-in.

The name of the plug-in and parameter are shown in the To field.
Note Repeater in Logic Pro for Mac

This plug-in mimics an audio delay by generating repeating MIDI notes.

Note Repeater parameters

- **Input Thru button**: Turn on to pass incoming MIDI note events to the output in addition to the delayed note events. Turn off to send only the delayed notes to the output.

- **Delay Sync button**: Synchronize the plug-in with the project tempo. Set the delay time with the Delay slider.

- **Delay slider and field**: Set the delay time in milliseconds or in bar/beat values when the Delay Sync button is on.
  
  *Note*: When the Delay Sync button is on, only bar and beat values are available.

- **Display**: Shows the unprocessed input MIDI note (bright bar) and delayed MIDI notes. The height of the bars represents the velocity of each delayed MIDI note.

- **Repeats knob**: Set the number of delay repetitions.

- **Transpose knob**: Transpose each delay repeat by the set amount.

- **Velocity Ramp knob**: Scale the velocity level of each delay repeat by the set amount.

- **Note Range Min and Max sliders (extended parameter)**: Click the disclosure arrow at the lower left to open the extended parameters. Move the sliders to set an input note range. Notes that fall within this range are processed (default range: 1–127). Notes outside the range are not processed.

  *Note*: You can position the Note Range Min slider above the Note Range Max slider and vice versa, which inverts the input note range behavior: note events that fall within the range are *not* processed and note events outside the range are processed.
Randomizer in Logic Pro for Mac

The Randomizer plug-in randomizes incoming MIDI events in real time.

Randomizer parameters

- *Event Type pop-up menu:* Choose the MIDI event type that you want to randomize.

- *Input Range sliders:* Set the upper and lower limit for the range of values that are affected. Only parameter values that fall within the range are processed. All values outside the range pass through the plug-in.
  
  *Note:* You can position the lower Input Range slider above the upper Input Range slider and vice versa, which inverts the input range behavior: events that fall within the range are not processed and events outside the range are randomized.

- *Amount slider:* Set the intensity of randomization. The box shows the range of possible output values in comparison with the unprocessed input signal shown in the middle.

- *Weight slider:* Increase or decrease the likelihood that an event is randomized within the set Amount range. The box reflects the weight setting: a darker gradient means less chance, and a brighter color means more chance to produce values in the respective area.
  
  - Drag toward the left (Low) to increase the chance of low values being randomized.
  - Drag toward the right (High) to increase the chance of high values being randomized.
  - In the centered position, neither low or high values are favored, resulting in the entire range of values being randomly altered.
• **Output Offset slider**: Offset the (random) MIDI output of the plug-in. Offsets can be negative or positive.

• **Seed slider (extended parameter)**: Specify a starting point (or seed) for randomization.

  An example is when using the Randomizer plug-in to randomize a piano melody. If you bounce the piano part, your randomized melody is saved as an audio file. If you bounce the song again, with Seed set to Random, the two bounces sound different. If Seed is set to the same specific value for both bounces, they are identical.

---

**Scripter**

**Use Scripter in Logic Pro for Mac**

The Scripter plug-in lets you load and use supplied or user-created scripts to process or generate MIDI data in real time. You don’t need any programming knowledge to use the plug-ins created in this environment, but you can view and modify them with the built-in script editor. Once authored and stored as a setting or patch or as part of a concert or project file, you can use the plug-in just like any other. A number of pre-built Scripter processors are included.

If you’re an advanced user, you can create your own custom MIDI plug-ins. See [Use the Script Editor](#).

**Important**: You need to select Enable Complete Features in Logic Pro > Settings > Advanced to use Scripter. The version of JavaScript used by the Scripter plug-in is determined by the JavaScriptCore framework version installed on your system. To ensure the greatest level of compatibility, install the latest software updates.

The Scripter plug-in has one global parameter. Further parameters, defined by the JavaScript script that is currently running, are shown below the global parameter.

- **Open Script in Editor button**: Open the Script Editor window.

  You can write your own scripts, or you can paste scripts from other sources into this window.
**Load a pre-built Scripter processor**

In Logic Pro, do one of the following:

- Load a setting from the plug-in window header.
- Load a patch from the Library.
- Load a channel strip setting from the channel strip Settings pop-up menu or Library.
- Load a project or concert that contains a Scripter plug-in with a running script.

You do not need to explicitly save an active script as a setting, patch, and so on. Saving the project or concert retains the script and status of all Scripter plug-ins.

**Use the Scripter Script Editor in Logic Pro for Mac**

The Script Editor is used to edit JavaScript code, enabling you to write your own MIDI plug-ins. Plug-in creation is in real time, which means that you can change and test your plug-in functions immediately. You can define interface elements, such as sliders and menus, that are shown in the Scripter plug-in window and can create the underlying logic and functions addressed by these onscreen controls. Some examples of utilities you can create with the Scripter plug-in are a chord strummer, a legato processor for stringed instruments, a harp glissando generator, and an algorithmic composer.

**Important:** The version of JavaScript used by the Scripter plug-in is determined by the JavaScriptCore framework version installed on your system. To ensure the greatest level of compatibility, install the latest Software Updates.

See the [Scripter API overview](#) for Scripter API documentation and code examples.
Script Editor parameters

- **Run Script button:** Evaluate the script and configure the plug-in and parameters. Output, including errors, is shown in the Interactive Console when you click this button.

- **Code Editor:** Type JavaScript code in this area. The editor provides the following features:
  - Syntax highlighting for JavaScript keywords and the available MIDI API (Application Programming Interface).
  - Live syntax checking, which highlights error lines immediately, making it easier to write your scripts.
  - Line numbers, which are useful for error checking because they are reported by line number in the Interactive Console.

- **Interactive Console:** Displays debugging information and allows you to execute code on the command prompt by typing after the prompt and pressing Return. Type `clear` and press Return to clear the console.

Create and store a Scripter plug-in

1. In Logic Pro, open the Scripter plug-in.
2. Click the Open Script In Editor button.
3. Type (or copy and paste existing) JavaScript code in the Code Editor.
4. Click the Run Script button.
5. Test your plug-in to verify it behaves as intended.
6. Assuming no errors are shown in the Interactive Console, save the host document, setting, or patch containing the script.

Scripter API overview in Logic Pro for Mac

You can create your own MIDI processing plug-ins using the JavaScript API described in these sections.

- **MIDI processing functions in Scripter**
- **JavaScript objects overview**
- **Create Scripter MIDI plug-in controls**

View the supplied Tutorial scripts in the Script Editor to see how they are constructed. You can modify and re-use the code to change functions or to create new processors. See Use the Script Editor.

**Note:** The supplied Tutorial scripts may vary slightly from the code examples shown in this documentation, due to post-publication changes in the JavaScriptCore framework or the Scripter plug-in. Please always use and refer to comments shown in the most recent Tutorial scripts and JavaScriptCore framework.
Scripter MIDI processing functions in Logic Pro for Mac

The Scripter plug-in exposes a set of JavaScript functions that you can implement in your script to communicate with Logic Pro. See these sections for details about different JavaScript function types and how to use them to create MIDI plug-ins.

- HandleMIDI function
- ProcessMIDI function
-getParameter function
- SetParameter function
- ParameterChanged function
- Scripter Reset function

Scripter HandleMIDI function in Logic Pro for Mac

The HandleMIDI() function lets you process MIDI events that the plug-in receives. HandleMIDI is called each time a MIDI event is received by the plug-in and is required in order to process incoming MIDI events. If you don’t implement the HandleMIDI function, events pass through the plug-in unaffected.

HandleMIDI is called with one argument, which is a JavaScript object that represents the incoming MIDI event. HandleMIDI and JavaScript Event object use is shown in the examples.

Load the corresponding Tutorial setting to view the script in the Script Editor. This will help you to understand the syntax structure and layout of code and comments. See Use the Script Editor.

Tutorial script 1: Simple Pass Through
Pass MIDI events through the plug-in.

```javascript
function HandleMIDI(event) {
    event.send();
}
```

Tutorial script 2: Trace Events
Log events to the plug-in console and don’t send them anywhere.

```javascript
function HandleMIDI(event) {
    event.trace();
}
```
**Tutorial script 3: Transpose and Delay**

Repeat notes up one octave with 100ms delay and pass all other events through.

Text following /* shows comments that explain the JavaScript code.

```javascript
function HandleMIDI(event) {
    event.send();   /* send original event */
    if (event instanceof Note) {  /* if it is a note */
        event.pitch += 12;   /* transpose up one octave */
        event.sendAfterMilliseconds(100);  /* send after delay */
    }
}
```

**Scripter ProcessMIDI function in Logic Pro for Mac**

The `ProcessMIDI()` function lets you perform periodic (generally timing-related) tasks. The function can be used when scripting a sequencer, an arpeggiator, or another tempo-driven MIDI effect. `ProcessMIDI` is generally not required for applications that don’t make use of musical timing information from the host. `ProcessMIDI` is called once per “process block,” which is determined by the host audio settings (sample rate and buffer size).

This function is often used in combination with the `TimingInfo` object to make use of timing information from Logic Pro. The use of `ProcessMIDI` and the `TimingInfo` object is shown in the example. Also see [Use the JavaScript TimingInfo object](#).

Load the corresponding Tutorial setting to view the script in the Script Editor. This will help you to understand the syntax structure and layout of code and comments. See [Use the Script Editor](#).

**Important:** To enable the `GetTimingInfo` feature, you need to add `var NeedsTimingInfo = true;` at the global script level (outside of any functions).

**Tutorial script 4: Process MIDI Callback**

Text following /* shows comments that explain the JavaScript code.

```javascript
/* Define NeedsTimingInfo as true at the global level to enable
GetHostInfo() */
var NeedsTimingInfo = true;
function ProcessMIDI() {
    var info = GetTimingInfo();  /* get a TimingInfo object from the host */
    if (info.playing) {
        Trace(info.tempo);   /* print the tempo in the plug-in console */
    }
}
```
Scripter GetParameter function in Logic Pro for Mac

The GetParameter() function retrieves information from parameters defined with var PluginParameters. Parameter variables can include type, minimum and maximum range values, and default values within the defined range, for example. Also see Create Scripter MIDI plug-in controls.

The GetParameter name argument must match the defined PluginParameters name value.

Load the corresponding Tutorial setting to view the script in the Script Editor. This will help you to understand the syntax structure and layout of code and comments. See Use the Script Editor.

Tutorial script 5: Velocity Slider

Text following /* shows comments that explain the JavaScript code.

```javascript
function HandleMIDI(event) {
    event.velocity = GetParameter("Note Velocity");
    /* retrieves "Note Velocity" information from the defined "Note Velocity" parameter */
    event.send(); /* sends the note event */
}
```

```javascript
var PluginParameters = [{
    name:"Note Velocity",
    type:"lin",
    minValue:1,
    maxValue:127,
    numberOfSteps:126,
    defaultValue:80
}];
/* create a linear parameter called "Note Velocity" with a range of 1 to 127, and a default value of 80 */
```

Scripter SetParameter function in Logic Pro for Mac

The SetParameter() function allows you to programmatically set the value of a control.

Usage is similar to the GetParameter function, but you need to add a second argument for the value you want to set.

- The first argument describes which parameter is accessed. This can be either an integer (index) or a string (parameter name).
- The second argument is the value that you want to set (this is always a number).

Important: Using SetParameter and track automation for a parameter at the same time can lead to unexpected behavior. You can circumvent such problems by disabling automation for each parameter.
**Code use example**

The example code creates a slider control and resets the value of that slider to 0 each time the plug-in is reset.

*Note:* You can opt out of automation on a per-parameter basis by including 'disableAutomation: true' in the parameter definition.

```javascript
function Reset() {
    SetParameter('slider', 0);
}
var PluginParameters = [{name:'slider', type:'lin', defaultValue:0.5, numberOfSteps:100, minValue:0, maxValue:1}];
```

**Scripter ParameterChanged function in Logic Pro for Mac**

The ParameterChanged() function lets you perform tasks triggered by changes to plug-in parameters. ParameterChanged is called each time one of the plug-in parameters is set to a new value. ParameterChanged is also called once for each parameter when you load a plug-in setting.

ParameterChanged is called with two arguments, first the parameter index (an integer number starting from 0), then the parameter value (a number).

Load the corresponding Tutorial setting to view the script in the Script Editor. This will help you to understand the syntax structure and layout of code and comments. See *Use the Script Editor*.

**Tutorial script 6: Parameter Changed Callback**

Print parameter changes to the plug-in console. This example also creates a slider in the plug-in window and assigns the ParameterChanged function to it.

Text following /* shows comments that explain the JavaScript code.

```javascript
var PluginParameters = [{name:"Slider", type:"lin", min Value:0, max Value:1, numberOfSteps:100, defaultValue:0}];
/* create a slider with a value range of 0.0 to 1.0 and a default value of 0 */
function ParameterChanged(param, value) {
    /* if it is the slider you just created */
    if (param == 0) {
        Trace(value);  /* print the value to the console */
    }
}
```

**Scripter Reset function in Logic Pro for Mac**

Reset() is called when you bypass the Scripter plug-in and when the transport is started.

You can implement this function to clear the plug-in history and set Scripter to its default state.
JavaScript objects overview in Logic Pro for Mac

The Scripter plug-in provides JavaScript objects that describe or represent MIDI information and information about Logic Pro, in addition to performing MIDI processing-related functions. See these sections for details about different object types.

- Use the JavaScript Event object
- Use the JavaScript TimingInfo object
- Use the Trace object
- Use the MIDI event beatPos property
- Use the JavaScript MIDI object

Use the JavaScript Event object in Logic Pro for Mac

When the `HandleMIDI` function is called, an Event object represents one MIDI event and implements several methods you can call in your script.

The Event object is not instantiated directly, but is a prototype for the following event-specific methods, properties, and types.

Tip: You can use the JavaScript “new” keyword to generate a new instance of an Event object of any type.

Event methods

- `Event.send()`: Send the event.
- `Event.sendAfterMilliseconds(number ms)`: Send the event after the specified value has elapsed (can be an integer or a floating point number).
- `Event.sendAtBeat(number beat)`: Send the event at a specific beat (floating point number) in the host timeline.
- `Event.sendAfterBeats(number beat)`: As above, but uses the beat value as a delay in beats from the current position.
- `Event.trace()`: Print the event to the plug-in console. See Use the Trace object.
- `Event.toString()`: Returns a String representation of the event.

Event properties

- `Event.toarticulationID(integer number)`: Sets the articulation ID from 0–254.
- `Event.channel(number)`: Set MIDI channel 1 to 16.
- `Event.beatPos`: Retrieves the event’s exact beat position.
Event types

The Event object is a prototype for the following event types. All event types inherit the methods and channel properties described above.

The event types and their properties are passed to HandleMIDI as follows:

- `NoteOn.pitch(integer number)`: Pitch from 1–127.
- `NoteOn.velocity(integer number)`: Velocity from 0–127. A velocity value of 0 is interpreted as a note off event, not a note on.
- `NoteOff.pitch(integer number)`: Pitch from 1–127.
- `NoteOff.velocity(integer number)`: Velocity from 0–127.
- `PolyPressure.pitch(integer number)`: Pitch from 1–127.
- `PolyPressure.value(integer number)`: Define a pressure value from 0–127.
- `ControlChange.number(integer number)`: Controller number from 0–127.
- `ControlChange.value(integer number)`: Controller value from 0–127.
- `ProgramChange.number(integer number)`: Program change number from 0–127.
- `ChannelPressure.value(integer number)`: Aftertouch value from 0–127.
- `PitchBend.value(integer number)`: 14-bit pitch bend value from -8192–8191. A value of 0 is center.
- `TargetEvent.target(string)`: Create user definable MIDI CC messages or control plug-in parameters.
- `TargetEvent.value(float)`: Sets the target value.

Load the corresponding Tutorial setting to view the script in the Script Editor. This will help you to understand the syntax structure and layout of code and comments. See Use the Script Editor.

Tutorial script 7: Event Creation

In Logic Pro, this example replaces every received MIDI event with a modulation control change message.

- Text following /* shows comments that explain the JavaScript code.

⚠ Tip: You can use the JavaScript “new” keyword to generate a new instance of an Event object of any type.

```javascript
function HandleMIDI() {
    var cc = new ControlChange;  /* make a new control change message */
    cc.number = 1;   /* set it to controller 1 (modulation) */
    cc.value = 100;   /* set the value */
    cc.send();    /* send the event */
    cc.trace();    /* print the event to the console */
}
```
Tutorial script 8: Event Modification

In Logic Pro, this example replaces every received MIDI event with a C3 note on/off. The example also uses the NeedsTimingInfo variable. See Use the JavaScript TimingInfo object.

- Text following /* shows comments that explain the JavaScript code.
  
  Tip: You can use the JavaScript “new” keyword to generate a new instance of an Event object of any type.

```javascript
var NeedsTimingInfo = true; /* needed for .sendAfterBeats() to work */
function HandleMIDI() {
    var on = new NoteOn;   /* make a new note on */
    on.pitch = 60;   /* set its pitch to C3 */
    on.send();    /* send the note */
    var off = new NoteOff(on);  /* make a note off using the note on to initialize its pitch value (to C3) */
    off.sendAfterBeats(1);  /* send a note off one beat later */
}
```

Tutorial script 15: Control Plug-ins

In Logic Pro, you can create user-definable MIDI CC messages, or you can control plug-in parameters. TargetEvent reads the parameter to be modified from a menu where the user can select a destination MIDI CC. Alternately, you can use the Learn Plug-in Parameter feature to assign any plug-in parameter inserted after (below) Scripter in the same channel strip. The chosen destination is saved with the plug-in setting.

- Text following /* shows comments that explain the JavaScript code.

  Tip: You can use the JavaScript “new” keyword to generate a new instance of an Event object of any type.

TargetEvent properties:

- TargetEvent.target(string) /* Name of target menu entry */
- TargetEvent.value(float) /* Value of set Target from 0.0 to 1.0 */

The code shown below controls any plug-in parameter with the modwheel. To test the function in Tutorial script 15, insert any plug-in or software instrument on the same channel and run the script. Choose Learn plug-in parameter in the menu, then click any plug-in parameter to control it with the modwheel.

To create a menu for the modwheel target, name the menu entry and set it to a “target” type.

```javascript
var PluginParameters = [
    /* parameter 0 */
    {
        name:"Modwheel Target",
        type:"target"
    }];
```
HandleMIDI is called every time Scripter receives a MIDI event in Tutorial script 15. The code shown below remaps the modulation wheel to the target chosen in the menu.

```javascript
function HandleMIDI(incomingEvent) {
  /* remap modulation to target selected in menu and check for incoming CC event with number 1 (Modwheel) */
  if ((incomingEvent instanceof ControlChange) && (incomingEvent.number == 1)) {
    var newEvent = new TargetEvent(); /* create new Target event */
    newEvent.target = "Modwheel Target"; /* name the menu entry to be used by this event */
    newEvent.value = incomingEvent.value / 127; /* rescale from 0..127 to 0.0...1.0 */
    newEvent.send(); /* send the event */
  } else {
    /* send all other events */
    incomingEvent.send();
  }
}
```

Use the JavaScript TimingInfo object in Logic Pro for Mac

The TimingInfo object contains timing information that describes the state of the host transport and the current musical tempo and meter. A TimingInfo object can be retrieved by calling GetTimingInfo().

TimingInfo properties

- `TimingInfo.playing`: Uses Boolean logic where “true” means the host transport is running.
- `TimingInfo.blockStartBeat`: A floating point number indicates the beat position at the start of the process block. An alternative is to use the beatPos property. See Use the MIDI event beatPos property.
- `TimingInfo.blockEndBeat`: A floating point number indicates the beat position at the end of the process block.
- `TimingInfo.blockLength`: A floating point number indicates the length of the process block in beats.
- `TimingInfo.tempo`: A floating point number indicates the host tempo.
- `TimingInfo.meterNumerator`: An integer number indicates the host meter numerator.
- `TimingInfo.meterDenominator`: An integer number indicates the host meter denominator.
- `TimingInfo.cycling`: Uses Boolean logic where “true” means the host transport is cycling.
• **TimingInfo.leftCycleBeat**: A floating point number indicates the beat position at the start of the cycle range.

• **TimingInfo.rightCycleBeat**: A floating point number indicates the beat position at the end of the cycle range.

    Note: The length of a beat is determined by the Logic Pro time signature and tempo.

Load the corresponding Tutorial setting to view the script in the Script Editor. This will help you to understand the syntax structure and layout of code and comments. See Use the Script Editor.

**Tutorial script 9: NeedsTimingInfo and GetTimingInfo**

In Logic Pro, this example prints the beat position to the console while the transport is running.

• Text following /* shows comments that explain the JavaScript code.

```javascript
var NeedsTimingInfo = true; /* needed for GetTimingInfo to work */
function ProcessMIDI() {
    var info = GetTimingInfo(); /* get the timing info from the host */
    if (info.playing) /* if the transport is playing */
        Trace(info.blockStartBeat) /* print the beat position */
}
```

**Use the Trace object in Logic Pro for Mac**

Trace is a Scripter specific function, rather than a JavaScript function. You can also use the Scripter Event.trace function to log events to the plug-in console. For more information, see Use the JavaScript Event object.

Trace(value) outputs the given value of any type to the Scripter console, which can be useful for generating debug outputs. It’s possible to mix different variable types in a single Trace() command, much like you would do with strings.

    Note: Console output is thinned for performance reasons if you send too many Trace commands in a short timeframe. This also happens with event.trace.

**Usage example for Trace() object**

```javascript
function HandleMIDI(event) {
    Trace("Hello World!");
    var int = 1;
    var float = 1.234;
    var str = "Teststring";
    Trace("The following is a float variable: " + float +
        " And now we inspect an integer: " + int +
        " And here's a test string: " + str);
}
```
Use MIDI event beatPos property in Logic Pro for Mac

Every MIDI event in Scripter has a property called "beatPos" that carries the exact beat position of the event. This makes more exact event timing possible and also handles loops correctly. This property can be used in place of timingInfo.blockStartBeat. See Use the JavaScript TimingInfo object.

Note: This property only works if "var NeedsTimingInfo = true", otherwise it will have a value of 0, and will print a warning if modified.

- In Logic Pro, type either of the following lines in the Script Editor window (both achieve the same result):
  event.send()
  event.sendAtBeat(event.beatPos)
- Alternatively, you can use either of the following lines in the Script Editor window (both achieve the same result):
  event.beatpos += 1; event.send()
  event.sendAtBeat(event.beatPos + 1)

Usage example for the beatPos property

You can use the beatPos property to send a MIDI event at a specific beat position. In the following example, a note off event is sent a beat later than the beat position of the corresponding note on event.

Note: You can also use the event.sendAtBeat(pos) method to send an event at a specific beat position. The advantage of using the beatPos property is that you don't actually have to send an event; you can simply use the property to retrieve the exact beat position of an event.

Text following /* shows comments that explain the JavaScript code.

```javascript
var NeedsTimingInfo = true; /* needed to make beatPos work */
function HandleMIDI(event) {
  var on = new NoteOn;  /* make a new note on */
on.pitch = 60;  /* set its pitch to C3 */
on.beatPos = event.beatPos; /* copy beat position from incoming event */
on.send();   /* send the note on */

  var off = new NoteOff(on); /* make a note off using the note on to initialize its pitch value to C3 */

  /* note that the beatPos does not get copied here */
  off.beatPos = on.BeatPos + 1; /* set the beat position of the note off event */
  off.send();   /* send the note off event */
}
```
Use the JavaScript MIDI object in Logic Pro for Mac

The MIDI object contains a number of convenient and easy to use functions that can be used when writing your scripts.

Note: The MIDI object is a property of the global object, which means that you do not instantiate it but access its functions much like you would the JavaScript Math object. An example is calling MIDI.allNotesOff() directly.

MIDI object properties

Use the following method names and arguments to perform these functions:

- `noteNumber(string name)`: Returns the MIDI note number for a given note name. For example: C3 or B#2.
  
  Note: You cannot use flats in your argument. Use A#3, not Bb3.
- `noteName(number pitch)`: Returns the name (string) for a given MIDI note number.
- `ccName(number controller)`: Returns the controller name (string) for a given controller number.
- `allNotesOff()`: Sends the all notes off message on all MIDI channels.
- `normalizeStatus(number status)`: Normalizes a value to the safe range of MIDI status bytes (128–239).
- `normalizeChannel(number channel)`: Normalizes a value to the safe range of MIDI channels (1–16).
- `normalizeData(number data)`: Normalizes a value to the safe range of MIDI data bytes (0–127).

Load the corresponding Tutorial setting to view the script in the Script Editor. This will help you to understand the syntax structure and layout of code and comments. See Use the Script Editor.

Tutorial script 10: Event Detection

In Logic Pro, this script passes all events through and sends an “all notes off” message when receiving a MIDI continuous controller 20 event.

- Text following /* shows comments that explain the JavaScript code.

```javascript
function HandleMIDI(event) {
    event.send(); /* pass through the event if the event is MIDI CC 20 */
    if (event instanceof ControlChange && event.number == 20)
        MIDI.allNotesOff(); /* send an all notes off message */
}
```
Create Scripter MIDI plug-in controls in Logic Pro for Mac

The following section outlines how you can use the Script Editor to create standard interface controllers such as sliders and menus for your Scripter plug-ins. The only mandatory property you have to define for a new parameter is “name”. This defaults to a basic slider. In addition, you can use further properties to change the type and behavior of controls.

Load the corresponding Tutorial setting to view the script in the Script Editor. This will help you to understand the syntax structure and layout of code and comments. See Use the Script Editor.

Optional properties

- **type**: Type one of the following strings as the value:
  - “lin”: Creates a linear fader.
  - “log”: Creates a logarithmic fader.
  - “momentary”: Creates a momentary button.
  - “menu”: Creates a menu.
  
  The menu type requires an additional valueStrings property that is an array of strings to show in the menu. See Tutorial script 13.

- **defaultValue**: Type an integer or floating point number to set a default value. If no value is typed, the default is 0.0.

- **minValue**: Type an integer or floating point number to set a minimum value. If no value is typed, the default is 0.0.

- **maxValue**: Type an integer or floating point number to set a maximum value. If no value is typed, the default is 1.0.

- **numberOfSteps**: Type an integer number to define the number of steps.

- **unit**: Type a string to present a unit description in the plug-in controls. If no value is typed, the default behavior is to display no unit.

- **text**: Type text to create a divider or header in the plug-in UI.

**Tutorial script 11: Slider Creation**

In Logic Pro, type the following in the Script Editor window to create a slider named “Parameter x” with a default range of 0 to 1. It is set to the mid-point value of 0.5.

```javascript
var PluginParameters = [{name:"Parameter x", defaultValue:0.5}];
```

**Tutorial script 12: Slider Ranges**

In Logic Pro, type the following in the Script Editor window to create a linear slider type, with five possible positions (steps), and a range from 0 to 5.

```javascript
var PluginParameters = [{name:"Octaves", defaultValue:3, minValue:0, maxValue:5,
numberOfSteps:5, unit:"octaves", type:"lin"}];
```
Tutorial script 13: Menu Creation

In Logic Pro, type the following in the Script Editor window to create a menu named "Range" with the options "Low", "Mid", and "High".

```javascript
var PluginParameters = [{name:"Range", type:"menu", valueStrings: ["Low", "Mid", "High"]}];
```

Dynamically hide or show MIDI plug-in controls

In complex Logic Pro scripts, it may be helpful to hide or show parameter controls dynamically, such as for a menu item that lets you choose a group of controls to display. Type the following in the Script Editor window to create these controller types.

- var PluginParameters = [{name:'uno'}, {name:'dos', hidden:true}];

Call `UpdatePluginParameters()` to change this dynamically.

Retrieve plug-in parameter values

Call `GetParameter()` with the parameter name to return a value (number object) with the current value of the parameter. `GetParameter()` is typically used inside the `HandleMIDI` function or `ProcessMIDI` function.

In Logic Pro, this code example converts modulation events into note events and provides a slider to determine note lengths.

- Text following /* shows comments that explain the JavaScript code.
  ```javascript
  var PluginParameters = [{name:"Note Length", minValue:0, maxValue:100, unit:"%"}]; /* create a slider (default range 0 - 100) */
  function HandleMIDI(event) {
    if(event instanceof ControlChange && event.number == 1) { /* if event is MIDI cc1 (modwheel) */
      var note = new NoteOn; /* create a NoteOn object */
      if(event.value == 0) /* because modwheel range is 0-127 and pitch range is 1-127, convert a modwheel value of 0 to 1 */
        event.value = 1;
      note.pitch = event.value; /* use cc value as note pitch */
      note.velocity = 100; /* use velocity 100 */
      note.send(); /* send note on */
      var off = new NoteOff(note); /* create a NoteOff object that inherits the NoteOn pitch and velocity values */
      var delayInBeats = GetParameter("Note Length")/100 + 0.1; /* retrieve the parameter value of the slider you created (add 0.1 to guarantee note on and off are not simultaneous) */
      off.sendAfterBeats(delayInBeats); /* send note off after the length in beats is set via the slider */
    }
  }
  ```
Transposer in Logic Pro for Mac

The Transposer MIDI plug-in can transpose incoming MIDI notes in real time and can correct notes to a selected scale.

Transposer parameters

- **Transpose slider**: Transpose incoming MIDI Notes by ± 24 semitones.
- **Root pop-up menu**: Choose the root note for the scale.
- **Scale pop-up menu**: Choose one of several preset scales or create your own custom scale (User) with the onscreen keyboard.
- **Keyboard**: Click notes to turn them on or off. Notes that are turned off are excluded from the User scale.

Velocity Processor

Velocity Processor overview in Logic Pro for Mac

The Velocity Processor MIDI plug-in processes incoming MIDI velocity events—note on and note off—in real time. Among other applications, it allows velocity compression and expansion.
Velocity Processor global parameters

- **Process buttons:** Click either button to process MIDI note on velocity or MIDI note off velocity. Both buttons can be active simultaneously.

- **Mode pop-up menu:** Choose a velocity processing mode. The available parameters change depending on the mode selected.
  - **Compress/Expand:** In Compress/Expand mode, the plug-in behaves like an audio compressor.
  - **Value/Range:** In Value/Range mode, the plug-in behaves like an audio limiter.
  - **Add/Scale:** In Add/Scale mode, the plug-in scales, adds to, or reduces the values of incoming MIDI velocity messages.

- **Note Range Min and Note Range Max sliders (extended parameter):** Click the disclosure arrow at the lower left to open the extended parameters. Move the sliders to set an input note range. Notes that fall within the input note range are processed (default range: 1–127). Notes outside the input note range are not processed.
  
  **Note:** You can cross over the Input Min and Input Max sliders, which inverts the input note range behavior: note events that fall within the range are not processed and note events outside the range have their velocities processed.

- **Range Learn checkbox (extended parameter):** Select to turn on Learn mode, then play a (low) key on your MIDI keyboard to set the Input Min value. Play a (high) key to set the Input Max value.
  
  Once both keys have been played, Learn mode is automatically turned off, and the Range Learn checkbox is cleared.

Velocity Processor Compress/Expand in Logic Pro for Mac

In Compress/Expand mode, the Velocity Processor MIDI plug-in behaves like an audio compressor.
Compress/Expand mode parameters

- **Threshold knob:** Set a velocity value. Incoming velocities above the threshold are processed. MIDI notes with velocity values below the threshold pass through unaffected.

- **Ratio knob:** Determine the slope of compression/expansion above the threshold. Processing is done using a “soft knee” characteristic.
  - Ratios smaller than 1 result in an expansion of incoming velocity values.
  - Ratios greater than 1 result in compression of incoming velocity values.

- **Make-up knob:** Set a velocity offset to compensate for the higher or lower overall velocity caused by compression/expansion. The velocity offset can be positive or negative, either adding to or subtracting from incoming velocity values.

- **Auto (Gain) button:** Automatically apply a maximum velocity reference level, set with the Make-up knob.
  
  **Note:** When the Auto button is active, the Make-up knob changes function: instead of setting the velocity offset value, it sets the maximum velocity reference level.

Velocity Processor Value/Range in Logic Pro for Mac

In Value/Range mode, the Velocity Processor MIDI plug-in can behave like an audio limiter.

Value/Range mode parameters

- **Value/Range switch:** Value limits all incoming MIDI velocities to the value set with the Value slider. Range limits only notes within the range set with the Note Range Min/Max sliders.

- **Value slider:** Set a fixed velocity for all processed notes.

- **Range sliders:** Set a note range to be processed. You can cross over the sliders to create a note range that is not processed.
Velocity Processor Add/Scale in Logic Pro for Mac

In Add/Scale mode, the Velocity Processor MIDI plug-in scales, adds to, or reduces the values of incoming MIDI velocity messages.

Add/Scale mode parameters

- **Scale slider**: Scale all incoming MIDI velocity values by a percentage from zero to 200%.
- **Add slider**: Add the set value to, or subtract it from, incoming MIDI velocity values.

Record MIDI plug-in output in Logic Pro for Mac

Record MIDI to Track Here lets you record the output of MIDI effects to a MIDI region on a track. For example, instead of just recording the notes you play to trigger the effects, Record MIDI to Track Here lets you record their real-time processed output, allowing precise editing of the resulting notes and controller data.

**Add Record MIDI to Track Here**

To capture the output of plug-ins, add Record MIDI to Track Here to the slot after the last MIDI plug-in you want to record. Any other plug-ins after the Record MIDI to Track Here slot will not be included in the recording.

To record the output of MIDI effect plug-ins, do the following:

1. Insert the MIDI plug-ins you want to record.
2. Click the arrows near the right edge of the last MIDI plug-in in the chain that you want to record.
3. Choose Record MIDI to Track Here from the MIDI plug-ins pop-up menu.
4. Record your sequence to a MIDI region.

*Note:* Record MIDI to Track Here will appear as two small yellow triangles in the MIDI Effect slot, directly below the plug-in where it was inserted.
Change the position of Record MIDI to Track Here

- Click the arrows near the right edge of the last MIDI plug-in in the chain you want to record, then choose Record MIDI to Track Here from the pop-up menu.

Remove Record MIDI to Track Here

- Click the arrows near the right edge of the MIDI plug-in above the slot containing Record MIDI to Track Here, then choose Record MIDI to Track Here from the pop-up menu.
Modulation effects

Modulation effects in Logic Pro for Mac

Modulation effects—such as chorus, flanging, tremolo, and phasing—are used to add motion and depth to your sound. Perceived width can be altered with the Spreader effect. Both motion and space can be introduced with the Rotor Cabinet effect.

Modulation effects typically delay the incoming signal by a few milliseconds and use an LFO to modulate the delayed signal. The LFO may also be used to modulate the delay time in some effects.

A low frequency oscillator (LFO) is similar to the sound-generating oscillators in synthesizers, but the frequencies generated by an LFO are so low that they can’t be heard and are therefore used only for modulation purposes. LFO parameters include speed (or frequency) and depth—also called intensity—controls.

You can also control the ratio between the affected (wet) signal and the original (dry) signal. Some modulation effects include feedback parameters, which add part of the effect output back into the effect input.

Other modulation effects involve pitch. The most basic type of pitch modulation effect is vibrato, which uses an LFO to modulate the frequency of the sound. Unlike other pitch modulation effects, vibrato alters only the delayed signal.

More complex modulation effects, such as Ensemble, mix several delayed signals with the original signal. Ringshifter combines a ring modulator with a frequency shifter effect. Modulation Delay allows flanging and chorus effects, emulations of tape speed fluctuations and metallic, robot-like modulations.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Chorus effect in Logic Pro for Mac

The Chorus effect delays the original signal, and the delay time is modulated with an LFO. The delayed, modulated signal is then mixed with the original, dry signal.

You can use the Chorus effect to enrich the incoming signal and create the impression that multiple instruments or voices are being played in unison. The slight delay time variations generated by the LFO simulate the subtle pitch and timing differences heard when several musicians or vocalists perform together. Using chorus also adds fullness or richness to the signal, and it can add movement to low or sustained sounds.
To add Chorus to your project, choose Modulation > Chorus in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Chorus parameters

- **Rate knob and field**: Set the frequency, or speed, of the LFO.
- **Intensity knob and field**: Set the modulation amount.
- **D-Mode button**: Turn on to introduce a spatial filtering effect that resembles a well-known vintage processor.
- **Mix knob and field**: Determine the balance between dry and wet signals.

Ensemble effect in Logic Pro for Mac

Ensemble can add richness and movement to sounds, particularly when you use a high number of voices. It is useful for thickening parts, but you can also use it for strong pitch variations between voices, resulting in a detuned quality to processed material. Ensemble combines up to eight chorus effects. Two standard LFOs and one random LFO enable you to create complex modulations. The graphic display represents the modulation rate and intensity of all LFOs and lets you directly adjust waveforms.

To add Ensemble to your project, choose Modulation > Ensemble in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Ensemble parameters

- **LFO1/LFO2/Random on/off buttons**: Enable or disable LFO 1, LFO 2, or the random LFO independently.
- **Rate fields**: Set the frequency of LFO 1, LFO 2, and random modulation.
- **Intensity fields**: Set the amount of LFO 1, LFO 2, and random modulation.
- **Graphic display**: Shows and lets you edit the shape and intensity of LFO 1, LFO 2, and random modulations. Move the pointer to the left third to adjust LFO 1, the center third to adjust LFO 2, or the right third to adjust the random LFO.
  - Modulation is represented by a horizontal line and waveform. The line represents the LFO intensity. The waveform represents the LFO rate. Drag the line or circular handle vertically (or use the corresponding field) to set modulation intensity. Drag the waveform or circular handle horizontally (or use the corresponding field) to set the modulation rate.
- **LFO1 parameters**: Drag the green handle to set modulation rate and intensity.
- **LFO2 parameters**: Drag the blue handle to set modulation rate and intensity.
- **Random LFO parameters**: Drag the white handle to set modulation rate and intensity.
- **Voices knob and field**: Set the number of chorus instances (voices) generated in addition to the original signal.
- **Stereo Spread slider and field**: Distribute voices across the stereo or surround field. You can set a value of 200% to artificially expand the stereo or surround base. Note that monaural compatibility may suffer if you do this.
  
  **Note**: When used in surround, the input signal is converted to mono before processing. In essence, you insert the Ensemble effect as a multi-mono instance.
- **Phase knob and field**: Control the phase relationship between the individual voice modulations. The value you choose here is dependent on the number of voices, which is why it is shown as a percentage value rather than in degrees. The value 100 (or −100) indicates the greatest possible distance between the modulation phases of all voices.
- **Volume Compensation knob and field**: Compensate for effects signal volume changes caused by adjusting the Voices value.
- **Output Mix knob and field**: Set the balance between dry and wet signals.

Flanger effect in Logic Pro for Mac

The Flanger effect works in much the same way as the Chorus effect but uses a significantly shorter delay time. In addition, the effect signal can be fed back into the input of the delay line.

Flanging is typically used to add a spacey or underwater quality to input signals.
To add Flanger to your project, choose Modulation > Flanger in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

**Flanger parameters**
- **Sync button:** Synchronize the modulation speed with the project tempo. Choose musical note values with the Rate knob.
- **Rate knob and field:** Set the frequency, or speed, of the LFO.
- **Intensity knob and field:** Set the modulation amount.
- **Feedback knob and field:** Set the amount of the effect signal that is routed back to the input. This can change the tonal color and can make the sweeping effect more pronounced. Negative Feedback values invert the phase of the routed signal.
- **Mix knob and field:** Determine the balance between dry and wet signals.

**Microphaser in Logic Pro for Mac**
Microphaser lets you quickly create swooshing, phasing effects.

To add Microphaser to your project, choose Modulation > Microphaser in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

**Microphaser parameters**
- **Sync button:** Synchronize the modulation speed with the project tempo. Choose musical note values with the Rate knob.
- **Rate knob and field:** Set the frequency, or speed, of the LFO.
- **Intensity knob and field:** Set the modulation amount.
- **Feedback knob and field:** Set the amount of effect signal routed back to the input. This can change the tonal color and can make the sweeping effect more pronounced.
Modulation Delay in Logic Pro for Mac

Modulation Delay is based on the same principles as Flanger and Chorus effects, but you can set the delay time, allowing both chorus and flanging effects to be generated. It can also be used without modulation to create resonator or doubling effects. The modulation section consists of two LFOs with variable frequencies.

Although rich, combined flanging and chorus effects are possible, the Modulation Delay is capable of producing some extreme modulation effects. These include emulations of tape speed fluctuations and metallic, robot-like modulations of incoming signals.

To add Modulation Delay to your project, choose Modulation > Modulation Delay in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Modulation Delay parameters

- **Mod Intensity knob and field**: Set the modulation amount.
- **Time knob and field**: Set the basic delay time. Set to the far left position to create flanger effects, to the center for chorus effects, and to the far right to hear clearly discernible delays.
- **Feedback knob and field**: Set the amount of effect signal routed back to the input. Use a high Feedback value for strong modulations. If you want to double the signal, don’t use Feedback. Negative values invert the phase of the feedback signal, resulting in more chaotic effects.
- **De-Warble button**: Turn on to make sure the pitch of the modulated signal remains constant.
- **Constant Mod button**: Turn on to make sure the modulation width remains constant, regardless of the modulation rate.

Note: When Constant Mod is enabled, higher modulation frequencies reduce the modulation width.
• **D-Mode button:** Turn on to introduce a spatial filtering effect that resembles a well-known vintage processor.

  *Note:* Available only in stereo or mono->stereo instances.

• **LFO 1/2 Rate knobs and fields:** Set the modulation rate for the left and right stereo channels. In surround instances, the center channel is assigned the middle value of the left and right LFO Rate knobs. The other channels are assigned values between the left and right LFO rates.

  *Note:* The right LFO Rate knob is available only in stereo and surround instances, and it can be set separately only if the Link L & R button is not enabled.

• **Link L & R button:** Link the modulation rates of the left and right stereo channels. Adjustment of either Rate knob affects the other channel in stereo instances, or other channels in surround instances.

• **Mix slider and fields:** Determine the balance between the two LFOs.

• **Phase knob and field:** Control the phase relationship between individual channel modulations. Available only in stereo and surround instances.

  • At 0°, the extreme values of the modulation are achieved simultaneously for all channels.
  
  • At 180° or −180°, you achieve the greatest possible distance between the modulation phases of the channels.

  *Note:* The Phase parameter is available for use only if the Link L & R button is active.

• **Distribution pop-up menu:** Choose how phase offsets between individual channels are distributed in the surround field. Choose from: circular, left↔right, front↔rear, random, or new random. Available only in surround instances.

  *Note:* When you load a setting that uses the random option, the saved phase offset value is recalled. If you want to randomize the phase setting again, choose new random from the Distribution pop-up menu.

• **Filter button:** Turn on to introduce an additional allpass filter into the signal path. This filter shifts the phase angle of a signal, influencing its stereo image.

• **Low/High Cut sliders and fields:** Set the frequency at which the phase shift crosses 90°—the halfway point of the total 180°—for each of the stereo channels. In surround instances, the other channels are automatically assigned values that fall between the two settings.

• **Volume Mod slider and field:** Determine the impact of LFO modulation on the amplitude of the effect signal.

• **Output Mix slider and field:** Set the balance between dry and wet signals.
Phaser effect in Logic Pro for Mac

The Phaser effect combines the original signal with a copy that is slightly out of phase with the original. This means that the amplitudes of the two signals reach their highest and lowest points at slightly different times. The timing differences between the two signals are modulated by two independent LFOs. In addition, Phaser includes a filter circuit and a built-in envelope follower that tracks volume changes in the input signal, generating a dynamic control signal. This control signal alters the sweep range.

Sonically, phasing is used to create whooshing, sweeping sounds that wander through the frequency spectrum. It is a commonly used guitar effect, but it is suitable for a range of signals.

To add Phaser to your project, choose Modulation > Phaser in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Phaser parameters

- **Stages knob and field**: Choose phaser algorithms (even numbers) or comb filtering (odd numbers).
  - The 4, 6, 8, 10, and 12 settings switch between five different phaser algorithms. All are modeled on analog circuits, with each designed for a specific application.
  - The 5, 7, 9, and 11 settings don’t generate actual phasing effects. The more subtle comb filtering effects produced by odd-numbered settings can, however, be useful.
- **Sweep Mode pop-up menu**: Choose a mode that determines the impact of incoming signal levels on the frequency range. Set the frequency range with the Ceiling and Floor controls.
- **Ceiling/Floor sliders and fields**: Determine the frequency range affected by LFO modulations. Drag the green slider area between Ceiling and Floor to move the entire range.
- **Rate 1/2 knobs and fields**: Set the speed for each LFO.
- **Sync buttons**: Synchronize the modulation speed of each LFO with the project tempo. Choose musical note values with the Rate 1 and Rate 2 knobs.
- **Phase knob and field**: Control the phase relationship between individual channel modulations. Available only in stereo and surround instances. At 0°, extreme modulation values are achieved simultaneously for all channels. At 180° or −180°, there is the greatest possible distance between channel modulation phases.
- **(LFO) Mix slider and fields**: Determine the ratio between the two LFOs.
• **Distribution pop-up menu:** Choose how phase offsets between individual channels are distributed in the surround field. Choose from: circular, left↔right, front↔rear, random, and new random. Available only in surround instances.

  *Note:* When you load a setting that uses the “random” option, the saved phase offset value is recalled. If you want to randomize the phase setting again, choose “new random” from the Distribution pop-up menu.

• **Level knob and field:** Determine the amount of effect signal routed back to the input.

• **Warmth button:** Enable or disable a distortion circuit, suitable for warm overdrive effects.

• **Low/High Cut sliders and fields:** Set the cutoff frequency of the lowpass (LP) and highpass (HP) filters.

• **Filter button:** Enable or disable the filter section.

• **(Out) Mix slider and field:** Determine the balance of dry and wet signals. Negative values result in a phase-inverted mix of the effect and direct (dry) signal.

### Ringshifter

**Ringshifter overview in Logic Pro for Mac**

Ringshifter combines a ring modulator with a frequency shifter effect in a clear, compact interface. Both effects were popular during the 1970s and are currently experiencing a renaissance.

The ring modulator modulates the amplitude of the input signal using either the internal oscillator or a side chain signal. The frequency spectrum of the resulting effect signal equals the sum of, and the difference between, the frequency content in the two original signals. Its sound is often described as **metallic** or **clangorous**.

The frequency shifter moves the frequency content of the input signal by a fixed amount and thereby alters the frequency relationship of the original harmonics. The resulting sounds range from sweet and spacious phasing effects to robot-like timbres.

*Note:* Do not confuse frequency shifting with pitch shifting. Pitch shifting transposes the original signal, leaving its harmonic frequency relationship intact.

To add Ringshifter to your project, choose Modulation > Ringshifter in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Ringshifter interface in Logic Pro for Mac

The Ringshifter interface consists of six main sections.

- **Mode buttons:** Determine whether Ringshifter operates as a frequency shifter or a ring modulator. See [Set the Ringshifter mode](#).
- **Oscillator parameters:** Configure the internal sine wave oscillator, which modulates the amplitude of the input signal in both of the frequency shifter modes as well as in the ring modulator OSC mode. See [Ringshifter oscillator parameters](#).
- **Delay parameters:** Delay the effect signal. See [Ringshifter delay parameters](#).
- **Envelope follower parameters:** Modulate the oscillator frequency and output signal with an envelope follower. See [Use the Ringshifter envelope follower](#).
- **LFO parameters:** Modulate the oscillator frequency and output signal with an LFO. See [Use the Ringshifter LFO](#).
- **Output parameters:** Set feedback, stereo width, and the amount of dry and wet signals. See [Ringshifter output parameters](#).

Set the Ringshifter mode in Logic Pro for Mac

The four mode buttons determine whether the Ringshifter operates as a frequency shifter or as a ring modulator.
Ringshifter mode parameters

- **Single Freq Shift button**: Turn on to generate a single, shifted effect signal. The oscillator Frequency control determines whether the signal is shifted to a positive value on the right side of the Frequency knob or to a negative value on the left side.

- **Dual Freq Shift button**: Turn on to produce one shifted effect signal for each stereo channel—one is shifted up, the other is shifted down. The oscillator Frequency control determines the shift direction towards the left or the right channel.

- **OSC Ring Mod button**: Enable to use the internal sine wave oscillator to modulate the input signal.

- **Side Chain Ring Mod button**: Enable to modulate the amplitude of the input signal with the audio signal assigned via the side chain input. The sine wave oscillator is switched off, and the Frequency controls are disabled when Side Chain mode is active.

Ringshifter oscillators in Logic Pro for Mac

In both frequency shifter modes and ring modulator OSC mode, the internal sine wave oscillator is used to modulate the amplitude of the input signal.

- In the frequency shifter modes, the Frequency parameter controls the amount of frequency shifting, either up or down, applied to the input signal.

- In the ring modulator OSC mode, the Frequency parameter controls the frequency content, or timbre, of the resulting effect. This timbre can range from subtle tremolo effects to clangorous metallic sounds.

Oscillator parameters

- **Frequency control**: Set the frequency of the sine oscillator.

- **Linear/Exponential buttons**: Switch the scaling of the Frequency control.
  - **Lin**: Linear scaling is even across the entire control range.
  - **Exp**: Exponential scaling offers extremely small increments around the 0 point, which is useful for programming slow-moving phasing and tremolo effects.

- **Env Follow slider and field**: Determine the impact of incoming signal levels on the oscillator modulation depth.

- **LFO slider and field**: Determine the amount of oscillator modulation by the LFO.
Ringshifter delay parameters in Logic Pro for Mac

The effect signal is routed through a delay, following the oscillator.

Delay parameters

- **Time knob and field**: Set the delay time. You can choose from: hertz values, when running freely, or note values, including triplet and dotted notes, when the Sync button is active.
- **Sync button**: Synchronize the delay with the project tempo. You can choose musical note values with the Time knob.
- **Level knob and field**: Set the level of the delay added to the ring-modulated or frequency-shifted signal. A Level value of 0 passes the effect signal directly to the output (bypass).
- **Delay Low/High Cut sliders and fields**: Click the disclosure arrow at the lower left of the interface to access these extended parameters. Cut frequencies below the Low Cut value and above the High Cut value to shape the sound of delay repeats with highpass and lowpass filters. The filters are located in the feedback circuit, which means that the filtering effect increases in intensity with each delay repeat. If you want an increasingly muddy and confused tone, move the High Cut slider toward the left. For ever thinner echoes, move the Low Cut slider toward the right.

Ringshifter envelope follower in Logic Pro for Mac

The oscillator Frequency and Dry/Wet parameters can be modulated with the internal envelope follower—and the LFO (see Use the Ringshifter LFO). The oscillator frequency even allows modulation through the 0 Hz point, thus changing the oscillation direction.

The envelope follower analyzes the amplitude (volume) of the input signal to create a continuously changing control signal—a dynamic volume envelope of the input signal. This control signal can be used for modulation purposes.
Envelope Follower parameters

- *Power button:* Turn the envelope follower on or off. When it is turned on, you can access the following parameters.
- *Sensitivity slider and field:* Determine how responsive the envelope follower is to the input signal. At lower settings, the envelope follower reacts only to the most dominant signal peaks. At higher settings, the envelope follower tracks the signal more closely but may react less dynamically.
- *Attack slider and field:* Set the response time of the envelope follower.
- *Decay slider and field:* Set the time it takes the envelope follower to return from a higher to a lower value.

Use the Ringshifter LFO in Logic Pro for Mac

The oscillator Frequency and Dry/Wet parameters can be modulated with the LFO—and the envelope follower (see Use the Ringshifter envelope follower). The oscillator frequency even allows modulation through the 0 Hz point, thus changing the oscillation direction. The LFO produces continuous, cycled control signals.

LFO parameters

- *Power button:* Turn the LFO on or off. When it is turned on, you can access the following parameters.
- *Symmetry/Smooth sliders and fields:* Change the shape of the LFO waveform.
- *Waveform display:* Shows changes to the LFO waveform shape.
- *Rate knob and field:* Set the waveform cycle speed of the LFO.
- *Sync button:* Synchronize the LFO rate with the project tempo, using musical note values.
Ringshifter output parameters in Logic Pro for Mac

Ringshifter output parameters set the balance between the effect and input signals and also set the width and feedback level.

Output parameters

- **Dry/Wet knob and field**: Set the mix ratio of the dry input signal and the wet effect signal.
- **Feedback knob and field**: Set the amount of signal routed back to the effect input. Feedback adds an edge to the Ringshifter sound and is used for a variety of special effects.
  - Feedback, in combination with a slow oscillator sweep, produces a rich phasing sound.
  - A high Feedback setting with a short delay time of less than 10 ms produces comb-filtering effects.
  - A high Feedback setting with a longer delay time produces continuously rising and falling frequency shift effects.
- **Stereo Width knob and field**: Determine the breadth of the effect signal in the stereo field. Stereo Width affects only the effect signal of the Ringshifter, not the dry input signal.
- **Env Follow slider and field**: Determine the amount of Dry/Wet parameter modulation by the input signal level.
- **LFO slider and field**: Set the LFO modulation depth of the Dry/Wet parameter.

Rotor Cabinet effect

Rotor Cabinet effect in Logic Pro for Mac

The Rotor Cabinet effect emulates the rotating loudspeaker cabinet of a Hammond organ. Also known as the Leslie effect, it simulates both the rotating speaker cabinet, with and without defectors, and the microphones that pick up the sound. You have full control of the Rotor Cabinet effect motor controls and can choose from a range of microphone types.
To add Rotor Cabinet to your project, choose Modulation > Rotor Cabinet in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Basic Rotor Cabinet parameters

- **Rotation switch**: Change the rotor speed between Slow, Brake, or Fast.
- **Cabinet Type pop-up menu**: Choose a cabinet model.
  - **Wood**: Mimics a Leslie with a wooden enclosure. It sounds like the Leslie 122 or 147 model.
  - **Proline**: Mimics a Leslie with a more open enclosure, similar to a Leslie 760 model.
  - **Single**: Simulates the sound of a Leslie with a single, full-range rotor. It sounds like the Leslie 825 model.
  - **Split**: Routes the bass rotor signal slightly to the left and the treble rotor signal toward the right.
  - **Wood & Horn IR**: Uses an impulse response of a Leslie with a wooden enclosure.
  - **Proline & Horn IR**: Uses an impulse response of a Leslie with a more open enclosure.
  - **Split & Horn IR**: Uses an impulse response of a Leslie with the bass rotor signal routed slightly to the left and the treble rotor signal routed more to the right.
- **Deflector switch**: Click to emulate a Leslie cabinet with the horn deflectors removed or attached. A Leslie cabinet contains a double horn, with a deflector at the horn mouth. This deflector makes the Leslie sound. You can remove the deflector to increase amplitude modulation and decrease frequency modulation.
Rotor Cabinet motor controls in Logic Pro for Mac

The Rotor Cabinet effect provides the following motor control parameters.

Motor parameters

- **Acceleration knob**: Set the time it takes to get the rotors up to speed (set with the Max Rate knob) and the length of time it takes for them to slow down. The Leslie motors need to physically accelerate and decelerate the speaker horns in the cabinets, and their power to do so is limited. Turn Acceleration to the far left position to switch to the preset speed immediately. As you rotate the knob to the right, it takes more time to hear the speed changes. At the default centered position, the behavior is Leslie-like.

- **Max Rate knob**: Set the maximum possible rotor speed.

- **Motor Control pop-up menu**: Choose different speeds for the bass and treble rotors. Use the Rotation switch to choose slow, brake, or fast mode.
  - **Normal**: Both rotors use the speed determined by the Rotation switch position.
  - **Inv (inverse)**: In fast mode, the bass compartment rotates at a fast speed, while the horn compartment rotates slowly. This is reversed in slow mode. In brake mode, both rotors stop.
  - **910**: The 910 (also known as “Memphis”), stops the bass drum rotation at slow speed, while the speed of the horn compartment can be switched. This is useful when you're after a solid bass sound but still want treble movement.
  - **Sync**: The acceleration and deceleration of the horn and bass drums are roughly the same. This sounds as if the two drums are locked, but the effect is clearly audible only during acceleration or deceleration.

*Note*: If you choose Single Cabinet from the (Cabinet) Type pop-up menu, the Motor Control setting is not relevant because there are no separate bass and treble rotors in a single cabinet.
Rotor Cabinet microphone types in Logic Pro for Mac

The Rotor Cabinet effect provides modeled microphones that pick up the sound of the Leslie cabinet. You can specify the microphone type with these parameters. Also see Rotor Cabinet mic controls.

- **Upper/Lower Microphones**: Choose a microphone type for the horn and drum speakers when Real Cabinet is chosen in the Type pop-up menu. See Rotor Cabinet effect overview.

- **Dynamic**: Emulates the sound of a dynamic cardioid microphone. This microphone type sounds brighter and more cutting than the Condenser mic.

- **Condenser**: Emulates the sound of a studio condenser microphone. The sound of condenser microphones is fine, transparent, and well-balanced.

- **Mid-Side Mic**: A Middle and Side (MS) configuration where two microphones are positioned closely together. One is a cardioid (or omnidirectional) microphone that directly faces the cabinet—in a straight alignment. The other is a bidirectional microphone, with its axes pointing to the left and right of the cabinet at 90° angles. The cardioid microphone captures the middle signal to one stereo side. The bidirectional microphone captures the side signal to the other stereo side.
Rotor Cabinet mic controls in Logic Pro for Mac

The Rotor Cabinet effect provides the following microphone processing parameters.

Mic processing parameters

- **Mic Position switch**: Choose either the front or rear position for the virtual microphone. See [Rotor Cabinet effect microphone types](#).
- **When Real Cabinet is chosen in the Type pop-up menu**:
  - **Horn knob**: Set the stereo width of the Horn deflector microphone.
  - **Drum knob**: Set the stereo width of the Drum deflector microphone.
- **When other cabinets are chosen in the Type pop-up menu**:
  - **Distance knob and field**: Determine the distance of the virtual microphones (the listening position) from the emulated speaker cabinet. Turn to the right for a darker and less defined sound.
  - **Angle knob and field**: Define the stereo image, by changing the angle of the simulated microphones between 0 and 180 degrees.
  - **Balance knob and field**: Set the balance between the horn and drum microphone signals.

Scanner Vibrato effect in Logic Pro for Mac

Scanner Vibrato simulates the scanner vibrato section of a Hammond organ. Scanner Vibrato is based on an analog delay line consisting of several lowpass filters. The delay line is scanned by a multipole capacitor that has a rotating pickup. It is a unique effect that cannot be simulated with simple LFOs.

You can choose between three different vibrato and chorus types. The stereo version of the effect features two additional parameters—Stereo Phase and Rate Right. These set the modulation speed independently for the left and right channels.

To add Scanner Vibrato to your project, choose Modulation > Scanner Vibrato in a channel strip Audio Effect plug-in menu. See [Add, remove, move, and copy plug-ins](#).
Scanner Vibrato parameters

- **Type knob:** Choose from three Vibrato positions (V1, V2, and V3) or three Chorus positions (C1, C2, and C3).
  - In each of the Vibrato positions, only the delay line signal is heard. Each vibrato type has a different intensity.
  - In the three Chorus positions (C1, C2, and C3), the signal of the delay line is mixed with the original signal. Mixing a vibrato signal with an original, statically pitched signal results in a chorus effect. This organ-style chorus sounds different from the Chorus plug-in.
  - In the C0 setting, neither the chorus nor the vibrato is enabled.
- **Depth knob and field:** Set the intensity of the chosen chorus effect type. If a vibrato effect type is chosen, this parameter has no effect.
- **Stereo Phase knob and field:** Determine the phase relationship between left and right channel modulations. If you set the knob to free, you can set the modulation speed of the left and right channels independently.
- **Rate Left knob and field:** Set the modulation speed of the left channel when Stereo Phase is set to free. If Stereo Phase is set to a value between 0° and 360°, Rate Left sets the modulation speed for both the left and right channels. The Rate Right knob has no function when in this mode.
- **Rate Right knob and field:** Set the modulation speed of the right channel when Stereo Phase is set to free.

Spreader effect in Logic Pro for Mac

Spreader widens the stereo spectrum of a signal by periodically shifting the frequency range of the original signal, thus changing the perceived width of the signal. You can also use Spreader to specify the delay between channels in samples, which adds to the perceived width and channel separation of a stereo input signal.

To add Spreader to your project, choose Modulation > Spreader in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

![Spreader Parameters](image)

**Spreader parameters**

- **Rate knob and field:** Set the speed of the integrated LFO.
- **Intensity knob and field:** Set the modulation amount.
- **Channel Delay knob and field:** Set the delay time in samples.
- **Mix knob and field:** Set the balance between the effect and input signals.
Tremolo effect in Logic Pro for Mac

Tremolo modulates the amplitude of the incoming signal, resulting in periodic volume changes. Tremolo is commonly used in vintage guitar combo amps, where it is sometimes incorrectly referred to as *vibrato*. The graphic waveform display shows all parameters except Rate.

To add Tremolo to your project, choose Modulation > Tremolo in a channel strip Audio Effect plug-in menu. See *Add, remove, move, and copy plug-ins*.

Tremolo parameters

- **Sync button**: Synchronize the modulation speed with the project tempo. Choose musical note values with the Rate knob.
- **Rate knob and field**: Set the frequency of the LFO.
- **Depth knob and field**: Determine the modulation amount.
- **Smoothing slider and field**: Change the shape of the LFO waveform. Also see Symmetry.
- **Distribution pop-up menu**: Choose how phase offsets between individual channels are distributed in the surround field. Choose from: circular, left↔right, front↔rear, random, and new random. Available only in surround instances.
- **Offset field**: Set the amount of left or right movement for the modulation (cycle). This results in small or large tremolo variations.
- **Symmetry field**: Skew the balance toward the upward or downward phase of waveform cycles.

  *Note:* If Symmetry is set to 50% and Smoothing to 0%, the LFO waveform becomes rectangular. The timing of the highest volume signal is then equal to the timing of the lowest volume signal, with the switch between both states occurring abruptly.

- **Phase field**: Control the phase relationship between individual channel modulations in stereo or surround signals. At 0, modulation values are reached simultaneously for all channels. At values of 180 or −180, there is the greatest possible distance between the modulation phases of the channels.
- **Waveform display**: Shows and lets you edit modulation Offset, Symmetry, and Phase.

- Modulation is represented by a repeating waveform cycle for each channel. The height represents the LFO intensity, or depth. Adjust the Depth knob to change. Two green handles and two blue handles let you control Offset, Symmetry, and Phase values.

- **Offset**: Drag the field or the green handle at the left of any waveform cycle to set left or right modulation movement.

- **Symmetry**: Drag the field or the green handle at the right of any waveform cycle to set the balance between upward or downward waveform phases.

- **Phase**: Drag the field or either blue handle of any waveform cycle to control phase relationship between channel modulations.
Multi effects

Multi effects in Logic Pro for Mac

The multi-effect units provide a one-stop solution for a number of musical situations where you need to highlight or enhance a musical part or song section. The included multi-effect processors can be used subtly or traditionally, but they are truly creative tools that excel at transforming your music.

- Beat Breaker is an audio plug-in that reorders incoming audio in real time, allowing you to slice up your audio, rearrange it, and add scratching effects. Not only can you use it to play back audio in a different slice order, but you can also set the speed, direction, and volume with a given number of repeats. See Beat Breaker.

- Phat FX is a “coloring” multi-effect unit designed primarily for use with drum, bass, and guitar parts. It can add warmth, punch, and presence, along with some heavy distortion if you want it. You can use it with any type of signal that needs some extra “flavor.” See Phat FX overview.

- Step FX is a multi-effect unit that provides deep modulation control, courtesy of three independent built-in 128-step modulators. It can be used with any type of signal and is capable of subtle or heavy rhythmic enhancements to musical parts, dance-floor gating effects, and warped manipulations that can turn your audio and instrument tracks into something completely new. See Step FX overview.

- Remix FX is a flexible multi-effect unit that combines several DJ-style effects, such as a filter, gater, downsampler, reverse, scratch, tape stop, and more. It’s designed primarily for use on the stereo bus to give electronic-style music a live dance-floor groove, but you can use it on any type of signal. See Remix FX.

Phat FX and Step FX settings are compatible with Camel Audio CamelPhat and CamelSpace settings. This lets you replace instances of the Camel Audio plug-ins with Phat FX or Step FX.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.
Replace Camel Audio CamelPhat or CamelSpace with Phat FX or Step FX on a track

1. In Logic Pro, select the track with the Camel Audio CamelPhat or CamelSpace plug-in.

2. In the channel strip for the selected track, place the pointer over the effect slot containing Camel Audio CamelPhat or CamelSpace, then choose Phat FX or Step FX from the pop-up menu.

   The new instance automatically retains your Camel Audio CamelPhat or CamelSpace settings.

   Note: Because of updates to Phat FX and Step FX controls and features, patches might not sound exactly the same as they did in Camel Audio CamelPhat and CamelSpace. Also, automation doesn’t carry over to Phat FX and Step FX.

Beat Breaker

Beat Breaker in Logic Pro for Mac

Beat Breaker is an audio plug-in that reorders incoming audio in real time, allowing you to slice up your audio, rearrange it, and add scratching effects. Not only can you use it to play back audio in a different slice order, but you can also set the speed, direction, and volume with a given number of repeats for each slice. All these slice playback features define patterns that you can change on the fly.

Beat Breaker is not just an effect you add to a track but an effect you can perform with onstage or in the studio. This unique plug-in excels at EDM and hip-hop, and it can help you overcome “writer’s block” during production. In addition, it’s great for coming up with new ideas for your beats and subsequent variations.

To add Beat Breaker to your project, choose Multi Effects > Beat Breaker in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
When you open Beat Breaker, it displays the Main Editor, which consists of three sections:

- The upper section contains the Edit Mode buttons, which you can use to select the types of effects you want to add to a slice. When you click a slice, its effect parameters become visible in the middle section, and you can drag them to change values. In addition, the upper section contains parameters such as Length, De-click, and Mix that you can use to fine-tune your pattern.

- The middle section contains the input buffer on the left, which displays the incoming audio. In the center is the audio waveform, where you can use gestures on your trackpad or drag on slices to change the effect parameters. Above the audio waveform is the Slice Editor strip, where you can add, delete, and move slices using slice markers. See Create a Beat Breaker pattern.

- The lower section contains the Pattern buttons for quickly switching between patterns and accessing the Pattern Slot menu, which you can use to load, save, and rename patterns in each pattern slot. See Work with pattern slots.

Beat Breaker Main Editor in Logic Pro for Mac

The Main Editor is the working area of Beat Breaker and where you can interact with its effects. On the far left, incoming audio enters the input buffer. In the center, the output waveform is visible, and slices represent where you can add effects to the audio. These slices are flexible; you can add, delete, and move them in relation to the Snap value using slice markers in the Slice Editor strip situated above the output waveform.

There are three types of effects, or edit modes: Time, Repeat, and Volume. You can select an effect using the Edit Mode buttons. When selected, each mode appears as a color: Time mode is orange, Repeat mode is magenta, and Volume mode is yellow.

When you select an edit mode and click a slice, the parameters for the selected slice are visible at the top of the Main Editor. You can adjust a parameter level by directly dragging the parameter value sliders or by using gestures on your trackpad.

When you click the slices in Time mode, a mapping line indicates which instant in the input buffer will play back in the output pattern, allowing you to select how to “chop” your audio and change its speed. You can use Repeat mode to add up to eight repetitions of the selected slice to create stutter effects, the rhythmic repetition of small audio fragments. With Volume mode, you can change the volume over the duration of a slice to create swells and changes in dynamics.
Finally, you use the Pattern Slot menu to save and organize your patterns. See Work with pattern slots.

Main Editor parameters

- **Edit Mode buttons**: Choose an edit mode to customize slice playback: Time for position and speed, Repeat for repetition frequency, and Volume for playback volume. See Edit modes.
  - **Time button**: Change the input position and speed of a slice. See Time mode parameters.
  - **Repeat button**: Change the number of repetitions for a slice to create stutter effects. See Repeat mode parameters.
  - **Volume button**: Change the volume of a slice. See Volume mode parameters.
- **Input buffer**: During playback, the input buffer displays the incoming audio, and its playhead shows which part of the input buffer is currently playing.
- **Slice Editor strip**: This area contains slice markers. Here you can add, move, and delete slice markers for the selected pattern. See Work with Beat Breaker slices.
- **Output Beat**: Set the position of the selected slice marker. This defines the beat at which the input beat is played back. See Move a slice.
- **Global controls**: A collection of controls such as Length, De-click, and Mix that you can use to fine-tune your pattern.
  - **Length menu**: Set the length of the current pattern in beats.
  - **De-click value**: Reduce clicks at locations where the playhead jumps by having a fast fade-out and fade-in. Decrease the value to hear more hard-hitting transients. Increase the value to remove audio clicks.
  - **Mix value**: Control the balance between the original and processed audio signals. Set to 100% to hear only the processed signal.
• **More button:** Choose how quantized values are used when setting parameters on the Slice Editor strip.

• **Snap Output Beat:** Set the snap value for the Output Beat parameter, allowing precise adjustment of parameters to quantized values when editing slices on the Main Editor.

• **Snap Input Beat:** Set the snap value for the Input Beat parameter, allowing precise adjustment of parameters to quantized values when editing slices on the Main Editor.

• **Snap Speed:** Set quantized values for the Speed parameter in the Main Editor, with Time for musical divisions, Pitch for semitone increments, and Off for no snapping.

• **Pattern buttons:** Select a new preset pattern, or use Pattern Off to turn off all pattern effects. Each Pattern button contains settings for Time mode, Repeat mode, Volume mode, and Length. You can use Pattern buttons to quickly switch Beat Breaker settings while performing or a recording.

• **Pattern Slot Edit button:** Turn on/off Pattern Slot Edit mode. In this mode, you can use the Pattern pop-up menu to load, save, and rename patterns in each pattern slot. See Work with pattern slots.

### Create a Beat Breaker pattern in Logic Pro for Mac

Here’s an overview of the pattern-making process in Beat Breaker:

• Select the Pattern Slot Edit button to enter Pattern Slot Edit mode.

• Select a Pattern button, then click Recall Default to reset the pattern to its default settings. See Work with pattern slots.

• Select an edit mode (Time, Repeat, or Volume). See Edit modes.

• Click a slice and and drag to change effect parameters for each edit mode. See Work with slices.

• Set values such as Pattern Length, De-click, and Mix to fine-tune your pattern. See Main Editor parameters.

• Select the Pattern Slot Edit button to organize and save your patterns. See Work with pattern slots.

### Edit modes

Use the Edit Mode buttons (Time, Repeat, and Volume) to switch between each effect type. When you select a mode, you can see the slices and lines representing the effects. When you select a slice, the Main Editor updates to display its effect parameters, and you can adjust their values by clicking and dragging.

• **Time button:** Select Time mode to change the input beat and speed of a slice. See Time mode.
• *Repeat button:* Select Repeat mode to change the number of repetitions for a slice. See Repeat mode.

• *Volume button:* Select Volume mode to change the volume of a slice. See Volume mode.

**Time mode in Logic Pro for Mac**

Using Time mode in Beat Breaker, you can change the Input Beat, Speed, and Curve parameter for each slice using your mouse or trackpad.

• Click the Time button to select Time mode.

![Time mode parameters](image)

**Time mode parameters**

• *Input Beat:* Set the start position of the selected slice. By changing the start position of slices, you can “chop up” your audio and rearrange it.

• *Speed:* Change the speed of the selected slice. Negative values play the audio in reverse.

• *Curve:* Change the speed of playback throughout the selected slice.

**Set the Input Beat parameter**

• Select a slice, then drag up or down or adjust the Input Beat value.

**Set the Speed parameter**

• Select a slice, then drag left or right or adjust the Speed value.

**Set the Curve parameter**

• Select a slice, press command, then drag up or down or adjust the Input Beat value.
Repeat mode in Logic Pro for Mac

Using Repeat mode in Beat Breaker, you can set the number of repeats for a slice. Repeat mode is useful for creating repetitions and stutter effects.

- Click the Repeat button to select Repeat mode.

Repeat mode parameters

- **Repeats**: Set the number of repeats for the selected slice. You can add up to eight repeats per slice.

Set the Repeats parameter

- Click a slice and drag the Repeats value up or down.

Volume mode in Logic Pro for Mac

Using Volume mode in Beat Breaker, you can set the Volume, Slope, and Curve values of a slice.

- Click the Volume button to select Volume mode.
Volume mode parameters

- **Volume**: Change volume for the selected slice.
- **Slope**: Change volume over time for the selected slice.
- **Curve**: Change the curve of the volume ramp over time for the selected slice.

**Set the Volume parameter**

- Select a slice, then drag up or down or adjust the Volume value.

**Set the Slope parameter**

- Select a slice, then drag left or right or adjust the Slope value.

**Set the Curve parameter**

- Select a slice, press command, then drag up or down or adjust the Curve value.

---

Work with Beat Breaker slices in Logic Pro for Mac

The Slice Editor strip lets you create, move, and delete slices. You can add up to 32 slice markers per pattern.

**Create a slice**

- Click the Slice Editor strip to create a new slice marker.

**Move a slice**

- Drag the slice marker to the left or right.

  🔄 **Tip**: To snap the movement of slices, click the More button, then choose a Snap Output Beat value.

**Delete a slice**

- Double-click the slice handle to delete a slice marker.

---

Work with pattern slots in Logic Pro for Mac

In Logic Pro for Mac, click the Pattern Slot Edit button to access all Beat Breaker presets and file operations.

**Pattern Slot Edit parameters**

- **Pattern Slot Edit button**: Turn on Pattern Slot Edit mode. In this mode, you can use the Pattern pop-up menu to load, save, and rename patterns in each pattern slot.
• Pattern pop-up menu: Choose a menu item to load, save, delete, copy, paste, and rename patterns.
  
  • Rename Pattern: Change the name of the current pattern.
  • Copy Pattern: Copy the current pattern.
  • Paste Pattern: Paste the copied pattern into the current slot.
  • Save Pattern: Save the current pattern settings. If you have edited an existing pattern and use this command, the existing filename is used, and the original pattern is overwritten.
  • Save Pattern As: Save the current pattern settings under a different name. Use this command when you want to save a copy or multiple versions of an edited pattern, rather than overwriting the original version.
  • Recall Default: Reset all values to their default state. This option is a good starting point when creating new patterns from scratch.
  • Delete Selected User Pattern: Delete the current user pattern.
  • Previous Pattern: Load the previous preset pattern.
  • Next Pattern: Load the next preset pattern.
  • Custom: This menu item is shown automatically when any pattern changes have been made. It can be considered the “current state” pattern preset.
  • Preset pattern list: Choose a pattern from the list of presets.
  • User: Contains a list of all your saved patterns.

Load a pattern
1. Click the Pattern Slot Edit button.
2. Click a Pattern button, then choose a pattern from a folder.

Save a pattern
1. Click the Pattern Slot Edit button.
2. Click the button of the pattern you’re currently editing, then click Save Pattern.
   
   Note: All of your saved patterns are stored in the User folder.

Delete a user pattern
1. Click the Pattern Slot Edit button.
2. Click a Pattern button, then click the pattern you want to delete from the User folder.
3. Click the Pattern button again, then click Delete Selected User Pattern.
   
   Note: You can only delete a user pattern after selecting it from the User folder.

Rename a pattern
1. Click the Pattern Slot Edit button.
2. Click a Pattern button, then click Rename Pattern.
3. Enter a new name for the pattern, then click Rename.
Recall the default pattern

1. Click the Pattern Slot Edit button.

2. Click a Pattern button that you want to reset, then click Recall Default.

Phat FX

Phat FX overview in Logic Pro for Mac

Phat FX is a powerful “coloring” multi-effect unit designed primarily for use with drum, bass, and guitar parts, adding warmth, punch and presence where required. It can, of course, be used with any type of signal. Phat FX combines several effect processors, filters, and modulators in a flexible tool that can be used to quickly enhance your projects.

Three distortion units are included, which can be used separately or blended together to create an endless variety of tones.

The bass enhancer and bandpass filter circuits can be used to enhance low end frequencies, making for great kick drum and bass guitar sweetening.

In addition, an easy-to-use multi-modeled compressor, a multimode resonant filter, and a modulation effect unit are included.

Two LFOs and an envelope follower, coupled with the assignable XY pad allow powerful automatic and real-time manipulation of the most important parameters.

Phat FX processors work in series—where the output of one effect is fed into the next in an effects chain. The routing order lets you choose whether a distorted signal should be filtered or the filtered sound should be distorted, for example.

Horizontally drag the name of the effect in the Effects order strip at the bottom of the window to determine the order of the effects chain.

To add Phat FX to your project, choose Multi Effects > Phat FX in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Phat FX processors in Logic Pro for Mac

The parameters of all Phat FX processors are described in the respective sections below.

Bandpass parameters

The Bandpass unit passes the portion of a signal occupying a band surrounding the cutoff frequency and rolls off the portions above and below that band. The Reject Mix knob lets you restore (mix in) the signal that was not band passed at the Bandpass unit position within the overall signal chain. This allows you to apply one or more effects to a specific frequency range only, leaving other frequencies unchanged.

- **On/Off button:** Enable/disable the bandpass filter.
- **Type pop-up menu:** Choose a filter characteristic. Each option provides a different tonal color and response to High and Low Res control values.
- **Low/High sliders and fields:** Set the lowest and highest frequencies allowed to pass by the filter. Frequencies outside these boundaries are cut.

  The length of the horizontal orange bar represents the frequency range. The handles on the left and right ends of the bar set the Low and High frequency values. You can move the entire frequency range by dragging the bar. You can also drag in the numeric fields above the bar to adjust the frequency values.

- **Low/High Res knobs and fields:** Determine the basic sonic character of filtering around the low and high frequencies set with the Low/High sliders. Higher Res settings emphasize the frequency, resulting in a sharper, brighter character. Lower Res settings result in a softer character.

- **Reject Mix knob:** Mix in (restore) the signal that was not band passed at the Bandpass unit position within the signal chain.

Filter parameters

The filter unit provides dozens of filter types. See Phat FX filter types.

- **On/off button:** Enable/disable the filter effect.
- **Type pop-up menu:** Choose a filter characteristic. Each option provides a different tonal color and response to Cutoff, Drive, and Res control values.

  **Note:** The chosen filter type can alter the names and functions of the default Cutoff, Res, and Drive knobs.
• **Cutoff knob and field:** Set the cutoff frequency for the filter. Higher frequencies are attenuated and lower frequencies are allowed to pass in a lowpass (LP) filter. The reverse is true in a highpass (HP) filter. When in a bandpass (BP) mode, cutoff determines the center frequency of the band that is allowed to pass. The comb and other filter types change the names and behaviors of the filter controls.

• **Res knob and field:** Boost or cut signals in the frequency band that surrounds the cutoff frequency.

• **Drive knob and field:** Overdrive the filter. This can lead to intense distortions, depending on filter type.

• **Mix knob and field:** Set the level of the original versus filtered signal.

### Distortion parameters

The three distortion units can be used independently or combined to create a huge variety of tones.

• **On/off button:** Enable/disable the distortion effect module.

• **Amount knobs and fields:** Set the level for each of the three distortion units.

• **Type pop-up menus:** Choose a distortion characteristic for effect unit 1, 2, or 3. Each option provides a different tonal color and response.
  - Bitcrusher is a harsher-sounding digital effect.
  - Diode gently clips and saturates the tone.
  - Dirt and Grit distortion types can saturate heavily when you use higher Amount values.
  - Downsampler is a lo-fi digital effect (similar to Bitcrusher but is frequency dependent).
  - Exciter hypes and emphasizes high frequency content.
  - Scream is a classic tube distortion effect that emphasizes high frequency content.
  - Soft Saturation is a tube-like distortion effect that can warm and thicken the tone.
  - Squared can be used to hard clip the tone.
  - Tube is a classic tube distortion effect.
  - Vari Drive emulates a tube-based distortion effect that is great for clean boost.

### Mod FX parameters

The modulation unit provides four types of chorus-like effects, ranging from soft through to doubling or ensemble type processing.

• **On/off button:** Enable/disable the Mod FX unit.

• **Mix knob and field:** Set the level of the original versus modulated signal. This is a modulation amount control.

• **Rate knob and field:** Set the speed of the modulation effect.

• **Type pop-up menu:** Choose a modulation characteristic. Each option provides a different tonal color and effect depth.
Bass Enhancer parameters
Bass Enhancer boosts the signal around a defined frequency.

- **On/off button**: Enable/disable the bass enhancer effect.
- **Amount knob and field**: Set the level of the effect signal.
- **Tune knob and field**: Set the center frequency for bass enhancement. Signals surrounding this frequency are boosted.
- **Type pop-up menu**: Choose a bass enhancement characteristic. Each option provides a different tonal color and response.

Compressor parameters
The compression unit tightens up your audio by smoothing out dynamics and increasing the overall volume.

- **On/off button**: Enable/disable the compressor effect.
- **Amount knob and field**: Set the level of compression.
- **Release knob and field**: Set the time it takes for the compression circuit to stop reducing the signal.
- **Type pop-up menu**: Choose an emulated compressor circuit. The choices are Classic, Clip, Platinum, Studio VCA and FET, Classic VCA, or Vintage VCA, FET, and Opto.
  - **FET models**: Field Effect Transistor compressors are known for their fast transient response. They can deliver a clean or warmer tone (notably midrange), and can be pushed toward a "crunchy" tone on transients. FET compressors are ideal for drums, vocals, and guitars. FET compressors can only attenuate the signal.
  - **VCA models**: Voltage Controlled Amplifier compressors can respond slowly or quickly to incoming transients. They tend towards a clean tone and are suited for bass guitars and low-frequency signals. VCA compressors can attenuate or amplify the signal.
  - **Opto model**: Optical compressors are known for their fast transient response and non-linear release handling. They are very clean and are ideal for vocals and guitars.

Phat FX modulators in Logic Pro for Mac
Phat FX modulators provide automatic control of Phat FX processor parameters. The parameters of all Phat FX modulators are described in the respective sections below.
Changes by modulator parameters are reflected by blue rings and dots around target parameter knobs, making it easy to identify a target parameter that is being modulated. The rings indicate the range (modulation depth) and the dots indicate the current value of the modulator. Real time, manual XY pad modulation is also indicated in a similar way for target parameters.

![Modulation visualization with rings and dots around knobs]

**Envelope follower parameters**

The envelope follower tracks incoming signal levels and generates a control signal that is used to modulate other Phat FX parameters.

A common use of the envelope follower is to track a side chain input signal that is used to control filter parameters.

- **On/Off button**: Enable/disable the envelope follower.
- **Target pop-up menu**: Choose a modulation target from any active effect processor or master control.
- **Attack knob**: Determine how quickly the envelope follower reacts to rising signal levels (transients).

  Longer attack times result in a slower tracking response to transients—level spikes—of the input signal. A long attack time on percussive input signals, such as a spoken word or hi-hat part, translates into a less accurate analysis.

- **Release knob**: Determine how quickly the envelope follower reacts to falling signal levels, following the initial transient spike.

  Longer release times cause the analyzed input signal transients to sustain for a longer period at the envelope follower output. A long release time on percussive input signals, such as a spoken word or hi-hat part, translates into a less accurate analysis. Use of extremely short release times can result in "choppy" sounds, depending on the chosen modulation target.

- **Depth knob**: Set the modulation amount. This determines the intensity of the control signal sent from the envelope follower.

  At a value of 100%, with a sine wave, white noise, or another signal that frequently reaches zero dB (and Attack set to zero), the output signal will reach the maximum amount. Most signals, however, are quieter than this and won’t reach zero dB, so the extra Depth knob range between 100%-1000% is useful for making the envelope effect sufficiently sensitive on quieter signals. When loading presets which use the envelope follower, you should experiment with the Depth parameter.
LFO 1/2 parameters

• *On/off button:* Enable/disable LFO 1 or 2.

• *Waveform pop-up menu:* Set the waveform type used by LFO 1 or 2.

• *Target pop-up menu:* Choose a modulation target from any active effect processor or master control for LFO 1 or 2.

• *LFO Rate knob and field:* Set the modulation speed of LFO 1 or 2. Values are in hertz—cycles per second. When the Sync button is on, bar/beat values—synchronized with the host tempo—are shown.

• *Sync button:* Enable or disable synchronization of LFO 1 or 2 with the host application.

  *Note:* The ability to use synchronous bar values could be used to perform a filter sweep every four bars on a cycled one-bar percussion part, for example. Alternatively, you could perform the same filter sweep on every eighth-note triplet within the same part. Either method can generate interesting results.

• *Depth knob:* Set the amount of LFO 1 or 2 modulation.

Phat FX global controls in Logic Pro for Mac

The XY pad provides real-time control of up to four target parameters. Drag the blue control point to simultaneously modulate your targets. The parameters of the XY pad and the Master controls are described in the respective sections below.

XY pad parameters

Changes to XY pad Target pop-up menus are reflected by blue rings and dots around target parameter knobs, which make it easy to identify a target parameter. The rings indicate the modulation range and the dots indicate the current value of the XY pad modulation.

- *XY pad:* Drag horizontally or vertically to change the value of the assigned X or Y target parameters.

- *On/off buttons:* Enable/disable the X or Y controller.

- *X Target pop-up menus:* Choose one or two modulation targets from any active effect processor, modulation source, or master control section.

- *X Depth fields:* Set the modulation amount/range for the chosen X target(s).

- *Y Target pop-up menus:* Choose one or two modulation targets from any active effect processor, modulation source, or master control section.

- *Y Depth fields:* Set the modulation amount/range for the chosen Y target(s).
Master controls

- **Limiter pop-up menu:** Choose soft or hard limiting, or turn off limiting.
- **Input knob and field:** Set the overall input level of the plug-in.
- **Mix knob and field:** Set the level of the original versus processed signal. This is essentially a wet/dry balance control.
- **Output knob and field:** Set the overall output level of the plug-in.

Effects order strip

The order and status of active and inactive effects units are indicated in the strip. Inactive effects are dimmed, and active effects are illuminated. The signal flow runs from left to right.

**Effects order strip:** Drag the name of an active (lit) or inactive (dimmed) effect horizontally to change the effects order.

Phat FX filter types in Logic Pro for Mac

Phat FX provides dozens of filter types.

**Phat FX filter types: lowpass, bandpass, highpass**

A lowpass (LP) filter passes the portion of a signal below a specified cutoff frequency and rolls off the portion above that frequency. A bandpass (BP) filter passes the portion of a signal occupying a band surrounding the cutoff frequency and rolls off the portions above and below that band. A highpass (HP) filter passes the portion of a signal above a specified cutoff frequency and rolls off the portion below that frequency.

There are multiple two-pole, four-pole, multi-pole state-variable and analog-modeled LP, BP, and HP filter designs in Phat FX, each with distinctive characteristics that you may prefer for a given purpose. The available LP, BP, and HP filter designs include Smooth, Edgy, Rich, Sharp, Clean, and Gritty variants.

- **Smooth:** Two- or multi-pole state-variable filters.
- **Edgy:** Two- or four-pole analog-modeled filters. Four-pole variants provide a steeper roll-off of frequencies beyond the cutoff.
- **Rich:** Two- or four-pole analog-modeled filters. Four-pole variants provide a steeper roll-off of frequencies beyond the cutoff.
- **Sharp:** Two-pole analog-modeled filters.
- **Clean:** Bi-Quad filters. These filters have no Drive option.
- **Gritty:** Two-pole filters designed to saturate heavily at higher Res and Drive settings.

The three principal filter controls have standard functions for all filter types.

- **Cutoff:** Controls the filter cutoff frequency.
- **Res(onance):** Controls the filter resonance or emphasis. Higher settings boost frequencies in the immediate vicinity of the cutoff frequency.
- **Drive:** Allows the filter to be overdriven; the precise effect varies with each filter design.
Phat FX filter types: notch and peaking

A notch filter cuts a narrow band around a resonant frequency. The remainder of the signal is affected minimally.

- **Cutoff**: Sets the frequency of the cut band.
- **Amount**: Controls the amount of attenuation.

A peaking filter boosts a narrow band around a resonant frequency. The remainder of the signal is affected minimally.

- **Cutoff**: Sets the frequency of the boosted band.
- **Gain**: Controls the amount of boost. Higher values are generally the most effective.
- **BW**: Sets the bandwidth around the cutoff frequency.

Phat FX filter types: comb filters

A comb filter mixes the original signal with one or more copies of the signal, which are delayed by a very short time interval. At some frequencies this mixture causes phase cancelations, while at other frequencies it causes reinforcements. The result is a spiky frequency spectrum with multiple resonant peaks. Graphically, these peaks resemble the teeth of a comb, which gives this filter type its name.

Phat FX offers three comb filter designs, each with its own character. The best choice depends on your preference and the type of sound you are trying to create. That said, there are some distinguishing characteristics that may help guide you.

Comb Pos uses positive feedback on the delay lines, while Comb Neg uses negative feedback to produce less extreme effects, often with a hollow quality. These two are the less powerful combs and offer a much more gradual increase in resonance. They can be useful when you require either a less dramatic effect or you want to hear more of the exciter signal character in your sound. The latter point is noteworthy as this trait can be useful when you want a more naturalistic sound.

Comb PM uses bipolar feedback on the delay lines. The resonance control is bipolar, allowing you to freely shift from negative (hollow sound) on the left to positive (bright and peaky) on the right. This comb is useful for classic bright Karplus-Strong style sounds, where the exciter impulse is not easily heard and the comb is more prominent. Take care with your resonance level because it is capable of quickly going to extremes, which can lead to feedback. Start with a resonance level of zero and increase (or decrease) slowly to find a suitable effect strength.

- **Cutoff**: Controls the delay time in the comb circuit. Lower cutoff values equate to a longer delay.
- **F-Back**: Controls the amount of feedback in the comb circuit.
- **Damp**: Softens the frequency peaks in the comb-filtered spectrum.

  **Note**: Sending a percussive sound into a highly resonant comb filter causes it to ring at a frequency determined by the delay time you have set with the Cutoff knob.
Phat FX filter types: ring modulation

Ring modulation is a process in which a modulator and a carrier signal are multiplied. Each frequency component of the modulator interacts with each frequency component of the carrier to produce two sidebands: a sum and a difference (carrier – modulator). When a filter is set to the RingMod type, the signal entering the filter acts as the modulator, while the carrier is supplied internally by the filter.

- **Frequency**: Controls the carrier frequency.
- **Mix**: Applies a constant offset to the carrier.
  - At 0%, the carrier wave varies between –1 and +1, resulting in classic ring modulation.
  - At 100%, the carrier wave varies between 0 and 1, resulting in classic amplitude modulation. In this case, the carrier signal itself is present alongside the sum and difference sidebands.

Phat FX filter types: distortion

Phat FX filters offer several distortion filter types.

- Bitcrusher is a harsher-sounding digital effect.
- Dirt is a classic tube distortion effect.
- Downsampler is a lo-fi digital effect (similar to Bitcrusher but frequency dependent).
- Grit is a transistor distortion.

The filter controls work as follows when the filter type is set to a distortion effect:

- **Amount**: Controls the intensity of the distortion effect.
- **Mix**: Controls the mix between clean and distorted signals. A 0% value results in the clean signal only. A 50% value results in an equal mix of clean and distorted signal. A 100% value results in the distorted signal only.
- **Freq**: Sets the frequency for the Downsampler distortion type.

Remix FX

Remix FX in Logic Pro for Mac

Remix FX includes a set of buttons, sliders, and XY pads you can use to control several real-time effects common to electronic and dance music. It makes it easy to scratch mix your project, much like a DJ using a turntable, to play short pieces of audio in reverse, to stop or downsample the song, and to apply a variety of other effects. It is intended mainly for use on the stereo output bus, but you can insert the plug-in on any type of signal in your project.

You can view and control Remix FX in the plug-in window or in the Smart Controls area. When you insert Remix FX on a channel strip, a Remix FX button is added to the Smart Controls menu bar for that channel.

To add Remix FX to your project, choose Multi Effects > Remix FX in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Remix FX can be fully automated so you can record, edit, and play back any movement of the Remix FX parameters as automation.

You can also control the XY pads and other parameters with MIDI controllers, assigned with Smart Controls.

Use the XY pads on the left and right to control various time-based and modulation effects. Drag the pointer horizontally (X axis) or vertically (Y axis) to set the value of the parameter shown on the bottom or left side of each pad.

**XY pad pop-up menus:** Clicking the name of the effect at the top of the XY pad opens a pop-up menu. Choose an effect type for either the left or right XY Pad.

- **Filter:** Removes frequencies above a cutoff frequency and accentuates frequencies around the resonance value. X sets the cutoff frequency and Y sets the resonance value. Click the Settings button to access the following additional parameter:
  - **Mode:** Choose between Phat, a warm-sounding filter with a 24 dB lowpass and 24 dB highpass filter, and Classic, a clean, state-variable filter with a slope of 12 dB/octave.

- **Wobble:** Modulates the audio signal through a vintage-style filter effect. X sets the modulation rate and Y sets the modulation depth. Click the Settings button to access the following additional parameter:
  - **Time:** Select from options for note division, note division with an added triplet, or a triplet of the note division.

- **Orbit:** Modulates the audio signal through a flanger effect, phaser effect, or a mix of both. X sets the modulation rate and Y sets the modulation depth. Click the Settings button to access the following additional parameter:
  - **Mode:** Choose between a phaser effect, a modulation effect that is a mix of both a phaser and flanger, or a flanger effect.

- **Repeater:** Creates a stuttering effect. X sets the repeat rate and Y sets the mix amount. Click the Settings button to access the following additional parameter:
  - **Time:** Select from options for note division, note division with an added triplet, or a triplet of the note division.

- **Reverb:** Adds ambience to your audio signal. X sets the reverb time and Y sets the mix amount. Click the Settings button to access the following additional parameter:
  - **Color:** Choose the character for the reverb. Dark rolls off the higher frequencies. Medium offers a relatively neutral ambience. Bright rolls off the lower frequencies.
• **Delay**: Adds echoes to your audio signal. X sets the modulation rate and Y sets the feedback depth. Click the Settings button to access the following additional parameter:

  **Time**: Select from options for note division, note division with an added triplet, or a triplet of the note division.

### Remix FX parameters

- **FX Lock button**: Freezes the current X and Y values when the pointer is removed from the pad.
- **Reset button**: Immediately halts all XY pad effects. Any active XY pad locks remain active.
- **Gater slider**: Applies a gate-style effect on the incoming signal. Click the Settings button to access the following additional parameters:

  **Gater**: Select from options for note division, note division with an added triplet, or a triplet of the note division.

  **Noise**: Injects a small amount of soft, noninvasive noise into your signal, so that even without any audio signal you can still hear some gating.

- **Downsampler slider**: Changes the resolution of incoming audio, making the sound thinner, gritty, or peaky, similar to Bitcrusher distortion. Click the Settings button to access the following additional parameter:

  **Downsampler**: Extreme introduces a sympathetic, ringing frequency to your audio signal. Classic downsamples the audio to “roughen it up.”

- **Reverse button**: Reverses playback of incoming audio. Touch-sensitive effect variations are available on the left and right sides of the button. Click the Settings button to access the following additional parameter:

  **Time**: Select a note division for the reverse effect.

- **Scratch button**: Simulates a record scratch on the incoming audio. Touch-sensitive effect variations are available on the left and right sides. Click the Settings button to access the following additional parameter:

  **Time**: Select a note division for the scratch effect.

- **Tape Stop button**: Simulates the slow down and stop of the incoming audio. Touch-sensitive effect variations are available on the left and right sides of the button. Click the Settings button to access the following additional parameter:

  **Time**: Select a note division for the tape stop effect.

- **Settings button**: Shows additional effect parameters for the currently selected effect.
Lock effects on the XY pads

You can lock the XY pads so they retain their current values when you remove the pointer from the pad. Once an XY pad is locked, you can choose a different XY effect for the same pad and use it in combination with the locked effect. When an XY pad is locked, you can click with the pointer at a different spot on the XY Pad and instantly change the parameter values.

1. Click the FX Lock button at the top of the XY pad.
2. Do any of the following:
   - **Combine effects on a locked XY pad:** Click the name of the effect at the top of the XY pad, then choose a different effect from the pop-up menu.
   - **Reset all XY pad effect parameters:** Click the Reset button. Any active XY pad locks remain active.
3. Click the FX Lock button again to unlock the XY pads.

Step FX

Step FX overview in Logic Pro for Mac

Step FX is a powerful multi-effect unit that provides deep modulation control, courtesy of three independent step modulators. It can be used with any type of signal and is capable of subtle or heavy rhythmic enhancements of musical parts, dance floor gating effects, and warped manipulations that can turn your audio and instrument tracks into something completely new.

The three independent step modulators—each with an envelope—provide up to 128 steps that can be used to control effects parameters, gate, and pan. Multiple step modulators can be used to control the same parameter, allowing for interesting polyrhythms. Control is further enhanced with the assignable XY pad that enables real time manipulation of up to four parameters. See the sections on Step FX modulator global controls, playback controls, and display controls.

Effects include a multimode filter, a modulation FX unit, delay, reverb, and distortion units. All effects parameters can be modulated.

Step FX processors work in series—where the output of one effect is fed into the next in an effects chain. The routing order lets you choose whether a delayed signal should be filtered or the filtered sound should be delayed—as an example.

Horizontally drag the name of the effect in the Effects order strip at the bottom of the window to determine the order of the effects chain.
To add Step FX to your project, choose Multi Effects > Step FX in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

### Step FX processors in Logic Pro for Mac

The parameters of all Step FX processors are described in the respective sections below.

### Mod FX parameters

The modulation FX unit provides chorus-like effects, ranging from soft through to heavy tone warping.

- **On/off button**: Enable/disable the Mod FX unit.
- **Delay knob and field**: Set the initial delay time.
- **Rate knob and field**: Set the LFO speed of the modulation effect.
- **Depth knob and field**: Set the intensity of the modulation effect.
- **Feedback knob and field**: Set the amount of the effect signal that is routed back to the input. Use high levels if you’re going for weird sounds.
- **Mix knob and field**: Set the level of the original versus modulated signal. This is a modulation amount control.
Delay parameters
A syncable stereo delay unit with integrated filter. See Step FX filter types.

- **On/off button**: Enable/disable the delay effect.
- **Filter Type pop-up menu**: Choose a lowpass (LP), bandpass (BP), highpass (HP), or lowpass/low cut hybrid (LP+LoCut) filter type.
- **Feedback knob and field**: Set the amount of feedback for the left and right delay signals. Higher values result in more delay repeats.
- **Cutoff knob and field**: Set the cutoff frequency for the chosen filter type. This filters the selected frequencies from the overall signal.
- **Mix knob and field**: Set the level of the source versus delay signal.
- **Sync button**: Turn on to synchronize delay repeats with the project tempo. Turn off to set delay times freely. Set time/beat/division values with the Time L/R knobs.
- **Time L/R knobs and fields**: Set the delay time in milliseconds or in beat/division values when synchronized with the project tempo.

Filter parameters
The filter unit provides dozens of filter types. See Step FX filter types.

- **On/off button**: Enable/disable the filter effect.
- **Type pop-up menu**: Choose a filter characteristic. Each option provides a different tonal color and response to the Cutoff and Res control values.
  
  **Note**: The chosen filter type can alter the names and functions of the default Cutoff and Res knobs.
- **Cutoff knob and field**: Set the cutoff frequency for the filter. Higher frequencies are attenuated and lower frequencies are allowed to pass in a lowpass (LP) filter. The reverse is true in a highpass (HP) filter. When in a bandpass (BP) mode, cutoff determines the center frequency of the band that is allowed to pass. The comb and other filter types change the names and behaviors of the filter controls.
- **Res knob and field**: Boost or cut signals in the frequency band that surrounds the cutoff frequency. Very high Res values cause the filter to begin oscillating at the cutoff frequency. This self-oscillation occurs before you reach the maximum resonance value.
- **Mix knob and field**: Set the level of the original versus filtered signal.

Distortion parameters
The distortion unit can add color and a saturated tone to your parts.

- **On/off button**: Enable/disable the distortion effect.
- **Exciter knob and field**: Set the amount of excitation. Exciter generates high frequency components that are not part of the original signal by introducing a nonlinear distortion.
- **Dirt knob and field**: Set the amount of this saturated, gritty distortion characteristic.
Reverb parameters
A simple reverb unit that can add space to your parts.

- **On/off button**: Enable/disable the reverb effect.
- **Type pop-up menu**: Choose a reverb characteristic. Each option provides a different tonal color and response.
- **Time knob and field**: Set the length of the reverb tail.
- **Mix knob and field**: Set the level of the original versus reverb signal.

Step FX step modulator global controls in Logic Pro for Mac

The step modulator is the heart of Step FX. It offers three independent step modulators that each provide up to 128 steps. Each modulator can be assigned to modulate effects unit parameters or to modulate gate or pan. It is also possible to assign multiple step modulators to the same parameter to create interesting polyrhythmic effects.

In addition to defining the number of steps in each modulator, you can change the level and length (gate time) of individual steps, and you can also tie steps. Each modulator provides independent Depth, Rate, and Swing amount controls, and also features an Attack, Hold, and Release envelope that defines the overall step shape for each modulator. See the sections on step modulator playback controls and display controls.

A number of modulator pattern presets are included, along with menu commands to help you quickly create new and interesting rhythmic modulation patterns.

![Step Modulator Controls Image](image)

**Step modulator global controls**

- **On/off buttons**: Enable/disable step modulator 1, 2, or 3.
- **Step modulator select buttons**: Click to select step modulator 1, 2, or 3. All parameters in the step modulator, envelope, and so on, update to show values for the chosen modulator.
• **Modulator Target pop-up menus:** Choose a target parameter for step modulator 1, 2, or 3. These pop-up menus also act as select buttons. The selected modulator name is shaded.

   It is possible to assign the same target for multiple modulators. Because each modulator can have a different pattern and length, along with independent Depth, Rate, Swing, and envelope control, this can lead to complex polyrhythmic modulations. There are two gate modes available that facilitate different playback behaviors:

   • **Gate Mix:** Gate Mix is the best Gate choice in most cases. In this mode, a Depth value of 0% results in no change to the sound. As the Depth value increases, the volume associated with the minimum step value decreases until at 100% it results in silence. Negative Depth values invert step values. When multiple Gate modulators are used, the Gate Mix value is multiplied by existing Gate values.

   • **Gate Add:** In Gate Add mode, a single Gate Add step modulator with a Depth value of 0% results in silence, and a Depth value of 100% sounds identical to Gate Mix. As you increase the Depth value, the amplitude of existing steps increases. Negative Depth values invert step values. When multiple Gate modulators are used, the Gate Add value is added to existing Gate values. For example, a Gate Add Depth value of +10 changes a step value of 50 to 60.

• **Preset pop-up menu:** Choose a menu item to save or load your own modulation pattern or to load a supplied modulation pattern.

   • **Save As:** Opens a name field. Enter a name, then click the Save button to save your modulation pattern. Click Cancel to stop the save operation and to exit the Save name field.

   User patterns are shown at the bottom of the Preset pop-up menu.

   • **Recall Default:** Initializes all steps and the envelope in the current user pattern to default (null) values.

   • **Copy/Paste:** Store the current modulation pattern in the Clipboard. Paste applies the modulation pattern currently found on the Clipboard.

   • **Delete User Preset:** Deletes the current user pattern.

   • **Custom:** This menu item is shown automatically when any pattern changes have been made. It can be considered the “current state” pattern preset.

   • **Previous/Next buttons:** Click the left or right arrow to choose the previous/next modulation pattern preset.

• **Action pop-up menu:** Choose a modulation pattern handling menu item. These include randomize, shift, reverse, and other functions.

   • **Random Full:** Apply full-range random offsets to modulation pattern step values. Use this command to create truly random modulation patterns.

   • **Random Deviation:** Apply limited-range random offsets to modulation pattern step values. Use this command to create slight variations of existing step values.

   • **Shift Left/Right:** Move all modulation pattern steps one position (a step) to the left or right. Steps at the first and last position “wrap around,” so step 16 would become step 1 if you used the Shift Right command on a 16-step modulation pattern.

   • **Double Note Length:** Doubles the length of all steps. Full-length steps are tied to the next step. Steps of 25% length become 50% length steps, 50% length steps become 100% length steps, and so on.
• **Reverse**: Reverse the position of all steps. Step 1 becomes step 16, step 2 becomes step 15, step 3 becomes step 14, and so on in a 16-step modulation pattern.

• **Invert**: Invert the level of all steps. A step with a level of 40% becomes a step with a level of 60%, a step with a level of 10% becomes a step with a level of 90%, a step with a level of 0% becomes a step with a level of 100%, and so on.

• **Append Duplicate**: Duplicate all active steps and copy them to the step immediately following the last step. For example, steps 1 to 10 would be copied to create a 20-step modulation pattern.

• **Append Reverse Duplicate**: Duplicate all active steps, reverse their order, then copy them to the step immediately following the last step. For example, steps 1 to 4 with values of 15, 20, 30, and 70 would be copied to create an 8-step modulation pattern with values of 15, 20, 30, 70, 70, 30, 20, and 15.

### Step FX step modulator playback controls in Logic Pro

These parameters are independently available for each of the three step modulators. Click the name in the Modulator Target pop-up menu to choose the modulator you want to edit. The selected modulator name is shaded.

Also see the sections on step modulator global controls and display controls.

![Step FX step modulator](image)

### Step modulator playback controls

- **Depth knob and field**: Set the intensity of modulation for step modulator 1, 2, or 3.

- **Rate knob and field**: Set the speed of step modulator 1, 2, or 3.

- **Swing knob and field**: Set the swing amount for step modulator 1, 2, or 3. Values over 0% increase the duration of odd-numbered steps (1, 3, 5, and so on) while decreasing even-numbered step lengths.

- **Envelope display**: Set an independent envelope shape for each step modulator. Values are expressed as a percentage of step length and apply to all steps in the selected modulation pattern. You can drag dots directly in the display or can drag field values.

- **Attack dot or field**: Set the envelope attack time for step modulator 1, 2, or 3.

- **Attack curve dot**: Drag the shaded dot shown on the line preceding the bright Attack dot to set the attack curve shape.

- **Hold dot or field**: Set the envelope hold time for step modulator 1, 2, or 3.

- **Release dot or field**: Set the envelope release time for step modulator 1, 2, or 3.

- **Release curve dot**: Drag the shaded dot shown on the line between the bright Hold and Release dots to set the release curve shape.
Step FX step modulator display controls in Logic Pro

These parameters are available for each of the three step modulators. Click the name in the Modulator Target pop-up menu to choose the modulator you want to edit. The selected modulator name is shaded.

Also see the sections on step modulator global controls and playback controls.

Step modulator pattern display controls

- **Pattern display:** Use to change the modulation pattern length, edit the level and length of individual steps, tie steps, and enable or disable steps.

- **Level/length bars:** Drag vertically to set the level/amount for each active step. Drag left to reduce step length. Drag right to increase step length or to create a tie to the next step. The currently playing step is brightly illuminated.
  - Where multiple level/length bars exist, drag across them to draw in the level of several steps.
  - Drag a level/length bar toward the left to reduce the step length. Drag to the right to increase the step length. This enables you to create different grooves. Dragging snaps to fixed positions at 25%, 50%, 75%, or 100% of the step length. Hold down Shift, then drag to set the step length freely. Edits are reflected immediately in the display with a shaded bar that indicates the step length.
  - Drag a level/length bar toward the right until it overlaps the next step to create a tie to that step. If the step to the right is a rest (an inactive step), this step is automatically turned on to create the tie. A step can be tied to multiple steps in a row. The original velocity values of tied steps are replaced by the velocity of the first step they are tied to, indicated graphically by the level bar extending over all tied steps. Edits are reflected immediately in the display with a shaded bar that indicates the tie length.

  Tied steps are indicated by blue dots, connected by lines, on the step number buttons below the steps. To remove or create a tie, click the line between two dots.

- **Pattern length handle:** Drag the handle to the right of the last step to change the modulation pattern length. A maximum of 128 steps is available for each modulator. Each modulation pattern can have a different length.
• **Step number buttons:** Click to turn each of the available steps on or off. The number of inactive steps (and level/length) is dimmed. Active steps (and level/length) are illuminated. You can drag horizontally across multiple steps to reverse their current state. Any existing step length or level is restored if an inactive step is turned on. Click between step numbers to create or remove a tie. Tied steps are indicated by blue dots, connected by lines.
  - *If a step is turned on:* A step is triggered at the respective modulator position.
  - *If a step is turned off:* The modulator position is silent and is perceived as a rest.
• **Scroll bar:** Drag to move to steps that are not visible in the display.

**Step FX global controls in Logic Pro for Mac**

The XY pad provides real-time control of up to four target parameters. Drag the blue control point to simultaneously modulate your targets. The parameters of the XY pad and the Master controls are described in the respective sections below.

**XY pad parameters**

Changes to XY pad Target pop-up menus are reflected by blue rings and dots around target parameter knobs, which make it easy to identify a target parameter. The rings indicate the modulation range and the dots indicate the current value of the XY pad modulation.

- **XY pad:** Drag horizontally or vertically to change the value of the assigned X or Y target parameters.
- **On/off buttons:** Enable/disable the X or Y controller.
- **X Target pop-up menus:** Choose one or two modulation targets from any active effect processor, modulation source, or master control section.
- **X Depth fields:** Set the modulation amount/range for the chosen X target(s).
- **Y Target pop-up menus:** Choose one or two modulation targets from any active effect processor, modulation source, or master control section.
- **Y Depth fields:** Set the modulation amount/range for the chosen Y target(s).
Master controls
- *Input knob and field:* Set the input level of the plug-in.
- *Mix knob and field:* Set the level of the original versus processed signal. This is essentially a wet/dry balance control.
- *Output knob and field:* Set the overall output level of the plug-in.

Effects order strip
The order and status of active and inactive effects units are indicated in the strip. Inactive effects are dimmed, and active effects are illuminated. The signal flow runs from left to right.

*Effects order strip:* Drag the name of an active (lit) or inactive (dimmed) effect horizontally to change the effects order.

Step FX filter types in Logic Pro for Mac
Step FX provides dozens of filter types.

**Step FX filter types: lowpass, bandpass, highpass**
A lowpass (LP) filter passes the portion of a signal below a specified cutoff frequency and rolls off the portion above that frequency. A bandpass (BP) filter passes the portion of a signal occupying a band surrounding the cutoff frequency and rolls off the portions above and below that band. A highpass (HP) filter passes the portion of a signal above a specified cutoff frequency and rolls off the portion below that frequency.

There are multiple two-pole, four-pole, multi-pole state-variable and analog-modeled LP, BP, and HP filter designs in Step FX, each with distinctive characteristics that you may prefer for a given purpose. The available LP, BP, and HP filter designs include Smooth, Edgy, Rich, Sharp, Clean, and Gritty variants.
- Smooth: Two- or multi-pole state-variable filters.
- Edgy: Two- or four-pole analog-modeled filters. Four-pole variants provide a steeper roll-off of frequencies beyond the cutoff.
- Rich: Two- or four-pole analog-modeled filters. Four-pole variants provide a steeper roll-off of frequencies beyond the cutoff.
- Sharp: Two-pole analog-modeled filters.
- Clean: Bi-Quad filters. These filters have no Drive option.
- Gritty: Two-pole filters designed to saturate heavily at higher Res and Drive settings.

The three principal filter controls have standard functions for all filter types.
- *Cutoff:* Controls the filter cutoff frequency.
- *Res(onance):* Controls the filter resonance or emphasis. Higher settings boost frequencies in the immediate vicinity of the cutoff frequency.
- *Drive:* Allows the filter to be overdriven; the precise effect varies with each filter design.
Step FX filter types: notch and peaking

A notch filter cuts a narrow band around a resonant frequency. The remainder of the signal is affected minimally.

- **Cutoff**: Sets the frequency of the cut band.
- **Amount**: Controls the amount of attenuation.

A peaking filter boosts a narrow band around a resonant frequency. The remainder of the signal is affected minimally.

- **Cutoff**: Sets the frequency of the boosted band.
- **Gain**: Controls the amount of boost. Higher values are generally the most effective.
- **BW**: Sets the bandwidth around the cutoff frequency.

Step FX filter types: comb filters

A comb filter mixes the original signal with one or more copies of the signal, which are delayed by a very short time interval. At some frequencies this mixture causes phase cancelations, while at other frequencies it causes reinforcements. The result is a spiky frequency spectrum with multiple resonant peaks. Graphically, these peaks resemble the teeth of a comb, which gives this filter type its name.

Step FX offers three comb filter designs, each with its own character. The best choice depends on your preference and the type of sound you’re trying to create. That said, there are some distinguishing characteristics that may help guide you.

Comb Pos uses positive feedback on the delay lines, while Comb Neg uses negative feedback to produce less extreme effects, often with a hollow quality. These two are the less powerful combs and offer a much more gradual increase in resonance. They can be useful when you require either a less dramatic effect or you want to hear more of the exciter signal character in your sound. The latter point is noteworthy as this trait can be useful when you want a more naturalistic sound.

Comb PM uses bipolar feedback on the delay lines. The resonance control is bipolar, allowing you to freely shift from negative (hollow sound) on the left to positive (bright and peaky) on the right. This comb is useful for classic bright Karplus-Strong style sounds, where the exciter impulse is not easily heard and the comb is more prominent. Take care with your resonance level because it’s capable of quickly going to extremes, which can lead to feedback. Start with a resonance level of zero and increase (or decrease) slowly to find a suitable effect strength.

- **Cutoff**: Controls the delay time in the comb circuit. Lower cutoff values equate to a longer delay.
- **F-Back**: Controls the amount of feedback in the comb circuit.
- **Damp**: Softens the frequency peaks in the comb-filtered spectrum.

  Note: Sending a percussive sound into a highly resonant comb filter causes it to ring at a frequency determined by the delay time you have set with the Cutoff knob.
Step FX filter types: ring modulation

Ring modulation is a process in which a modulator and a carrier signal are multiplied. Each frequency component of the modulator interacts with each frequency component of the carrier to produce two sidebands: a sum and a difference (carrier – modulator). When a filter is set to the RingMod type, the signal entering the filter acts as the modulator, while the carrier is supplied internally by the filter.

- **Frequency**: Controls the carrier frequency.
- **Mix**: Applies a constant offset to the carrier.
  - At 0%, the carrier wave varies between -1 and +1, resulting in classic ring modulation.
  - At 100%, the carrier wave varies between 0 and 1, resulting in classic amplitude modulation. In this case, the carrier signal itself is present alongside the sum and difference sidebands.

Step FX filter types: distortion

Phat FX filters offer several distortion effects.

- **Bitcrusher** is a harsher-sounding digital effect.
- **Dirt** is a classic tube distortion effect.
- **Downsampler** is a lo-fi digital effect (similar to Bitcrusher but frequency dependent).
- **Grit** is a transistor distortion.

The filter controls work as follows when the filter type is set to a distortion effect:

- **Amount**: Controls the intensity of the distortion effect.
- **Mix**: Controls the mix between clean and distorted signals. A 0% value results in the clean signal only. A 50% value results in an equal mix of clean and distorted signal. A 100% value results in the distorted signal only.
- **Freq**: Sets the frequency for the Downsampler distortion type.
Pitch effects

Pitch effects overview in Logic Pro for Mac

You can use the pitch effects to transpose or correct the pitch of audio signals. These effects can also be used for creating unison or slightly thickened parts, or even for creating harmony voices.

You can also define a scale to automatically correct some, but not all, sung notes in a vocal performance, for example. This enables you to effectively perfect an imperfect vocal take.

You can also use pitch correction effects creatively, modifying all pitched notes in a performance to a single pitch or a particular key.

See Pitch Correction, Pitch Shifter, and Vocal Transformer.

If you're new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Pitch Correction effect

Pitch Correction effect in Logic Pro for Mac

You can use the Pitch Correction effect to fix the pitch of incoming audio signals. Improper intonation is a common problem with vocal tracks, for example. The sonic artifacts that can be introduced by the process are minimal and are almost silent when making moderate corrections.

Pitch correction works by accelerating and slowing down the audio playback speed, matching the input signal (sung vocal) with the correct note pitch. If you try to correct larger intervals, you can create special effects. Natural articulations of the performance, such as breath noises, are preserved.

Any scale can be defined as a pitch reference (technically speaking, this is known as a pitch quantization grid). Improperly intoned notes are corrected in accordance with this scale.

The Pitch Correction effect can be fully automated. This means that you can automate the Scale and Root parameters to follow harmonies in the project. Depending on the accuracy of the original intonation, setting the appropriate key with the Scale parameter may suffice. Less precise intonations may need more significant changes to the Scale and Root parameters.
**Note:** Polyphonic recordings, such as choirs, and highly percussive signals with prominent noisy portions cannot be corrected to a specific pitch. Despite this, you may want to try the plug-in on some drum sounds, such as toms and congas, because it can deliver interesting results.

To add Pitch Correction to your project, choose Pitch > Pitch Correction in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

### Pitch Correction effect controls in Logic Pro for Mac

#### Pitch Correction parameters

- **Root Note pop-up menu:** Choose the root note of the scale.
- **Scale/Chord pop-up menu:** Choose a pitch quantization grid.
- **Show Pitch buttons:** Show the pitch of the input or output signal, respectively, on the notes of the keyboard.
- **Edit Scale button:** Click to exclude notes from pitch quantization grids.
- **Bypass Notes button:** Click to exclude notes from pitch correction.
- **Bypass All button:** Quickly compare the corrected and original signals or audition automation changes.
- **Keyboard mode button:** Choose Edit Scale Keyboard to exclude notes from pitch quantization grids, or Bypass Notes to exclude the corresponding note from pitch correction.
- **Edit Scale Keyboard:** Click a key to exclude the corresponding note from pitch quantization grids. This effectively removes this key from the scale, resulting in note corrections that are forced to the nearest available pitch (key). See Exclude notes from Pitch Correction.
- **Bypass Notes Keyboard:** Click a key to exclude the corresponding note from pitch correction. In other words, all notes that match this pitch are not corrected. This applies to both user and built-in scale quantization grids. See Bypass individual notes in a scale in the Pitch Correction effect.
- **Correction display:** Indicates the amount of pitch change. The marker indicates the average correction amount over a longer time period. You can use the display when discussing (and optimizing) the vocal intonation with a singer during a recording session.
• **Neural Pitch Detection button:** Turn on pitch detection to automatically detect the Pitch Range. You can turn it off to set the pitch range manually in the Pitch Range pop-up menu.

• **Pitch Range pop-up menu:** Choose a low or normal pitch range that is scanned (for notes that need correction). See Pitch Correction effect quantization.

  Note: When Neural Pitch Detection is turned on, it is not necessary to set Pitch Range manually.

• **Response knob and field:** Determine how quickly the voice reaches the corrected destination pitch.

  Singers use portamenti and other gliding techniques. If you choose a Response value that’s too low, seamless portamenti turn into semitone-stepped glissandi, but the intonation is perfect. If the Response value is too high, the pitch of the output signal won’t change quickly enough. The optimum setting for this parameter depends on the singing style, tempo, vibrato, and accuracy of the original performance.

• **Tolerance knob and field:** Set a zone around the core frequency where no correction takes place. A low value results in more extreme or faster corrections and higher values allow for more pitch variation (for example, vibrato) to happen, before any correction is applied.

• **Global Tuning button:** Turn on to use project Tuning settings for the pitch correction process. Turn off to set the reference tuning with Reference parameter. See Use Pitch Correction reference tuning.

• **Reference pop-up menu:** Set the reference tuning in cents (relative to the root).

• **Detune knob:** Detune the output signal by the set value.

---

**Pitch Correction quantization in Logic Pro for Mac**

The Neural Pitch Detection button should generally be left on to handle pitch tracking. When Neural Pitch Detection is turned off, you can use the Pitch Range pop-up menu to set the pitch range that is scanned. Normal is the default range and works for most audio material. Low should be used only for audio material that contains extremely low frequencies (below 100 Hz), which may result in inaccurate pitch detection. These parameters have no effect on the sound; they are simply optimized tracking options for the chosen target pitch range.
The Scale/Chord pop-up menu allows you to choose different pitch quantization grids. The default setting is the chromatic scale.

The user scale is the scale that is set manually with the onscreen keyboard in the plug-in window. If you’re unsure of the intervals used in any given scale, choose User Scale from the Scale/Chord pop-up menu and look at the onscreen keyboard. You can alter any note in the chosen scale by clicking the keyboard keys. Any such adjustments overwrite the existing user scale settings.

There is only one user scale per project. You can, however, create multiple user scales and save them as Pitch Correction plug-in settings files.

Tip: The drone scale uses a fifth as a quantization grid, and the single scale defines a single note. Neither of these scales is meant to result in realistic singing voices, but try them if aiming for interesting effects.

Choose the root note of the scale from the Root Note pop-up menu. You can freely transpose the major and minor scales and scales named after chords.

Exclude notes from Pitch Correction in Logic Pro for Mac

You can use the Pitch Correction effect onscreen keyboard to exclude notes from the pitch quantization grid.

When you first open the effect, all notes of the chromatic scale are selected. This means that every incoming note is altered to fit the next semitone step of the chromatic scale. If the intonation of the singer is poor, this might lead to notes being incorrectly identified and corrected to an unwanted pitch. For example, the singer may have intended to sing an E, but the note is actually closer to a D#. If you do not want the D# in the song, the D# key can be disabled on the keyboard. Because the original pitch was sung closer to an E than a D, it is corrected to an E.

Note: The settings made with the Pitch Correction effect onscreen keyboard are valid for all octave ranges. Individual settings for different octaves are not provided.

Bypass individual notes in a scale in the Pitch Correction effect

In the majority of working situations, you choose a scale from the Scale/Chord menu. You can also bypass individual notes by activating the Bypass Notes button, but this is a less common use case scenario.

• In Logic Pro, click the Bypass Notes button.
  Bypassed notes are orange.

  This is particularly useful for “blue” notes. Blue notes are notes that slide between pitches, making the major and minor status of the keys difficult to identify. As you may know, one of the major differences between C minor and C major is the Eb (E flat) and Bb (B flat), instead of the E and B. Blues singers glide between these notes, creating an uncertainty or tension between the scales. Use of the bypass buttons allows you to exclude particular keys from changes, leaving them as they were.

Tip: It’s often best to correct only the notes with the most harmonic gravity. For example, choose “sus4” from the Scale/Chord pop-up menu, and set the Root note to match the project key. This limits correction to the root note, the fourth, and the fifth of the key scale. Turn on the bypass buttons for all other notes and only the most important and sensitive notes are corrected, while all other singing remains untouched.
**Bypass all pitch correction in the Pitch Correction effect**

Not all audio material can be effectively pitch corrected. In some cases, you may need to use Logic Pro pitch manipulation and automation features to process a portion of an audio performance.

- In Logic Pro, click the Bypass All button to pass the input signal through unprocessed and uncorrected.

This is useful for spot corrections to pitch through use of automation. Bypass all is optimized for near-instant, seamless operation in all situations.

**Use Pitch Correction reference tuning in Logic Pro for Mac**

Turn on the Global Tuning button to use Logic Pro Tuning settings for the pitch correction process. This ensures that all software instruments and your tuned vocal part are in tune with each other.

If Global Tuning is turned off, you can use the Reference parameter to set the reference tuning to the root key or note.

As an example of where choosing a value with the Reference parameter can be effective, consider that the intonation of a vocal line is often slightly sharp or flat throughout an entire song. You can use the Reference parameter to address this issue at the input of the pitch-detection process by setting it to reflect the constant pitch deviation in cent values. This allows for more accurate pitch correction.

*Note:* Tunings that differ from software instrument tuning can be interesting when you want to individually correct the notes of singers in a choir. If all voices are individually and perfectly corrected to the same pitch, the choir effect is partially lost. You can prevent this by (de)tuning the pitch corrections individually.

**Set Logic Pro reference tuning**

- In Logic Pro, choose File > Project Settings > Tuning to determine the tuning reference for all software instruments.

**Pitch Shifter**

**Pitch Shifter overview in Logic Pro for Mac**

Pitch Shifter provides a simple way to combine a pitch-shifted version of the signal with the original signal. See *Use Pitch Shifter.*
To add Pitch Shifter to your project, choose Pitch > Pitch Shifter in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Pitch Shifter parameters

- **Semi Tones knob and field:** Set the pitch shift value in semitones.
- **Cents knob and field:** Control detuning of the pitch shift value in cents (1/100 of a semitone).
- **Mix knob and field:** Set the balance between the effect and original signals.
- **Latency Comp button:** Turn on to compensate for delays that may be introduced by some algorithms with particular types of source material.
- **Stereo Link buttons:** Normal retains the source stereo signals. Invert swaps (inverts) stereo channel signals, with right channel processing occurring on the left, and vice versa.
- **Timing pop-up menu:** Choose an algorithm to determine how timing is derived.
  - **Drums:** Maintains the groove (rhythmic feel) of the source signal.
  - **Speech:** Provides a balance between both the rhythmic and harmonic aspects of the signal. This is suitable for complex signals such as spoken-word recordings, rap, and hybrid signals such as rhythm guitar.
  - **Vocals:** Retains the intonation of the source, making it well-suited for signals that are inherently harmonic or melodious, such as string pads.
  - **Manual:** Uses the settings of the Delay, Crossfade, and Stereo Link parameters.
  - **Pitch Tracking:** Follows the pitch of incoming audio material.

Note: The following parameters are active only when Manual is chosen from the Timing pop-up menu.

- **Delay slider and field:** Set the amount of delay applied to the input signal. The lower the frequencies of the input signal, the higher (longer) a delay time is required—to effectively pitch shift the signal.
- **Crossfade slider and field:** Set the range (shown as a percentage of the original signal) used to analyze the input signal.
Use Pitch Shifter in Logic Pro for Mac

Pitch Shifter is used most effectively when you take a structured approach.

Use pitch shifting
1. In Logic Pro, you can set the amount of transposition, or pitch shift, by dragging the Semi Tones slider.
2. To set the amount of detuning, drag the Cents slider.
3. Choose the algorithm that best matches the material you are working with from the Timing pop-up menu.

If you are working with material that does not fit any of these categories, experiment with each of the algorithms (starting with Speech), then compare the results and use the one that best suits your material.

⚠️ Tip: While auditioning and comparing different settings, temporarily set the Mix parameter to 100% because this makes Pitch Shifter artifacts easier to hear.

Vocal Transformer

Vocal Transformer in Logic Pro for Mac

Vocal Transformer can be used to transpose the pitch of a vocal line, to augment or diminish the range of the melody, or even to reduce it to a single note that mirrors the pitches of a melody. No matter how you change the pitches of the melody, the constituent parts of the signal (formants) remain the same.

You can shift the formants independently, which means that you can turn a vocal track into a Mickey Mouse voice, while maintaining the original pitch. Formants are characteristic emphases of certain frequency ranges. They are static and do not change with pitch. Formants are responsible for the specific timbre of a given human voice.

Vocal Transformer is well suited to extreme vocal effects. The best results are achieved with monophonic signals, including monophonic instrument tracks. It is not designed for polyphonic voices—such as a choir on a single track—or other chordal tracks.

See Vocal Transformer parameters and Use Vocal Transformer.

To add Vocal Transformer to your project, choose Pitch > Vocal Transformer in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
Vocal Transformer controls in Logic Pro for Mac

Vocal Transformer includes the following parameters.

Vocal Transformer parameters

- Pitch knob and field: Determine the amount of transposition applied to the input signal. See Use Vocal Transformer.
- Robotize button: Turn Robotize mode on or off. This mode is used to augment, diminish, or mirror the melody.
- Pitch Base slider and field: Available only in Robotize mode. Transpose the note that the Tracking parameter is following.
- Tracking slider, field, and buttons: Available only in Robotize mode. Control how the melody is changed.
- Mix slider and field: Define the level ratio between the original (dry) and effect signals.
- Formant knob and field: Shift the formants of the input signal.
- Glide slider and field (Extended Parameters area): Determine the time vocal transformation takes, allowing sliding transitions to the set Pitch value.
- Grain Size slider and field (Extended Parameters area): The effect algorithm is based on granular synthesis. Drag to set the size of the grains and thus affect the precision of the process. Experiment to find the best setting. Try Auto first.
- Formants pop-up menu (Extended Parameters area): Choose how Vocal Transformer processes formants.
  - Process always: All formants are processed.
  - Keep unvoiced formants: Only voiced formants are processed. This retains sibilant sounds in a vocal performance and produces a more natural-sounding transformation effect with some signals.
- Detune slider and field (Extended Parameters area): Detune the input signal by the set value. This parameter is of particular benefit when automated.
Use Vocal Transformer in Logic Pro for Mac

You can change the pitch of performances, inclusive of, or independent from, formants. Robotize mode can augment or diminish the melody.

Use the Vocal Transformer Pitch and Formant parameters

- In Logic Pro, rotate the Pitch knob to transpose the pitch of the signal upward or downward. Adjustments are made in semitone steps. Incoming pitches are indicated by a vertical line below the Pitch Base field.

Transpositions of a fifth upward (Pitch = +7), a fourth downward (Pitch = −5), or by an octave (Pitch = ±12) are the most useful harmonically.

As you alter the Pitch parameter, you might notice that the formants don’t change.

The Pitch parameter is expressly used to change the pitch of a voice, not its character. If you set negative Pitch values for a female soprano voice, you can turn it into an alto voice without changing the specific character of the singer’s voice.

- To shift the formants while maintaining—or independently altering—the pitch: Rotate the Formant knob. If you set this parameter to positive values, the singer sounds like Mickey Mouse. By altering the parameter downward, you can achieve vocals reminiscent of Darth Vader.

Tip: If you set Pitch to 0 semitones, Mix to 50%, and Formant to +1 (with Robotize turned off), you can effectively place a singer (with a smaller head) next to the original singer. Both will sing with the same voice, in a choir of two. This doubling of voices is quite effective, with levels easily controlled by the Mix parameter.

Use Vocal Transformer Robotize mode

1. In Logic Pro, click the Robotize button to turn on Robotize mode. In this mode, Vocal Transformer can augment or diminish the melody.

You can control the intensity of this distortion with the Tracking parameter.
2. Click one of the following buttons to immediately set the Tracking slider to one of these most useful values:

- **−1 button**: Set the slider to −100%. All intervals are mirrored.
- **0 button**: Set the slider to 0%. Delivers interesting results, with every syllable of the vocal track being sung at the same pitch. Low values turn sung lines into spoken language.
- **1 button**: Set the slider to 100%. The range of the melody is maintained. Higher values augment, and lower values diminish, the melody.
- **2 button**: Set the slider to 200%. The intervals are doubled.

The Pitch Base parameter is used to transpose the note that the Tracking parameter is following. For example, with Tracking set to 0%, the pitch of the (spoken) note is transposed to the chosen base pitch value.
Reverb effects

Reverb effects in Logic Pro for Mac

You can use reverb effect plug-ins to simulate the sound of acoustic environments such as rooms, concert halls, caverns, or an open space.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Sound waves repeatedly bounce off the surfaces—walls, ceilings, windows, and so on—of any space, or off objects within a space, gradually dying out until they are inaudible. These bouncing sound waves result in a reflection pattern, more commonly known as a reverberation (or reverb).

The starting portion of a reverberation signal consists of a number of discrete reflections that you can clearly discern before the diffuse reverb tail builds up. These early reflections are essential in human perception of spatial characteristics, such as the size and shape of a room.
Plates, digital reverb effects, and convolution reverb

The first form of reverb used in music production was actually a purpose-built room with hard surfaces, called an echo chamber. It was used to add echoes to the signal. Mechanical devices, including metal plates and springs, were also used to add reverberation to the output of musical instruments and microphones.

Digital recording introduced digital reverb effects, which consist of thousands of delays of varying lengths and intensities. The time differences between the original signal and the arrival of the early reflections can be adjusted by a parameter known as predelay. The average number of reflections in a given period of time is determined by the density parameter. The regularity or irregularity of the density is controlled with the diffusion parameter. Included among the digital reverbs are the unique EnVerb and ChromaVerb. See ChromaVerb overview.

Computers make it possible to sample and analyze the reverb characteristics of real spaces, using convolution reverbs. These room characteristic sample recordings are known as impulse responses.

Convolution reverbs work by convolving (combining) an audio signal with the impulse response recording of reverb characteristics for a given space. See Space Designer overview.

ChromaVerb

ChromaVerb in Logic Pro for Mac

ChromaVerb features 14 discrete room type algorithms.

The fundamental approach behind ChromaVerb diverges from other methods of reverb creation. It is based on the principle of a circular structure in which the sound is gradually absorbed, much like in a real room. The absorption characteristics are dependent on the chosen room type and reverb parameter settings.

Each room type offers a unique tonal color, ranging from dense rooms to wide spaces and large halls.

The ChromaVerb interface is divided into two views:

- **Main view:** Shows common reverb parameters such as Attack, Size, Density, Distance, and Decay. A visualization of the reverb output is shown in a graphic display that allows you to directly edit damping factors, thus changing decay frequencies and dependencies.

- **Details view:** Provides access to advanced parameters such as Width, Quality, and Modulation. The graphic display shows an editable Output EQ that you can use to shape the ChromaVerb output signal.
To add ChromaVerb to your project, choose Reverb > ChromaVerb in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

ChromaVerb display and Damping EQ in Logic Pro for Mac

The main view contains the most commonly used parameters and shows a Damping equalizer overlay in the graphic display.

The details view contains advanced parameters and shows the built-in six-band Output EQ. Click the Main or Details buttons at the upper right to switch between views.
ChromaVerb display and Damping EQ parameters

- **Room Type pop-up menu:** Choose the type of reverb space you want to recreate. See ChromaVerb room types.

- **Main/Details button:** Switch between the main view and the details view.

- **Graphic display:** Shows a real-time visualization of changes to parameter values and the incoming signal. A Damping EQ curve is overlaid on the display. You can change the Damping EQ curve in the display or with the fields below it.

The Damping EQ adjusts the frequencies of the decay signal. It is divided into four bands, with independent high and low shelving EQ bands, and two parametric EQ bands.

- **Low shelving EQ dot:** Drag horizontally to adjust the frequency and drag vertically to adjust the ratio of the low shelving band in the Damping EQ. Option-click to reset to default values. Hold Option-Command, then drag vertically to change the Q value.

- **Low parametric EQ dot:** Drag horizontally to adjust the frequency and drag vertically to adjust the ratio of the low parametric band in the Damping EQ. Option-click to reset to default values. Hold Option-Command, then drag vertically to change the Q value.

- **High parametric EQ dot:** Drag horizontally to adjust the frequency and drag vertically to adjust the ratio of the high parametric band in the Damping EQ. Option-click to reset to default values. Hold Option-Command, then drag vertically to change the Q value.

- **High shelving EQ dot:** Drag horizontally to adjust the frequency and drag vertically to adjust the ratio of the high shelving band in the Damping EQ. Option-click to reset to default values. Hold Option-Command, then drag vertically to change the Q value.

The following parameters are identical for each Damping EQ band:

- **Frequency field:** Set the Damping EQ band center frequency.

- **Ratio field:** Set the Decay parameter timing ratio of the Damping EQ band.

- **Q field:** Set the band width surrounding the center frequency of the Damping EQ band.

- **Visualization on/off button:** Enable or disable the real-time visualization in the graphic display.

  **Note:** Visualization works only on computers that support the Metal framework which helps to display graphics faster by reducing processing bottlenecks.

**ChromaVerb main view controls in Logic Pro for Mac**

The main view contains the most commonly used parameters and shows a Damping EQ overlay in the graphic display.

The details view contains advanced parameters and shows the built-in six-band Output EQ. Click the Main or Details buttons at the upper right to switch between views.
ChromaVerb main view parameters

- **Attack knob and field:** Set the attack phase of the reverb. This affects either the volume or the density build-up time, depending on the chosen room type.
  - For the following room types the Attack parameter increases volume over time: Theatre, Dense Room, Smooth Space, Reflective Hall, Strange Room, Airy.
  - For the following room types the Attack parameter sets the amount of time it takes for the reverb to reach the maximum density value, determined with the Density knob: Room, Chamber, Concert Hall, Synth Hall, Digital, Dark Room, Vocal Hall, Bloomy.
- **Size knob and field:** Determine the dimensions of the room. Higher values correspond to a larger space.
- **Density knob and field:** Adjust the density of the early and late reflections simultaneously, depending on room type.
- **Predelay field:** Set the time between the start of the original signal and the arrival of the early reflections. A short predelay setting tends to push sounds away and longer predelay settings tend to bring sounds more to the forefront.
  An extremely short predelay setting can color the sound and make it difficult to pinpoint the position of the signal source. A very long predelay setting can be perceived as an unnatural echo and can divorce the original signal from its early reflections, leaving an audible gap between them. An optimal predelay setting depends on the type of input signal—or more precisely, the envelope of the input signal. Percussive signals generally require shorter predelays than signals where the attack fades in gradually. A good working method is to use the longest possible Predelay value before you start to hear side effects, such as an audible echo. When you reach this point, reduce the Predelay setting slightly.
- **Predelay sync button:** Turn on to restrict Predelay values to divisions synchronized with the host application tempo.
- **Decay knob and field:** Set the decay time. The decay for certain frequencies is dependent on damping parameter values.
- **Decay sync button:** Turn on to restrict Decay values to divisions synchronized with the host application tempo.
- **Freeze button:** Turn on to recirculate the signal infinitely inside the chosen room type.
- **Distance knob and field:** Set the perceived distance from the source by altering early and late energy.
- **Dry/Wet sliders and fields:** Independently set the levels of the source and effect signals.
ChromaVerb Output EQ in Logic Pro for Mac

The details view contains advanced parameters and shows the built-in six-band Output equalizer.

The main view contains the main view controls and shows a Damping EQ overlay in the graphic display. Click the Main or Details buttons at the upper right to switch between views.

ChromaVerb Output EQ parameters

- **Output EQ on/off button**: Turn on to enable the Output EQ, which adjusts frequencies of the overall combined reverb and source signal.
- **Main/Details button**: Switch between the main view and the details view.
- **Graphic display**: Shows the six-band Output EQ curve, which you can interact with directly in the display or the fields below it.
- **Band 1 On/Off button**: Switch on a highpass filter that allows high frequencies to pass and reduces the level of low frequencies near the cutoff (set) frequency. When active, you can change band parameters directly in the graphic display.
  - **Band 1 background or dot**: Drag the red shaded area horizontally to change the frequency value. Drag the red dot horizontally to change the frequency and drag vertically to change the Q value. Option-click to reset to default values. Hold Option-Command, then drag vertically to change the Q value.
- **Band 2 On/Off button**: Switch on a low shelving filter that adjusts the level of low frequencies and has a minimal impact on frequencies above the cutoff (set) frequency. When active, you can change band parameters directly in the graphic display.
  - **Band 2 background or dot**: Drag the orange shaded area or dot horizontally to change the frequency and drag vertically to change the gain value. Option-click to reset to default values. Hold Option-Command, then drag vertically to change the Q value.
- **Band 3 On/Off button**: Switch on a low parametric filter with three controls. Frequency sets a center frequency. Q sets the width of the frequency band around the center frequency. Gain sets the level of the band. When active, you can change band parameters directly in the graphic display.
  - **Band 3 background or dot**: Drag the green shaded area or dot horizontally to change the frequency and drag vertically to change the gain value. Option-click to reset to default values. Hold Option-Command, then drag vertically to change the Q value.
• **Band 4 On/Off button**: Switch on a high parametric filter with three controls. Frequency sets a center frequency. Q sets the width of the frequency band around the center frequency. Gain sets the level of the band. When active, you can change band parameters directly in the graphic display.
  
  • **Band 4 background or dot**: Drag the blue shaded area or dot horizontally to change the frequency and drag vertically to change the gain value. Option-click to reset to default values. Hold Option-Command, then drag vertically to change the Q value.
  
  • **Band 5 On/Off button**: Switch on a high shelving filter that adjusts the level of high frequencies and has a minimal impact on frequencies below the cutoff (set) frequency. When active, you can change band parameters directly in the graphic display.
  
  • **Band 5 background or dot**: Drag the purple shaded area or dot horizontally to change the frequency and drag vertically to change the gain value. Option-click to reset to default values. Hold Option-Command, then drag vertically to change the Q value.
  
  • **Band 6 On/Off button**: Switch on a lowpass filter that allows low frequencies to pass and reduces the level of high frequencies near the cutoff (set) frequency. When active, you can change band parameters directly in the graphic display.
  
  • **Band 6 background or dot**: Drag the pink shaded area to change the frequency value. Drag the pink dot horizontally to change the frequency and drag vertically to change the gain value. Option-click to reset to default values. Hold Option-Command, then drag vertically to change the Q value.
  
  • **Frequency field**: Set the frequency of the selected EQ band.
  
  • **Gain field**: Set the level of the selected EQ band (bands 2 to 5).
  
  • **Order field**: Set the order (filter slope) for band 1 or band 6.
  
  • **Q field**: Set the band width surrounding the frequency of the selected EQ band.

**ChromaVerb details view controls in Logic Pro for Mac**

The details view contains advanced parameters and shows the built-in six-band Output EQ. The main view contains the main view controls and shows a Damping EQ overlay in the graphic display. Click the Main or Details buttons at the upper right to switch between views.

**ChromaVerb details view parameters**

• **Quality pop-up menu**: Choose a quality level. Low produces a grainy reverb with noisy modulation. High sounds clean and precise. Ultra delivers a smooth, expensive-sounding reverb.

• **Mod Speed slider and field**: Set the speed of the built in LFO.
• **Mod Depth slider and field:** Set the depth of LFO modulation. The range is determined by the chosen room type.

• **Mod Source buttons:** Choose a sine, random, or noise waveform for the LFO.

• **Smoothing slider and field:** Change the shape of the LFO waveform. The random waveform is smoothed and the sine and noise waveforms are saturated.

• **Early/Late Mix slider and field:** Set the level of early and late reflections. These vary depending on the Distance parameter value. See main view controls.

• **Width slider and field:** Set the stereo width of the reverb.

• **Mono Maker on/off button:** Turn on to remove stereo information below the frequency set with the corresponding slider.

• **Mono Maker slider and field:** Set a frequency below which stereo information is removed. This compensates for perceived level losses in the overall low frequency range.

### ChromaVerb room types in Logic Pro for Mac

The chosen room type defines the basic color of the reverb and determines the ranges in which controls operate. It also sets the absorption characteristics of the space and determines how the Size, Reverb Color, Density, and other parameters behave.

<table>
<thead>
<tr>
<th>Room Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room</td>
<td>Natural-sounding room with a rapid build-up of dense reflections.</td>
</tr>
<tr>
<td>Chamber</td>
<td>A punchy reverb that emulates a small to medium room. It has a fast attack and high echo density with low coloration.</td>
</tr>
<tr>
<td>Concert Hall</td>
<td>A large space with long delays in the initial sound, a slow build, minimal high end response, and moderate diffusion build.</td>
</tr>
<tr>
<td>Theater</td>
<td>A medium to large dry room with medium reflection density.</td>
</tr>
<tr>
<td>Synth Hall</td>
<td>Wider than the Room model with the sparsest reflections of all room types.</td>
</tr>
<tr>
<td>Digital</td>
<td>A medium room with midrange reflection density. It has a slower attack than the Room model. The decay is brighter and creates a lush-sounding chorus-like reverb. It has a dense reverb tail, with extended high and low response.</td>
</tr>
<tr>
<td>Dark Room</td>
<td>A small to medium sized, dark sounding, less dense room reverb.</td>
</tr>
<tr>
<td>Dense Room</td>
<td>A small room with a dense reflection pattern that builds very quickly.</td>
</tr>
<tr>
<td>Smooth Space</td>
<td>Smooth sounding reverb that emulates a medium size space.</td>
</tr>
<tr>
<td>Vocal Hall</td>
<td>A medium to large, smooth vocal hall with a midrange number of reflections.</td>
</tr>
<tr>
<td>Reflective Hall</td>
<td>A medium to large, highly reflective hall reverb with a low reflection density.</td>
</tr>
<tr>
<td>Airy</td>
<td>A large space with sparse reflections.</td>
</tr>
<tr>
<td>FX - Strange Room</td>
<td>A medium space with midrange reflection density and a distinct color.</td>
</tr>
<tr>
<td>FX - Bloomy</td>
<td>A large space reverb with moderate reflection density that creates blooming decays.</td>
</tr>
</tbody>
</table>
EnVerb in Logic Pro for Mac

EnVerb is a versatile reverb effect with a unique feature: it allows you to adjust the envelope—the shape—of the diffuse reverb tail. EnVerb is divided into two areas:

- **Time parameters**: The graphic display shows and lets you adjust levels over time (the envelope) of the reverb. You can control the delay time of the original signal and can change the reverb tail over time.

- **Sound parameters**: The controls below the envelope display shape the sound of the reverb signal. You can split the incoming signal into two bands with the Crossover parameter and can set the low frequency band separately.

To add EnVerb to your project, choose Reverb > EnVerb in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

---

### EnVerb time parameters

Drag parameter handles directly in the envelope display, or drag vertically in parameter fields to adjust EnVerb values.

- **Attack handle and field**: Set the time it takes for the reverb to climb to its peak level.

- **Decay handle and field**: Set the time it takes for the level of the reverb to drop from its peak to the sustain level.

- **Sustain (Hold) handle and field**: Drag vertically to set a constant reverb level for the sustain phase. It is expressed as a percentage of the full-scale volume of the reverb signal. See Hold parameter.

- **Release handle and field**: Set the time it takes for the reverb to fade out completely, after the sustain phase.

- **Dry Signal Delay handle and field**: Determine the delay of the original signal. Set a suitable level with the Dry slider in the Mix section.
• **Predelay field:** Set the time between the original signal and the start point of the reverb attack phase—the very beginning of the first reflection.

• **Hold (Sustain) handle and field:** Drag horizontally to set the duration of the reverb sustain phase. See Sustain parameter.

### EnVerb sound parameters

• **Density knob and field:** Set the reverb density.

• **Spread knob and field:** Control the width of the reverb stereo image. At 0% the effect generates a monaural reverb. At 200% the stereo base is artificially expanded.

• **High Cut knob and field:** Filter frequencies above the set value out of the reverb tail.

• **Crossover knob and field:** Set the frequency used to split the input signal into two frequency bands for independent processing.

• **Low Freq Level knob and field:** Set the relative level of (reverb signal) frequencies below the crossover frequency. In most cases you get better-sounding results when you set negative values for this parameter.

• **Dry/Wet sliders and fields:** Determine the balance between the effect (wet) and direct (dry) signals.

### SilverVerb in Logic Pro for Mac

SilverVerb provides a low frequency oscillator (LFO) that can modulate the reverberated signal. It also includes a high cut and a low cut filter, allowing you to filter frequencies from the reverb signal. High frequency transients in reverb signals can sound unpleasant, can hamper speech intelligibility, or can mask the overtones of the original signal. Long reverb tails with a lot of bass generally result in an indistinct mix.

To add SilverVerb to your project, choose Reverb > SilverVerb in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

### SilverVerb parameters

• **Predelay knob and field:** Set the time between the original signal and the reverb signal.

• **Reflectivity knob and field:** Define how reflective the imaginary walls, ceiling, and floor are.

• **Size knob and field:** Define the dimensions of the simulated room.

• **Density/Time knob and field:** Determine both the density and the duration of the reverb.
• **Low Cut slider and field:** Filter frequencies below the set value out of the reverb signal. This affects only the tone of the reverb signal, not the original signal.

• **High Cut slider and field:** Filter frequencies above the set value out of the reverb signal. This affects only the tone of the reverb signal, not the original signal.

• **Modulation On/Off button:** Enable or disable the LFO. This affects the Rate, Phase, and Intensity parameters.

• **Rate knob and field:** Set the frequency, or speed, of the LFO.

• **Phase knob and field:** Define the phase of the modulation between the left and right channels of the reverb signal.
  - At 0°, the extreme values (minimum or maximum) of the modulation are achieved simultaneously on both the left and right channels.
  - At a value of 180°, the extreme values opposite each other (left channel minimum, right channel maximum, or vice versa) are reached simultaneously.

• **Intensity slider and field:** Set the modulation amount. A value of 0 turns off the delay modulation.

• **Dry/Wet sliders and fields:** Set the balance between the effect (wet) and original (dry) signals.
Space Designer overview in Logic Pro for Mac

Space Designer is a convolution reverb effect that you can use to place your audio signals in exceptionally realistic recreations of real-world acoustic environments. Space Designer generates reverb by convolving, or combining, an audio signal with an impulse response reverb sample. An impulse response is a recording of reverb characteristics, or more precisely, a recording of all reflections in a given room following an initial signal spike. The actual impulse response file is a standard audio file.

To understand how this works, imagine a situation where Space Designer is used on a vocal track. An impulse response file recorded in an actual opera house is loaded into Space Designer. This impulse response file is convolved with your vocal track, placing the singer inside the opera house.

Convolution can be used to place your audio signal inside any space, including a speaker cabinet, a plastic toy, a cardboard box, and so on. All you need is an impulse response recording of the space.

In addition to loading impulse responses, Space Designer includes an on-board impulse response synthesis facility. This lets you create completely unique effects, particularly when the synthesized impulse response doesn’t represent a real space.

Space Designer also offers features such as envelopes, filters, Output EQ, and stereo/surround balance controls, which provide precise control over the dynamics, timbre, and length of the reverberation.

Space Designer can operate as a mono, stereo, true stereo (meaning each channel is processed discretely), or surround effect.

Automation and Space Designer

Space Designer cannot be fully automated—unlike most other Logic Pro plug-ins. This is because Space Designer needs to reload the impulse response and recalculate the convolution before audio can be routed through it.

You can, however, record, edit, and play back any movement of the following Space Designer parameters:

- X-Over. See Use Space Designer global controls.
- Direct and Reverb Output level. See Use Space Designer output controls.
- Output EQ. See Space Designer Output EQ.
To add Space Designer to your project, choose Reverb > Space Designer in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Space Designer interface in Logic Pro for Mac

The Space Designer interface consists of the following main sections:

- **Impulse response parameters**: Use to load, save, or manipulate recorded or synthesized impulse response files. The chosen impulse response file determines what Space Designer uses to convolve with your audio signal. See Use impulse responses.

- **Envelope, filter, and EQ parameters**: Use the buttons in the display mode bar to change the main display and parameter bar between envelope, filter, and EQ views. Use the main display to edit parameters graphically, or use the parameter bar to edit them numerically. See Space Designer envelopes and EQ overview and Space Designer filter and envelope.

- **Global parameters**: After your impulse response is loaded or generated, use these parameters to determine how Space Designer operates on the overall signal and impulse response. Included are input and output parameters, predelay, and more. See Space Designer global parameters.
Use impulse responses in Logic Pro for Mac

Space Designer can use either recorded impulse response files or synthesized impulse responses. The Sampled IR and Synthesized IR buttons choose the impulse response mode.

**Important:** To convolve audio in real time, Space Designer must first calculate any parameter adjustments to the impulse response. This requires a moment or two following parameter edits and is indicated by waveform changes in the main display.

### Impulse response parameters

- **Sampled IR button:** Turn on Sampled IR mode. In this mode, an impulse response sample is used to generate reverberation.

- **Synthesized IR button:** Turn on Synthesized IR mode. A new synthesized impulse response is generated, derived from the values of the Length, Envelope, Filter, EQ, and Spread parameters.

- **IR Sample pop-up menu:** Shows the name of the loaded impulse response. Click to choose an IR sample command. Also see Space Designer global parameters.
  - **Load IR:** Loads an impulse response sample without changing the envelopes.
  - **Load IR & Init:** Loads an impulse response sample and initializes all envelopes.
  - **Show in Finder:** Opens a Finder window that shows the location of the current impulse response.
  - **Open IR Utility:** Opens the Impulse Response Utility window. This application lets you create your own impulse response files.

- **IR Format display:** Shows the channel format of the loaded sample-based impulse response.
Several related parameters are shown below the main display.

- **Quality pop-up menu**: Choose the sample rate. Lo-Fi produces a grainy reverb. Low halves the host application sample rate. Medium matches the host application sample rate. High is smooth and clean sounding.

- **Reverse button**: Reverse the impulse response and envelopes. When the impulse response is reversed, you are effectively using the tail rather than the front end of the sample. You may need to adjust the Predelay and other parameter values when reversing. See Space Designer global parameters.

- **Length knob and field**: Adjust the length of the impulse response. This control works in conjunction with the Size knob.

- **Size knob and field**: Adjust the sample rate of the loaded impulse response file, thereby changing the perceived size of the reverb by widening or narrowing the room. Size can also be used to preserve the original length of the impulse response when changing the sample rate with the Quality pop-up menu.

  The Size knob value has an impact on the decay because it is multiplied with the Length knob value. To explain, when you rotate the Length knob to its maximum value and use a Size knob value of 100%, this results in a decay that is the full length of the loaded impulse response.

**Use Sampled IR mode**

In Sampled IR mode, Space Designer loads and uses an impulse response recording of an acoustic environment. This is convolved with the incoming audio signal to place it in the acoustic space provided by the impulse response.

1. In Logic Pro, click the Sampled IR button above the main display.
2. Click the Sample IR pop-up menu and choose Load IR.
3. Choose an impulse response file from any folder.

**Manage the loaded impulse response file**

- In Logic Pro, click the IR Sample pop-up menu to use any of the following commands:
  - **Load IR**: Loads an impulse response sample without changing the envelopes.
  - **Load IR & Init**: Loads an impulse response sample and initializes the envelopes.
  - **Show in Finder**: Opens a Finder window that shows the location of the current impulse response.
  - **Open IR Utility**: Opens the Impulse Response Utility window.

  This application lets you create your own impulse response files. It provides recording, editing, and processing facilities designed specifically for this task. See Impulse Response Utility Help in the Impulse Response Utility application for details.

All supplied impulse responses are installed in the /Library/Audio/Impulse Responses/Apple folder. Deconvolution files have an .sdir file extension.
Any mono or stereo AIFF or WAV file can be used as an impulse response. In addition, surround formats up to 7.1, discrete audio files, and B-format audio files that consist of a single surround impulse response can be used.

**Use Synthesized IR mode**

In Synthesized IR mode, Space Designer generates a synthesized impulse response based on the values of parameters such as Length, Filter, Spread, and various envelope values.

*Note:* You can switch between a loaded impulse response sample and a synthesized impulse response without losing the settings of the other.

- In Logic Pro, click the Synthesized IR button above the main display.

Repeated clicks of the Synthesized IR button randomly generate new impulse responses with slightly different reflection patterns. The current impulse response state is saved with the setting file, including parameter and other values that represent the IR reflection patterns and characteristics.

*Note:* Click the Synthesized IR button while you’re in Sampled IR mode to switch to the synthesized impulse response stored with the setting.

**Set the impulse response sample rate and preserve length**

Changing the sample rate upward increases—or changing it downward decreases—the frequency response (and length) of the impulse response, and to a degree the overall sound quality of the reverb. Upward sample rate changes are of benefit only if the original impulse response sample actually contains higher frequencies. When reducing the sample rate, use your ears to decide if the sonic quality meets your needs.

*Note:* Natural room surfaces—except concrete and tiles—tend to have minimal reflections in higher frequency ranges, making half-rate and full-rate impulse responses sound almost identical.

- In Logic Pro, choose one of the following from the Quality pop-up menu to set the sample rate of an impulse response:
  - **Lo-Fi:** This setting divides the sample rate by four. If the project sample rate is 96 kHz, the impulse response sample rate is converted to 24 kHz. If the project sample rate is 44.1 kHz, the impulse response sample rate is converted to 11.025 kHz, and so on.
• **Low:** This setting effectively halves the sample rate. If the project sample rate is 96 kHz, the impulse response sample rate is converted to 48 kHz. If the project sample rate is 44.1 kHz, the impulse response sample rate is converted to 22.05 kHz, and so on.

When you select a half sample rate, the impulse response becomes twice as long. The highest frequency that can be reverberated is halved. This results in a behavior that is much like doubling every dimension of a virtual room—multiplying the volume of a room by eight. The Low (and Lo-Fi) setting can also be used for interesting tempo, pitch, and retro digital effects. Another benefit of reducing the sample rate is that processing requirements drop significantly, making the lower quality settings useful for large, open spaces.

This behavior also applies when you choose Lo-Fi, but the sample rate is divided by four and the impulse response is multiplied in length four times.

• **Medium:** Space Designer uses the current project sample rate. The sample rate of a loaded impulse response is automatically converted to match the current project sample rate, if necessary. For example, this allows you to load a 44.1 kHz impulse response into a project running at 96 kHz, and vice versa.

• **High:** Space Designer uses the highest possible sample rate.

• **To retain the original length of the impulse response when the sample rate is changed:** Adjust the Size knob value. Using this parameter with your Quality pop-up menu choice can lead to interesting results.

If you’re running Space Designer in a project that uses a higher sample rate than the impulse response, you may also want to reduce the impulse response sample rate. Adjust the Size knob value to reduce CPU processing time without compromising reverb quality.

⚠️ **Tip:** You can make similar adjustments while running in Synthesized IR mode. Most typical reverb sounds don’t contain an excessive amount of high frequency content. If your project is running at 96 kHz, for example, you would need to use lowpass filtering to obtain the mellow frequency response characteristics of many reverb sounds. A better approach would be to first reduce the high frequencies by choosing a lower rate from the Quality pop-up menu, followed by using the lowpass filter, thus conserving significant CPU resources. It is also worth noting that longer impulse responses (sampled or synthesized) place a higher strain on the CPU.
Set impulse response lengths

In Logic Pro, rotate the Length knob to set the length of the impulse response—sampled or synthesized.

The Length knob setting changes the decay value, depending on the current Size knob value. To clarify, a maximum Length value and a Size value of 100% result in a decay that is the full length of the loaded impulse response.

All envelopes are automatically calculated as a percentage of the overall length. Changes to the Length or Size parameter values result in envelope curves stretching or shrinking to fit the new impulse response length.

Note: When you’re using a sampled impulse response file, the combined Length (and Size) parameter values cannot exceed the length of the underlying impulse response sample.

Space Designer envelopes and EQ

Space Designer envelopes and EQ in Logic Pro for Mac

The main display is used to show and edit envelope, filter, and Output EQ parameters. It consists of the display mode bar at the top, the main display itself, and the parameter bar.

- The display mode bar buttons are used to select the current envelope or Output EQ view/edit mode.
- The main display shows the impulse response waveform and all active envelopes. You can graphically edit envelopes or the Output EQ curve.
- The parameter bar displays and allows you to numerically edit the parameter values of the selected envelope or EQ curve. Parameter bar functions are discussed in each envelope section, in the Output EQ section, and in the filter section.
Space Designer display mode bar in Logic Pro for Mac

The display mode bar is used to set the main display and parameter bar to envelope and Output EQ views.

- **In Sampled IR mode**: The IR Sample pop-up menu is shown in the display mode bar, beside the Volume Env and Filter Env buttons. See Use impulse responses.

![Space Designer display mode bar in Logic Pro for Mac](image1)

- **In Synthesized IR mode**: The Density Env buttons are shown in the display mode bar, beside the Volume Env and FilterEnv buttons. See Space Designer density envelope.

![Space Designer display mode bar in Logic Pro for Mac](image2)

**Display mode bar parameters**

- **Volume Env On/Off button**: Turn the volume envelope on or off.
- **Volume Env button**: Show the volume envelope in the foreground of the main display. Other active envelope curves are shown as transparencies in the background. See Space Designer volume envelope.
- **Filter Env On/Off button**: Turn the filter envelope on or off. This also automatically turns the filter on or off.
- **Filter Env button**: Show the filter envelope in the foreground of the main display. Other active envelope curves are shown as transparencies in the background. See Space Designer filter and envelope.
- **Density Env On/Off button**: Turn the density envelope on or off.
- **Density Env button**: Show the density envelope in the foreground of the main display. Other active envelope curves are shown as transparencies in the background. See Space Designer density envelope.

  Note: The density envelope is available only in Synthesized IR mode.

- **Output EQ On/Off button**: Turn the Output EQ on or off.
- **Output EQ button**: Show the six-band Output EQ in the main display. See Space Designer Output EQ.

**Edit Space Designer envelopes in Logic Pro for Mac**

You can edit the volume and filter envelope of sampled or synthesized impulse responses. You can also alter the density envelope of synthesized impulse responses. All envelopes can be adjusted graphically in the main display, or numerically in the parameter bar.

The combined total of the volume and filter envelope Attack and Decay time parameter values is equal to the length of the synthesized or sampled impulse response, unless the decay time is reduced. See Use impulse responses.
The positions of nodes in the main display indicate the current parameter value shown in the parameter bar below—for Init Level, Attack, Decay, and other envelope parameter values. If you edit any numerical value in the parameter bar, the corresponding node moves in the main display, and vice-versa.

**Change an envelope value numerically in Space Designer**

- In Logic Pro, vertically drag the parameter field—Attack, for example—in the parameter bar at the bottom of the main display.
  
  The corresponding node (including associated nodes, if applicable) moves in the main display.

**Move an envelope node graphically in Space Designer**

- In Logic Pro, drag the node (large, solid circle) in any available direction.
  
  The corresponding field value changes in the parameter bar below the main display.

  *Note:* Some nodes change multiple field values.

**Change Space Designer envelope curve shapes**

Make sure that *Show Bezier Handles* is active in the Action pop-up menu at the top right of the global parameters.

1. In Logic Pro, drag the envelope curve (the line itself) in the main display.

2. Drag the small nodes (hollow circles) attached to a line for fine adjustments to envelope curves. These nodes are tied to the envelope curve itself, so you can view them as handles that you use to change the shape of the envelope curve.
Space Designer volume envelope in Logic Pro for Mac

The volume envelope is used to set the reverb initial level and to control volume changes over time. You can edit all volume envelope parameters numerically, and you can also edit many of them graphically. See Edit Space Designer envelopes.

Volume envelope parameters

- **Init Level field and node**: Set the initial volume level of the impulse response attack phase. Drag the node vertically. It is expressed as a percentage of the full-scale volume of the impulse response file. The attack phase is generally the loudest point of the impulse response. Set Init Level to 100% to ensure maximum volume for early reflections.

- **Attack field and node**: Determine the time before the decay phase of the volume envelope begins. Drag the node horizontally.

- **Decay field**: Set the length of the decay phase.

  *Note*: The overall decay is determined by the global Length and Size parameter values. To explain, a maximum Length value and a Size value of 100% result in a decay that is the full length of the loaded impulse response.

- **LIN button**: The decay curve of the volume envelope is shaped by a linear algorithm, and results in a less natural-sounding reverb tail.

- **EXP button**: The decay curve of the volume envelope is shaped by an exponential algorithm, in order to generate the most natural-sounding reverb tail.

- **End Level field**: Set the end volume level. It is expressed as a percentage of the overall volume envelope. Drag the node vertically. Horizontal drag sets the Decay time.
  - If set to 0%, the reverb tail fades out completely towards the end of the Decay time.
  - If set to a higher value, the reverb tail will not have faded out completely at the end of the Decay time, which stops the reverb abruptly at that point. If the end time falls outside the reverb tail, End Level has no effect.

- **Decay / End Level node**: Drag the node horizontally to set the Decay value. Drag the node vertically to set the End Level value.

- **Envelope curve**: Drag the curve line to change the shape of the associated volume envelope phase.

- **Bezier handles**: Drag the hollow nodes to change the associated volume envelope phase between linear, exponential, logarithmic, or s-curve shapes.
Space Designer filter and envelope in Logic Pro for Mac

The filter provides control over the timbre of the reverb.

You can choose from several filter types and also have envelope control over filter cutoff. Changes to filter settings result in a recalculation of the impulse response rather than a direct change to the sound as it plays through Space Designer.

The main filter parameters are shown at the right side of the parameter bar when the filter envelope is selected in the main display.

Click the Filter Env On/Off button to turn the filter envelope and the filter itself on or off. You can use the envelope to control the filter cutoff frequency over the duration of the reverb. You can adjust all filter envelope parameters, either numerically in the parameter bar or graphically in the main display using the techniques discussed in Edit Space Designer envelopes.

Main filter parameters

- *Filter type pop-up menu:* Set the filter type.
  - *LP 6dB:* Bright, general-purpose lowpass filter that retains the top end of most material while still providing some filtering.
  - *LP 12dB:* Warm, lowpass filter without drastic filter effects that is useful for smoothing bright reverbs.
  - *BP:* 6 dB per octave bandpass design that cuts the low and high ends of the signal, leaving the frequencies around the cutoff frequency intact.
  - *HP:* 12 dB per octave (two-pole) highpass design that cuts the level of frequencies that fall below the cutoff frequency.
  - *Res(onance) field:* Emphasize frequencies above, around, or below the cutoff frequency. The impact of the resonance value on the sound is highly dependent on the chosen filter mode, with steeper filter slopes resulting in more pronounced tonal changes.

Filter envelope parameters

- *Init Freq field and node:* Set the initial cutoff frequency of the filter envelope. Drag the node vertically.
- *Attack field:* Determine the time required to reach the Break Level.
- *Break Level field:* Set the filter cutoff frequency that is reached at the end of the Attack phases. From there, the Decay phase of the envelope starts to reach the cutoff frequency set by the End Freq point. You can create interesting filter sweeps by setting the Break Level value lower than the Init Level parameter value.
• **Decay field**: Determine the time required after the frequency value of the Break Level point to reach the End Freq value.

• **Attack / Break Level / Decay node**: Drag the node horizontally to set the Attack value. Drag the node vertically to set the Break Level value. The node position also affects the Decay value.

• **End Freq field**: Set the cutoff frequency at the end of the filter envelope decay phase.

• **Decay / End Freq node**: Drag the node horizontally to set the Decay value. Drag the node vertically to set the End Freq value.

• **Envelope curve**: Drag the curve line to change the shape of the associated filter envelope phase.

• **Bezier handles**: Drag the hollow nodes to change the associated filter envelope phase between linear, exponential, logarithmic, or s-curve shapes.

**Space Designer density envelope in Logic Pro for Mac**

The density envelope controls the density (the average number of reflections) of the synthesized impulse response over time. You can adjust the density envelope numerically in the parameter bar, and you can graphically edit the Init Density, Ramp Time, and End Density parameters using the techniques described in Edit Space Designer envelopes.

**Note**: The density envelope is available only in Synthesized IR mode.

![Density envelope interface](image)

**Density envelope parameters**

• **Init Density field and node**: Set the initial reverb density (the average number of reflections in a given time period). Low values result in audible reflection patterns and discrete echoes. Drag the node vertically.

• **Ramp Time field**: Adjust the time between the Initial and End Density values.

• **End Density field**: Set the density of the reverb. An End Density value that’s too low can result in a grainy sounding reverb tail. The stereo spectrum may also be affected by lower values.
- **Ramp Time / End Density node**: Drag the node horizontally to set the Ramp Time value. Drag vertically to set the End Density value.

- **Reflection Shape field**: Determine the steepness (shape) of early reflection clusters as they bounce off the walls, ceiling, and furnishings of the virtual space.

  Low values result in clusters with a sharp contour. High values result in an exponential slope and a smoother sound. Reflection Shape is useful when recreating rooms constructed of different materials. When used with suitable envelope, density, and early reflection settings, you can create rooms of almost any shape and material.

**Space Designer Output EQ in Logic Pro for Mac**

Space Designer has a six-band Output EQ consisting of high and low pass bands, two parametric mid-bands, plus a low shelving filter and a high shelving filter. You can edit EQ parameters numerically in the parameter bar or graphically in the main display.

![Output EQ](image)

**Output EQ parameters**

- **EQ On/Off button**: Turn the Output EQ on or off. When on you can adjust the frequencies of the overall combined reverb and source signal.

- **Band 1 On/Off button**: Turn a highpass filter on or off. This filter allows high frequencies to pass and cuts the level of low frequencies below the set frequency. When active, you can change band parameters directly in the graphic display.

  - **Band 1 background and node**: Drag the red shaded area or node horizontally to change frequency. Drag vertically to change the Q value (when 12dB/Oct is chosen in Order pop-up menu).

- **Band 2 On/Off button**: Turn the low shelving filter on or off. This filter increases or decreases the frequencies below/above the Frequency value. When active, you can change band parameters directly in the graphic display.

  - **Band 2 background and node**: Drag the orange shaded area or node horizontally to change frequency. Drag vertically to change gain. Command-Option drag vertically to set the Q value.
• **Band 3 On/Off button:** Turn a parametric bell filter on or off. Frequency sets a center frequency. Q sets the width of the frequency band around the center frequency. Gain sets the level of the band. When active, you can change band parameters directly in the graphic display.

  • **Band 3 background and node:** Drag the green shaded area or node horizontally to change frequency. Drag vertically to change gain. Command-Option drag vertically to set the Q value.

• **Band 4 On/Off button:** Turn a parametric bell filter on or off. Frequency sets a center frequency. Q sets the width of the frequency band around the center frequency. Gain sets the level of the band. When active, you can change band parameters directly in the graphic display.

  • **Band 4 background and node:** Drag the blue shaded area or node horizontally to change frequency. Drag vertically to change gain. Command-Option drag vertically to set the Q value.

• **Band 5 On/Off button:** Turn a high shelving filter on or off. This filter increases or decreases the frequencies below/above the Frequency value. When active, you can change band parameters directly in the graphic display.

  • **Band 5 background and node:** Drag the purple shaded area or node horizontally to change frequency. Drag vertically to change gain. Command-Option drag vertically to set the Q value.

• **Band 6 On/Off button:** Turn a lowpass filter on or off. This filter allows low frequencies to pass and cuts the level of high frequencies above the set frequency. When active, you can change band parameters directly in the graphic display.

  • **Band 6 background and node:** Drag the pink shaded area or node horizontally to change frequency. Drag vertically to change the Q value (12dB/Oct active in Order pop-up menu).

• **Frequency field or background:** Set the cutoff, center, or knee frequency for the selected EQ band.

• **Gain field:** Cut or boost the selected EQ band (bands 2 to 4).

• **Order pop-up menu:** Choose the filter rolloff amount for the highpass and lowpass filter bands (bands 1 and 6). Higher order filters have a steeper rolloff.

• **Q field:** Set the Q factor—the width—for the selected band. High values result in a narrow frequency band selection. Low values encompass a broad frequency band.

**Use the Output EQ graphic display**

The graphic display shows the current curve of each EQ band. The color of each band matches the corresponding button above the display. Each band (and corresponding Frequency, Gain, Order, and Q field) is highlighted as you move the pointer across it.

Click a curve line segment, the (frequency) node, or anywhere in the space between the zero line and EQ curve to adjust the band.

Click the node to select a band for editing. Once a band is selected, no other band node that falls within the active area of the selected band can be selected.
Click the graphic display background (outside a band) to deselect the selected band.

- **Band 1 and 6:**
  - Drag the node or the band background to adjust the Frequency value.
  - Option-Command drag the node to adjust the Frequency and Q value.
    
    *Note: Q values are only available when the Order parameter is set to 12dB/Oct.*

- **Bands 2 to 5:**
  - Drag the node or the band background to adjust the Frequency and Gain value.
  - Option-Command drag the node or the band background to adjust the Frequency and Q value.

- **Additional gestures:**
  - Hold down Command while dragging to limit dragging to vertical or horizontal movement.
  - Use a two-finger vertical swipe with the trackpad, or a single-finger vertical swipe with the Magic Mouse, to adjust the Q value of the selected band.

### Space Designer global parameters

#### Space Designer global parameters in Logic Pro for Mac

The global parameters affect the overall input, output, or behavior of the effect. See [Space Designer global controls](#) and [output controls](#).

*Note: Some parameters discussed in this section are available only in Sampled IR or Synthesized IR mode. Most parameters are available in both modes. Some parameters are specific to stereo or surround use, and are not shown when Space Designer is used in other channel formats.*

![Space Designer global parameters](image)

#### Global parameters

- **Quality pop-up menu:** Choose the sample rate. Lo-Fi produces a grainy reverb. Low halves the host application sample rate. Medium matches the host application sample rate. High is smooth and clean sounding.

- **IR Offset field:** Set the playback start point in the impulse response sample. The IR Offset parameter is not available for use in Synthesized IR mode.

- **Reverse button:** Reverse the impulse response and envelopes. When the impulse response is reversed, you are effectively using the tail rather than the front end of the sample. You may need to adjust the Predelay and other parameter values when reversing.
• **Definition field:** Set a value (as a percentage of the overall length) to reduce the resolution of the synthesized impulse response tail. This emulates reverb diffusion and saves CPU resources.

• **Action menu:** Choose a menu command or turn plug-in features on or off.
  - **Reset Selected Envelope:** Reset the currently displayed envelope to default values.
  - **Reset All Envelopes:** Reset all envelopes to default values.
  - **Reset EQ:** Reset the Output EQ to default values.
  - **Latency Compensation:** Turn the internal latency compensation feature on or off. When turned on, the direct signal in the output section is delayed to match the processing delay of the effect signal.

  The complex calculations made by Space Designer take a small amount of time, which results in a processing delay, or latency, between the direct input signal and the processed output signal. Space Designer processing latency increases if Low or Lo-Fi is chosen in the Quality pop-up menu. Processing latency does not increase in surround mode or at sample rates above 44.1 kHz (Medium or High Quality pop-up menu settings).

  **Note:** This compensation feature is not related to latency compensation in Logic Pro; it occurs entirely within Space Designer.

  • **Volume Compensation:** Turn the internal impulse response volume matching function on or off.

  The reverb volume compensation feature attempts to match the perceived—not the actual—volume differences between impulse response files. It should generally be left on, although it may not work with all types of impulse responses. If you have an impulse response that is of a different level, turn off volume compensation, then adjust input and output levels accordingly.

  • **Show Bezier Handles:** Turn on to view envelope curve handles (nodes) in the main display. These let you precisely reshape envelopes. See Edit Space Designer envelopes.

  • **Input slider:** Determine how Space Designer processes the stereo input signal. See Use Space Designer global controls.

  • **Predelay sync button:** Turn on to restrict Predelay knob values to divisions synchronized with the project tempo.

  • **Predelay knob and field:** Set the reverb predelay time, or time between the original signal and the first reflections from the reverb. See Space Designer global controls.

  • **Length knob and field:** Adjust the length of the impulse response. This control works in conjunction with the Size knob.

  • **Size knob and field:** Adjust the perceived size of the space by widening or narrowing the room. Size can also be used to preserve the original length of the impulse response when changing the sample rate with the Quality pop-up menu.

  The Size knob value has an impact on the decay because it is multiplied with the Length knob value. To explain, a Length knob value of 100% and a Size knob value of 100% result in a decay that is the full length of the loaded impulse response.

  • **Refi Shape knob and field:** Adjust to change the perceived shape of the room in surround instances. This control alters the spacing of early reflections.
Global output parameters

• **X-Over slider and field**: The X-Over slider sets the crossover frequency. Any impulse response frequency that falls below this value is affected by the Lo Spread knob. Frequencies above are affected by the Hi Spread knob. See Use Space Designer output controls.

• **Lo/Hi Spread controls and fields**: The Spread controls set the perceived width of the stereo field.

  Note: No Spread controls are shown in the Sampled IR mode of surround instances.

• **LFE to Rev slider and field**: Adjust the level of the LFE channel from the source signal that is sent to the reverb input.

  Note: The multichannel reverb output doesn't have an LFE channel.

• **C(enter) slider and field**: Set the output level of the center channel (of the multichannel reverb output) independently of other surround channels.

• **Bal(ance) slider and field**: Set the balance of the reverb output between the front channels (Lm-L-R-Rm) and the rear channels (Ls-Rs). The center channel is not affected.
  
  • In 7.1 ITU surround, the balance pivots around the Lm-Rm speakers, taking the surround angles into account.
  
  • In 7.1 SDDS surround, the Lc-Rc speakers are considered front speakers. In surround formats that contain height channels, two Balance sliders are shown:
  
  • **Balance Bottom/Top slider and field**: Balance the reverb output between ear-level speakers (value of 0) and height speakers (value of 1). This doesn’t affect the center channel reverb output.
  
  • **Balance Front/Rear slider and field**: Balance the reverb output between rear speakers (value of 0) and front speakers (value of 1). This applies to ear-level and height speakers, but not the center channel reverb output.

• **Dry/Wet sliders and fields**: Set output levels for the dry (source) and wet (effect) signal.

Use Space Designer global controls in Logic Pro for Mac

Space Designer global parameters affect the overall input, output, or behavior of the plug-in. See Space Designer global parameters and output controls.

The tasks below cover the use of Space Designer global parameters.
Use the Space Designer Input slider
The Input slider works only in stereo channel configurations. It is not shown in mono or surround channels.

• In Logic Pro, drag the Input slider to determine how a stereo signal is processed.
  • Stereo setting (top of slider): The left and right input channels of the reverb are processed individually, retaining the stereo balance of the original signal.
  • Mono setting (middle of slider): The left and right input channels are summed together and processed as a mono signal.
  • XStereo setting (bottom of slider): The signal is inverted, with processing for the right channel occurring on the left, and vice versa.
  • In-between positions: A mixture of stereo to mono crossfeed signals is produced.

Use the Space Designer Definition parameter
The Definition parameter emulates the diffusion of natural reverb patterns when in Synthesized IR mode.

Natural reverbs contain most of their spatial information in the first few milliseconds. Toward the end of the reverb, the pattern of reflections—signals bouncing off walls, and so on—becomes more diffuse. In other words, the reflected signals become quieter and increasingly nondirectional, containing far less spatial information. To emulate this phenomenon, use the full impulse response resolution only at the onset of the reverb, then use a reduced impulse response resolution toward the end of the reverb.

• In Logic Pro, vertically drag the Definition field at the top of the global parameters section to set the crossover point—where the transition to the reduced impulse response resolution occurs.
  The Definition field is shown as a percentage, where 100% is equal to the length of the full resolution impulse response.

Use the Space Designer predelay feature
Predelay is the amount of time that elapses between the original signal and the initial early reflections of the reverberation. For a room of any given size and shape, predelay is determined by the distance between the listener and the walls, ceiling, and floor. Space Designer lets you adjust this parameter beyond the range that would be considered natural.

• In Logic Pro, rotate the Predelay knob to set a suitable predelay time.
  The ideal predelay setting for different sounds depends on the properties of—or more accurately, the envelope of—the original signal. Percussive signals generally require shorter predelays than signals where the attack fades in gradually, such as strings. A good rule of thumb is to use the longest predelay possible before undesirable side effects, such as an audible echo, begin to materialize.

In practice, an extremely short predelay tends to make it difficult to pinpoint the position of the signal source. It can also color the sound of the original signal. On the other hand, an excessively long predelay can be perceived as an unnatural echo. It can also divorce the original signal from its early reflections, leaving an audible gap between the original and reverb signals.
These guidelines are intended to help you design realistic-sounding spaces that are suitable for various signals. If you want to create unnatural sound stages or otherworldly reverb and echoes, experiment with the Predelay parameter.

**Change the impulse response start point**

The IR Offset parameter affords a number of options that can be quite creative, particularly when combined with the Reverse function. See Space Designer global parameters.

*Note:* The IR Offset parameter is not shown in Synthesized IR mode.

- In Logic Pro, vertically drag the IR Offset field at the top of the global parameters section to shift the playback start point of the impulse response.

  This effectively cuts off the beginning of the impulse response, which can be useful for eliminating level peaks at the start of the sample.

**Use Space Designer output controls in Logic Pro for Mac**

Space Designer global parameters affect the overall input, output, or behavior of the effect. See Space Designer global parameters and Use Space Designer global controls.

The tasks below cover the use of Space Designer output parameters.

**Set Space Designer mono/stereo output parameters**

In Logic Pro, use the output parameters to adjust the balance between the direct (dry) signals and the processed (wet) signals. The parameters that are available depend on the input configuration.

Space Designer provides two output sliders—the Dry slider for the direct signal, and the Wet slider for the reverb signal.

- *Set the level of the Dry slider:* Move to set the level of the non-effect, or dry, signal. Move the slider to a value of 0 (mute) if Space Designer is inserted in an aux channel strip (used as an effect return) or when you’re using modeling impulse responses, such as speaker simulations.

- *Set the level of the Wet slider:* Move to adjust the level of the effect signal.

**Set Space Designer surround output parameters**

In Logic Pro, use the output parameters to adjust the balance between the direct, or dry, signal and processed signals. The parameters that are available depend on the input configuration.
In surround configurations, Space Designer provides up to four sliders that together comprise a small surround mixer, in addition to the Dry and Wet sliders.

![Slider Image]

When you choose surround formats that include height channels, this changes the appearance of parameters, and the operation of surround faders.

- **Set the level of the LFE to Rev slider**: Adjust the level of the LFE channel from the source signal that is sent to the reverb input.
  
  *Note*: The multichannel reverb output doesn't have an LFE channel.

- **Set the level of the C(enter) slider**: Adjust the output level of the center channel (of the multichannel reverb output) independently from other surround channels.

- **Set the the Bal(ance) slider**: Move to balance between the front (Lm-L-R-Rm) and the rear channels (Ls-Rs). The center channel is not affected.
  
  - In 7.1 ITU surround, the balance pivots around the Lm-Rm speakers, taking the surround angles into account.
  
  - In 7.1 SDDS surround, the Lc-Rc speakers are considered front speakers.

  In surround formats that contain height channels, two Balance sliders are shown:

  - **Balance Bottom/Top slider and field**: Balance the reverb output between ear-level speakers (value of 0) and height speakers (value of 1). This doesn’t affect the center channel reverb output.

  - **Balance Front/Rear slider and field**: Balance the reverb output between rear speakers (value of 0) and front speakers (value of 1). This applies to ear-level and height speakers, but not the center channel reverb output.

- **Set the level of the Dry slider**: Move to set the overall level of the non-effect signal for all channels. Move the slider to a value of 0 (mute) when using Space Designer as a bus effect in an aux channel strip. Use the Send knob of each bussed channel strip to control the wet/dry balance.

- **Set the level of the Wet slider**: Move to adjust the output level of the effect, or wet, signal for all channels.
Use the Space Designer Spread parameters

The X-Over (crossover) slider setting and Hi and Lo Spread knob values enhance the perceived width of the signal. This occurs without losing the directional information of the input signal normally found in the higher frequency range. Low frequencies are spread to the sides, reducing the amount of low frequency content in the center—allowing the reverb to encompass the mix.

- *In Logic Pro, set the level of the Spread knob(s) and field(s):* Rotate to extend the stereo base to frequencies below or above the frequency determined by the X-Over parameter.
  - At a Spread value of 0.00, no stereo or surround information is added. The inherent stereo or surround information of the source signal and reverb is retained.
  - At a Spread value of 1.00, divergence between the left and right channels is at its maximum.
    
    *Note:* No Spread controls are shown in the Sampled IR mode of surround instances.

- *Set the X-Over slider and field value:* Set the crossover frequency in hertz. Any impulse response frequency below or above the value you set is affected by the Lo and Hi Spread parameters (at values over zero).

*Note:* These parameters have no impact when you use Space Designer as a mono plug-in.
Specialized effects

Specialized effects in Logic Pro for Mac

Logic Pro includes specialized effects designed to address tasks encountered during production or performance.

The **Exciter** plug-in adds life to your recordings by generating artificial high frequency components.

**SubBass** generates an artificial bass signal that is derived from the incoming signal, making it a great option for adding bottom end.

If you’re new to using plug-ins in Logic Pro, see [Add, remove, move, and copy plug-ins](#).

Exciter in Logic Pro for Mac

Exciter generates high frequency components that are not part of the original signal. It does this by utilizing a nonlinear distortion process that resembles the one used to produce overdrive and distortion effects.

Unlike this process, however, the Exciter distortion process involves passing the input signal through a highpass filter before feeding it into the harmonics (distortion) generator. Artificial harmonics are thus added to the original signal, and these added harmonics contain frequencies at least one octave above the threshold of the highpass filter. The distorted signal is then mixed with the original, dry signal.

You can use Exciter to add life to recordings, particularly audio tracks with a weak treble frequency range. You can also use Exciter to enhance guitar tracks.
To add Exciter to your project, choose Specialized > Exciter in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

**Exciter parameters**

- *Frequency field:* Drag vertically to set the cutoff frequency of the highpass filter. The input signal passes through the filter before (harmonic) distortion is introduced.
- *Frequency display:* Shows the frequency range used as the source signal for the excite process. You can drag the green line or handle to set the cutoff frequency.
- *Dry Signal button:* Turn on to mix the original (pre-effect) signal with the effect signal. Turn off to hear only the effect signal.
- *Harmonics knob and field:* Set the ratio between the effect and the original signals. If the Dry Signal button is turned off, this parameter has no effect.

*Note:* In most cases, it is preferable to select higher Frequency and Harmonics values, because human ears cannot easily distinguish between the artificial and original high frequencies.

- *Color 1 and 2 buttons:* Turn on Color 1 to generate a less dense harmonic distortion spectrum. Color 2 generates more intense harmonic distortion.

*Note:* Color 2 also introduces more intermodulation distortions, which can result in unpleasant artifacts.

**SubBass**

**SubBass overview in Logic Pro for Mac**

SubBass generates frequencies below those of the original signal, resulting in artificial bass content. The simplest use for SubBass is as an octave divider, similar to octaver effect pedals for electric bass guitars. Whereas such pedals can only process a monophonic input sound source of clearly defined pitch, SubBass can be used with complex summed signals as well.

To add SubBass to your project, choose Specialized > SubBass in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.
SubBass creates two bass signals, derived from two separate portions of the incoming signal. These are defined with the High and Low parameters. See SubBass parameters.

WARNING: Using SubBass can produce extremely loud output signals. Choose moderate monitoring levels, and only use loudspeakers that are actually capable of reproducing the very low frequencies produced. Never try to force a loudspeaker to output these frequency bands with an EQ.

SubBass parameters in Logic Pro for Mac

SubBass provides the following parameters.

SubBass parameters

- **High Ratio knob and field**: Adjust the ratio between the generated signal and the upper frequency band of the original signal.
- **High Center knob and field**: Set the center frequency of the upper frequency band.
- **High Bandwidth knob and field**: Set the width of the upper frequency band.
- **Graphic display**: Shows the selected upper and lower frequency bands.
- **Freq. Mix slider and field**: Adjust the mix ratio between the upper and lower frequency bands.
- **Low Ratio knob and field**: Adjust the ratio between the generated signal and the lower frequency band of the original signal.
- **Low Center knob and field**: Set the center frequency of the lower frequency band.
- **Low Bandwidth knob and field**: Set the width of the lower frequency band.
- **Dry slider and field**: Set the amount of dry (non-effect, original) signal.
- **Wet slider and field**: Set the amount of wet (effect) signal.
SubBass use tips in Logic Pro for Mac

Unlike a pitch shifter, SubBass generates a waveform that is not based on the waveform of the input signal; instead it uses a sine wave. Given that pure sine waves rarely work well in complex arrangements, make sure to use the Wet and Dry sliders to control the amount of—and balance between—the generated and original signals.

Use the High parameters and the Low parameters to define the two frequency bands that SubBass uses to generate tones. High Center and Low Center define the center frequency of each band, and High Bandwidth and Low Bandwidth define the width of each frequency band.

The High Ratio and Low Ratio knobs define the transposition amount for the generated signal in each band. This is expressed as a ratio of the original signal. For example, a Ratio value of 2 transposes the signal down one octave.

Important: Within each frequency band, the filtered signal should have a reasonably stable pitch in order to be analyzed correctly.

In general, narrow bandwidths produce the best results, because they minimize frequency intermodulations which can lead to unpleasant artifacts. Set the High Center knob value a fifth higher than Low Center, a factor of 1.5 for the center frequency.

Derive the sub-bass to be synthesized from the existing bass portion of the signal, and transpose by one octave in both bands, using a Ratio of 2. Do not overdrive the process or you will introduce distortion. If you hear frequency gaps, move one or both Center frequency knobs, or widen the Bandwidth of one or both frequency ranges a little.

⚠️ Tip: Be prudent when using SubBass, and compare the extreme low frequency content of your mixes with other productions. It is very easy to over-enhance the low end of some tracks, resulting in an unbalanced mix.
Utilities and tools

Utilities and tools in Logic Pro for Mac

The tools found in the Utility category can help with routine tasks and situations you may encounter during production. Examples include the Gain plug-in, which you can use to adjust the level or phase of input signals, and I/O utility, which you can use to integrate external audio effects into Logic Pro for Mac channel strips. Also included is Auto Sampler, which simplifies the creation of sampler instruments.

The suite also includes a Test Oscillator and the Tuner utility and plug-in, which is found in the Metering tools.

If you’re new to using plug-ins in Logic Pro for Mac, see Add, remove, move, and copy plug-ins.

Auto Sampler

Auto Sampler overview in Logic Pro for Mac

Auto Sampler makes it easy to create sampler instruments that you can use in MainStage and Logic Pro. You can create a sampler instrument from a MIDI-capable hardware synthesizer, from a software instrument, or from a combination of synthesizers, software instruments, and effect plug-ins.

You add Auto Sampler to an Audio FX slot in a channel strip. The type and location of the channel strip determine what is captured to the resulting sampler instrument. For example:

- Insert Auto Sampler in a software instrument channel strip to capture a software instrument.
- Insert Auto Sampler in an external instrument channel strip to capture a hardware synthesizer.
Where you place Auto Sampler in the signal chain, relative to other plug-ins, determines whether those plug-ins become part of the sound of the resulting sampler instrument.

- Plug-ins placed \textit{before} Auto Sampler in the signal chain are part of the sound of the resulting sampler instrument.
- Plug-ins placed \textit{after} Auto Sampler in the signal chain are \textit{not} part of the sound of the resulting sampler instrument.

\textit{Note}: Using effects when creating a sampler instrument is a creative process, but is different from using effects in real time in two ways: first, effects are applied to each sampled note, not on multiple notes or chords; and second, effects parameters cannot be edited or automated to produce changes in the sound over time.

The format of AutoSampler (mono or stereo) matches the channel strip format.

\textbf{Auto Sampler interface in Logic Pro for Mac}

After inserting Auto Sampler in an Audio FX slot in a channel strip, you open the Auto Sampler window. The Auto Sampler window includes the following controls:

- \textit{Preset pop-up menu}: Choose presets for various Auto Sampler uses.
- \textit{Keyboard}: Shows the key range as well as the actual notes to be sampled (in blue). You can adjust the key range by dragging the edges of the Sample Note Range rectangle overlaid on the keyboard. The keyboard is also “live;” you can play notes by clicking keys.
- Auto Sampler main controls: Use to set the key range, which notes are sampled, the sustain length, the number of velocity layers sampled, whether samples are auto-looped, and other settings. See controls and parameters.
- \textit{Graphic display}: Serves two functions. When you play notes, shows the level and indicates whether played notes are clipping. During the sampling process, shows the waveform of the sound currently being sampled.
• **Input Gain slider:** Adjust the input gain so notes are sampled at a sufficiently high level, without clipping. You can play notes on the keyboard display and view the levels in the graphic display to see if any notes are clipping (appear red). If notes clip, reduce the input gain level until no clipping occurs.

  *Note:* The Input Gain slider controls only the input recording level to Auto Sampler, not the channel strip volume.

• **Sample button:** Click Sample to start the process of creating a sampler instrument.

### Auto Sampler controls in Logic Pro for Mac

The following lists the Auto Sampler controls, with brief descriptions of their functions.

• **Range Start field and slider:** Drag vertically to set the lowest note of the key range. You can also drag the left Sample Note Range handle in the keyboard display.

• **Range End field and slider:** Drag vertically to set the highest note of the key range. You can also drag the right Sample Note Range handle in the keyboard display.

• **Sample Every field and slider:** Drag vertically to set the interval between sampled notes in semitones.

• **Round Robin pop-up menu:** Choose the number of times each sample is captured to provide sound variations for more realistic sample playback (if the source provides sound variations). Choose No to capture each sample only a single time (no round robin).

• **Sustain field and slider:** Drag vertically to set the duration that the note is sampled (before its release phase begins) in seconds. Percussion and other short-duration sounds are shortened after sampling if the end contains complete silence.

  For notes (pitched sounds), a Sustain value of 10 seconds or more is recommended.

• **Velocity Layers pop-up menu:** Choose the number of velocity layers to sample. The default is 1. To sample multiple velocity layers, the source instrument must respond to MIDI Velocity as well as MIDI Note messages.

• **Velocity Response pop-up menu:** When multiple velocity layers are sampled, choose a velocity response curve:
  
  • **Linear:** Divides the Velocity span region equally. This is the default, and is recommended for most situations.
  
  • **Exp1-Exp3:** Gradually render the Velocity curve more exponentially. After the Velocity high and low parameters are set, more zones are sampled next to the High Velocity setting. This results in more zones with smaller Velocity spans, and lower Velocity zones that span more Velocity values.
  
  • **Log1-Log3:** Gradually render the Velocity curve more logarithmically. After the Velocity high and low parameters are set, more zones are sampled next to the Low Velocity setting. This results in more zones with smaller Velocity spans, and higher Velocity zones that span more Velocity values.
• **Velocity Editor:** View and edit velocity layers. Hold the pointer over the Velocity Layers and Velocity Response pop-up menus to show the Velocity editor in the lower part of the window. Each velocity layer appears as a horizontal line, with its velocity value displayed. You can drag lines vertically to adjust their velocity value. When you manually adjust velocity layers in the Velocity editor, the Velocity Response value changes to Custom.

• **Auto Loop pop-up menu:** Choose if loop points are automatically determined by Auto Sampler, and if so, which method or algorithm to use.
  - **None:** No auto-looping is performed.
  - **Search:** The audio content is analyzed and the optimal loop in each sample is set, without adding a loop crossfade. This is useful if the sampled sound contains clearly looping sections.
  - **Search with XFade:** The audio content is analyzed and the optimal loop in each sample is set, with a loop crossfade also added to smooth the loop. This is useful if the sampled sound contains clearly looping sections.
  - **Search with Rev XFade:** The audio content is analyzed and the optimal loop in each sample is set. A copy of the loop is automatically created, reversed and mixed with the analyzed loop, and then a loop crossfade is added.
  - **Penrose Machine:** Instead of searching for the best loop in each sample, a snapshot of the sample is taken, and the Penrose Machine algorithm is used to create a DSP-synthesized loop from the snapshot, which is inserted and crossfaded with the rest of the sample.

  The Penrose Machine is an algorithm in which the sonic properties of the current loop are analyzed, and an artificial loop is created with the same sonic properties. This algorithm is completely automatic and has no parameters, making it simple as well as very powerful.

  - **Bidirectional:** The loop area is cut, doubled in length (by being crossfaded into a reversed copy of itself—hence the name “bidirectional”), and the resulting loop is smoothly crossfaded back into the original sample.

  - **Auto Loop Start field and slider:** Drag vertically to set the Auto Sampler search start point for an automatic loop. The value indicates a percentage of the total sample length/time. For example, in a 10-second sample with an Auto Loop Start value of 40%, Auto Sampler begins looking for an auto loop start point after 4 seconds.

  - **Auto Loop End field and slider:** Drag vertically to set the auto loop end point. The value indicates a percentage of the total sample length/time.

  - **One Shot checkbox:** Turn on to save samples as non-repeating, “one shot” samples that play to the end of the sample and stop, rather than loop.

When you trigger a one shot sample, it plays to the end of the file, regardless of whether other samples are triggered. One shot samples are typically used for percussion sounds and sound effects.
Create a sampler instrument with Logic Pro for Mac

Auto Sampler

After you have added Auto Sampler to a channel strip and configured the Auto Sampler controls, you are ready to create a sampler instrument.

Create a sampler instrument using Auto Sampler

1. In an Audio FX slot on the selected channel strip, choose Utility > Auto Sampler.
   
The Auto Sampler plug-in window opens.

2. If you are sampling an external device such as a synthesizer, do all of the following:
   - Connect the instrument to your computer (both audio and MIDI).
   - Create an external instrument channel strip. In the Add Channel Strip dialog, be sure to set the MIDI input, MIDI output, MIDI channel, and (audio) Input for the channel strip.
   - Click keys on the Auto Sampler onscreen keyboard to make sure the instrument can receive MIDI Note messages.
   - Make sure that Logic Pro for Mac can receive audio input from the external device on the correct audio input, and set the levels using the Input Gain slider for a full signal (close to 0dB) without clipping.

3. Play notes on the Auto Sampler onscreen keyboard to make sure they sound (especially the start and end notes of the key range and other notes shown in blue).

4. Adjust the Key Range Start and End and Sample Every values (and any other Auto Sampler controls) as needed.

5. When you are ready, click Sample.

6. In the Save dialog, type a name for the sampler instrument, then click Start.
   
The sampling process starts. Notes being sampled are shown in orange on the keyboard, and the note name and velocity appear in the lower-left part of the Auto Sampler window. The waveform of each sampled note appears on the graphic display, with the percentage completed and remaining time shown below the graph.

7. You can stop the sampling process by clicking Cancel. No sampler instrument is created.

8. After the new sampler instrument is created, you can close Auto Sampler, open Sampler on a channel strip, and open the new sampler instrument from the AutoSampled Instruments submenu of the Sampler Setting pop-up menu.
Work with AutoSampled instruments in Logic Pro for Mac

When you create a sampler instrument using Auto Sampler, the default location to which the sampler instrument is saved is Audio Music Apps > Sampler Instruments > AutoSampled Instruments. Sampler instruments saved to this location are available in the AutoSampled Instruments submenu of the Sampler Setting pop-up menu. You can choose a different location to save the new sampler instrument, but it might not appear in the Sampler Setting pop-up menu.

The samples are saved to a folder in Audio Music Apps > Samples > AutoSampled > [the name of the sampler instrument]. Inside the folder, the individual samples are saved with the following naming scheme:

- `<Sampler instrument name>-<note>-<velocity>-<4-character suffix>`

After creating a sampler instrument using Auto Sampler, you can work with it the same as with any other sampler instrument.

Sampler instruments are supported by Sampler, Alchemy, and Ultrabeat.

Down Mixer in Logic Pro for Mac

You can use Down Mixer to quickly check a surround mix in stereo, for example.

Choose the output format you want to use from the Insert menu when you insert the plug-in in the surround master channel strip.

To add Down Mixer to your project, choose Utility > Down Mixer in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

**Down Mixer parameters**

- *Level sliders*: Control the respective channel levels. The number and names of sliders depend on the chosen destination format.

  Although channel mapping, panning, and downmixing are automatically handled behind the scenes, these sliders provide you with some control over the mix.
Gain plug-in in Logic Pro for Mac

Gain amplifies (or reduces) the signal by a specific decibel amount. It is very useful for quick level adjustments when you work with automated tracks during post-processing—for example, when you have inserted an effect that doesn’t have its own gain control, or when you want to change the level of a track for a remix version.

To add Gain to your project, choose Utility > Gain in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Gain plug-in parameters

- **Gain knob and field**: Set the amount of gain.
- **Phase Invert Left/Right buttons**: Invert the phase of the left and right channels, respectively.
  
  Inverting phase is useful for dealing with time alignment problems, particularly those caused by simultaneous recording with multiple microphones. When you invert the phase of a signal heard in isolation, it sounds identical to the original. When the signal is heard in conjunction with other signals, however, phase inversion may have an audible effect. For example, if you place microphones above and below a snare drum, inverting the phase of either microphone can improve (or ruin) the sound. As always, rely on your ears.
- **Balance knob and field**: Adjust the balance of the incoming signal between the left and right channels.
- **Swap L/R button**: Swap the left and right output channels. Swapping occurs after the Balance parameter in the signal path. The Swap L/R button is disabled when the Mono button is turned on.
- **Mono button**: Output the summed mono signal on both the left and right channels.

*Note*: The Gain plug-in is available in mono, mono to stereo, and stereo instances. Only one Phase Invert button is available in mono and mono to stereo modes. In mono mode, the Balance, Swap L/R, and Mono parameters are also disabled. A separate Multichannel Gain plug-in is also available in Surround channels. This features per-channel Phase Invert and Mute buttons, and Level sliders for each channel.
I/O utility in Logic Pro for Mac

I/O utility lets you use external audio effects units in a similar way to the use of internal effects.

Note: I/O utility is not practical unless you are using an audio interface that provides discrete inputs and outputs, either analog or digital, that are used to send signals to and from the external audio effects unit.

I/O utility parameters

• *Output Volume slider and field:* Adjust the level of the output signal.

• *Output pop-up menu:* Choose the output, or output pair, of your audio hardware.

• *Input pop-up menu:* Choose the input, or input pair, of your audio hardware.
  
  Note: The Input pop-up menu is visible only when an audio interface with multiple inputs is active.

• *Input Volume slider and field:* Adjust the level of the input signal.

• *Latency Detection (Ping) button:* Detect the delay between the selected output and input. Following detection, any delay is automatically compensated for.
  
  Note: You can obtain the most accurate reading by bypassing any latency-inducing plug-ins on the track.

• *Latency Offset slider and field:* Displays the value for the detected latency between the selected output and input in samples. You can also use this slider to offset the latency manually.

• *Dry/Wet slider and field:* Set the balance between the direct and effected signal, if effects are used.

• *Format buttons:* Choose between Stereo and Mid/Side in stereo instances.
Use an external effects unit with I/O utility

1. In Logic Pro, connect an output of your audio interface with the input on your effects unit, and connect the output of your effects unit with an input on your audio interface.

   *Note:* These can be either analog or digital connections, depending on the features of your audio interface and effects unit, and each connection can be either an output or an output pair.

2. Click an effect slot of an aux channel strip that is being used as a bus send/return, and choose Utility > I/O.

3. In the I/O utility window, choose the Outputs and the Inputs of the audio hardware that your effects unit is connected to.

4. Route the signals of any channel strips that you want to process to the bus (aux channel strip) chosen in step 3, and set appropriate Send levels.

5. Adjust the Input Volume and Output Volume sliders as required in the I/O utility window.

6. Click the Latency Detection (Ping) button if you want to detect and compensate for any delay between the selected output and input.

When you start playback, the signals of any channel strips routed to the aux channel chosen in step 3 are processed by the external effects unit.

Multichannel Gain in Logic Pro for Mac

Multichannel Gain allows you to independently control the gain and phase of each channel in a surround mix.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Multichannel Gain parameters

- *Master slider and field:* Set the master gain for the combined channel output.
- *Channel gain sliders and fields:* Set the amount of gain for the respective channel.
- *Phase Invert buttons:* Invert the phase of the selected channel.
- *Mute buttons:* Mute the selected channel.
Test Oscillator in Logic Pro for Mac

Test Oscillator is useful for tuning studio equipment and instruments. It can be inserted as an instrument or effect plug-in. It operates in two modes, generating either a static frequency or a sine sweep. Click the Test Tone or Sine Sweep label to access each mode.

- In Test Tone mode, a test signal is generated immediately when the plug-in is inserted. You can switch off the test tone by bypassing the plug-in.
- In Sine Sweep mode, a user-defined frequency spectrum tone sweep is generated when you click the Trigger button.

To add Test Oscillator to your project, choose Utility > Test Oscillator in a channel strip Audio Effect plug-in menu. See Add, remove, move, and copy plug-ins.

Test Tone mode parameters

- **Generator buttons**: Select the waveform to use for test tone generation. The Square Wave and Needle Pulse waveforms are available as either aliased or anti-aliased versions. The Sine and Square waveforms are bipolar. The Needle Pulse waveform is a unipolar impulse waveform that is always positive, which makes it a useful tool for analyzing polarity or phase issues.
- **Decorrelated button**: Enable to decorrelate the left and right channels of noise waveforms.
- **Anti Aliased button**: Enable to use anti-aliased versions of Square or Needle Pulse waves.
- **Frequency knob and field**: Set the frequency of the oscillator (the default is 1 kHz). You can also double-click this field and enter a value ranging from 1 Hz to 22 kHz, exceeding the possible values that can be set with the knob. If you enter “1,” a 1 Hz test tone is the result.
- **Level knob and field**: Set the overall output level. This parameter is common to both modes.
- **Dim button**: Reduce the output level by 18 dB. This parameter is common to both generator modes.
Sine Sweep mode parameters

- *Time knob and field:* Set the duration of the sine wave sweep.
- *Sweep Mode pop-up menu:* Choose a sweep curve—Linear or Logarithmic.
- *Start/End Frequency knobs and fields:* Set the oscillator frequency for the beginning and end of the sine sweep.
  
  *Note:* The Frequency field shown below the Start and End Frequency parameters is a real-time display of the frequency sweep.
- *Trigger pop-up menu:* Choose the sine sweep mode. Single triggers the sweep once. Continuous triggers the sweep indefinitely.
- *Trigger button:* Start or stop the sine sweep of the spectrum set with the Start and End Frequency knobs. The Frequency field shows values in real-time.
Legacy effects

Legacy effects in Logic Pro for Mac

Legacy effects are included for project or concert compatibility. These plug-ins are inserted when you load a project or concert (that contains these plug-ins) created with an older Logic Pro version.

You can use these plug-ins or you can replace them with other effect plug-ins available in Logic Pro.

You cannot directly insert these plug-ins in Logic Pro unless you override the effects plug-in menu.

Display and insert legacy plug-ins in Logic Pro

1. In Logic Pro, press Option, then click an Audio Effect slot on a channel strip.
   The plug-in menu opens, with a Legacy submenu shown below the Utility plug-in submenu.
2. Choose the legacy plug-in that you want to insert from the Legacy submenu.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Legacy AVerb in Logic Pro for Mac

AVerb is a basic reverb effect that employs a single parameter (Density/Time) to control both the early reflections and diffuse reverb tail. It is a quick and easy tool for creating a range of interesting space and echo effects.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.
AVerb parameters

- *Predelay slider and field:* Determine the time between the source signal and the early reflections of the reverb signal.

- *Reflectivity knob and field:* Define how reflective the imaginary walls, ceiling, and floor are. In other words, emulate how hard the walls are and what they are made of. Glass, stone, timber, carpet, and other materials have a dramatic impact on the tone of the reverb.

- *Room Size knob and field:* Define the dimensions of simulated rooms.

- *Density/Time slider and field:* Determine both the density and duration of the reverb.
  - Low values generate clearly discernible early reflection clusters, resulting in an echo.
  - High values result in a more reverb-like effect.

- *Mix slider and field:* Set the balance between the effect (wet) and direct (dry) signals.

Legacy Bass Amp in Logic Pro for Mac

Bass Amp simulates the sound of several famous bass amplifiers. You can route bass guitar and other signals directly through Bass Amp, reproducing the sound of your musical part played through a number of high-quality bass guitar amplification systems.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

### Bass Amp Parameters

- *Model pop-up menu:* Choose one of the following amplifier models:
  - **American Basic:** 1970s-era American bass amp, equipped with eight 10” speakers. Suitable for blues and rock recordings.
  - **American Deep:** Based on the American Basic amp, but with strong lower-mid frequency (from 500 Hz on) emphasis. Suitable for reggae and pop recordings.
  - **American Scoop:** Based on the American Basic amp, but combines the frequency characteristics of the American Deep and American Bright, with both low-mid (from 500 Hz) and upper-mid (from 4.5 kHz) frequencies emphasized. Suitable for funk and fusion recordings.
  - **American Bright:** Based on the American Basic amp, this model emphasizes the upper-mid frequencies (from 4.5 kHz upward).
• **New American Basic:** 1980s-era American bass amp, suitable for blues and rock recordings.

• **New American Bright:** Based on the New American Basic amp, this model emphasizes the frequency range above 2 kHz. Suitable for rock and heavy metal.

• **Top Class DI Warm:** Famous DI box simulation, suitable for reggae and pop recordings. Mid frequencies, in the range between 500 and 5000 Hz, are de-emphasized.

• **Top Class DI Deep:** Based on the Top Class DI Warm, this model is suitable for funk and fusion. The mid frequency range is strongest around 700 Hz.

• **Top Class DI Mid:** Based on the Top Class DI Warm, this model features an almost linear frequency range, with no frequencies emphasized. It is suitable for blues, rock, and jazz recordings.

• **Pre Gain slider:** Set the pre-amplification level of the input signal.

• **Bass, Mid, and Treble sliders:** Adjust the bass, mid, and treble levels.

• **Mid Freq slider:** Set the center frequency of the mid band (between 200 Hz and 3000 Hz).

• **Output Level slider:** Set the final output level for Bass Amp.

### Legacy DeEsser in Logic Pro for Mac

DeEsser is a frequency-specific compressor, designed to compress a particular frequency band within a complex audio signal. It is used to eliminate hiss (also called *sibilance*) from the signal. The advantage of using DeEsser rather than an EQ to cut high frequencies is that it compresses the signal dynamically, rather than statically. This prevents the sound from becoming darker when no sibilance is present in the signal. DeEsser has extremely fast attack and release times.

When using DeEsser, you can set the frequency range being compressed (the Suppressor frequency) independently of the frequency range being analyzed (the Detector frequency). The two ranges can be compared in the DeEsser Detector and Suppressor frequency range displays. The Suppressor frequency range is reduced in level for as long as the Detector frequency threshold is exceeded.

DeEsser does not use a frequency-dividing network—a crossover utilizing lowpass and highpass filters. Rather, it isolates and subtracts the frequency band, resulting in no alteration of the phase curve.
If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

The Detector parameters are on the left and the Suppressor parameters are on the right. The center section includes the Detector and Suppressor displays and the Smoothing slider.

**DeEsser Detector parameters**
- *Frequency knob and field:* Set the frequency range for analysis.
- *Sensitivity knob and field:* Set the degree of responsiveness to the input signal.
- *Monitor pop-up menu:* Choose the signal you want to monitor and adjust.
  - *Det(ector):* Choose to monitor the isolated detector signal and to set the frequency range.
  - *Sup(pressor):* Choose to monitor the filtered suppressor signal and to set the frequency range.
  - *Sens(itivity):* Choose to remove the sound from the input signal in response to the Sensitivity parameter.
  - *Off:* Choose to hear the DeEsser output.
- *Detector Display:* Shows the frequency range for detection.

**DeEsser Suppressor parameters**
- *Frequency knob and field:* Set the frequency range for reduction.
- *Strength knob and field:* Set the amount of gain reduction for signals that surround the specified frequency.
- *Activity LED:* Indicates active suppression in real time.
- *Suppressor Display:* Shows the frequency range for suppression.

**DeEsser common parameter**
- *Smoothing slider and field:* Set the reaction speed for the gain reduction start and end phases. Smoothing controls both the attack and release times.
Denoiser

Legacy Denoiser in Logic Pro for Mac

Denoiser eliminates or reduces any noise below a threshold volume level. It does this by using Fast Fourier Transform (FFT) analysis to identify frequency bands of lower volume and less complex harmonic structure, which it then reduces to the defined decibel level.

If you use Denoiser too aggressively, you may encounter artifacts that are less pleasant than the existing noise. Use the three Smoothing knobs to reduce or eliminate these artifacts. See Legacy Denoiser smoothing controls.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Denoiser main parameters

- **Threshold slider and field:** Set the threshold level to a point below which the noise signals are reduced. Locate a section of the audio where only noise is audible, then set the Threshold slider to a dB value that filters only signals at or below this level.

- **Reduce slider and field:** Set the amount of noise reduction applied to signals that fall below the threshold. Aim for a Reduce slider value with which noise reduction is optimal but little of the music or vocal signal is reduced. Each 6 dB reduction halves the volume level, and each 6 dB increase doubles it.

  *Note:* If the noise level of your recording is very high (more than −68 dB), reducing it to a level of −83 to −78 dB should suffice, provided no audible side effects are introduced. This reduces the noise by more than 10 dB, to less than half its original volume.

- **Noise Type slider and field:** Determine the type of noise you want to reduce.
  - A value of 0 equals white noise—equal frequency distribution.
  - Positive values change the noise type to pink noise—harmonic noise; greater bass response.
  - Negative values change the noise type to blue noise—hissey tape noise.

- **Graphic display:** Shows how the lowest volume level signals in your audio material, which are mostly or entirely noise, are reduced.
Legacy Denoiser smoothing controls in Logic Pro for Mac

Denoiser has the following smoothing parameters:

Denoiser smoothing parameters

- **Frequency knob and field**: Adjust how smoothing is applied to neighboring frequencies. If Denoiser recognizes that only noise is present on a certain frequency band, use the Frequency parameter to smooth the neighboring frequencies to avoid artifacts. The higher you set the Frequency parameter, the more the neighboring frequency bands are changed.

- **Time knob and field**: Set the time required to reach maximum noise reduction. This is the simplest form of smoothing.

  *Note*: The Time parameter also sets a release time, which is the time required for the signal to revert to its normal level from the maximum noise reduction level. As with all Denoiser parameters, the Threshold value determines the level that triggers the noise reduction process.

- **Transition knob and field**: Adjust how smoothing is applied to neighboring volume levels. If Denoiser recognizes that only noise is present in a certain volume range, use the Transition parameter to smooth the neighboring volume levels to avoid artifacts. The higher you set the Transition parameter, the more similar-level values are changed.

Legacy Ducker in Logic Pro for Mac

Ducking is a common technique used in radio and television broadcasting. When the DJ or announcer speaks while music is playing, the music level is automatically reduced. When the announcement has finished, the music is automatically raised to its original volume level. Ducker provides a simple means of achieving this result with existing recordings. It does not work in real time.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

*Note*: For technical reasons, Ducker can be inserted only in output and aux channel strips.
Ducker parameters

- **Ducking checkbox:** Turn ducking on or off.
- **Amount slider and field:** Set the amount of volume reduction of the music mix channel strip—in effect, the output signal.
- **Threshold slider and field:** Set the lowest level that a side chain signal must reach before the music mix output level is reduced (by the value set with the Amount slider). If the side chain signal level doesn’t reach the threshold, the music mix channel strip volume is not affected.
- **Attack slider and field:** Control how quickly the volume is reduced. If you want the music mix signal to be gently faded out, set this slider to a high value. The Attack value also controls whether or not the signal level is reduced before the threshold is reached. The earlier this occurs, the more latency is introduced.
  
  *Note:* Ducker does not work with live (real-time) ducking signals. The ducking signal must be an existing recording. Logic Pro needs to analyze the signal level before it is played back to predefine the point where ducking begins.
- **Hold slider and field:** Define the length of time that the music mix channel strip volume is reduced. This control prevents a chattering effect that can be caused by a rapidly changing side chain level. If the side chain level hovers around the threshold value rather than clearly exceeding or falling short of it, set the Hold parameter to a high value to compensate for any rapid volume reductions.
- **Release slider and field:** Control how quickly the volume returns to the original level. Set it to a high value if you want the music mix to slowly fade up after the announcement.
- **Lookahead checkbox:** Turn on to make sure that Ducker reads the incoming signal before processing. This results in no latency—it is primarily intended for slower computers.

Use the Ducker plug-in

1. In Logic Pro, insert Ducker into an aux channel strip.
2. Assign all channel strip outputs that are supposed to “duck” (dynamically lower the volume of the mix) to a bus—the aux channel strip chosen in step 1.
3. In the Ducker plug-in window header, choose the bus that carries the ducking (vocal) signal from the Side Chain pop-up menu.
   
   *Note:* Unlike all other side chain-capable plug-ins, the Ducker side chain is mixed with the output signal after passing through the plug-in. This ensures that the ducking side chain signal—the voiceover—is heard at the output.
4. Adjust the Ducker parameters.
EQ

Legacy DJ EQ in Logic Pro for Mac

DJ EQ combines high and low shelving filters, each with a fixed frequency, and one parametric EQ. You can adjust the Frequency, Gain, and Q-Factor of the latter. The DJ EQ allows the filter gain to be reduced by as much as −30 dB.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

![DJ EQ](image)

**DJ EQ parameters**

- High Shelf slider and field: Drag to set the amount of gain for the high shelving filter.
- Frequency slider and field: Drag to set the center frequency of the parametric EQ.
- Q-Factor slider and field: Drag to set the range (bandwidth) of the parametric EQ.
- Gain slider and field: Drag to set the amount of gain for the parametric EQ.
- Low Shelf slider and field: Drag to set the amount of gain for the low shelving filter.

Legacy Fat EQ in Logic Pro for Mac

Fat EQ is a versatile multiband EQ that can be used on individual sources or overall mixes. Fat EQ provides up to five individual frequency bands, graphically displays EQ curves, and includes a set of parameters for each band.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.
Fat EQ parameters

- **Band Type buttons**: For bands 1, 2, 4, and 5, click one of the paired buttons to select the EQ type. Band 3 is parametric.
  - **Band 1**: Click the highpass or low shelving button.
  - **Band 2**: Click the low shelving or parametric button.
  - **Band 3**: Always acts as a parametric EQ band.
  - **Band 4**: Click the parametric or high shelving button.
  - **Band 5**: Click the high shelving or lowpass button.

- **Graphic display**: Shows the EQ curve of each frequency band. The scale is shown in dB.

- **Frequency fields**: Set the frequency for each band.

- **Gain knobs and fields**: Set the amount of gain for each band.

- **Q fields**: Set the Q or bandwidth of each band—the range of frequencies around the center frequency that are altered. At low Q factor values, the EQ covers a wider frequency range. At high Q values, the effect of the EQ band is limited to a narrow frequency range. The Q value can significantly influence how audible your changes are—if you are working with a narrow frequency band, you usually need to cut or boost more drastically to notice the difference.
  
  **Note**: For bands 1 and 5, this changes the slope of the filter.

- **Band On/Off buttons**: Turn the corresponding band on or off.

- **Master Gain slider and field**: Set the overall output level of the signal. Use it after boosting or cutting individual frequency bands.

Legacy Single-Band EQs in Logic Pro for Mac

The single-band EQs are used for different types of equalization tasks.

- **High Cut or Low Cut**: High Cut attenuates the frequency range above the selected frequency. Low Cut attenuates the frequency range that falls below the selected frequency.

- **High Pass or Low Pass Filter**: High Pass Filter affects the frequency range below the set frequency. Higher frequencies pass through the filter. You can use High Pass Filter to eliminate the bass below a selectable frequency. Low Pass Filter affects the frequency range above the selected frequency.

- **High Shelf or Low Shelf EQ**: Low shelving EQ affects only the frequency range that falls below the selected frequency. High shelving EQ affects only the frequency range above the selected frequency.

- **Parametric EQ**: Parametric EQ is a simple filter with a variable center frequency. It can be used to boost or cut any frequency band in the audio spectrum, either with a wide frequency range or as a notch filter with a very narrow range. A symmetrical frequency range on either side of the center frequency is boosted or cut.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.
High Cut and Low Cut parameters
- Frequency slider and field: Drag to set the cutoff frequency.

High Pass and Low Pass parameters
- Frequency slider and field: Drag to set the cutoff frequency.
- Order slider and field: Drag to set the filter order. The more orders used, the stronger the filtering effect.
- Smoothing slider and field: Drag to adjust the amount of smoothing, in milliseconds.

High and Low Shelving EQ parameters
- Gain slider and field: Drag to set the amount of cut or boost.
- Frequency slider and field: Drag to set the cutoff frequency.

Parametric EQ parameters
- Gain slider and field: Drag to set the amount of cut or boost.
- Frequency slider and field: Drag to set the cutoff frequency.
- Q-Factor slider and field: Drag to set the Q (bandwidth).

Legacy Silver EQ in Logic Pro for Mac
Silver EQ includes three bands—a high shelving EQ, a parametric EQ, and a low shelving EQ. You can adjust the cutoff frequencies for the high shelving and low shelving EQs. You can adjust the center frequency, gain, and Q factor of the parametric EQ.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Silver EQ parameters
- High Shelf slider and field: Drag to set the level of the high shelving EQ.
- High Frequency slider and field: Drag to set the cutoff frequency for the high shelving EQ.
- Frequency slider and field: Drag to set the center frequency of the parametric EQ.
- Q-Factor slider and field: Drag to set the range (bandwidth) of the parametric EQ.
- Gain slider and field: Drag to set the amount of cut or boost for the parametric EQ.
- Low Shelf slider and field: Drag to set the level of the low shelving EQ.
- Low Frequency slider and field: Drag to set the cutoff frequency for the low shelving EQ.
GoldVerb

GoldVerb in Logic Pro for Mac

GoldVerb allows you to edit both the early reflections and diffuse reverb tail separately, making it easy to precisely emulate real rooms.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

GoldVerb is divided into four parameter areas:

- **Early reflections parameters**: Used to emulate the original signal first reflections as they bounce off the walls, ceiling, and floor of a natural room. See GoldVerb early reflections controls.

- **Reverb parameters**: Control the diffuse reverberations. See GoldVerb reverb parameters.

- **Balance ER/Reverb slider and field**: Set the balance between the early reflections and the reverb signal. When the slider is set to either extreme position, the other signal is not heard.

- **Mix slider and field**: Determine the balance between the effect (wet) and direct (dry) signals.
GoldVerb early reflections controls in Logic Pro for Mac

The GoldVerb provides the following early reflections parameters.

GoldVerb early reflections parameters

- **Predelay slider and field**: Set the time between the start of the original signal and the arrival of the early reflections.
  - **Extremely short**: Predelay settings can color the sound and make it difficult to pinpoint the position of the signal source.
  - **Very long**: Predelay settings can be perceived as an unnatural echo and can divorce the original signal from its early reflections, leaving an audible gap between them.
  - **The optimum**: Predelay setting depends on the type of input signal—or more precisely, the envelope of the input signal. Percussive signals generally require shorter predelays than signals where the attack fades in gradually. A good working method is to use the longest possible Predelay value before you start to hear side effects, such as an audible echo. When you reach this point, reduce the Predelay setting slightly.

- **Room Shape slider and field**: Define the geometric form (the shape) of the room. The numeric value (3 to 7) represents the number of corners in the room. The graphic display visually represents this setting.

- **Room Size slider and field**: Determine the dimensions of the room. The numeric value indicates the length of the room walls—the distance between two corners.

- **Graphic display**: Shows changes to Room Size and Room Shape parameters.

- **Stereo Base slider and field**: Set the distance between the two virtual microphones that capture the simulated room signal.

  Note: Spacing the microphones slightly farther apart than the distance between two human ears generally delivers the best, and most realistic, results. This parameter is available only in stereo instances of the effect.
GoldVerb reverb parameters in Logic Pro for Mac

GoldVerb provides the following reverb parameters.

GoldVerb reverb parameters

- **Initial Delay slider and field**: Set the time between the original signal and the diffuse reverb tail. If you are trying to attain a natural-sounding, harmonic reverb, the transition between the early reflections and the reverb tail should be as smooth and seamless as possible. Set the Initial Delay parameter so that it is as long as possible, without a noticeable gap between the early reflections and the reverb tail.

- **Spread slider and field**: Control the width of the reverb stereo image. At 0%, the effect generates a monaural reverb. At 200%, the stereo base is artificially expanded.

- **High Cut knob and field**: Filter frequencies above the set value from the reverb signal. Uneven or absorbent surfaces—wallpaper, wood paneling, carpets, and so on, tend to reflect lower frequencies better than higher frequencies. The High Cut filter mimics this effect. If you set the High Cut filter to its maximum value, the reverb sounds like it is reflecting off stone or glass.

- **Density knob and field**: Control the density of the diffuse reverb tail. Ordinarily you want the signal to be as dense as possible. In rare instances, however, a high Density value can color the sound, which you can fix by reducing the Density knob value. Conversely, if you select a Density value that is too low, the reverb tail sounds grainy.

- **Reverb Time knob and field**: Set the time it takes for the reverb level to drop by 60 dB—often indicated as RT60. Most natural rooms have a reverb time somewhere in the range of 1 to 3 seconds. This time is reduced by absorbent surfaces, such as carpet and curtains, and soft or dense furnishings, such as sofas, armchairs, cupboards, and tables. Large empty halls or churches have reverb times of up to 8 seconds, with some cavernous or cathedral-like venues extending beyond that.

- **Diffusion slider and field (Extended Parameters area)**: Set the diffusion of the reverb tail. High Diffusion values represent a regular density, with few alterations in level, times, and panorama position over the course of the diffuse reverb signal. Low Diffusion values result in the reflection density becoming irregular and grainy. This also affects the stereo spectrum. As with Density, find the best balance for the signal.
Legacy Grooveshifter in Logic Pro for Mac

Grooveshifter allows you to rhythmically vary audio recordings, imparting a swing feel to the input signal. Imagine a guitar solo played in straight eighth or sixteenth notes. Grooveshifter can make this straightforward solo swing.

Grooveshifter automatically follows all changes to the project tempo, which it uses as the reference tempo.

*Note:* Grooveshifter relies on perfect matching of the project tempo with the tempo of the treated recording. Any tempo variations deliver less precise results.

If you’re new to using plug-ins in Logic Pro, see *Add, remove, move, and copy plug-ins.*

![Grooveshifter interface](image)

**Grooveshifter source material parameters**

- *Beat and Tonal buttons:* Select the type of source, or input, material you are using.
  - *Beat button:* The beat algorithm is optimized for percussive input material. The Grain Size slider is disabled when you select Beat.
  - *Tonal button:* The tonal algorithm is optimized for tonal input material. Because this algorithm is based on granular synthesis, the Grain Size slider is available when you select Tonal.
  - *Grain Size slider and field:* Set the size of the grains—from 1 ms to 20 ms. Technically, this determines the analysis precision. The default Auto setting at the left end of the slider automatically assigns a suitable grain size value based on the incoming signal.

**Grooveshifter swing parameters**

- *Grid buttons:* Set the beat division used as a timing reference when analyzing audio material.
  - *1/8 button:* Select if the audio material contains primarily eighth notes.
  - *1/16 button:* Select if the audio material consists mostly of sixteenth notes.
- *Swing slider and field:* Set the amount that even beats are delayed—from 50% to 75%. A value of 50% means there is no swing, which is typical for most pop and rock music styles. The higher the value, the stronger the swing effect.
- *Accent slider and field:* Set the level of even beats, from –12 dB to +12 dB, suppressing or accentuating them. Such accents are typical of a variety of rhythmic styles, such as swing or reggae.
Guitar Amp Pro

Legacy Guitar Amp Pro in Logic Pro for Mac

Guitar Amp Pro simulates the sound of popular guitar amplifiers and the speakers used with them. You can process guitar signals directly, reproducing the sound of your guitar through a number of high-quality guitar amplification systems. Guitar Amp Pro can also be used for experimental sound design and processing. You can use it with other instruments, applying the sonic character of a guitar amp to a trumpet or vocal part, for example.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

An amplifier “model” consists of an amplifier, speaker cabinet, EQ type, and microphone type. You can create your own hybrids of different amplifiers, cabinets, and so on—using the pop-up menus at the top center of the interface. You choose the microphone position and type in the yellow areas to the left and right. Guitar Amp Pro also emulates classic guitar amplifier effects, including reverb, vibrato, and tremolo.

You can use the Settings pop-up menu to save your new hybrid amp combos as setting files, which also include any parameter changes you may have made.

The Guitar Amp Pro window is organized into several parameter sections.

• **Amp section:** The model parameters at the top are used to choose the type of amp, EQ model, and speaker. The knobs in the V-shaped section are used to set tone, gain, and level. See Guitar Amp Pro amplifier models, Guitar Amp Pro cabinet models, and Guitar Amp Pro EQ.

• **Effects section:** Provides parameters to control the built-in tremolo, vibrato, and reverb effects. See Guitar Amp Pro effects.
• **Microphone Position and Type sections:** These sections enable you to set the position and type of the microphone. See [Guitar Amp Pro mic parameters](#).

• **Output slider:** The Output slider is found at the bottom, below the Effects section. It serves as the final level control for Guitar Amp Pro and can be thought of as a “behind the speaker” volume control that is used to set the level fed to the ensuing plug-in slots on the channel strip or to Output channel strips.

  *Note:* This parameter is different from the Master control, which serves the dual purpose of sound design as well as controlling the level of the Amp section.

## Guitar Amp Pro amplifier models in Logic Pro for Mac

You can choose an amplifier model from the Amp pop-up menu near the top of the interface.

### Amp models

- **UK Combo 30W:** Neutral-sounding amp, suitable for clean or crunchy rhythm parts.
- **UK Top 50W:** Quite aggressive in the high frequency range, suitable for classical rock sounds.
- **US Combo 40W:** Clean sounding amp model, suitable for funk and jazz sounds.
- **US Hot Combo 40W:** Emphasizes the high mid-frequency range, making this model ideal for solo sounds.
- **US Hot Top 100W:** This amp produces very fat sounds, even at low Master settings, that result in broad sounds with a lot of “oomph.”
- **Custom 50W:** With the Presence parameter set to 0, this amp model is suitable for smooth fusion lead sounds.
- **British Clean (GarageBand):** Simulates the classic British Class A combos used continuously since the 1960s for rock music, without any significant modification. This model is ideally suited for clean or crunchy rhythm parts.
- **British Gain (GarageBand):** Emulates the sound of a British tube head and is synonymous with rocking, powerful rhythm parts and lead guitars with a rich sustain.
- **American Clean (GarageBand):** Emulates the traditional full tube combos used for clean and crunchy sounds.
- **American Gain (GarageBand):** Emulates a modern Hi-Gain head, making it suitable for distorted rhythm and lead parts.
- **Clean Tube Amp:** Emulates a tube amp model with very low gain (distortion only when using very high input levels or Gain/Master settings).
Guitar Amp Pro cabinet models in Logic Pro for Mac

The speaker cabinet can have a huge bearing on the type of tones you can extract from your chosen amplifier. The speaker parameters are found near the top of the interface.

Speaker cabinet parameters

- **Speaker pop-up menu**: Choose one of 15 speaker models:
  - **UK 1 x 12 open back**: Classic open enclosure with one 12" speaker, neutral, well-balanced, multifunctional.
  - **UK 2 x 12 open back**: Classic open enclosure with two 12" speakers, neutral, well-balanced, multifunctional.
  - **UK 2 x 12 closed**: Loads of resonance in the low frequency range, therefore suitable for Combos: crunchy sounds are also possible with low Bass control settings.
  - **UK 4 x 12 closed slanted**: When used in combination with off-center miking, you can attain an interesting mid frequency range; therefore, this model works well when combined with High Gain amps.
  - **US 1 x 10 open back**: Minimal resonance in the low frequency range. Suitable for use with blues harmonicas.
  - **US 1 x 12 open back 1**: Open enclosure of an American lead combo with a single 12" speaker.
  - **US 1 x 12 open back 2**: Open enclosure of an American clean/crunch combo with a single 12" speaker.
  - **US 1 x 12 open back 3**: Open enclosure of another American clean/crunch combo with a single 12" speaker.
  - **US broad range**: Simulation of a classic electric piano speaker.
  - **Analog simulation**: Internal speaker simulation of a well-known British tube preamplifier.
  - **UK 1 x 12 (GarageBand)**: A British Class A tube open back with a single 12" speaker.
  - **UK 4 x 12 (GarageBand)**: Classic closed enclosure with four 12" speakers (black series), suitable for rock.
  - **US 1 x 12 open back (GarageBand)**: Open enclosure of an American lead combo with a single 12" speaker.
  - **US 1 x 12 bass reflex (GarageBand)**: Closed bass reflex cabinet with a single 12" speaker.
  - **DI Box**: Bypasses the speaker simulation section.
  - **Amp-Speaker Link button**: Links the Amp and Speaker pop-up menus, so that changes to amp model selection result in the speaker associated with that amp also being loaded.
Guitar Amp Pro EQ in Logic Pro for Mac

The EQ pop-up menu and the Amp-EQ Link button are near the top of the interface.

EQ parameters

- **EQ pop-up menu:** Contains the following EQ models: British1, British2, American, and Modern. Each EQ model has unique tonal qualities that affect the way the Bass, Mids, and Treble knobs in the Amp section respond.

- **Amp-EQ Link button:** Located between the Amp and EQ pop-up menus, links these pop-up menus so that when you change the amp model, the EQ model associated with that amp is loaded automatically.

  Each amp model has a speaker and EQ model associated with it. The default combinations of amp, speaker, and EQ settings re-create a well-known guitar sound. You can combine any speaker or EQ model with any amp by turning off the two Link buttons.

Guitar Amp Pro amplifier controls in Logic Pro for Mac

The Gain, Bass, Mids, Treble, Presence, and Master knobs run from left to right in the V-shaped formation in the upper half of the interface.

Amplifier parameters

- **Gain knob:** Set the amount of pre-amplification applied to the input signal. This control has different effects, depending on which Amp model is chosen. For example, when you are using the British Clean amp model, the maximum Gain setting produces a powerful crunch sound. If you use the British Gain or Modern Gain amps, the same Gain setting produces heavy distortion, suitable for lead solos.

- **Bass, Mids, and Treble knobs:** Adjust the frequency range levels of the EQ models, similar to the tone knobs on a hardware guitar amplifier.

- **Presence knob:** Adjust the high frequency range level. The Presence parameter affects only the output (Master) stage of Guitar Amp Pro.

- **Master knob:** Set the output volume of the amplifier—going to the speaker. For tube amplifiers, increasing the Master level typically produces a more compressed and saturated sound, resulting in a more distorted and powerful—that is, louder—signal. High Master settings can produce an extremely loud output that can damage your speakers or hearing, so ramp this up slowly. In Guitar Amp Pro, the Master parameter modifies the sonic character, and the final output level is set using the Output parameter at the bottom of the interface.
Guitar Amp Pro effects in Logic Pro for Mac

The effects parameters include Tremolo, Vibrato, and Reverb, which emulate the processors found on many amplifiers.

You can use the pop-up menu to choose either Tremolo, which modulates the amplitude or volume of the sound, or Vibrato, which modulates the pitch.

Reverb can be added to either of these effects, or used independently.

To use or adjust an effect, you must first enable it by clicking the corresponding On button to the left. The On button is red when active.

Note: The Effects section is placed before the Presence and Master controls in the signal flow, and receives the preamplified, pre-Master signal.

Tremolo and vibrato parameters

- **On/off button**: Turn the tremolo/vibrato effect on or off.
- **FX pop-up menu**: Choose either Tremolo or Vibrato.
- **Depth knob**: Set the intensity of the modulation.
- **Speed knob**: Set the speed of the modulation in hertz. Lower settings produce a smooth and floating sound, while higher settings produce a rotor-like effect.
- **Sync button**: Turn on to synchronize the modulation speed with the project tempo. You can adjust the Speed knob to select bar, beat, and musical note values (including triplet and dotted notes). When the Sync button is turned off, the modulation speed can be set to any available value with the Speed knob.

Reverb parameters

- **On/off button**: Turn the reverb effect on or off.
- **Reverb pop-up menu**: Choose one of the three types of spring reverb.
- **Level knob**: Rotate to set the amount of reverb applied to the pre-amplified amp signal.

Guitar Amp Pro mic controls in Logic Pro for Mac

After choosing a speaker cabinet from the Speaker menu, you can set the type of microphone you want to be emulated, and where the microphone is placed in relation to the speaker. The Microphone Position parameters are available in the yellow area to the left, and the Microphone Type parameters in the yellow area to the right.

Microphone position parameters

- **Centered button**: Places the microphone in the center of the speaker cone, also called on-axis. This placement produces a fuller, more powerful sound, suitable for blues or jazz guitar tones.
- **Off-Center button**: Places the microphone on the edge of the speaker, also referred to as off-axis. This placement produces a tone that is brighter and sharper, but also thinner—suitable for cutting rock or R & B guitar parts.

When you select either button, the graphic speaker display reflects your choice.
Microphone type parameters

- **Condenser button:** Emulates the sound of a studio condenser microphone. The sound of condenser microphones is fine, transparent, and well-balanced.

- **Dynamic button:** Emulates the sound of a dynamic cardioid microphone. This microphone type sounds brighter and more cutting than the Condenser model. At the same time, the lower-mid frequency range is less pronounced, making this model more suitable for miking rock guitar tones.

⚠️ Tip: Combining both microphone types can sound quite interesting. Duplicate the guitar track, and insert Guitar Amp Pro as an insert effect on both tracks. Select different microphone types in each Guitar Amp Pro instance, while retaining identical settings for all other parameters, and mix the track signal levels. You can also choose to vary any other parameters.

PlatinumVerb

PlatinumVerb in Logic Pro for Mac

PlatinumVerb allows you to edit both the early reflections and diffuse reverb tail separately, making it easy to precisely emulate real rooms. PlatinumVerb splits the incoming signal into two bands: each is processed and can be edited separately.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.
PlatinumVerb is divided into four parameter areas:

- **Early reflections parameters**: Emulate the original signal first reflections as they bounce off the walls, ceiling, and floor of a natural room. See PlatinumVerb early reflections controls.

- **Reverb parameters**: Control the diffuse reverberations. See PlatinumVerb reverb parameters.

- **Output parameters**: Determine the balance between the effected (wet) and direct (dry) signals. See PlatinumVerb output parameters.

- **Balance ER/Reverb slider and field**: Control the balance between the early reflections and reverb signal. When the slider is set to either extreme position, the other signal is not heard.

**PlatinumVerb early reflections controls in Logic Pro for Mac**

PlatinumVerb provides the following early reflections parameters.

![PlatinumVerb early reflections controls](image)

**PlatinumVerb early reflections parameters**

- **Predelay slider and field**: Set the time between the start of the original signal and the arrival of the early reflections.
  - **Extremely short**: Predelay setting can color the sound and make it difficult to pinpoint the position of the signal source.
  - **Very long**: Predelay setting can be perceived as an unnatural echo and can divorce the original signal from its early reflections, leaving an audible gap between them.
  - **The optimum**: Predelay setting depends on the type of input signal—or more precisely, the envelope of the input signal. Percussive signals generally require shorter predelays than signals where the attack fades in gradually. A good working method is to use the longest possible Predelay value before you start to hear side effects, such as an audible echo. When you reach this point, reduce the Predelay setting slightly.

- **Room Shape slider and field**: Define the geometric form (the shape) of the room. The numeric value (3 to 7) represents the number of corners in the room.

- **Room Size slider and field**: Determine the dimensions of the room. The numeric value indicates the length of the room walls—the distance between two corners.

- **Graphic display**: Shows changes to Room Size and Room Shape parameters.
• **Stereo Base slider and field**: Set the distance between the two virtual microphones that capture the simulated room signal.

  *Note*: Spacing the microphones slightly farther apart than the distance between two human ears generally delivers the best, and most realistic, results. This parameter is available only in stereo instances of the effect.

• **ER Scale slider and field** *(Extended Parameters area)*: Scale early reflections along the time axis. This simultaneously influences the Room Shape, Room Size, and Stereo Base parameters.

---

**PlatinumVerb reverb parameters in Logic Pro for Mac**

PlatinumVerb provides the following reverb parameters.

![PlatinumVerb reverb parameters](image)

**PlatinumVerb reverb parameters**

• **Initial Delay slider and field**: Set the time between the original signal and the diffuse reverb tail.

• **Spread slider and field**: Control the width of the reverb stereo image. At 0%, the effect generates a monaural reverb. At 200%, the stereo base is artificially expanded.

• **Crossover slider and field**: Set the frequency used to split the input signal into two frequency bands, for separate processing.

• **Low Ratio slider and field**: Determine the relative reverb times of the bass and high frequency bands. It is expressed as a percentage. At 100%, the reverb time of the two bands is identical. At values below 100%, the reverb time of frequencies below the crossover frequency is shorter. At values greater than 100%, the reverb time for low frequencies is longer.

• **Low Freq Level slider and field**: Set the level of the low frequency reverb signal. At 0 dB, the volume of the two bands is equal. In most mixes, set a lower level for the low frequency reverb signal. This lets you boost the bass level of the incoming signal, making it sound punchier. This also helps to counteract bottom-end masking effects.

• **High Cut slider and field**: Filter frequencies above the set value from the reverb signal. Uneven or absorbent surfaces—wallpaper, wood paneling, carpets, and so on, tend to reflect lower frequencies better than higher frequencies. The High Cut filter replicates this effect. If you set the High Cut filter so that it is wide open (maximum value), the reverb sounds as if it is reflecting off stone or glass.

• **Density slider and field**: Set the density of the diffuse reverb tail. Ordinarily you want the signal to be as dense as possible. In rare instances, however, a high Density value can color the sound, which you can fix by reducing the Density slider value. Conversely, if you select a Density value that is too low, the reverb tail sounds grainy.
• **Diffusion slider and field:** Set the diffusion of the reverb tail. High Diffusion values represent a regular density, with few alterations in level, times, and panorama position over the course of the diffuse reverb signal. Low Diffusion values result in the reflection density becoming irregular and grainy. This also affects the stereo spectrum. As with Density, find the best balance for the signal.

• **Reverb Time slider and field:** Determine the reverb time of the high frequency band. Most natural rooms have a reverb time somewhere in the range of 1 to 3 seconds. This time is reduced by absorbent surfaces, such as carpet and curtains, and soft or dense furnishings, such as sofas, armchairs, cupboards, and tables. Large empty halls or churches have reverb times of up to 8 seconds, with some cavernous or cathedral-like venues extending beyond that.

PlatinumVerb output controls in Logic Pro for Mac

PlatinumVerb provides the following output parameters.

PlatinumVerb output parameters

• **Dry slider and field:** Control the amount of the original signal.

• **Wet slider and field:** Control the amount of the effect signal.

Silver Compressor in Logic Pro for Mac

Silver Compressor is a simplified version of the Compressor plug-in. See Use Compressor.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.
Silver Compressor parameters

- *Gain Reduction meter:* Show the amount of compression in real time.
- *Threshold slider and field:* Set the threshold level. Signals that exceed the threshold are reduced in level.
- *Attack knob and field:* Set the time it takes for Silver Compressor to react when the signal exceeds the threshold.
- *Release knob and field:* Set the time it takes for Silver Compressor to stop reducing the signal, after the signal falls below the threshold.
- *Ratio slider and field:* Set the ratio by which the signal is reduced, when it exceeds the threshold.

Silver Gate in Logic Pro for Mac

Silver Gate is a simplified version of the Noise Gate plug-in. See Use Noise Gate.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Silver Gate parameters

- *Lookahead slider and field:* Set how far ahead Silver Gate analyzes the incoming signal, allowing it to respond more quickly to peak levels.
- *Threshold slider and field:* Set the threshold level. Signals that fall below the threshold are reduced in level.
- *Attack knob and field:* Set the time it takes to fully open the gate after the signal exceeds the threshold.
- *Hold knob and field:* Set the time the gate remains open after the signal falls below the threshold.
- *Release knob and field:* Set the time it takes to fully close the gate after the signal falls below the threshold.
Legacy Speech Enhancer in Logic Pro for Mac

You can use Speech Enhancer to improve speech recordings made with the computer internal microphone, if applicable. It combines denoising, advanced microphone frequency remodeling, and multiband compression.

If you’re new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Speech Enhancer parameters

- **Denoise slider and field:** Determine the noise floor in the recording, from –60 dB to –20 dB, and thus the amount of noise reduction required. Settings toward –60 dB allow more noise to pass; settings toward –20 dB increasingly suppress background noise but also proportionately increase artifacts.

- **Mic Correction checkbox:** Turn on to improve the frequency response of recordings made with your built-in microphone. This can create the impression that a more expensive microphone was used.

- **Mic Model pop-up menu:** Choose a microphone model to compensate for tonal characteristics of specific built-in Mac microphones.

  Note: You can use Speech Enhancer with other microphones as well, but microphone correction models are provided only for built-in Mac and iSight microphones. If you are using a non-Apple microphone, choose Generic from the Mic Correction pop-up menu.

- **Voice Enhance checkbox:** Turn on the Voice Enhance multiband compression circuit.

- **Enhance Mode pop-up menu:** When Voice Enhance is active, choose a setting that makes the recorded voice louder and more intelligible.
  - **(Female or Male) Solo:** Choose when the recorded signal consists of a vocal only.
  - **(Female or Male) Voice Over:** Choose when the recorded signal contains both a vocal performance and a musical or atmospheric bed.